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Chapter 33

Using the Edit Page
In this chapter, you’ll learn how to use and configure the Edit page 
user interface to prepare for editing projects in DaVinci Resolve. 

For more information on how to use the Edit page to import and conform projects edited in other 
applications for color correction and finishing in DaVinci Resolve, see Chapter 56, “Conforming and 
Relinking Clips.”
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The Edit Page User Interface
The Edit page has evolved into a source-record style NLE that contains nearly every editorial tool 
you need for creative editing through finishing. The Edit page is divided into three main regions: the 
browsers found at the left, the Viewers at the top, and the Timeline at the bottom, all of which work 
together to let you import, edit, and trim timelines with a flexible variety of tools and methods.

The Interface Toolbar

At the very top of the Edit page is a toolbar with buttons that let you show and hide different parts of 
the user interface. These buttons are as follows, from left to right:

The Interface toolbar

Media Pool/Effects Library/Edit Index height button: Lets you set the area used by the Media 
Pool, Effects Library, and/or Edit Index to take up the full height of your display (you can display two at 
a time), giving you more area for browsing at the expense of a narrower timeline. At half height, the 
Media Pool/Effects Library/Edit Index are restricted to the top of the UI (you can only show one at a 
time), and the timeline takes up the full width of your display.
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Media Pool: Opens or hides a smaller version of the full Media Pool page, 
allowing access to all the video clips, audio clips, and images used in the project.

Effects Library: Opens or hides the repository of all transitions, generators, 
OpenFX, and audio filters available to use in the Edit page.

Index: Opens or hides the Edit, Tracks, and Markers indexes.

Sound Library: Opens or hides the libraries of sound effects and music 
registered with DaVinci Resolve. For more information on using the Sound Library,  
see Chapter 166, “Using the Fairlight Page.”

Quick Export: Opens the Quick Export window.

Mixer: Opens or hides the Audio Mixer, giving you graphical controls to 
adjust your sound mix.

Metadata: Shows or hides the Metadata Editor.

Inspector: Shows or hides the Inspector, which shows you the transform and 
compositing effects of selected clips, or the editable options of selected effects 
such as transitions or generators.

Navigating the Edit Page
Each of the panels in the Edit page user interface can be given focus via the Workspace > Active Panel 
Selection submenu. Additionally, the following keyboard shortcuts can be used to give focus to 
select bins, clips, the Source and Timeline Viewers, the Timeline, the Effects Library, Edit Index, 
and Inspector.

Key Function

Command-1 Media Folders

Command-2 Media Clips

Command-3 Source Viewer

Command-4 Timeline

Command-5 Timeline Viewer

Command-6 Effects

Command-7 Edit Index

Command-8 n/a

Command-9 Inspector

Q Toggle between Source and Timeline Viewers
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Showing Which Panel Has Focus
Each panel you use has “focus,” meaning that clicking an item or control within a particular panel 
makes that panel the active panel, which serves to direct keyboard shortcuts that are shared among 
many panels to the particular panel you’re using. If you want to see which panel is in focus, you can 
turn on the “Show focus indicators in the User Interface” checkbox in the UI Settings panel of the User 
Preferences. When on, a red line at the top of the active panel indicates that it has focus.

The focus indicator shown at the top edge of the Media 
Pool, shown next to a viewer that doesn’t have focus

The Media Pool
In the Edit page, the Media Pool contains all of the video, audio, and still image media you’ve imported 
for editing into the project at hand, as well as all of the timelines that you’re going to be editing into. 
The Media Pool is also mirrored on the Media, Cut, Fusion, Color, and Fairlight pages, so you can 
access any audio or video clip, graphic, or timeline from any page where they can be used. 

The Media Pool in Thumbnail mode, shown in half-height mode
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The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is also 
used to organize your timelines. By default, the Media Pool consists of a single bin, named “Master,” 
but you can add more bins as necessary to organize timelines and clips by right-clicking anywhere 
in the empty area of the Media Pool and choosing Add Bin. You can rename any custom bin by 
double-clicking on its name and typing a new one, or by right-clicking a bin’s name and choosing 
Rename Bin. The Bin list can be hidden or shown via the button at the upper left-hand corner of the 
Edit page toolbar.

The browser area to the right shows the contents of the currently selected folder. Every timeline you 
create, and every AAF, XML, or EDL file you import, appears here. You can create or import as many 
timelines as you need within a single project.

As in the Media page, the Media Pool can be displayed in either Metadata, Icon, or List view. In List 
view, you can sort the contents by any one of a subset of the total metadata that’s available in the 
Metadata Editor of the Media page. Of particular interest to editors are columns for Name, Reel Name, 
different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, Circled, Start 
KeyKode, Flags, Usage, Resolution, and Frames Per Second.

For more information on using the myriad features of the Media Pool, see Chapter 18, “Adding and 
Organizing Media with the Media Pool.” In the sections that follow, some key features of the Media Pool 
are summarized for your convenience.

Importing Media Into the 
Media Pool on the Edit Page
While adding clips to the Media Pool in the Media page provides the most organizational flexibility and 
features, if you find yourself in the Edit, Cut, Fusion, Color, or Fairlight page and you need to quickly 
import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder to  
the Edit page Media Pool (macOS only):

1 Select one or more clips in the Finder.

2 Drag those clips into the Media Pool of DaVinci Resolve or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

To use the Import Media command in the Edit page Media Pool:

1 With the Edit page open, right-click anywhere in the Media Pool, and choose Import Media.

2 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

For more information on using the myriad features of the Media Pool, see Chapter 18, “Adding and 
Organizing Media with the Media Pool.” Below, some key features of the Media Pool are summarized for 
your convenience.

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of the Bin 
list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden by selecting/deselecting 
in the Media Pool option menu Show Smart Bins, and Show Power Bins. Here are the differences 
between the different kinds of bins:
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 — Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, and that’s 
where it lives, until you decide to move it to another bin. Bins may be hierarchically organized, so 
you can create a Russian dolls nest of bins if you like. Creating new bins is as easy as right-clicking 
within the bin list and choosing Add Bin from the contextual menu.

 — Power Bins: Hidden by default. These are also manually populated bins, but these bins are 
shared among all of the projects in your current project library, making them ideal for shared title 
generators, graphics movies and stills, sound effects library files, music files, and other media that 
you want to be able to quickly and easily access from any project. To create a new Power Bin, show 
the Power Bins area of the Bin list, then right-click within it and choose Add Bin.

 — Smart Bins: These are procedurally populated bins, meaning that custom rules employing 
metadata are used to dynamically filter the contents of the Media Pool whenever you select a 
Smart Bin. This makes Smart Bins fast ways of organizing the contents of projects for which you 
(or an assistant) has taken the time to add metadata to your clips using the Metadata Editor, 
adding Scene, Shot, and Take information, keywords, comments and description text, and myriad 
other pieces of information to make it faster to find what you’re looking for when you need it. 
To create a new Smart Bin, show the Smart Bin area of the Bin list (if necessary), then right-click 
within it and choose Add Smart Bin. A dialog appears in which you can edit the name of that bin 
and the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows
If you right-click a bin in the Bin List, you can choose “Open As New Window” to open that bin into its 
own window. Each window is its own Media Pool, complete with its own Bin List, Power Bins and Smart 
Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag these 
separate bins to the second display while DaVinci Resolve is in single screen mode. If you hide the 
Bin list, not only do you get more room for clips, but you also prevent accidentally switching bins if 
you really want to only view a particular bin’s contents in that window. You can as many additional 
Bin windows open as you care to, in addition to the main Media Pool that’s docked in the primary 
window interface.

Media Pool bins opened as new windows
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Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular bins 
with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the color you 
want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red tag. 
A bin’s color tag then appears as a colored background behind that bin’s name.

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter drop-down menu 
(the drop-down control to the right of the Bin List button) to filter out all but a single color of bin.

Using Color Tags to identify bins Using color tag filtering to  
isolate the red bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter drop-down.

Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by Bin Name, Date Created, or Date 
Modified, in either ascending or descending order. Simply right-click anywhere within the Bin list and 
choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all 
bins in the Bin list to be in whatever order you like. As you drag bins in this mode, a highlighted line 
indicates the new position that bin will occupy when dropped.

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and forth 
between any of the other sorting methods (Name, Date Created, Date Modified) and User Sort and 
your manual User Sort order will be remembered, making it easy to use whatever method of bin 
sorting is most useful at the time, without losing your customized bin organization.
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Dragging a bin 
to a new position 
in the Bin list in 
User Sort mode

More About Timelines and Grading
DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence in other 
applications) which are also organized in the Media Pool, and displayed in the Timeline Editor (referred 
to as “the Timeline”). Timelines contain clips, the source media of which is kept in the Media Pool, and 
which also appear as edit events in the Edit Index that can be shown at the right of the Timeline.

Timelines, Grades, and Versions
Within any given timeline, grades are associated with the timecode of the source clip they’re applied to. 
That means that as you alter the timeline, each clip’s grade moves along with it, making it extremely easy 
to move back and forth between editing and grading as your needs require. By default, each timeline 
in a project has independent sets of grades using local versions; this is true even if your timelines are 
duplicates. That means each clip within every timeline has a completely independent grade.

However, if you switch the clips in one or more timelines to use Remote versions, a clip’s grades are 
shared by every instance of that clip in all timelines with clips that also use Remote versions. If you 
import a new timeline that rearranges clips into a different order and switch it to using Remote 
versions, then grades will automatically follow the clips, so that the clips within each new timeline 
inherits the grades applied to those same clips in other timelines.

You can switch a timeline between using Local and Remote grades at any time. For more information 
on using Local versus Remote versions, see Chapter 139, “Grade Management.” You can also copy 
grades from one timeline to another using the ColorTrace feature. For more information about 
ColorTrace, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”

Enabling the Use of a Master Timeline
Previous versions of DaVinci Resolve had a Master Timeline, which consisted of one long timeline 
containing every clip in the Media Pool, arranged by default in ascending order by timecode. While 
the Master Timeline was useful for a variety of tasks, architectural improvements have rendered 
it unnecessary, and by default the Master Timeline does not appear in new projects created by 
DaVinci Resolve version 10 or later.
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However, if you want a Master Timeline in order to have a single timeline that always contains all clips 
currently in the Media Pool, there’s a way you can create one. You need to do it immediately upon 
creating a new project, before adding any media to the Media Pool. Once you’ve added one or more 
clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1 Create a new project, open the General Options panel of the Project Settings, and turn on the 
“Automatically match master timeline with media pool” checkbox. If you also want all clips to use 
Remote versions as you grade by default as in previous versions of DaVinci Resolve, you can turn 
off the “Use local version for new clips in timeline.”

The option to use a Master Timeline is in the Color section 
of the General Options panel of the Project Settings

2 Click Save to close the Project Settings window.

3 Open the Edit page, and choose File > New Timeline (Command-N).

4 When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, and 
click Create New Timeline.

Now, in addition to the new timeline, a Master Timeline appears in the Timeline list.

TIP: If you want to make sure that you always have a Master Timeline when you create 
new projects, you can alter the Project Setting preset for your user account to reflect 
these settings, or you can create a new Project Setting preset with these settings that 
you can easily switch to. 

Creating a Master Timeline
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The Master Timeline consists of one long sequence of every clip in the Media Pool, arranged in 
ascending order by timecode. Each clip in the Master Timeline appears at its full duration, regardless 
of the duration of corresponding clips in an EDL-, AAF-, or XML-imported timeline. Whenever you add 
more clips to the Media Pool, they’re automatically added to the Master Timeline. 

The Master Timeline is useful for organizing media for which no editing has yet been done, such as 
when grading digital dailies. The Master Timeline is also useful for identifying a range of similar clips, 
based on their similar ranges of timecode. For example, you could find all the talking head shots from 
a particular section of tape clustered together in the Master Timeline.

Using the Effects Library
All effects that you can add to your edit, including filters, transitions, titles, and generators, are found in 
the Effects Library, which is split into two parts. To the left is a bin list that shows a hierarchical list of all 
of the different Transitions, Title Effects, Generators, and Filters that are available, sorted by category. 
To the right is a browsing area in which you can see the contents of whichever bins are selected.

The Effects Library

Similar to the Media Pool, the Effects Library’s bin list can be opened or closed using a button at the 
top left, while a menu just to the right of this button lets you sort the list into different categories.
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The Toolbox
All of the video and audio transitions, titles, and generators that ship along with DaVinci Resolve 
appear in the Toolbox category of the Effects Library.

 — Toolbox: Exposes all Transitions, Titles, Generators, and Effects at once.

 — Video Transitions: Contains all of the built-in transitions that are available from DaVinci Resolve. 
You can drag any video transition to any edit point in the Timeline that has overlapping clip 
handles to add it to your edit; you have the option to drag the transition so that it ends on, is 
centered on, or starts on the edit point. For more information, see Chapter 47, “Using Transitions.”

 — Audio Transitions: Contains audio transitions for creating crossfades.

 — Titles: Titles can be edited into the Timeline like any other clip. Once edited into the Timeline, you 
can edit the title text and position directly in the Timeline Viewer, or you can access its controls in 
the Inspector for further customization.

 — Generators: Generators can also be edited into the Timeline like any other clip. Selecting a generator 
and opening the Inspector lets you access its controls for further customization. You can also choose 
a standard duration for generators to appear with in the Editing panel of the User Preferences.

 — Effects: Contains unique placeholder effects like Adjustment Clip, and Fusion Composition, that 
can be customized to apply sophisticated effects to your programs.

OpenFX
DaVinci Resolve supports the use of third-party OpenFX filters, transitions, and generators in the 
Edit page. Once you install these effects on your workstation, they appear in this section of the 
Effects Library, organized by type and group depending on the metadata within each effect.

 — OpenFX: Exposes all Resolve FX and third-party OpenFX installed on your workstation at once.

 — Filters: Contains the Resolve FX filters that ship with DaVinci Resolve, as well as any third-party 
OFX plugins you’ve installed on your workstation. Filters can be dragged onto video clips to apply 
an effect to that clip. Once applied, filters can be edited and customized by opening the OpenFX 
panel of the Inspector.

 — Transitions: Contains any third-party OFX transitions you have installed on your workstation. 
OFX transitions can be used similarly to any other transition, but they also expose an OpenFX 
panel next to the Transition panel in the Inspector, where you can customize settings that are 
unique to that transition.

 — Generators: Contains any third-party OFX generators you have installed on your workstation. 
Can be edited into the Timeline just like the native generators that ship with DaVinci Resolve, but 
they also expose an OpenFX panel next to the Transition panel in the Inspector, where you can 
customize settings that are unique to that transition.

Audio FX
On all platforms, DaVinci Resolve supports Fairlight FX, which are built-in audio plugins that come with 
DaVinci Resolve. Additionally, DaVinci Resolve supports the use of third-party VST audio plugins on 
macOS and Windows, and Audio Unit (AU) audio plugins on macOS. Once you install these effects on 
your workstation, they appear in this panel of the Effects Library. Audio plugins let you apply effects 
to audio clips or an entire track’s worth of audio to add creative qualities such as echo or reverb, or to 
take care of mastering issues using noise reduction, compression, or EQ.
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Effects Library Favorites
You can click on the far right of any transition, title, or generator to flag that effect with a star as 
a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the 
bottom of the Effects Library Bin list.

Stars indicate a flagged favorite effect; all favorites are currently filtered.

Index
The index provides information about your timeline in a simplified spreadsheet format; it is used 
for both reference and timeline navigation. The index is broken up into the Edit Index, Tracks, and 
Markers tabs.

Edit Index
Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view of 
all the edit events in the current timeline. Whichever timeline is selected in the Timeline list displays 
its events here. However, the contents of the Edit Index can be filtered using commands found in 
the Option drop-down, described later in this section.
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Edit Index List shown open

Each clip and transition is shown as an individual event, each of which contains multiple columns 
of information. If you re-edit a timeline, your changes are also reflected in this list. The Edit Index is 
useful for creative editors that are looking for specific effects that are used in the current timeline, or 
for finishing editors that need more information about a specific clip, or who might need to filter the 
entire edit by specific criteria in order to troubleshoot various issues.

Navigating the Timeline Using the Edit Index
Whenever you move the Timeline playhead to intersect a clip, the Edit Index updates to show only the 
clips on the video track the intersecting clip is on, and that clip’s event is highlighted in the Edit Index. 
This makes it easy to see the correspondence between a clip in the Timeline and its event, which is 
helpful when troubleshooting problems. There are also commands available in the Option menu to 
display only clips on enabled tracks, only video clips, and only audio clips.

Edit Index Columns
Each event populates several columns of information. These columns can be rearranged by dragging 
them to the left or right, depending on what information is most important to you.

The available columns of information are:

 — #: The event number (which corresponds to the clip number shown in the Thumbnail timeline of 
the Color page).

 — Reel: The reel name of the corresponding clip.

 — Match: Flags clips that have clip conflicts, which display a question mark in this column. 
Once the clip conflict has been resolved, this flag disappears.

 — V: Video event.

 — C: The event type (C for cut, D for dissolve or transition).

 — Dur: A number showing the duration of a transition in frames. 
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 — Source In/Source Out: The Source In and Source Out timecode indicating the range of timecode 
referenced by that clip; corresponds to the timecode locations of each clip’s In and Out point 
relative to the source media it comes from.

 — Record Duration: The duration of the clip in the Timeline, determined by the 
Record In/Out timecodes.

 — Record In/Record Out: Record In and Record Out timecode indicating that clip’s 
position in the Timeline.

 — Name: The name of the clip.

 — Comments: Whatever comments were present in the EDL that was imported. For example, 
clip names exported from the original NLE to be used as reel names in RED workflows 
using EDL import.

 — Source Start/ Source End: The very first and last frame of media available in the Source Media 
for that clip.

 — Source Duration: The duration, in timecode, of the total source media available in that clip.

 — Codec: The codec of the corresponding clip.

 — Source FPS: The frame rate of the corresponding clip.

 — Resolution: The frame size of the corresponding clip.

 — Color: The color of flags or markers applied to that clip.

 — Notes: Notes entered inside of markers applied to clips or the Timeline.

 — EDL Clip Name: Shows the name of the imported EDL, if that’s available.

 — Marker Keywords: Lists all keywords found in a particular marker.

The columns in the Edit Index can be customized to prioritize the information that’s important to you.

Methods of customizing metadata columns in the Edit Index:

 — To show or hide columns: Right-click at the top of any column in the Edit Index and select an 
item in the contextual menu list to check or uncheck a particular column. Unchecked columns 
cannot be seen.

 — To rearrange column order: Drag any column header to the left or right to 
rearrange the column order.

 — To resize any column: Drag the border between any two columns to the right or left to 
narrow or widen that column.

You can also customize column layouts in the Edit Index. Once you’ve customized a column layout that 
works for your particular purpose, you can save it for future recall. 

Methods of saving and using custom column layout:

 — To create a column layout: Show, hide, resize, and rearrange the columns you need for a 
particular task, then right-click any column header in the Media Pool and choose Create Column 
Layout. Enter a name in the Create Column Layout dialog, and click OK.

 — To recall a column layout: Right-click any column header in the Media Pool and choose the name 
of the column layout you want to use. All custom column layouts are at the top of the list.

 — To delete a column layout: Right-click any column header in the Media Pool and choose the 
name of the column layout you want to delete from the Delete Column Layout submenu.
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Filtering the Edit Index
You can use options found in the Edit Index’s option menu to filter specific things that you want to 
check out, whether to go through all of the marked clips to see if there are any notes you need to 
address, or to isolate all offline clips, or to go through edits to see if there’s anything you need to fix. 
You can filter the Edit Index in the following ways:

 — Show All: Shows all entries in the list. Choose this option after using any of the other options to 
go back to seeing the entire timeline.

 — Show Active Track Items: Filters out all clips that appear on tracks above or below tracks 
identified with a destination control. For example, if you have three video tracks and the 
destination control is on track V2, then all clips on tracks V1 and V3 will be hidden from 
the Edit Index.

 — Show Video Track Items: Filters out all audio clips so only video clips appear in the list.

 — Show Audio Track Items: Filters out all video clips so only audio clips appear in the list.

 — Show Flags: Isolates clips with flags in the list. A submenu lets you choose to show all clips with 
flags or only clips with a particular color of flag.

 — Show Markers: Isolates all clips with markers in the list. A submenu lets you choose to show all 
clips with markers or only clips with a particular color of marker.

 — Show Clip Colors: Isolates all clips that have been labelled with clip colors in the list. A submenu 
lets you choose to show all clips that are labelled using any clip color or only clips labelled with a 
particular color.

 — Show Through Edits: Filters only clips that have through edits, or cuts where continuous 
timecode appears from the outgoing to the incoming half of the edit, that you may or may not 
want to remove, depending on why they’re there.

 — Show Offline Clips: Isolates all offline clips (clips that have become unlinked from the 
corresponding source media on disk) in the Timeline, so you can quickly navigate to each one and 
troubleshoot the issue.

 — Show Clip Conflicts: Filters all clips with clip conflict warning badges (indicating there is reel, 
name, and timecode metadata that overlap that of another clip) in the Timeline, so you can quickly 
navigate to each one and check whether they’re using the correct clip.

 — Show Clips With Speed Effects: Filters all clips with linear or variable Speed Effects in 
the Timeline.

 — Show Clips With Composite Effects: Filters all clips with Composite mode or Opacity settings 
other than the default (Normal, 100).

 — Show Clips With Transform Effects: Filters all clips with altered Transform settings.

 — Show Clips With Filters: Filters all clips with Resolve FX or OFX filters applied to them.

 — Show Stills and Freeze Frames: Filters all clips that are stills or that have freeze frame speed 
effects applied to them.

 — Show Compound Clips and Nested Timelines: Filters all compound clips and nested timelines in 
the Timeline.

 — Show VFX Connect Clips: Filters all Fusion Connect Clips.
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Exporting the Edit Index
If you’ve filtered a series of edits in the Edit Index that you’d like to share with someone else, this 
is easy to do. For example, you might filter the Edit Index to show a list of all the offline clips in the 
current timeline, and then export a list as either a .csv or .txt file to give to your assistant editor so 
they can chase down the necessary media. Both types of files are widely compatible with spreadsheet 
and database software in the event you want to import the data into another application.

To export the Edit Index:

1 Click on the Edit Index option menu, and choose Export Edit Index from the contextual menu.

2 Use the Export Edit Index window to choose a location to save the exported file, and choose 
a format from the drop-down menu at the bottom. You can export either a Comma Separated 
Values (.csv) file, or a Tab Delimited Values (.txt) file.

3 Click Save.

Tracks
Several of the most common track controls can be found together in the Track Index. The Track 
Index is accessed by clicking on the Index Pane, and selecting the Tracks Tab. The index shows all the 
current tracks in your timeline and their position and attributes. These are all modifiable right inside 
the Track Index.

The Tracks Index 

Tracks Index Columns
Each track reveals several columns of information. These columns can be rearranged by dragging the 
column headers to the left or right, depending on what information is most important to you. Clicking 
on a track row selects the track for modification.

The available columns of information are:

 — Color: The current color of the track is shown. Right-click anywhere in the row and choose Change 
Track Color to choose a new one.

 — #: Displays the current track order. You can rearrange the order of the tracks by dragging the 
number in this column up or down in the track hierarchy and releasing the mouse button. Note 
that the actual absolute track number (V1, A1, etc.) does not change, but the track that is assigned 
to that number will have changed.

 — Name: The name of the Track. You can click in this field to rename the track.
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 — Track Controls: The same track controls that are found in the Track Header in the Timeline can 
also be accessed here: Lock/Unlock, Auto Track Select, Disable/Enable Video Track, Solo, and Mute.

 — Format (audio track only): Shows the current format of the audio track. You can change this 
format to any other by right-clicking anywhere in the row of an audio track and choosing Change 
Track Type to, and then selecting a new format from the contextual menu.

 — Monitor (audio track only): Selects which tracks can be selected in the monitor drop-down 
menu in the upper right of the Edit Timeline or Fairlight page windows.

 — ADC (audio track only): Checking this box turns on Automatic Delay Compensation (ADC) 
for the track.

Clicking on the Tracks Index’s option menu lets you include or exclude track types (video, audio, 
subtitle) from the tracks. 

Markers
You can use the Marker Index to easily view, edit, and organize all your timeline and clip markers in 
one convenient location. The Marker Index can be found by clicking on the Index panel and selecting 
the Markers tab.

Methods of working with markers in the Marker Index:

 — To filter markers in the Marker Index: Click the Option menu of the Marker Index, and choose 
Show All or Show Only to choose a specific color. Each clip with a matching marker appears in 
a list, with columns corresponding to the color(s), information, and notes of each timeline and 
clip marker. Columns can be sorted in ascending or descending order by clicking on the column 
header. Individual columns can be turned on or off by right-clicking on the column header and 
checking or unchecking the column name.

 — To move the playhead to the position of a marker in the Marker Index: Double-click that 
marker’s entry in the list.

 — To edit marker information: You can change the values of a marker by clicking in the Name, 
Notes, or Keyword fields and modifying the text field. Other values are not editable in the Marker 
Index and should be changed in the timeline marker’s Edit dialog.

 — To search for a specific marker: Click on the Search icon (magnifying glass), and type in your 
search terms. Currently the search only queries the Marker Name column; you cannot search by 
notes and keywords.

 — To switch between Thumbnail and List view: Click on either the Thumbnail or List View icons in 
the top bar of the Marker Index.

The Marker Index in List View mode lets you edit and organize all your timeline’s markers in one place.
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Source and Timeline Viewers
By default, the Edit page presents a traditional source/record style editing experience. The Source 
Viewer lets you view individual clips from the Media Pool to prepare them for editing. Meanwhile, the 
Timeline Viewer lets you play through your program, showing you the frame at the position of the 
playhead in the Timeline. 

Source and Timeline Viewers

You can select either viewer by clicking with the pointer, or by pressing Q (Source/Timeline Viewer), 
and the name of the viewer that currently has focus appears in orange.

How Each Clip’s Grade Looks in Each Viewer
Because of DaVinci Resolve’s deep color and effects tools, the state of the image you see in each 
viewer of the Edit page depends on a number of things.

The Source Viewer
The Source Viewer shows each clip as it looks at the source. If you have Resolve Color Management 
(RCM) turned on or source LUTs applied, then the Source Viewer will show your clips as they’re being 
processed by RCM and/or the source LUTs, since those are source-level color operations. However, in 
the absence of RCM and source LUTs, the image in the Source Viewer looks exactly the same as it does 
on disk. If you have log-encoded media that looks flat and low-contrast, then that’s how it’s going to 
look in the Source Viewer.

The Timeline Viewer
The Timeline Viewer follows all of the same rules as the Source Viewer, with the addition that 
the Timeline Viewer also shows you how each clip in the Timeline looks with Fusion page and/or 
Color page operations applied, since the Timeline Viewer is actually showing you the output of the 
Color page, so you can see every clip of your program in context of how the image is being affected by 
the DaVinci Resolve image processing pipeline.

NOTE: The Color Viewer Lookup Table options in the Color Management panel of the 
Project Settings only affect the GUI Viewer in the Color page. They do not affect the viewers 
in the Edit page.

610Edit | Chapter 33 Using the Edit Page



Turning Grades and/or Fusion Effects Off in the Timeline Viewer
The Bypass Color Grades and Fusion Effects button/drop-down from the Color page is also available 
on the Edit page either via the View > Bypass Color and Fusion drop-down, or via a toggle button/
drop-down menu in the Timeline Viewer. If you choose Bypass All Grades or click the Viewer control, 
you’ll turn off whatever is checked in the optional menu, which lets you choose whether or not you 
want to bypass both Color and Fusion, or just one or the other.

(Left) Menu commands for bypassing Color and Fusion, (Right) Edit page Timeline Viewer controls

Turning off color grades and Fusion effects is an easy way to improve playback performance on low 
power systems when you just need to make a quick set of edits, and it’s also a convenient way to 
quickly evaluate the original source media.

Source and Timeline Viewers vs. Single Viewer Mode
If you want to change the Edit page layout to hide the Source Viewer, you can choose Workspace > 
Single Viewer Mode to instead use just a single viewer to contextually display either a selected Source 
Clip or the current frame of the Timeline.

Single Viewer mode turned on

In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which controls 
appear in the Viewer, which lets you do nearly everything you can do with two simultaneously 
open viewers.
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Viewer Controls
Both viewers share the following onscreen controls:

 — Zoom drop-down menu: Choosing Fit fits the currently visible frame to the available size of the 
Viewer. Choosing a percentage zooms the visible frame to that size. You can also use the scroll 
wheel functionality of your mouse, trackpad, or tablet to zoom in and out of the Viewer..

 — Duration field: At the top left-hand side of the Source Viewer, this displays the total duration of 
the clip, or the duration from the In to the Out point, if these have been placed. In the Timeline 
tab, this displays the total duration of the currently selected timeline.

 — GPU Status Display: Every viewer in DaVinci Resolve exposes a GPU status indicator and a 
frame-per-second (FPS) meter, which appears in the Viewer’s title bar, which shows you your 
workstation’s performance whenever playback is initiated. Since DaVinci Resolve uses one or 
more GPUs (graphics processing units) to handle all image processing and effects, the GPU status 
display shows you how much processing power is being used by whichever clip is playing.

 — Clip Name: The clip name is displayed at the center of the Source Viewer title bar. 

 — The Source Viewer displays a drop-down at the top of the Source Viewer, next to the name 
of the currently open clip, which lets you open a menu containing a list of the last 10 clips 
you opened in the Source Viewer. This list is first in, first out, with the most recently opened 
clips appearing at the top. If you wish to clear the visual history in the menu, you can remove 
unwanted entires and start a new queue by clicking on the Viewer’s option menu and 
selecting Clear Recently Viewed Clips.

 — The Timeline Viewer displays the timeline name and is also a drop-down menu that lets you 
switch among other timelines in the current project. The clip/timeline name is highlighted 
orange when either the Source or Timeline Viewer has focus.

 — Bypass Color Grades and Fusion Effects: The Bypass Color Grades and Fusion Effects button/
drop-down from the Color page is also available on the Edit page either via the View > Bypass 
Color and Fusion drop-down, or via a toggle button/drop-down menu in the Timeline Viewer. 
Turning off color grades and Fusion effects is an easy way to improve playback performance on 
low power systems when you just need to make a quick set of edits, and it’s also a convenient way 
to quickly evaluate the original source media.

 — Source/Timeline Timecode/Frame/Keykode Display: At the top right-hand side of the Source 
Viewer, this field shows the timecode of the current frame at the position of the playhead in 
the Source Viewer’s jog bar, and can be switched between source timecode, source frame, and 
keykode by right-clicking and choosing from the contextual menu. In the Timeline Viewer, this field 
shows the record timecode of the current frame at the position of the playhead in the Timeline, 
and can be switched between source and record timecode, source and record frames, and 
keykode by right-clicking and choosing from the contextual menu. 

 — Source Viewer Option menu: Contains the following commands:

 — Gang Viewers: With Gang Viewers enabled, the movement of the Source and Timeline Viewer 
playheads is locked together, so that they move in unison. This is useful when you’re matching 
the timing of part of a clip in the Source Viewer to match an event in the Timeline.

 — Live Media Preview: Enabled by default, makes it possible for thumbnails that you’re 
skimming in the Media Pool to show the skimmed frame in the Viewer. When skimming with 
Live Media Preview enabled, the playhead that appears in the thumbnail is locked to the 
playhead displayed in the Viewer’s jog bar.
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 — Show All Video Frames: When available processing power is insufficient to play the clip or 
clips at the position of the playhead due to the grade, transforms, or effects that are applied 
at that moment in the Timeline, you have the ability to choose exactly how performance in 
DaVinci Resolve degrades. When off, DaVinci Resolve prioritizes audio playback at the expense 
of dropping video frames when processing power is tight, resulting in a more conventional 
playback experience. When on, audio quality is compromised while every frame of video plays 
in slower-than-real time to maintain playback.

 — Show Zoomed Audio Waveform: When enabled, shows an audio waveform overlay at the 
bottom of the Source Viewer with a zoomed in section of the audio surrounding the current 
position of the playhead.

 — Show Full Clip Audio Waveform: When enabled, shows an audio waveform overlay at the 
bottom of the Source Viewer that displays the audio over the entire duration of the clip.

 — Show Marker Overlays: Enabled by default, markers that intercept the playhead when 
playback is paused appear superimposed in the Viewer.

 — Markers submenu: When one or more markers are applied to the clip in the Source Viewer, 
they appear in this list in chronological order, listed by Name and Note. Choosing a marker 
from this menu jumps the playhead to that marker in the Source Viewer.

 — Timeline Viewer Option menu: Contains the following commands:

 — Gang Viewers: With Gang Viewers enabled, the movement of the Source and Timeline Viewer 
playheads is locked together, so that they move in unison. This is useful when you’re matching 
the timing of part of a clip in the Source Viewer to match an event in the Timeline.

 — Show All Video Frames: When available processing power is insufficient to play the clip or 
clips at the position of the playhead due to the grade, transforms, or effects that are applied 
at that moment in the Timeline, you have the ability to choose exactly how performance in 
DaVinci Resolve degrades. When off, DaVinci Resolve prioritizes audio playback at the expense 
of dropping video frames when processing power is tight, resulting in a more conventional 
playback experience. When on, audio quality is compromised while every frame of video plays 
in slower-than-real time to maintain playback.

 — Timeline Sort Order: These options allow you to set the sort order that timelines use in the 
timeline selector in the top middle of the Viewer. Options are: Alphabetical, Creation Date, or 
Recently Used.

 — Show Marker Overlays: Enabled by default, markers that intercept the playhead when 
playback is paused appear superimposed in the Viewer.

 — Show Timecode Overlays: When enabled, shows the source timecode of the video and audio 
clips under the position of the playhead when playback is paused.

 — Show Overlays During Playback: When enabled, shows timecode and marker overlays 
on the Viewer constantly during playback. When disabled, overlays are only visible while 
playback is paused.

 — Markers submenu: When one or more markers are applied to a Timeline, they appear in this 
list in chronological order, listed by Name and Note. Choosing a marker from this menu jumps 
the playhead to that marker in the Timeline.
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 — Source Viewer Mode drop-down (Source Viewer only): This drop-down menu lets you set the 
Source Viewer to display different views of the clips you’re working on, depending on what you 
need to do.

 — Source: Shows the video of the currently open clip in the Source Viewer.

 — Offline Reference Movie button: If you’ve assigned an offline reference movie to the 
currently selected timeline, clicking the Offline Mode button lets you display the offline movie 
so you can compare it with the currently open timeline. In this mode, Source and Timeline 
playback are synced; an Offset field replaces the duration field, letting you re-sync the offline 
reference movie, if necessary.

 — Audio Track: Shows the audio waveforms corresponding to all channels of the currently 
open clip in the Source Viewer. The top of this audio-only view shows the waveform for the 
entire duration of the clip, while the main region of the viewer shows a zoomed in section of 
the audio waveform. The level of zoom displayed is controlled by the zoom drop-down at the 
upper left-hand corner of the Source Viewer.

 — Multicam: Shows you the multi-angle Multicam Viewer that you can use to switch among 
different angles of video and audio while multicam editing a clip in the Timeline. For more 
information on multicam editing, see Chapter 41, “Multicam Editing.”

 — Annotations: Allows you to draw directly onto the current frame to highlight areas 
for further attention. 

 — Transform Mode drop-down (Timeline Viewer Only): This functions as both a toggle switch 
and a drop-down menu. Clicking the button control to the left enables or disables onscreen 
controls that you can use to transform the clip right in the viewer. Clicking the drop-down control 
to the right lets you switch between two modes of transforms:

 — Transform: Exposes controls for Pan (X) and Tilt (Y), Scale X and Y, and Rotation.

 — Crop: Exposes controls to crop from the top, bottom, left, and right.

 — Dynamic Zoom: Shows controls to do quick pan and scan effects on the selected clip.

 — OpenFX Overlay: Exposes the onscreen controls of an applied OpenFX filter.

 — Fusion Overlay: Exposes the onscreen controls of an applied Fusion FX or Title filter.

 — Annotations: Allows you to draw directly onto the current frame to highlight areas for 
further attention.

 — Smart Reframe: Exposes the onscreen controls of the Smart Reframe. 

 — Jog control: Clicking the Jog control and dragging left and right lets you move slowly through a 
clip or the Timeline a frame at a time.

 — Transport controls: These controls include, from left to right, Jump to First Frame, Play Reverse, 
Stop, Play Forward, Jump to Last Frame.

 — Loop Playback: Enables or disables looped playback. Looping is also controllable via the Playback 
> Loop/Unloop command (Command-/). When enabled, each playback command loops back to 
the beginning when the end of that command’s range is reached. In and Out points in the Source 
or Timeline Viewers do not trigger looping. For example, when enabled, the Play command will 
play through the entire clip or timeline, and then loop back to the beginning when the end is 
reached and start playing automatically. The Play Around command, on the other hand, will start 
at the beginning of pre-roll, play through the post-roll, and then immediately loop back around to 
the beginning of pre-roll, continuing playback in this manner until you stop it.
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 — Match Frame: In the Source Viewer, Match Frame attempts to move the playhead in the Timeline 
to match the current frame of the clip in the Source Viewer. In the Record Viewer, Match Frame 
opens the Media Pool clip corresponding to the clip at the current position of the playhead into 
the Source Viewer, setting In and Out points and the playhead position to match those of the 
clip in the Timeline.

 — In/Out buttons: Places In and Out points with which to define a range of the clip, or of the 
Timeline, in preparation for making different kinds of edits.

 — Jog bar: In the Source Viewer, drag within the jog bar to reposition the Source playhead, scrubbing 
through the clip. In the Timeline tab, drag to reposition the playhead throughout the entire program.

Transport Controls and Important Playback Controls
While the operation of the main transport controls is probably obvious, there are additional 
playback controls of interest to the editor that may not be so readily found. 

For more information about transport controls, see Chapter 35, “Preparing Clips for Editing 
and Viewer Playback.”

Simultaneous Audio Waveform 
Display in the Source Viewer
When the Source Viewer is set to Source, two options in the Option menu let you see a superimposed 
audio waveform running along the bottom of the viewer, over the video of the currently selected clip.

 — Show Zoomed Audio Waveform: Shows a zoomed-in section of audio that scrolls as you play the 
clip. Useful for seeing dialog and music cues as you play through a clip.

 — Show Full Clip Audio Waveform: Shows the audio waveform for the entire source media of 
that clip. The section of audio from the In to Out points you’ve set in the Source Viewer are 
highlighted. Useful for using the audio waveform to navigate throughout that clip using the 
waveform as a reference.

The Source Viewer 
with “Show Current 
Frame Audio 
Waveform” enabled
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Cinema Viewer Mode
You can also put either the Source or Timeline Viewers into Cinema Viewer mode by choosing 
Workspace > Viewer Mode > Cinema Viewer (P), causing whichever viewer is currently selected to fill 
the entire screen, which is good for doing a test viewing of your edit without the distractions of the 
DaVinci Resolve Edit Page UI. This command toggles Cinema Viewer mode on and off.

Viewer Indicators
Certain frames trigger visible indicators in either the Source or Timeline viewers. For example, if the 
playhead is at the very first or last frame of media available to a particular clip, indicators appear in the 
lower-left or right corner of the frame to let you know there’s no more media in that direction.

The first and last 
frame clip indicators

If the playhead in the Timeline is on the first frame of black immediately after the last video clip 
in the Timeline, an end of sequence indicator appears in the Timeline Viewer to let you know 
that you’re viewing the last frame of the current sequence of clips, even though the playhead 
is actually on a frame of black. This makes it easy to see what you’re doing while you’re first 
assembling clips together.

The end-of-
sequence indicator

Other Viewer Options
There are additional overlays and options you can use to customize how the viewer appears.

 — Safe Area: Choosing View > Safe Area > On lets you turn on Safe Area overlays showing you Title 
Safe, Action Safe, and other available overlays. If you want to choose the aspect ratio with which 
these overlays are represented, you can do so from the View > Select Aspect Ratio submenu.

 — Show Gray Backgrounds in Viewers: Checking the Show Gray Backgrounds in Viewers box in 
the User Preference’s UI Settings changes the empty area of the Viewer (if there is any) to a lighter 
gray, making it easier to see which parts of the viewer are black because of blanking, and which 
parts are simply empty because of the way the image is zoomed or panned.
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Fast Review in the Timeline Viewer
Fast Review plays back your timeline at variable fast forward speeds where the speed of playback is 
dependent on the length of each clip on the Timeline. Longer clips play back at faster speeds than 
shorter ones. This feature is designed to allow you to quickly scan through a large amount of material 
on a timeline.

To use the Fast Review feature on your Edit page Timeline, select Playback > Fast Review. Pressing K 
or the spacebar will return you to the normal JKL playback mode. If you use this feature often you can 
bind Fast Review to a specific key in the Keyboard Customization window.

NOTE: Fast Review does not work for clips in the Source Viewer, only for timelines in the 
Timeline Viewer.

Opening Clips in the Source Viewer
There are two methods of opening clips into the Source Viewer. Which is enabled depends on the “Live 
Media Preview” setting found in the Viewer options menu (the three-dots menu found at the upper 
right-hand corner of the Viewer).

 — When Live Media Preview is enabled (by default), skimming a thumbnail in the Media Pool also 
shows the skimmed frame in the Source Viewer, effectively opening each clip you skim in the 
Media Pool into the Source Viewer. As you skim, the playhead that appears in the thumbnail is 
locked to the playhead that’s displayed in the Viewer’s jog bar.

 — When Live Media Preview is disabled, you must either double-click a clip in the Media Pool to open 
it into the Source Viewer, or you can select a clip in the Media Pool and press the Return key to 
open it into the Source Viewer. 

Which method is best is purely a matter of preference.

Timeline Viewer Edit Overlays
Dragging a clip from the Media Pool or Source Viewer onto the Timeline Viewer also exposes edit overlays 
that let you choose what kind of edit you want to make by choosing which overlay to drop the clip onto.

The overlay that appears 
when you drag a clip 
onto the Timeline 
Viewer lets you choose 
from a variety of edits
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This overlay exposes every type of edit that’s available in DaVinci Resolve, including the Insert, 
Overwrite, Replace, Fit to Fill, Place On Top, Ripple Overwrite, and Append at End edits, all of which 
are also available from the Edit menu. It’s a useful method of making three-point edits if you like drag 
and drop editing, but it also provides a nice reminder of what types of edits are available, given all the 
different options that are available.

By default, the larger empty area to the left of these overlays defaults to the highlighted Overwrite 
overlay, while all the smaller buttons let you perform each of the other edit types that are available. 

However, the “Timeline overlay retains the last performed action” checkbox in the Editing panel of the 
User Preferences can be turned on if you want DaVinci Resolve to always remember the last edit type 
you used, and highlight it on this overlay whenever you drag another clip over the Timeline Viewer to 
let you know that the last edit you performed is the new default edit if you drop clips to the left of the 
overlay. For example, with this option enabled, if you perform a place on top edit, then the next time 
you drop a clip into the empty area to the left of the overlays, the result will be another place on top 
edit. This option is off by default.

Copy and Paste Timecode in Viewer Timecode Fields
You can right-click on most Viewer timecode fields in the Media, Edit, and Color pages to choose Copy 
and Paste commands from a contextual menu for copying and pasting timecode values. You can also 
click in the timecode fields and use the normal Copy (Command-C), and Paste (Command-V) keyboard 
commands. This works even between pages. The timecode value you’re pasting must be valid 
timecode, for example you can’t paste 0 hour timecode onto a 1 hour timeline.

Right-clicking on 
a timecode field 
to use the Copy 
Timecode command

Export The Current Frame from The Viewer
You can now export a still frame from the Viewer in the Media, Cut, and Edit pages. 

To Export a Still Frame from the Viewer:

1 Select either the Source or Timeline viewer for export. 

2 Use the Viewer’s playback controls to navigate to the frame you want to export.

3 Select File > Export > Current Frame as Still.

4 Enter the name of the still frame in the File System viewer.

5 Enter the desired format of the still frame in the File System viewer.

6 Click on the Export button.
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Metadata Editor
Both the Media and Edit pages have a Metadata Editor. In the Edit page, the Metadata Editor opens 
in the same place as the Inspector, to the right of the Source and Timeline Viewers. When you select 
a clip in the Media Pool or Timeline, its metadata is displayed within the Metadata Editor, and the title 
bar indicates whether you’re evaluating a clip in the Timeline or Media Pool. If you select multiple clips, 
only the last clip’s information appears. The Metadata Editor’s header contains uneditable information 
about the selected clip, including the file name, directory, duration, frame rate, resolution, and codec.

Because there are so very many metadata fields available, two drop-down menus at the top let you 
change which set of metadata is displayed in the Metadata Editor.

 — Metadata Presets (to the left): If you’ve used the Metadata panel of the User Preferences to 
create your own custom sets of metadata, you can use this drop-down to choose which one to 
expose. Surprisingly enough, this is set to “Default” by default.

 — Metadata Groups (to the right): This drop-down menu lets you switch among the various 
groups of metadata that are available, grouped for specific tasks or workflows.

The heart of the Metadata Editor is a series of editable fields underneath the header that let you 
review and edit the different metadata criteria that are available. For more information on editing clip 
metadata, and on creating custom metadata presets, see Chapter 19, “Using Clip Metadata.”

Clip Metadata Editor 
showing the Clip 
Details panel for a 
clip in the Timeline
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Inspector
The Inspector can be opened to let you customize compositing, transform, and cropping parameters 
for clips, as well as clip-specific retime and scaling options. Furthermore, the Inspector lets you edit 
the parameters of transitions, titles, and generators used in the Timeline, in order to customize 
their effect.

The Inspector, opened and showing a clip’s parameters

When the Inspector is open, the Source and Timeline viewers move to the left, to sit alongside the 
Inspector showing the selected clip’s parameters. However, if your computer display’s resolution is not 
high enough, opening the Inspector may result in the Source Viewer being hidden.

Methods of showing parameters in the Inspector:

 — To open a video or audio clip’s transform settings when the Inspector is closed: Select that 
clip, and then click the Inspector button at the far right of the Edit page toolbar.

 — If the Inspector is already open: You need only select a clip or effect to reveal its 
controls in the Inspector. 

 — If the Inspector is closed: Double-clicking any transition will automatically open it. 

The Inspector shows different buttons at the top that let you switch among different pages of 
parameters. For example, when you select a clip with both audio and video components, the Inspector 
shows Video and Audio buttons at the top that let you switch among each set of controls.

Timeline
The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s where 
you either edit programs together from scratch, or import sequences from other applications. 
For imported programs, the Timeline provides a visual representation of the edited program that’s 
helpful for verifying that the project was imported correctly, checking the media corresponding to 
each clip in the program, and performing whatever editorial tasks are necessary to prepare a project 
for grading (such as replacing or adding clips, superimposing composites, and modifying composite 
modes or transitions).
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An edited timeline

 — Timeline Ruler: The Timeline Ruler shows the program’s timecode, and the playhead indicates 
the current frame of the current clip. Whichever clip intersects the playhead is the one that you’ll 
be working on in the Color page. Dragging within the Timeline Ruler moves the playhead. When 
you add markers to the timeline, these markers appear within the Timeline Ruler, as well.

 — Playhead: The playhead automatically syncs with the Timeline Viewer’s jog bar playhead, the 
playheads in the Mini-Timeline and Thumbnail timeline of the Color page, Cut page, and the 
playhead on the Deliver page. Furthermore, the Edit Index event that corresponds to the clip 
intersecting the playhead is automatically highlighted.

 — Timecode field: Shows the current timecode value corresponding to the position of the playhead.

 — Video Tracks: DaVinci Resolve supports multiple video tracks. At the left of each track is a header 
area that contains a number of controls.

 — Track Header: The Track Header contains different controls for selecting, locking/unlocking, 
and enabling/disabling tracks. Each track header also lists how many clips appear on that track. 
The Track Header contains the following five controls, from left to right:

Track Header area 
showing the controls 
for each track that 
are located within

 — Track Color: Each track can be color-coded with one of 16 different colors. These color codes 
correspond to the Edit page Mixer, and to the Fairlight page Mixer and Audio Meters. You can 
choose a new color for any track by right-clicking the track header and choosing from the 
Change Track Color submenu.

 — Destination control and Track Number: These controls are highlighted orange when that 
track is selected for editing, dark gray when that track is not selected, and flat gray if that 
track is disabled for editing. The Destination buttons dictate into which tracks audio and video 
media in the Source Viewer will be placed when an edit is executed. Ordinarily, there is one 
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video destination control (V1) and one audio destination control (A1). If you add additional 
tracks, you can see that each destination control is numbered according to its track position. 
The bottom track is “V1,” and subsequently numbered tracks appear higher in the Timeline. 
Click any track’s number to select that track for different editing functions; the selected track 
is highlighted black.

 — Track Name: Each track has a name that defaults to the type of track and the track number, 
such as Video 1, Audio 1. However, you can click any track’s name and edit it to be whatever 
you like. For example, you can rename each audio track with the type of audio you’re editing 
onto it, such as Production, Ambience, SFX, or Music. These track names are also used to 
identify each track’s channel in the Edit page Mixer and in the Fairlight page Mixer.

 — Enable Track/Mute button: A slash indicates when a track is disabled. This control lets you 
turn tracks on and off. Clips on tracks that are turned off aren’t visible in the viewer, don’t 
show up in the Color page, and aren’t available for rendering or output. For Audio tracks this 
is the Mute button.

 — Lock Track button: Light gray when turned on, dark gray when turned off. When a track is 
locked, clips can’t be replaced, moved, or otherwise edited, although clips on locked tracks 
can be graded.

 — Auto Select button: On by default. Light gray when that track is selected, dark gray when 
that track is not selected. When this control is on, clips on that track are automatically included 
in operations that affect all clips that intersect the position of the playhead, or that intersect 
a region defined by the Timeline In and Out points. When this control is off, clips on that track 
are ignored by those same operations. Furthermore, rippling is suspended on tracks with 
Auto Select turned off for operations that would otherwise ripple the Timeline. Note, manual 
selections made in the Timeline that highlight specific clips take precedence over the Auto 
Select controls, so if Auto Select is turned off on track 1, but you’ve selected a clip on track 1, 
the selected clip will be still be affected by whatever operation you’re about to perform.

 — Audio Channel Type indicator: Audio tracks also show which channel configuration that 
track uses, listing the number of channels for mono, stereo, 5.1, 7.1, and adaptive.

 — Number of clips: The number of clips on that particular track of the Timeline is listed, but only 
if the track is tall enough to have room for them.

 — Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of video tracks is taller than the current height of the Timeline, these 
scroll bars let you drag to navigate around your program.

 — Individual Timeline track resizing: Any track in the Timeline can be individually resized by 
dragging its top divider in the Track Header area.

Resizing an individual 
timeline track by 
dragging its top border 
in the Track Header
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Timeline Options
Specific elements and behaviors within the Timeline can be customized in various ways.

Selection Follows Playhead
As of DaVinci Resolve 17, the Clip selection no longer automatically moves along with the playhead. 
Instead, a new set of commands lets you create and move a selection by holding down the Command 
key and pressing the Up, Down, Left, and Right Arrow keys. This allows you to select clips above and 
below the current track and to the left and right, independently of the playhead.

You can return the Clip Selection mode back to its previous behavior of automatically selecting the top 
clip it’s intersecting by choosing the option Timeline > Selection Follows Playhead.

Show Playhead Shadow
Ordinarily, the playhead is shown in the Timeline as a single line that indicates the beginning of the 
frame that you’re viewing in the Timeline Viewer. However, you can choose Show Playhead Shadow 
from the User Preferences UI Settings to display an orange-ish background surrounding the playhead.

(Left) The playhead’s 
default look, (Right) The 
playhead showing the 
optional playhead shadow

This shadow can make it easier to see the playhead’s position, and it can also serve as a measuring 
tool for projects where you have an interest in visualizing a specific offset, in frames, both before 
and after the current position of the playhead. This offset can be adjusted by changing the Pre- and 
Post-Playhead Shadow Length parameters in the Editing panel of the User Preferences, which let you 
specify the number of frames to shadow both before and after the playhead. The default length of the 
playhead shadow is 5 frames.

TIP: You can set the “Pre-playhead shadow length” to 0, and the “Post-playhead shadow 
length” to 1 if you want to display a “Media Composer-style” playhead that shows the 
duration of the current frame.
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Enabling and Disabling Audio Scrubbing
Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the playhead 
with the mouse back and forth. While this can be useful when you’re searching for audio cues, it can 
also be distracting if you’re just focused on the picture.

To enable or disable audio scrubbing:

 — Choose Timeline > Audio Scrubbing (Shift-S)

Playback Post-Roll
Enables the playhead to continue playing past the last clip in the Timeline for a duration equal to the 
“Post-roll time” Project Setting in the Editing panel. This is good for editors that want to experience 
a few moments of playback after cutting or fading to black after the last frame of audio and video in 
the Timeline.

To enable or disable playback post-roll:

 — Choose Timeline > Playback post-roll

Switching Among Multiple Timelines
Timelines can be organized like any other clip in the Media Pool. To open or switch among timelines, 
use the following procedures.

To switch timelines, do one of the following:

 — Double-click a timeline in the Media Pool on any page.

 — Turn on Stacked Timelines in the Timeline View Options menu of the Edit page toolbar, so that all 
timelines you open appear as tabs. Clicking different tabs switches to that timeline.

 — In the Edit page Timeline Viewer, choose a timeline from the Timelines drop-down menu at the 
top of the viewer.

 — In the Color page, choose a timeline from the Timelines drop-down menu at the top of the Viewer.

 — In the Fairlight page, choose a timeline from the Timelines drop-down menu to the left of the 
transport controls.

Toolbar
At the center of the toolbar that sits above the Timeline, several buttons let you choose different tools 
and options for performing various editing functions.

Buttons in the toolbar
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Timeline View Options: The controls let you customize the look of the clips 
on the tracks (Filmstrip, Thumbnail, or Minimized), audio waveform displays, 
stacked timelines, subtitles, and the adjustable height of the video and audio tracks.

Selecting the Timeline View options

Selection Mode: The default mode in which you can move and resize clips in the 
Timeline, roll edits, and do other basic editing tasks. In this mode, making specific 
selections in the Timeline and using the nudge commands of Comma and Period 
resizes, moves, or rolls the selection, as does absolute or relative timecode entry.

Trim Edit Mode: In this mode, the Trim tool lets you make slip, slide, ripple, and roll 
edits by dragging different parts of clips in the Timeline, by making specific selections 
and using the “nudge” keyboard shortcuts of Comma and Period to move the selection 
left or right, or by making specific selections and using timecode entry to make 
relative or absolute adjustments.

Dynamic Trim Mode: This mode works in conjunction with either the Selection or 
Edit modes. With Dynamic Trim mode enabled, you can either resize and move clips 
(in Selection mode), or ripple, slip, or slide them (in Trim mode) using the JKL keyboard 
shortcuts that play forward and backward through the Timeline. While enabled, the 
spacebar triggers the Play Around Current Selection command. The Toolbar button 
for this mode also changes to show you whether you’re in slip or slide mode for 
nudging, timecode-entry adjustment, or dynamic trim (set by pressing the S key).

Blade Edit Mode: Lets you add cuts to clips at the playhead in  
the Timeline by clicking.

Insert Clip: Performs an insert edit to the Timeline with whatever 
clip is in the Source Viewer.

Overwrite Clip: Performs an overwrite edit to the Timeline with whatever clip is in the 
Source Viewer.
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Replace Clip: Performs a replace edit to the Timeline with whatever clip is in 
the Source Viewer.

Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing.

Linked Selection: Enables or disables audio/video linking. When turned on, clicking a 
video clip in the Timeline automatically selects the corresponding audio clip if they’re 
linked together. When turned off, clicking a video clip won’t select its audio. Clip linking 
can be toggled while you work by pressing the Option key while clicking to make 
selections in the Timeline.

Position Lock: Prevents clips from being moved to the left or right, and it prevents all 
ripple operations. Essentially ensures all the Timeline elements stay in sync and can’t 
be adjusted accidentally. 

Flag Clip/Flag Colors drop-down menu: Flags identify clips, and indicate all clips 
that correspond to the same item of media in the Media Pool. Clips can have multiple 
flags. Clicking the Flag button automatically adds a flag to whichever clip is currently 
selected in the Timeline. A drop-down menu to the right lets you choose differently 
colored flags, and clear all flags from the currently selected clip.

Add Marker/Marker Colors drop-down menu: Markers identify specific frames 
of individual clips. Clicking the Add Marker button adds a marker of the currently 
displayed color to the clip at the position of the playhead in the Timeline. A drop-down 
menu to the right lets you choose differently colored markers, and clear all markers 
from the currently selected clip.

Full Extent Zoom: Dynamically adjusts the zoom level to encompass the whole 
Timeline as you add or remove clips.

Detail Zoom: Zooms the Timeline in on the Playhead to the frame level.

Custom Zoom: Zooms the Timeline to the level selected by the Zoom slider 
to its immediate right.

Zoom Slider: Lets you zoom into or out of the clips in the Timeline. Use the scroll 
wheel of your mouse to horizontally zoom into and out of the Timeline. Scrolling up 
zooms in, while scrolling down zooms out. You can also use Command-Plus to zoom in, 
and Command-Minus to zoom out, and Shift-Z to fit every clip in your program into the 
available width of the Timeline.

These functions are described in greater detail in the following sections of this chapter.
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Toolbar Audio Monitoring Controls
At the far right of the toolbar, a set of three monitoring controls lets you quickly control the output 
volume of your mix. An audio Enable/Disable button lets you turn audio playback on and off, while a 
slider lets you change the volume, and a DIM button lets you temporarily duck the monitored volume 
being output in order to have a quick chat with your client about sports or the state of the world while 
keeping half an ear on the mix.

The monitoring controls in the Edit page

When there are multiple audio Mains defined for a project, an additional drop-down dialog appears 
with the audio monitoring controls in the toolbar that lets you choose which Main you’re listening to.

The Mixer and Meters
The Audio Mixer provides a set of graphical controls you can use to set track levels, pan stereo audio, 
and mute and solo tracks, all while you continue to edit.

The Audio Mixer, with four channel strips 
corresponding to the four tracks in the Timeline

To open the Audio Mixer:

 — Click the Mixer button on the Interface toolbar.

The Audio Mixer exposes a set of channel strips 
with controls that correspond to the tracks in the 
Timeline, and each channel strip displays a number 
of audio meters equal to the number of channels 
within that track. By default, a Main 1 channel strip 
appears all the way to the right that lets you adjust 
the overall level of the mix. However, if you add 
subs and mains on the Fairlight page, those will 
appear at the right of the mixer as well.

For more information about the use of the Mixer in 
the Edit page, see Chapter 44, “Working with Audio 
in the Edit Page.” 

For more information about using the Mixer in 
the Fairlight page, see Chapter 173, “Mixing in the 
Fairlight Page.”
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Displaying Audio Meters
If you just want to see your program’s levels, you can also switch to display the “Control Room” 
audio meters instead of the Mixer. How many audio meters appear depends on the current speaker 
configuration in the Video and Audio I/O panel of the System Preferences.

To show the Audio Meters:

 — Click the Mixer button on the Interface toolbar to display the audio panel, and then choose Meters 
from the option menu at the upper right-hand corner.

Using Video Scopes
DaVinci Resolve has a set of four real-time video scopes that you can use to monitor the internal data 
levels of clips in your project as you work. Each scope provides an unambiguous graphical analysis 
of the various characteristics of the video signal, showing you the relative strength and range of 
individual color components including luma, chroma, saturation, hue, and the red, green, and blue 
channels that, together, comprise the color and contrast of the images in your program.

To open video scopes from the Media, Cut, Edit, Color, 
or Deliver pages, do one of the following:

 — Choose Workspace > Video Scopes > On/Off (Command-Shift-W) to open video scopes into a 
floating window.

 — Choose Workspace > Dual Screen > On to open video scopes as part of a dual screen layout.

Video scopes in a floating window
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The video scopes aren’t just available in the Color page. They’re also available in the Media, Cut, Edit, 
and Deliver pages for whenever you need to evaluate the video signal more objectively, such as when 
you’re setting up to capture from tape or scan from film, or when you’re setting up for output.

For more information on using the video scopes, see Chapter 124, “Using the Color Page.”

Floating Timecode Window
A Timecode Window is available from the Workspace menu on every page except Fusion. Choosing 
this option displays a floating timecode window that shows the timecode of the Viewer or Timeline 
that currently has focus. This window is resizable so you can make the timecode larger or smaller.

A new floating timecode window is available

Dual Monitor Layout
The Edit page has a dual monitor layout that provides maximum space for the Timeline and Viewers 
on the primary monitor, and an enlarged Media Pool, simultaneously displayed Timelines browser, 
Edit Index, Effects Library, and Metadata Editor on the secondary monitor.

To enter dual screen mode:

 — Choose Workspace > Dual Screen > On. 
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The Edit page in dual-screen mode

To switch which UI elements appear on which monitors:

Choose Workspace > Primary Display > (Monitor Name), which reverses the contents of both monitors 
in dual screen mode.

Customizing the Edit Page
The default layout is quite efficient for a number of tasks on most displays. You can always return 
to the default layout by choosing Workspace > Reset UI Layout. However, the Edit page can be 
customized to create more room for specific areas of the interface to accommodate different tasks.

To resize any area of the Edit page:

 — Drag the vertical or horizontal border between any two panels to enlarge one and shrink 
the other.

To expand the width of the Timeline:

 — Click the Media Pool/Effects Library/Edit Index height button to reduce the area used by the 
Media Pool, Effects Library, and/or Edit Index to shrink to half height. At this size, the Media Pool/
Effects Library/Edit Index are restricted to the top of the UI (you can only show one at a time), and 
the Timeline takes up the full width of your display.

 — Hiding the Edit Index and the Effects Library causes the Timeline to expand to the full 
width of your screen.

To resize the height of individual video or audio tracks:

 — Move the pointer to the top border of any video track header, or the bottom border of any audio 
track header, and when it becomes a resize cursor, drag that border up or down to resize that 
track. Each track can have an independent size when you do this.

630Edit | Chapter 33 Using the Edit Page



To enable a full-screen timeline in Dual Screen mode:

 — Choose Workspace > Dual Screen > Full Screen Timeline, which causes the Timeline to fully occupy 
the primary display, while the Browser, Viewers, Audio Mixer, Edit Index, and Effects Library 
appear on the secondary display.

To customize the columns in the Edit Index:

 — To show or hide columns in the Edit Index: Right-click any column header, and choose the 
column you want to show or hide from the contextual menu. Checked columns are shown, 
unchecked columns are hidden.

To resize any column of the Edit Index: 

 — Move your pointer over the divider between any two columns and drag when the horizontal resize 
cursor appears.

To sort the Edit Index by any column: 

 — Click the Option button at the top right to display all active tracks, just the video, or just the 
audio tracks.

To rearrange Edit Index columns: 

 — Drag the header of any column to the left and right to move that column.

To show and hide the Audio Meters or Audio Mixer:

 — Click the Mixer button in the UI toolbar.

To switch between the Audio Meters and the Audio Mixer:

 — Choose Meters or Mixer from the Option menu at the top right corner of the Mixer.

Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The next time 
you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate 
sets of undo “stacks” to help you manage your work.

 — The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack 
out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.

 — Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the 
composition of each clip, independently.

 — Each clip in the Color page has its own undo stack so that you can undo changes you make to 
grades in each clip, independently.
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In all cases, there is no practical limit to the number of steps that are undoable (although there may be 
a limit to what you can remember). To take advantage of this, there are three ways you can undo work 
to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

 — Choose Edit > Undo (Command-Z) to undo the previous change.

 — Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

 — On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP: If you have the DaVinci control panel, there is one other control that lets you 
control the undo stack more directly when using the trackballs, rings, and pots. Pressing 
RESTORE POINT manually adds a memory of the current state of the grade to the undo 
stack. Since discrete undo states are difficult to predict when you’re making ongoing 
adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set 
predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time of this 
writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

To undo and redo using the History submenu:

1 Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.

2 Choose an item on the list to undo back to that point. The most recent thing you’ve done appears 
at the top of this list, and the change you’ve just made appears with a check next to it. Steps 
that have been undone but that can still be redone remain in this menu, so you can see what’s 
possible. However, if you’ve undone several changes at once and then you make a new change, 
you cannot undo any more and those steps disappear from the menu.

The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you its 
current state.
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To undo and redo using the Undo window:

1 Choose Edit > History > Open History Window.

2 When the History dialog appears, click an item on the list to undo back to that point. Unlike 
the menu, in this window the most recent thing you’ve done appears at the bottom of this list. 
Selecting a change here grays out changes that can still be redone, as the project updates to 
show you its current state.

The Undo history window that lets 
you browse the entire available 
undo stack of the current page

3 When you’re done, close the History window.
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Chapter 34

Creating and 
Working with 
Timelines
In this chapter, you’ll learn how to create and modify the timelines 
into which you edit clips to create the edited sequences that are 
your programs.
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Keyboard Shortcuts in This Chapter
Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

Key Shortcut Function

Command-N Create new timeline

Delete/Backspace Remove timeline from Media Pool

Command-Shift-N Create new bin in Media Pool

Command-Minus (–) Zoom out of timeline

Command-Equals (=) Zoom into timeline

Shift-Z
Zoom all clips to available width of screen; toggles back to previous 
zoom level

Home Move playhead to beginning of timeline

End Move playhead to end of timeline

N Toggle timeline snapping off and on

Command-Shift-L Toggle linked selection off and on

Command-4 Select the timeline panel

Creating and Duplicating Timelines
If you’re not importing a project that’s been edited elsewhere, you can create a new timeline to cut 
together a new edit from scratch, to use to assemble clips for use in a Fusion composition, to grade a 
set of dailies, or to put together an audio program within the Fairlight page. When you create a new 
timeline, you can either create a timeline that contains all clips found in the Media Pool to quickly 
create a big batch of offline dailies, or an empty timeline that’s ready for you to add specific clips to. 
Timelines you create are stored in the currently selected Media Pool bin. 

If you’d like an easy way to browse all the timelines in your project at once, regardless of their diverse 
locations, you can enable the “Smart Bin for Timelines” option, which is in the Editing panel of the User 
Preferences. This creates a Smart Bin in the Bin list of the Media Pool that filters all timelines in your 
project, making it easy to see all your timelines without altering your original organization.

Individual Timeline Settings for Format, 
Monitoring, Output, and Color
When you create a new timeline, there are a number of ways you can customize it, but by default it 
will mirror the current project-wide timeline settings for resolution, frame rate, and other format and 
monitoring parameters.
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The Create New Timeline 
dialog with standard 
customization settings

However, you have the option of creating separate timelines with individual Format, Monitoring, 
Output Sizing, and Color Management settings for situations where you need to set up multiple 
timelines to create multiple deliverables with different resolutions, pixel aspect ratios, frame rates, 
monitoring, or output scaling options, and color management than the overall project, including 
“Mismatched Resolution Files” settings. To choose individual settings, uncheck the Use Project 
Settings box in the New Timeline dialog, and additional controls will appear.

Clicking Use Custom Settings 
exposes additional panels for 
individualized timeline settings

Once you’ve created a timeline with individual settings, you can edit its settings by right-clicking that 
timeline in the Media Pool, and choose Timelines > Timeline Settings from the contextual menu. 
An Edit Timeline dialog appears, with separate panels for Format, Monitor, Output, and Color settings 
that you can choose. You can also click Use Project Settings to have that timeline use the project-wide 
timeline settings instead.

It is also possible to change the starting timecode for multiple timelines at the same time using the 
custom timeline settings.

To change the start timecode for multiple timelines at once:

1 Select the Timelines whose timecode you want to modify.

2 Right-click on one of the selected Timelines and choose Timelines > Starting Timecode from the 
contextual menu.

3 Enter the new timecode in the Time Start field.

4 Click on OK.
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Creating Blank and Stringout Timelines
If you’re cutting a new video or audio program, you’ll usually want a blank timeline. However, the same 
command can be used to create stringout timelines when putting together dailies by turning the 
“Empty Timeline” checkbox off.

To create a new blank timeline:

1 (Optional) Select or create a folder in the Bin list in which to put the new timeline.

2 Do one of the following:

 — Choose File > New Timeline (Command-N).

 — Right-click within the Media Pool, and choose Timelines > Create New Timeline.

3 When the New Timeline Options window opens, set the following options:

 — Start Timecode: You can change the Start Timecode if a specific start time is required.

 — Timeline Name: Enter a name into the Timeline Name field.

 — No. of Video Tracks: Enter how many video tracks you want to have. You can also drag within 
this field to adjust the number of video tracks with a virtual slider.

 — Use Fairlight Preset: If this box is checked, it creates a timeline with pre-assigned audio 
tracks using a previously created Fairlight Configuration preset. A drop-down menu then 
appears, allowing you to select the specific preset for the Timeline. The preset is used in lieu 
of the No. Of Audio Tracks setting below. You can create Fairlight Configuration presets using 
the Fairlight Presets Library, available from the Fairlight menu. 

For more information, see Chapter 169 , “Setting up Tracks, Buses, and Patching” in the 
DaVinci Resolve Manual. If you have no Fairlight Configuration presets saved, this option will 
not appear.

 — No. of Audio Tracks: Enter how many audio tracks you want to have. You can also drag within 
this field to adjust the number of audio tracks with a virtual slider.

 — Audio Track Type: Choose the channel mapping you want the new audio tracks to use.

 — Empty Timeline: Checked by default, this sets new timelines to be created empty. If you 
turn off the Empty Timeline checkbox, the new Timeline that’s created will contain all media 
found in every bin within the Media Pool, effectively creating a stringout of everything 
you’ve imported.

 — Use Selected Mark In/Out: Only available when “Empty Timeline” is turned off. When you 
turn this checkbox on, each clip’s duration in the new Timeline is defined by the In and 
Out points saved within each clip. If there are no In/Out points in a clip, the clip’s entire 
duration is used.

 — Use Custom Settings: Click this button if you want to expose the Format, Monitor, and 
Output tabs that can expose unique settings for each timeline.

4 Click Create New Timeline.

A new timeline is created. If necessary, you can duplicate an existing timeline in order to alter an edit 
or create an alternate grade.
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TIP: If you’re going to be creating several new timelines with a specific set of parameters, 
you can open the User pane of the Preferences and edit the New Timeline Settings, found 
in the Editing panel. This will define new presets that populate the New Timeline Options 
window from that point forward.

Creating Timelines by Drag and Drop
When you first create a new project, no timeline inhabits the Timeline Editor, and you have an 
opportunity to create a new timeline by drag and drop.

To create a timeline by dragging and dropping a clip:

Drag any clip into the empty Timeline Editor area underneath the Viewers on the Edit page, and a new 
timeline will automatically be created.

Creating Timelines From Bins and Selections
The “Create Timeline Using Bin” and “Create Timeline Using Selected Clips” commands let you quickly 
assemble a timeline using the contents of the Media Pool, using whatever In and Out points have been 
added to each clip, and using the sort order of the enclosing bin to determine the order in which the 
clips will be assembled.

TIP: These commands are especially useful for putting together quick assembly edits if you 
have metadata-rich media with scene, shot, and take information that you can use to sort 
clips into the proper order, and In and Out points that you’ve already logged.

To create a timeline using the full contents of a bin:

1 (Optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, 
and sort the Media Pool by the column that will put all clips in the order you want them to 
be assembled.

2 Right-click the bin in the Bin list, and choose Create Timeline Using Bin.

3 Type the name of the new timeline in the New Timeline Properties dialog. If you want to use 
the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click 
Create New Timeline.

To create a timeline using manually selected clips:

1 (Optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, and sort 
the Media Pool by the column that will put all clips in the order you want them to be assembled.

2 Select one or more clips you want to assemble into a new timeline.

3 Right-click one of the selected clips, and choose Create Timeline Using Selected Clips.

4 Type the name of the new timeline in the New Timeline Properties dialog. If you want to use the 
In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click Create 
New Timeline. By default, Audio Track Type is set to “Based on selected media,” so the timeline 
audio tracks reflect the track mapping of the clips you’ve selected, but you can manually choose 
other specific mappings if you need to.
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Creating Timelines Using an IMF or 
DCP Composition Playlist (CPL)
You can create a timeline in DaVinci Resolve that exactly replicates the Composition Playlist (CPL) 
of a DCP or IMF package. This is currently a DaVinci Resolve Studio only feature.

To create a timeline using a Composition Playlist (CPL):

1 Import an IMF or DCP package into the Media Pool, like any other piece of media.

2 Right-click on the imported clip and choose “Create New Timeline Using Composition Playlist” 
from the contextual menu.

3 In the New Timeline dialog box, choose a specific CPL from the package in the 
“Composition Playlist” drop-down menu.

4 Make any other normal new Timeline adjustments you may need (such as Resolution, 
Aspect Ratio, etc.),  then click the “Create” button.

Duplicating Timelines
You can also duplicate existing timelines in preparation for saving a copy prior to making 
modifications, or as a starting point for a different version of your content.

To duplicate a Timeline, do one of the following:

 — Select a timeline in the Media Pool, and choose Edit > Duplicate Timeline. The duplicate timeline 
appears with “copy” appended to the name.

 — Right-click a timeline in the Media Pool, and choose Duplicate Timeline from the contextual menu.

Disabling Timelines
You can disable/enable timelines in the Media Pool for both performance and organizational 
purposes. This is particularly useful for editors who like to maintain a history of a program’s editing via 
an ongoing series of periodically duplicated timelines. Since having a large number of timelines within 
a single project file can affect performance, having the ability to disable timelines lets you maintain 
these backup/alternate timelines without any penalty. 

Disabled timelines are never loaded into RAM, have no effect on the speed at which a project opens, 
saves, exports, or loads, and have no effect on program performance. A disabled timeline also hides 
the timeline from the viewer drop-down menus throughout the program. Disabled timelines are 
still visible in the Media Pool, but have a crossed out eye icon in the lower left to show the status. 
A disabled timeline cannot be opened in any page of DaVinci Resolve.

To disable a timeline:

 — Select the Timeline, right-click on it and choose “Disable Timeline” from the drop-down menu.

To enable a timeline: 

 — Select the Timeline, right-click on it and choose “Enable Timeline” from the drop-down menu.  
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The crossed-out eye in the 
lower left of the thumbnail indicates 
this Timeline is disabled.

TIP: Enabled and Disabled timelines can be 
easily grouped and organized across the entire 
project by creating a Smart Bin with the MediaPool 
Properties > Timeline fields, and choosing 
“is Enabled/Disabled.” 

Import and Export  
DaVinci Resolve Timelines (.drt)
You can export and import individual timelines from one DaVinci Resolve project into another 
previously existing DaVinci Resolve project, allowing you to pass timelines quickly between projects 
and workstations, without creating additional imported project files. Just the timeline and its 
associated clip information are exported; none of the actual media files are included.

To export a timeline from the Media Pool:

1 Select a timeline from the Media Pool.

2 Choose File > Export > Export AAF, XML, DRT (Shift-Command-O).

3 Choose “DaVinci Resolve Timeline Files (*.drt)” from the format options popup in the file 
system dialog.

4 Choose where to save the DaVinci Resolve Timeline file (.drt) in the file system dialog, and 
click Save.

To import a timeline into the Media Pool:

1 Choose a bin in the Media Pool in which you want the imported timeline to be saved.

2 Do one of the following:

 — Choose File > Import Timeline > Import AAF, XML, DRT (Shift-Command-I), then Select a 
DaVinci Resolve Timeline file (.drt) from the file system dialog, and click Open.

 — Double click the .drt file in your file system.

The timeline will appear in the Media Pool, along with all of the clips associated with it, including 
any media sync information. Any timelines imported this way will have the word “import” appended 
to their name, to avoid duplicate names. The imported timeline will be automatically conformed 
to corresponding media that’s already in the Media Pool. However, if the timeline has been moved 
to another computer, you may have to reimport or relink missing or offline media in to bring the 
imported timeline fully online.

NOTE: Only a single timeline can be imported and exported at a time using this method. 
To import or export multiple timelines, use the Import/Export Bin function instead.
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Backing Up and Restoring Timelines
Turning on the Timeline Backups checkbox in the Project Save and Load panel of the User Preferences 
enables DaVinci Resolve to save multiple backups of a timeline at periodic intervals, using a method 
that’s analogous to a GFS (grandfather-father-son) backup scheme. This can be done regardless of 
whether or not Live Save is turned on.

If you want to revert to a previous backup of a timeline, simply right-click on the Timeline in the Media 
Pool, select Restore Timeline Backup from the contextual menu, and choose the backup from the list 
of options. Backups are organized by date and time, making it easy to find the specific timeline you 
want to restore.

Restoring a timeline backup does not overwrite your current timeline. Instead the selected backup will 
be brought into the Media Pool as a new timeline with the name “Backup” appended to it.

 

Restoring a timeline backup in the Media Pool

Timeline backups are only saved when changes have been made to a project. If DaVinci Resolve sits 
idle for any period of time, such as when your smart watch tells you to go outside and walk around the 
block, no additional project backups are saved, preventing DaVinci Resolve from overwriting useful 
backups with unnecessary ones.

Three fields let you specify how often to save a new backup, while the fourth lets you choose where 
the backups will be saved. These settings apply to both Project and Timeline backups.
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 — Perform backups every X minutes: The first field specifies how often to save a new backup 
within the last hour you’ve worked. By default, a new backup is saved every 10 minutes, resulting 
in six backups within the last hour. Once an hour of working has passed, an hourly backup is saved 
and the per-minute backups begin to be discarded on a first in, first out basis. By default, this 
means that you’ll only ever have six backups at a time that represent the last hour’s worth of work.

 — Hourly backups for the past X hours: The second field specifies how many hourly project 
backups you want to save. By default, two hourly backups will be saved for the current day. Past 
that number, hourly backups will begin to be discarded on a first in, first out basis.

 — Daily backups for the past X days: The third field specifies for how many days you want to save 
backups. The very last backup saved on any given day is preserved as the daily backup for that 
day, and by default daily backups are only saved for two days. Past that number, daily backups 
will begin to be discarded on a first in, first out basis. If you’re working on a project over a longer 
stretch of time, you can always raise this number.

 — Project backup location: Click the Browse button to choose a location for these backups to be 
saved. By default they’re saved to a “ProjectBackup” directory on your scratch disk, although you 
could change this to a volume that better fits into your data backup methodology. This folder 
contains both Project and Timeline backups.

Timeline View Options
As you’re working on an edit, it can often be useful to modify the appearance of the Timeline, 
changing the height of video or audio clips, choosing whether audio waveforms are drawn or not, and 
so on. Using the Timeline View Options drop-down at the far left of the Timeline, you can make these 
kinds of changes as you work.

Timeline View Options
Three buttons let you choose to show or hide specific Timeline interface elements, 
including the following:

The Timeline View Options drop-down
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Show tabbed and stacked timelines: This option lets you open multiple timelines by 
displaying a tabbed interface, and also gives you the ability to show stacked timelines for 
simultaneous display of timelines one on top of another.

Subtitle Tracks: Lets you display or hide the subtitle tracks region of the Timeline. Hiding 
subtitle tracks does not disable subtitle display; to do that you must disable the currently 
displayed subtitle track.

Show Audio Waveforms: Lets you turn audio waveform viewing off and on. When Audio 
Waveform is turned off, audio tracks are minimized.

Video View Options
Three buttons let you choose the overall appearance of video and audio tracks. From left to right:

Filmstrip: Displays each clip as a series of frames along its length. The number of frames 
displayed depends on the current zoom level of the clip in the Timeline. 

Thumbnail: Displays each clip as a solid color with a thumbnail image of the clip’s In 
point at the beginning of the clip, and a thumbnail image of the Out point at the end. 
The thumbnails displayed depend on the current zoom level, and track height of the 
clip in the Timeline. If the clip does not have enough room for both, only the In point 
thumbnail will appear.

Simple: Minimizes all track height and displays each clip as a solid color along its 
length. Hovering the mouse over the track selection indicator will reveal the track 
names in a tooltip.

Audio View Options
Three buttons govern the look of audio waveforms in the Timeline, when visible.

Non-Rectified Waveform: Lets you toggle between the waveform being drawn from the 
bottom of the audio track up, or centered and mirrored about itself.

Full Waveform: Hides the divider bar that keeps the waveform separate from the 
file name area of each audio clip, so the waveform occupies the full space of each audio 
bar in the Timeline.

Waveform Border: Draws a dark border around the edges of each waveform to make 
them easier to see.

Track Height
In addition, any track in the Timeline can be individually resized by dragging its top divider in the Track 
Header area. Track heights in the Edit page are independent of the Thumbnail and Waveform view 
settings in the Timeline View options. Previously, specific Timeline viewing options such as Filmstrip or 
Thumbnail view had minimum track height settings. Now you can freely change track height no matter 
what options you’ve chosen, and resizing one or more tracks below the minimum height for filmstrips 
or thumbnails automatically collapses those tracks into Simple view to avoid clutter.
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Video track height slider: Lets you resize the size of all video tracks at once, 
independently of the audio tracks.

Audio track height slider: Lets you resize the size of all audio tracks at once, 
independently of the video tracks.

Resizing an individual Timeline track by 
dragging its top border in the Track Header

Modifying Timeline Tracks
When you’re getting ready to edit clips into the Timeline, you need to make sure you’ve got enough 
tracks to do the job. The following procedures cover the different methods available for adding, 
removing, and rearranging tracks as you work. These commands are all available via the contextual 
menu that appears when you right-click anywhere in the Timeline header area (the header of the 
Timeline is the area to the left where each track’s various buttons and controls are located).

Methods for adding, deleting, and rearranging tracks:

 — To add a track to the Timeline: Right-click on a Track Timeline header and choose Add Track. 
A new video track will be created immediately above the track you right-clicked on. A new audio 
track will be created immediately below the track you right-clicked on. If you add an audio track, 
you can choose what type of channel mapping you want. For more information about audio track 
channel mappings, see Chapter 44, “Working with Audio in the Edit Page.”

 — To add multiple tracks to the Timeline at a specific position: Right-click anywhere in the 
Timeline header and choose Add Tracks. When the Add Tracks dialog appears, choose the number 
of video and audio tracks you want to add, choose the position you want to insert the tracks above 
or below, and choose the Audio Track Type you want to add if you’re adding audio tracks. When 
you’re done, click “Add Tracks.”

 — To delete a track from the Timeline: Right-click within a track’s Timeline header and choose 
Delete Track. If there are clips on a track you remove, they are deleted from the Timeline.

 — To delete all unused tracks in the Timeline: Right-click anywhere in the track header area and 
choose Delete Empty Tracks. All tracks without clips will be deleted at once.

 — To move tracks and the clips on them up and down: Right-click within a track’s Timeline header 
and choose Move Track Up or Move Track Down from the contextual menu. That track, along with 
all clips on it, will be moved up or down relative to the other tracks in the Timeline. You can also 
rearrange track order from the Tracks Index. Simply click on the track in the # field and drag the 
track to its new position.
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The Add Tracks Dialog lets 
you add multiple tracks 
at once and set their 
locations in the timeline.

Naming Timeline Tracks
If you’re a stickler for organization, you can also name the tracks on a timeline to identify its purpose.

To rename a track:

1 Make sure the Timeline View Options are set to either the Filmstrip view or the Thumbnail view, 
and that audio tracks are tall enough, so that track names are visible.

2 To edit the name of any track, click the default “Video X” or “Audio X” track name to select it, then 
type your preferred name and press the Return key.

Using the Tracks Index
Several of the most common track controls can be found together in the Track Index. The Track Index 
is accessed by clicking on the Index pane, and selecting the Tracks tab. The resulting list shows all the 
current tracks in your timeline and their position and attributes. These are all modifiable right inside 
the Track Index.

The Tracks Index 
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Tracks Index Columns
Each track reveals several columns of information. These columns can be rearranged by dragging the 
column headers to the left or right, depending on what information is most important to you. Clicking 
on a track row selects the track for modification.

The available columns of information are:

 — Color: The current color of the track is shown. Right-click anywhere in the row and choose Change 
Track Color to choose a new one.

 — #: Displays the current track order. You can rearrange the order of the tracks by dragging the 
number in this column up or down in the track hierarchy and releasing the mouse button. Note 
that the actual absolute track number (V1, A1, etc.) does not change, but the track that is assigned 
to that number will have changed.

 — Name: The name of the Track. You can click in this field to rename the track.

 — Track Controls: The same track controls that are found in the Track Header in the Timeline can 
also be accessed here: Lock/Unlock, Auto Track Select, Disable/Enable Video Track, Solo, and Mute.

 — Format (audio track only): Shows the current format of the audio track. You can change this 
format to any other by right-clicking anywhere in the row of an audio track and choosing Change 
Track Type to, and then selecting a new format from the contextual menu.

 — Monitor (audio track only): Chooses which busses or tracks can be selected in the monitor 
drop-down menu in the upper right of the Edit or Fairlight Fairlight page windows.

 — ADC (audio track only): Checking this box turns on Automatic Delay Compensation (ADC) 
for the track.

Clicking on the Tracks Index’s option menu lets you include or exclude track types (video, audio, 
subtitle) from the index.

Using Timeline Snapping 
and Zooming
When preparing to make an edit into the Timeline, you can set the snapping and zoom controls to 
whichever state is most useful for the operation you need to perform. For example, if you’re editing 
an insert shot into a rapid-fire section of edits in the Timeline, you may want to zoom in to better see 
the exact place where you want to place the incoming clip. Since there are many edits at that point, 
disabling snapping might make it useful to avoid having the clip jump to the nearest edit point if you 
need to move the incoming clip to a very specific frame.

Playhead Snapping:
To turn clip and playhead snapping on and off: Click the Snapping button in the 
toolbar, or press N. When snapping is turned on, the In and Out points and markers of 
clips all snap to one another and to the playhead. You can also press N to temporarily turn 
snapping on or off while dragging a clip in the Timeline, or while scrubbing the playhead 
using the pointer (snapping reverts to its previous state when you finish the operation).
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Timeline Zoom presets:

From left to right: Full Extent, Detail, 
and Custom Zoom controls

Full Extent Zoom: This mode dynamically adjusts the zoom level to encompass the 
whole Timeline as you add or remove clips. As your timeline grows by adding clips, 
the zoom level decreases automatically to fit the new clips into your Timeline Viewer. 
Conversely, the zoom level will increase automatically as you remove clips.

Detail Zoom: This setting zooms the Timeline in on the Playhead to the frame level to 
quickly make fine timing adjustments.

Custom Zoom: Zooms the Timeline to the level selected by the Zoom Slider to its 
immediate right.

Zoom Slider: Drag the zoom slider to the left to zoom out, and right to zoom in. You can 
also press Command-Minus (–) and Command-Equal (=) to zoom out and in. Either way, 
zooming is always centered on the current position of the playhead, even if the playhead 
is off screen.

To frame every clip into the width of the Timeline: Press Shift-Z. This is a toggle, so 
pressing Shift-Z frames your whole edited sequence to the width of the Timeline, and 
then pressing Shift-Z again returns the Timeline to whatever level of zoom you were using 
previously. Using this keyboard shortcut makes it really easy to navigate the Timeline 
when you’re zoomed in, as you can press Shift-Z, move the playhead to another part of 
the Timeline you want to work on, and then press Shift-Z again to zoom back into the new 
location of the Timeline.

Zoom Around Mouse Pointer
You can set up the Edit Timeline zoom controls to stay centered on the pointer as you zoom in or 
out,  instead of staying centered on the Timeline playhead as usual, by selecting View > Zoom Around 
Mouse Pointer. This can be helpful when navigating longer timelines. 

With this option enabled, zooming in and out of the Timeline using the scroll control of your pointing 
device while holding the Option key down keeps the Timeline centered on the pointer. Deselect this 
option to return to the behavior of only zooming in or out centered on the playhead position.

Scrolling Through the Timeline 
When you’re zoomed into the Timeline, there are several methods you can use to scroll around 
as you work.

 — You can scroll left and right, or up and down, by dragging the Timeline’s horizontal and vertical 
scroll bars.
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 — You can scroll left and right through the Timeline, one “page” at a time at the current zoom level, 
by selecting Playback > Next/Previous > Timeline Page. If you use these often, you can assign 
them a keyboard shortcut. 

 — You can also scroll up and down the tracks of the Timeline using the scroll wheel, scroll ball, or 
scroll gestures of your mouse, trackball, trackpad, or other pointing device. 

 — You can also scroll within the Timeline by middle-clicking and dragging in any direction, which 
works the same as panning around a viewer that you’ve zoomed into. This frees you from having 
to use the scroll bars as you move around your edited clips.

If you scroll past the position of the playhead, a small playhead indicator appears in the bottom 
scroll bar to let you know where it is relative to the entire duration of your edited sequence.

A small indicator shows the position 
of the playhead if it’s outside of 
the visible area of the Timeline.

Scroll Wheel Controls on Timeline
Additional scroll wheel and key presses can be used to manipulate the Timeline on the Edit page.

To manipulate the Timeline, rotate the scroll wheel while holding down:

 — Shift: Expands or contracts all the Video or Audio track heights, depending on what section the 
pointer is located at when you scroll. 

 — Option: Zooms in and out the view of the Timeline.

 — Command: Navigates forward and backward in the Timeline.

Resizing the Timeline’s Video 
and Audio Track Regions
If you need to see more of the video or audio tracks in the available area of the Timeline, you can 
drag the horizontal divider that separates the audio and video tracks up or down to create room 
where you need it.

Dragging the Timeline center divider to 
make more room for audio or video tracks
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Using the Tracks Index
The Tracks Index presents an easy to use track list that lets you view and control all your track headers 
in one place. It also gives more audio information than the track header section of the Timeline. 
The Tracks Index is especially useful for controlling projects with a large number of video and audio 
tracks, and is accessed by clicking on the Index pane, and selecting the Tracks tab.

Using the Tracks Index for video tracks:

 — Color: Shows a bar of the track’s assigned color. You can right-click on the track to change 
its color.

 — #: Shows the track’s number.

 — Name: Shows the track’s name. This field is editable.

 — Track Controls: Exposes the Lock, Auto Track Selector, and the Enable/Disable Video track toggle. 
All of these controls are active.

Using the Tracks Index for audio tracks:

 — Color: Shows a bar of the track’s assigned color. You can right-click on the track to 
change its color.

 — #: Shows the track’s number.

 — Name: Shows the track’s name. This field is editable.

 — Track Controls: Exposes the Lock, Auto Track Selector, Solo, and Mute controls. 
All of these controls are active.

 — Format: Shows the audio track type. Right-clicking on this field lets you change the audio 
track type.

 — ADC: Shows the current amount of Automatic Delay Compensation on the track. Clicking on 
the checkbox toggles the automatic delay compensation on or off.

 — Group: Shows the track’s VCA group number.

 — Tags: Shows any tags assigned to the track.

Using the Tracks Index for subtitle tracks:

 — Color: Shows a bar of the track’s assigned color. You can right-click on the track to 
change its color.

 — #: Shows the track’s number.

 — Name: Shows the track’s name. This field is editable.

 — Track Controls: Exposes the Lock, Auto Track Selector, and the Enable/Disable Subtitle toggle. 
All of these controls are active.

Using the Tracks Index options:

 — To search for a specific track: Click on the search icon (magnifying glass), and type in your 
search terms. Currently the search only queries the Track Name column.

 — To select which type of tracks are included in the Tracks Index: Click on the Option menu to 
choose which type of tracks will be included in the list. The options are: Video, Audio, and Subtitle.
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The Tracker Index lets you control all your track headers in one place.

Tabbed and Stacked Timelines
The Timeline now supports the option to have tabs that let you browse multiple timelines quickly. 
With tabbed timeline browsing enabled, a second option lets you open up stacked timelines to 
simultaneously display two (or more) timelines one on top of another.

Tabbed Timelines
The Timeline View Options menu in the toolbar has a button that lets you enable tabbed browsing and 
the stacking of timelines. 

A button in the Timeline View Options 
enables tabbed timelines.

When you first turn this on, a Timeline tab bar appears above the Timeline, displaying a tab for the 
currently open timeline that contains a Close button and a Timeline drop-down menu. Once you 
enable Tab mode, opening another timeline from the Media Pool opens it into a new tab.
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To the right of the currently existing tabs, an Add Tab button lets you create additional tabs that 
default to “Select Timeline.” Click any tab’s drop-down menu to choose which timeline to display 
in that tab.

Tabs above the Timeline Editor let you 
switch among multiple timelines quickly

Right-clicking a tab opens a contextual menu that gives access to several commonly used 
Timeline functions.

Tabbed timeline contextual menu options:

 — Close Timeline: Closes the current tab’s timeline, and removes the tab. The same as clicking on 
the “x” inside the tab.

 — Close All Other Timelines: Closes all open timelines and tabs except for the one that you right 
clicked and chose this option on.

 — Rename Timeline: Opens the tab’s text editing field, allowing you to change the name of the 
timeline inside the tab. This will change the timeline’s name across the project in the Media Pool 
as well.

 — Find Timeline in Media Pool: Opens the bin where the timeline is stored in the Media Pool, and 
highlights the timeline in orange.

 — Duplicate TImeline: Creates a duplicate of the selected timeline in the same bin, with the word 
“copy” appended to the timeline name. It also automatically opens the copied timeline in a new tab.

Right-clicking on a tab will 
show the timeline options.

Methods of working with tabbed timelines:

 — Click any tab to switch to that timeline. 

 — Use the drop-down menu within any tab to switch that tab to display another timeline from the 
Media Pool. Each tab’s drop-down menu shows all timelines within that project, in alphabetical 
order, but a timeline can only be open in one tab or stack at a time.

 — Drag any tab left or right to rearrange the order of timeline tabs.

 — Click any tab’s Close button to close that timeline and remove that tab.

 — Middle-click any tab to close that timeline and remove that tab.
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Stacked Timelines
While tabbed browsing is turned on, an Add Timeline button appears on the far right of the tab bar 
that enables you to stack two (or more) timelines one on top of another. This lets you have two (or 
more) timelines open at the same time, making it easy to edit clips from one timeline to another.

A good example of when this is useful is when you’ve created a timeline that contains a stringout of 
selects from a particular interview. You can stack two Timeline Editors, one on top of another, and 
then open the Selects Timeline at the top and the Timeline you’re editing into at the bottom. With this 
arrangement, it’s easy to play through the top timeline to find clips you want to use, to drag and drop 
into the bottom timeline to edit into your program.

Two timelines stacked on top of one another

To enable or disable stacked timelines:

 — Click the Add Timeline button at the right of the Timeline tab bar.

The button for adding 
a stacked timeline

Once you’ve enabled stacked timelines, each timeline has its own tab bar and an orange underline 
shows which timeline is currently selected.

At the right of each Timeline tab bar, a Close Timeline button appears next to the Add Timeline 
button, which lets you close any timeline and remove that timeline browsing area from the stack.

The button for closing 
a stacked timeline
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Duplicate Frame Detection
You can turn on Duplicate Frame Detection (often referred to as Dupe Detection) for clips in the 
Timeline by choosing View > Show Duplicate Frames. Doing so shows colored bars at the top of clips in 
the Timeline whenever a range of frames has been used more than once.

Duplicate Frame Detection shows colored bars where a range 
of frames is used more than once in a timeline

Comparing Timelines
For instances where you’re importing multiple versions of a timeline that’s been edited in another 
application, or where you’re working with multiple editors on different versions of the same Timeline 
in either collaborative mode or on multiple separate DaVinci Resolve installations, DaVinci Resolve 
provides a method of comparing two timelines with one another. Using the Timeline Comparison 
window, you can both see a visual comparison of which sections of two timelines differ, and you can 
derive a more traditional change list by opening up the Difference Index.

To compare two timelines:

1 Open the first timeline you want to compare.

2 Right-click a second timeline in the Media Pool, and choose Compare With Current Timeline.

A Timeline Comparison window appears, showing you the currently opened Timeline at the bottom 
and the Timeline you right-clicked at the top.

The Timeline Comparison Window
When you first open the Timeline Comparison window, the first thing you see is a pair of miniature 
timelines. The currently open Timeline appears at the bottom and the Timeline you right-clicked 
appears at the top.
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The Timeline Comparison window

Comparison Window Playhead Output
By default, the two playheads are ganged together, with the top playhead being displayed in the 
Source Viewer, and the bottom playhead being displayed in the Timeline Viewer. These playheads 
can be unganged if you want to compare different areas of both timelines, simply by turning off Sync 
Playheads in the option menu.

Highlighting Differences
Special highlights indicate sections of both timelines that are different. Individual changes are not 
individually highlighted, although they can be seen, on the premise that you’re more interested in a 
section by section analysis of what your collaborating editor has been doing, for purposes of deciding 
whether to incorporate changes or reversions based on this comparison.

Each section of differences between the two timelines are highlighted

When using this tool, you can change the bottom Timeline to match the top Timeline, on a section by 
section basis, by right-clicking a highlighted section and choosing Accept Change from the contextual 
menu. When you do this, the currently open Timeline is immediately changed to incorporate the 
altered section from the Timeline you’re comparing to. If necessary, you can undo this.

Identifying Differences Using Clip Labelling
You can also use the Timeline Comparison window to use clip labeling to indicate all differences 
between the comparison Timeline and the currently open Timeline. The method for doing this has not 
yet been defined at the time of this writing.
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The Change List
Clicking the Diff Index button opens the change list, which shows you a more conventional item by 
item comparison of the differences between the two timelines. 

The Change List of the Timeline Comparison window

The method of exporting this change list has not yet been defined at the time of this writing.
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Chapter 35

Preparing Clips for 
Editing and Viewer 
Playback
Before you start editing, there are a wide variety of things you 
can do to prepare your clips for editing. In this chapter, you’ll learn 
how to browse, select, and play through clips that you need to log, 
adding markers, setting In and Out points, and creating subclips as 
you identify pieces you’ll be using later as you edit. 
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Keyboard Shortcuts in This Chapter
Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

Key Shortcut Function

Arrow Keys 
(Media Pool)

Move selection in Media Pool; left and right arrow keys also open and 
close bins in the Bin list

Shift (modifier)
Hold Shift down when clicking-to-select clips to select a 
contiguous range

Command (modifier)
Hold Command down when clicking-to-select clips to select 
non-contiguous clips

Command-A Select all; selects all clips in the Media Pool browser area

Return or Enter
Opens selected clip or timeline into the Source Viewer  
(in dual viewer mode) or Viewer

I, O Set in/out point in Media Pool, Source Viewer, or Timeline

Option-Shift-I, O Set video-only in/out point in Media Pool, Source Viewer, or Timeline

Command-Shift-I, O Set audio-only in/out point in Media Pool, Source Viewer, or Timeline
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Key Shortcut Function

Shift-I, O Move playhead to in/out point

Spacebar Play and stop

J, K, L Play reverse, stop, play forward; more uses covered later in this chapter

Option-L Play again

Option-K Stop and go to last position (of playhead)

/ Play around current selection

Up, Down Arrow Go to previous clip/edit, go to next clip/edit

M Add marker; doesn’t stop playback

Command-M
Add marker, open modify marker while pausing playback, then 
continue playback

Shift-M Modify marker

Option-M Delete marker

Shift-Up, Down Arrow Go to previous/next marker

Option-B Create subclip (in currently selected Media Pool bin)

Browsing Clips in the Media Pool
The following procedures show how to select one or more clips in the Media Pool to accomplish 
various editing tasks, either by opening a clip in the Source Viewer, or selecting a group of clips with 
which you want to do drag and drop editing. This section starts by presenting different ways you 
can browse the contents of the Media Pool to find clips you want to use, in preparation for making a 
selection for your next operation.

Methods of browsing clips in the Media Pool:

In the Metadata View mode, each clip is represented by its own card with a thumbnail and basic 
clip metadata information visible. This view is designed to have more metadata information than 
a thumbnail but more targeted information than the List view. This feature, combined with its Sort 
modes, is a powerful way to organize and reorganize your clips in the Media Pool.

 — Using thumbnail hover scrub in the Media Pool’s Metadata view: Drag the pointer over a 
thumbnail to scrub through its contents.

The Metadata View icon view 
(highlighted icon in the top bar), 
showing the thumbnail being 
scrubbed next to the clip’s metadata
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 — Using thumbnail hover scrub in the Media Pool’s Thumbnail view: Drag the pointer over a 
thumbnail to scrub through its contents.

Thumbnail 
hover scrubbing

 — Using the Media Pool Filmstrip in the Media Pool’s List view: Select “Show Filmstrip” in the 
Media Pool’s option menu. Select a clip to expose it in the Filmstrip at the top of the Media Pool, 
and hover the pointer over the Filmstrip to watch it play. At any time, you can double-click a clip in 
the Filmstrip to open it into the Source Viewer.

Using the Filmstrip when the Media Pool is in List view

TIP: When browsing media, you can open clips you want to have a closer look at in the 
Source Viewer by double-clicking them in the Media Pool. Meanwhile, you can continue to 
open other clips in the Filmstrip with a single clip in order to compare different clips with 
your main selection that remains in the Viewer.

Selecting Clips in the 
Media Pool to Edit
Once you’ve found one or more clips that you want to use in your edit, you’ll need to make a selection 
in preparation for performing an edit.

Methods of selecting clips in the Media Pool using the mouse:

 — To select a single clip: Click a clip in the Media Pool. 

 — To select a contiguous range of clips: In either Metadata, Thumbnail, or List view, drag a 
selection box over all the clips you want to select, or click to select the first clip in a series, then 
Shift-click the last clip to select those clips and everything in between.

Selecting a 
contiguous 
range of clips
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 — To select a noncontiguous range of clips: Command-click each clip you want to include in the 
selection. Or, you can hold the Command key down while you drag bounding boxes over unselected 
clips to add them to the current selection, or over selected clips to remove them from the selection.

Selecting a 
noncontiguous 
range of clips

Methods of selecting clips using the keyboard:

 — To navigate the Bin list: Either click any bin in the Bin list to the left of the Media Pool, or press 
Command-1 to make the Bin list the active pane of the Edit page, then use the Up and Down 
Arrow keys to to move up and down among the available bins. Use the Right Arrow key to open a 
bin that’s closed, and use the Left Arrow key to close the bin again.

 — To select a single clip: Press Command-1 to make the Media Pool Bin list the active area, and use 
the arrow keys to select and open bins. Then press Command-2 to select the clip browser area 
and use the Arrow keys to move the selection from clip to clip. Once a clip is selected, you can use 
any of the edit keyboard shortcuts to edit the selected Media Pool clip straight to the currently 
open Timeline.

 — To select multiple clips: Hold the Shift key down while you’re using the Arrow keys to move the 
selection to expand or contract a continuous selection in the Media Pool.

 — To select all clips in the Media Pool: Make sure the Media Pool has focus by clicking a clip or 
clicking anywhere in the background of the Media Pool, then press Command-A to select all clips.

 — To open a selected clip or timeline into the Source Viewer: Press the Return key. Once you’ve 
opened a clip into the Source Viewer, you can use the transport controls to play through it.

Duplicating Clips in the Media Pool
If you want to create duplicates of clips in the Media Pool, you can Option-drag one or more clips to 
another bin. You can also select the clip or clips you want to duplicate and select Edit > Duplicate Clips. 
The duplicated clips will appear in the same bin as the original media. The duplicate clips have their 
own individual links to the source media on disk.
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Viewer Playback and Navigation
By default, the Edit page presents a traditional source/record style editing experience. The Source 
Viewer lets you view individual clips from the Media Pool to prepare them for editing. Meanwhile, the 
Timeline Viewer lets you play through your program, showing you the frame at the position of the 
playhead in the Timeline. 

 

Source and Timeline Viewers

Source and Timeline Viewers vs. Single Viewer Mode
If you want to change the Edit page layout to hide the Source Viewer, you can choose Workspace > 
Single Viewer Mode to instead use just a single viewer to contextually display either a selected Source 
Clip or the current frame of the Timeline.

Single Viewer mode

In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which controls 
appear in the Viewer, which lets you do nearly everything you can do with two simultaneously 
open viewers.
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Opening Clips Into the Source 
Viewer to Prepare for Editing
Once you’ve decided which clips you want to use in your program, you can open them into the Source 
Viewer to review them more completely. How this works depends on the Source Viewer’s Live Media 
Preview setting.

To skim through a Media Pool metadata or thumbnail and view clips in the 
Source Viewer using Live Media Preview:

1 Turn on Live Media Preview (if necessary) by clicking the Source Viewer option menu and choosing 
Live Media Preview.

2 With the Media Pool open and in Metadata or Thumbnail mode, position the pointer over a clip, 
and after a few moments when that clip’s thumbnail starts to skim, you can see the clip you’re 
scrubbing in the Source Viewer. Do one of the following:

a) As you skim within the thumbnail, the playhead that appears in the thumbnail is locked to the 
playhead displayed in the Viewer’s jog bar. While skimming, you can add markers and set In 
and Out points

b) Leaving the pointer positioned over that clip, use the JKL keyboard shortcuts to play through 
the clip, adding markers and setting In and Out points as you like

3 It takes a moment for skimming to begin, which allows you to quickly move the pointer from that 
clip back to the Source Viewer without opening any other clip.

Turning off Live Media Preview lets you use more traditional and controlled methods of opening clips 
into the Source Viewer.

To open a clip into the Source Viewer using the mouse:

 — Double-click any clip in the Media Pool, or in the Filmstrip of the Media Pool, to open it 
into the Source Viewer.

To load the previous or next clip in the bin into the Source Viewer:

1 Click inside the Source Viewer to bring it into focus.

2 Press the Up Arrow key to navigate to the previous clip in the currently open bin, and load it into 
the Source Viewer.

3 Press the Down Arrow key to navigate to the next clip in the currently open bin, and load it 
into the Source Viewer.

To open a clip into the Source Viewer using the keyboard:

1 If necessary, press Command-1 to select the Bin list, and press the Up and Down arrows to choose 
a folder to view its contents. Press the Right Arrow key to open folders and show any nested 
folders within, or the Left Arrow key to close folders and hide their nested contents. 

2 Press Command-2 to select the Media Pool browser, and use the Arrow keys to change the 
selection from clip to clip in the Media Pool, up, down, left, and right. 

3 When the clip you want is highlighted, press Return to open it into the Source Viewer.
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To open a timeline into the Source Viewer:

 — Drag and drop any timeline into the Source Viewer in preparation for either ganging it 
to the existing Timeline, or editing it, in whole or in part using In and Out points, into the 
currently open Timeline.

Monitoring with an External Video Display
While working in the Edit page, the image that’s displayed on an external video display 
(if one is connected) is determined either by the current selection in the Media Pool, or by 
which part of the Edit page interface has focus. For example, if you select a clip in the Media 
Pool so it’s displayed within the Filmstrip, that clip is output to video. If you then open it into 
the Source Viewer, then the contents of the Source Viewer are output to video. If you switch 
to the Timeline Viewer, then your timeline is output to video.

Viewer Transport Controls
The Edit page has two Viewers. The left Viewer, when you’re editing, should be set to show either 
source video or source audio, so it shows the source clip in any edit you’re setting up. At right is the 
Timeline Viewer, that shows the frame at the current position of the playhead in the Timeline. Using 
the Source and Timeline Viewers, you can set up a wide variety of edits.

There are identical transport controls underneath each of the Viewers.

The transport controls at the bottom of the Source Viewer

A jog bar appears directly underneath the transport controls, letting you drag the playhead directly 
with the pointer. The full width of the Source Viewer’s jog bar represents the full duration of a clip, 
while the full width of the Timeline Viewer’s jog bar represents the full duration of the current timeline. 
The current position of each playhead is shown in the timecode field at the upper right-hand corner of 
each viewer.

A separate jog control, to the left of the other transport controls, provides a way to jog more slowly 
through long clips or a long timeline. Click and drag to the left and right to move through a clip or the 
Timeline a frame at a time.

Transport controls appear above the jog bar. In the Source Viewer, these controls let you Jump to the 
First Frame, Play Reverse, Stop, Fast Forward, and Jump to the Last Frame. In the Timeline Viewer, 
these controls move to the Previous Edit, Play Reverse, Stop, Play Forward, and move to the Next Edit.  
A loop control governs the looping behavior during playback.
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Simple Keyboard Shortcuts for 
Playback and Navigation
There are many different keyboard shortcuts you can use to simply navigate clips and timelines, and 
control playback.

 — Spacebar: You can use the Spacebar to start and stop playback.

 — Play Again: Press Option-L to immediately restart playback from where the playhead began 
without stopping; for instances where you quickly want to replay the beginning of what you’re 
listening to.

 — Step One Frame Forward/Step One Frame Back: The Left Arrow and Right Arrow keys move the 
playhead back and forth one frame at a time, while Shift-Left Arrow and Shift-Right Arrow move 
the playhead in one-second increments.

 — Step One Second Forward/Step One Second Reverse: Shift-Left Arrow and Shift-Right Arrow 
moves the playhead back and forth one second at a time.

 — Next Edit/Previous Edit: Up Arrow moves the playhead to the previous edit and selects the edit 
point, while Down Arrow moves the playhead to the next edit and selects the edit point.

 — First Frame/Last Frame of the Current Clip: The Semicolon key moves the playhead to the first 
frame of the clip intersecting the playhead, while the Apostrophe key moves the playhead to the 
last frame of the clip intersecting the playhead.

 — Previous Keyframe/Next Keyframe: Shift-Semicolon moves the playhead to the next previous 
keyframe on the left when keyframes are displayed in the Timeline, while Shift-Apostrophe moves 
the playhead to the next keyframe to the right.

 — Previous Marker/Next Marker: If there are markers in either the Timeline Ruler or within clips 
in the Timeline, Shift-Up Arrow and Shift-Down Arrow moves the playhead left and right from one 
marker to the next.

 — Previous Gap/Next Gap: If any tracks of the Timeline that have Auto Select control enabled have 
gaps between clips, Option-Command-Semicolon and Option-Command-Apostrophe moves the 
playhead left and right from one gap to the next.

 — Timeline Start/Timeline End: The Home key moves the playhead to the first frame of the 
Source or Timeline Viewer, while the End key moves the playhead to the last frame of the Source 
or Timeline Viewer.

Go to 

 — In Point/Go to Out Point: Shift-I moves the playhead to the In point set in either the Viewer or 
the Timeline. Shift-O moves the playhead to the Out point.

TIP: One of the options in the Editing panel of the User Preferences window, “Always 
highlight current clip in the media pool,” lets you decide whether the current selection in 
the Timeline is mirrored in the Media Pool.
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Using JKL to Control Playback
The JKL keyboard shortcuts are common to many editing applications, and experienced editors know 
these to be some of the most useful controls for playback and editing there are. Here’s a list of the 
many different ways you can use these three keyboard shortcuts to play through clips and timelines 
as you work.

J Plays 100% backward

K Stops playback

L Plays 100% forward

Press J repeatedly Increases backward play speed each time you press J,  
for a range of fast-reverse speeds

Press L repeatedly Increases forward play speed each time you press L,  
for a range of fast-forward speeds

Shift-J Plays in fast reverse

Shift-L Plays in fast forward

Shift-K Play Slow at 1/2, 1/4 or 1/8 speeds

Press and hold K+J Plays backward at slow motion (with slow motion 
audio playback)

Press and hold K+L Plays forward at slow motion (with pitch-corrected audio 
playback on macOS)

Pressing K while tapping J Moves the playhead back one frame

Pressing K while tapping L Moves the playhead forward one frame

Command-J and Command-L Holding the Command key down while using the J and L 
keyboard shortcuts lets you dynamically resize or trim 
selected edit points or clips at 100 percent or faster speed, 
depending on whether the Selection or Trim tool is enabled. 

For more information on dynamic trimming, see Chapter 43, 
“Trimming.”

When you’re playing back at faster or slower than real-time speed using the JKL commands, a speed 
indicator appears to the right of the frame per second indicator of the Viewer.

A speed indicator above the Viewer shows 
that you’re playing at 4x speed

Once you learn all the different methods of JKL playback, they will probably become one of the main 
ways you move the playhead around in DaVinci Resolve.
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Special-Purpose Playback Commands
In addition to the standard transport controls, there are some additional playback controls, available 
via keyboard shortcuts or the Playback menu, that let you perform different playback operations.

 — Loop: Command-Forward Slash (/). Toggles looped playback off and on. While looped 
playback is on, playback initiated with any of the following commands will loop automatically until 
you stop playback.

 — Play around selection: Forward Slash (/). This command works contextually depending on 
what’s selected in the Timeline. Plays a section of the Timeline from x frames before to y frames 
after (a) the playhead (if nothing’s selected), (b) the currently selected edit point, (c) the currently 
selected clip, (d) the currently selected transition, (e) a selection of multiple clips. This command is 
useful for previewing how the current selection plays within the context of the clips immediately 
surrounding it. The pre-roll and post-roll time is customizable in the Editing panel of the 
User Preferences.

 — Play around current frame: Plays a section of the Timeline from x frames before to y frames 
after the current position of the playhead. This command is useful for previewing how edits play 
within the context of the clips immediately surrounding them. The pre-roll and post-roll time is 
customizable in the Editing panel of the User Preferences.

 — Play around current clip: (no default key assigned). Plays a section of the Timeline from x frames 
before to y frames after the current clip intersecting the position of the playhead. The pre-roll and 
post-roll time is customizable in the Editing panel of the User Preferences.

 — Play Around In: Option-Space. Plays a section of the Timeline from x frames before to y frames 
after the current assigned In point, letting you preview the transition from one clip to the next. 
The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

 — Play Around Out: Shift-Space. Plays a section of the Timeline from x frames before to y frames 
after the current assigned Out point, letting you preview the transition from one clip to the next. 
The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

 — Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline with In 
and Out points, this command lets you preview how it will play.

 — Play to In: (no default key assigned). Initiates playback and stops at the current In point.

 — Play to Out: Option-Command-Forward Slash (/). Initiates playback and stops at the 
current Out point.

Option to “Stop and Go to Last Position”
Playback > Stop and Go to Last Position lets you set DaVinci Resolve to a mode where the playhead 
returns to where playback began whenever you stop. This option is most useful when editing audio, 
although it’s available any time. When using the JKL keys to navigate the Viewer in this mode, “K” will 
pause the playhead in place, while the space bar (stop) will go to last position.

This option is also available when you right-click on the Stop button in the transport controls of any 
viewer. A contextual menu appears where you can turn “Stop and go to last position” on or off as the 
default behavior.
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Enabling and Disabling Audio Scrubbing
Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the playhead 
with the mouse back and forth. While this can be useful when you’re searching for audio cues, it can 
also be distracting if you’re just focused on the picture.

To enable or disable audio scrubbing:

 — Choose Timeline > Audio Scrubbing (Shift-S).

Playback Post-Roll
Enables the playhead to continue playing past the last clip in the Timeline for a duration equal to the 
“Post-roll time” Project Setting in the Editing panel. This is good for editors that want to experience 
a few moments of  playback after cutting or fading to black after the last frame of audio and video in 
the Timeline.

To enable or disable Playback Post-Roll:

 — Choose Timeline > Playback Post-Roll.

Moving the Playhead 
Using Timecode
You can use absolute or relative timecode entry to either move the playhead in both the Source and 
Timeline Viewers, or to move or trim selected edit points or clips. When navigating the Timeline, timecode 
entry lets you move the playhead very precisely, or jump to specific timecode values really quickly.

TIP: The method of timecode entry described here is used for many different commands 
that require timecode entry and is designed for fast and efficient editing.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the 
timecode field at the upper right-hand corner of the Viewer with focus. When you’re finished typing, 
press the Return key to execute the timecode command. The rules for timecode entry are as follows:

 — The right-most pair of timecode values (or period) you enter is always the frame number.

 — A period to the left or to the right of any number you type is considered to be a pair of zeroes. 

 — A single period between two numbers is considered to either be a single zero, or ignored if it’s 
between two pairs of numbers.

 — Any untyped pairs of values to the left of what you enter are assumed to be whatever those values 
were prior to the timecode you entered; this makes it easy to type partial timecode values even 
when the Timeline starts at hour one. 

 — It’s not necessary to enter colons or semicolons. 
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Absolute Timecode Entry
Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points 
are selected when you press the Return key, the playhead will move to that timecode value. If an 
edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, 
if possible.

Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 1115.. 11:15:00:00

01:10:10:10 23... 23:00:00:00

Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus 
results in the value you type being added to the current timecode value for purposes of offsetting 
the playhead or moving a selection. Adding a minus will subtract the value you type from the current 
timecode value.

Here are two examples of  relative timecode entry:

User-Typed Value Result

+20. 00:00:20:00 is added to the current timecode value.

+3.. 00:03:00:00 is added to the current timecode value.

-5 00:00:00:05 is subtracted from the current timecode value.

Copy and Paste Timecode in Viewer Timecode Fields
You can right-click on most Viewer timecode fields in the Media, Edit, and Color pages to choose Copy 
and Paste commands from a contextual menu for copying and pasting timecode values. You can also 
click in the timecode fields and use the normal Copy (Command-C), and Paste (Command-V) keyboard 
commands. This works even between pages. The timecode value you’re pasting must be valid 
timecode, for example you can’t paste 0 hour timecode onto a 1 hour timeline.
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Right-clicking on 
a timecode field 
to use the Copy 
Timecode command

Gang Viewers (Playhead Ganging)
Ordinarily, the playhead movement in the Source and Timeline Viewers is independent. However, if 
you click the Option menu at the upper right-hand corner of either Viewer and turn Gang Viewers 
on, the movement of the Source and Timeline Viewer playheads is locked together, so that they move 
in unison. This is useful when you’re marking the In and Out points of a clip in the Source Viewer to 
match the duration of a clip or other event in the Timeline.

When the Source and Timeline Viewers are ganged, you can still switch focus back and forth between 
the Source and Timeline Viewers, and your video output device will consistently switch to output 
whichever Viewer is in focus.

Adding Markers
While markers, flags, and clip labels are covered in much more detail elsewhere in the editing 
section, the use of markers is so important that a summary of how to add and edit markers appears 
here. Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text into a 
marker, that marker displays a small dot that indicates there’s more information inside of it. Once 
placed, markers snap to In and Out points, edit points, the playhead, and other markers whenever 
snapping is enabled, making it easy to use markers to “measure” edits and trims that you make in 
the Timeline.

Adding Markers to Clips
You can place markers on the jog bar of source clips in the Source Viewer (or in the Media Page 
Viewer) and on clips that are selected within a timeline.

Markers placed on a source clip
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Markers placed on a clip in the Timeline

To mark a source clip in the Source Viewer or Media Page Viewer, do one of the following: 

 — To place a marker without doing anything else, move the playhead to the frame you want to 
mark, and then press M. 

 — To place a marker and immediately open the marker dialog to enter a name or note within it 
during playback, press Command-M. Playback pauses until you enter the text you want to and 
close the marker dialog again, at which point playback continues.

 — Move the playhead to the frame you want to mark, then right-click in the jog bar and choose a 
marker color from the Add Marker submenu of the contextual menu.

Once you’ve added some markers, you may want to edit their contents to make them more useful.

To open a marker’s edit dialog to alter its properties:

1 Do one of the following:

 — Press Command-M to add a marker during playback and immediately open its edit dialog.

 — Double-click any marker you want to edit.

 — Move the playhead to the frame containing the marker you want to annotate using Shift-Up 
Arrow/Down Arrow and press M.

 — Select a marker anywhere in the Source Viewer or Timeline, and press Shift-M.

2 When the marker dialog opens, you can modify several properties.

The properties found in the marker dialog

For much more information about markers, see Chapter 40, “Marking and Finding Clips in the Timeline.”
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Setting In and Out Points
Now that you’ve used playback commands to review your clips, you can place In and Out points to set 
the range of each clip that you want to edit into the Timeline. If you don’t set In or Out points, then the 
entire clip will be edited into the Timeline. If you do set In and Out points, those points will be saved in 
the Media Pool and used the next time you edit that clip.

Setting Clip In and Out Points in the Media Pool
You can set In and Out points right in the Media Pool to prepare for editing.

To set In and Out points while skimming a thumbnail in the Media Pool’s Metadata view:

 — Set the Media Pool to Metadata view, then move the pointer over the Thumbnail and wait a 
moment until dragging the pointer begins to skim through that clip. As you skim, press I and O to 
set In and Out points to encompass the part of that clip you’re going to want to use.

To set In and Out points while skimming a thumbnail in the Media Pool’s Thumbnail view:

 — Set the Media Pool to Thumbnail view, then move the pointer over a clip and wait a moment until 
dragging the pointer begins to skim through that clip. As you skim, press I and O to set In and 
Out points to encompass the part of that clip you’re going to want to use. When you’re finished, 
that clip’s thumbnail will show a range indicator at the bottom to show how much of the clip 
you’ve selected.

To set In and Out points using the Media Pool’s List view Filmstrip: 

 — Set the Media Pool to List view, then select a clip to expose it in the Filmstrip at the top of the 
Media Pool, drag the pointer through the Filmstrip to watch it play, and press I and O to set In and 
Out points to the appropriate range.

Marking In and Out points in the Filmstrip of the Media Pool in List view

The Filmstrip will dim the heads and tails to let you see the range of media you’ve marked. Once 
you’ve marked In and Out points in the Filmstrip, you can drag them to the left and right to 
move them.

Setting Clip In and Out Points in the Source Viewer
For a better look at your footage, you can set In and Out points in the Source Viewer in preparation 
for editing.
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To set In and Out points in the Source Viewer:

1 Either skim a Media Pool thumbnail with Live Media Preview enabled in the Source Viewer’s option 
menu, or open a clip into the Source Viewer. 

2 Use JKL, the Spacebar, the transport controls, or drag in the jog bar to move the playhead to 
where you want to set an In or Out point.

3 Do one of the following:

 — To mark simple In and Out points: Use the In and Out buttons to the right of the transport 
controls, or press the I or O keys.

 — To mark split In and Out points in preparation for making a split edit: Right-click the 
Jog Bar and choose Mark Split > Mark Video In (Shift-Option-I) / Mark Audio In (Command-
Option-I) / Mark Video Out (Shift-Option-O) / Mark Audio Out (Command-Option-O).

Marking In and Out points in the Source Viewer, 
both as simple (Left) and split edits (Right)

Simple In and Out points let you join the audio and video of two clips at a single edit point in the 
Timeline. However, setting split In or Out points sets you up to create split edits where the video is 
offset from the audio in a single step.

Clearing and Navigating In and Out Points
Once placed, you can also clear In and Out points you don’t want and move the playhead to In and 
Out points you might want to edit.

To clear In and Out points:

 — To clear In or Out points: Move the pointer over a marked thumbnail in the Media Pool or over 
the Media Pool film strip, or open a clip in the Source Viewer, and then press Option-I to clear the 
current In point, or Option-O to clear the current Out point. 

 — To clear Split In or Split Out points: Press Shift-Option-X to clear the Video In and Video Out 
points. Press Command-Option-X to clear Audio In and Audio Out points.

 — To clear both the In and Out points at once: With the pointer over a marked thumbnail in the 
Media Pool or over the Media Pool film strip, or with the Source Viewer selected, press Option-X.

To jump the playhead to the current In or Out points in the Source or Timeline Viewer: 

 — Press Shift-I to move the playhead to the current In point (Playback > Go To > In). 

 — Press Shift-O to move the playhead to the current Out point (Playback > Go To > Out).
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The Go to In and Go to Out commands are capable of placing the playhead at the implicit (but 
unmarked) In and Out points defined by a three point edit you’re setting up, even when Preview Marks 
have not been enabled. For example, if you mark In and Out points in the Timeline, and you then mark 
an In point for a clip in the Source Viewer, pressing Shift-O (Go to Out) automatically moves the Source 
Viewer playhead to the frame that will be the Out point of that clip were you to execute this edit.

(Left) In and Out points set in the Timeline and an In point set in the Source 
Viewer set up a three point edit, (Right) Using Go to Out to move the Source 
Viewer playhead to the implicit Out point defined by a three point edit

Clip Edit Points Are Saved
Once set, In and Out points remain in place within each source clip or timeline until you set new ones. 
If you quit DaVinci Resolve and later reopen the same project, each clip’s In and Out points are saved 
for future reference.

Turning In and Out 
Points into Markers 
With Duration and Back Again
If you want to log the most important sections of clips using In and Out points, you can only log a 
single section at a time, as In and Out points are used to identify the next section of a clip to be edited 
in a three point edit. However, two commands in the contextual menu of the Source Viewer jog bar 
work together to let you turn In and Out points into Markers with Duration, and vice versa:

 — Convert In and Out to Duration Marker: Turns a pair of In and Out points into a duration 
marker. By default, no key shortcut is mapped to this command, but you can map one if you like.

 — Convert Duration Marker to In and Out: Turns a duration marker into a pair of In and Out 
points, while retaining the marker. By default, no key shortcut is mapped to this command, but 
you can map one if you like.
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Using these two commands, you can easily use markers with duration to mark regions of clips that you 
want to log for future use, turning each region into an In and Out point when necessary for editing. 
By default, these commands don’t have keyboard shortcuts assigned to them, but you can assign 
them if you use them frequently.

To turn In and Out points into a duration marker:

1 Set In and Out points in the Source Viewer jog bar to identify a region you want to log 
for future reference.

Marking In and Out points in preparation 
to log that section of the clip

2 Do one of the following:

 — Right-click the jog bar and choose Convert In and Out to Duration Marker.

 — Choose Mark > Convert In and Out Into Duration Marker.

A duration marker appears above the In and Out points. To edit its name or notes, double-click 
the marker, press Shift-M, or choose Mark > Modify Marker.

A duration marker is created 
from the In and Out points

In this way, you can log several regions within a single clip for future use. 

A clip with multiple logged sections identified via markers with duration

To turn a duration marker into an In and Out point:

1 Find a duration marker you want to convert into In and Out points..

Finding a duration marker to convert into In and Out points

2 Do one of the following,

 — Right-click the jog bar and choose Set In and Out from Duration Marker.

 — Position the playhead over the duration marker and choose Mark > Set In and Out 
from Duration Marker.

674Edit | Chapter 35 Preparing Clips for Editing and Viewer Playback



In and Out points appear under the duration marker.

In and Out points are created from the duration marker

In this way, you can turn a duration marker that you’ve logged into In and Out points in 
preparation for executing a three-point edit. 

These are extremely useful logging techniques for three reasons. First, markers with duration can be 
searched for in the Media Pool using the All Fields, Marker Name, and Marker Notes Filter by options. 
Second, they can be filtered with Smart Bins using the Marker Name and Marker Notes Media Pool 
Properties options. Lastly, once one or more duration markers have been added to a clip, they can 
quickly be used to perform three-point edits into the Timeline.

Organizing Media 
by Creating Subclips
Subclips give you another way of organizing media in the Media Pool, letting you break excessively 
long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where 
multiple takes are all recorded within a single clip, you can break these takes up by making them 
into subclips.

To create a subclip in the Edit page:

1 Do one of the following to open a clip into the Source Viewer in either the Media page or the 
Edit page, in preparation for creating subclips.

 — Double-click any clip in the Media Pool.

 — Single-click any clip in the Media Library of the Media page to create a subclip without needing 
to first import that clip into the Media Pool.

2 Set In and Out points in the Source Viewer to define the section you want to turn into a subclip.

3 Do one of the following:

 — Choose Mark > Create Subclip.

 — Press Option-B.

 — Right-click the jog bar and choose Create Subclip from the contextual menu.

 — Drag a clip from the Source Viewer to the Media Pool.

4 A new subclip dialog appears, allowing you to name the subclip and decide to use its full extents 
by turning on the checkbox.

675Edit | Chapter 35 Preparing Clips for Editing and Viewer Playback



The New SubClip dialog

Once created, subclips appear and work like any other clip in DaVinci Resolve. You can also create 
subclips in the Media page while performing other organizational tasks there.

Removing or Changing Subclip Limits
Once created, you can right-click any subclip in the Media Pool or a timeline and choose Edit Subclip 
to open a dialog in which you can turn on a checkbox to use the subclip’s full extents, or to change the 
start or end timecode of the subclip via timecode fields, before clicking Update to modify the subclip.

The Edit Subclip dialog

Audio Transcription and Text  
Based Editing (Studio Version Only)
The most critical metadata about any clip is knowing what people have said in it. A full transcription 
of a shot is useful in narrative film letting you find specific clips based on the dialog in the script, 
but a transcript is especially important in unscripted documentary and news production, both to 
understand what pieces of the story you actually captured and for a variety of organizational, creative 
and legal requirements. 

Until recently, transcribing audio was a labor-intensive process requiring a human being to listen to 
a clip in real time and then type out what was being said in a log sheet. With recent advances in the 
DaVinci Resolve Neural Engine, your computer can now perform the tedious work of transcribing 
each clip for you automatically, and most importantly, accurately. In addition, having text transcripts 
attached to the clips in your project gives you powerful new text-based editing tools to select, search 
and insert clips into your timeline.
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Transcribe Audio
The Transcribe Audio feature is accessed via the Media Pool in the Media, Cut, Edit, and Fairlight pages 
and is a fully automated process.

The Transcribe  
Audio icon in the 
Media and Edit pages

To automatically transcribe the audio of a clip:

1 Select a clip or clips with audio to transcribe in the Media Pool.

2 Right-click on any of the selected clips and select Audio Transcription > Transcribe from the 
contextual menu. Or click on the Transcribe Audio icon in the Media Pool toolbar.

The Transcribing 
Audio Window

At this point the Transcribing Audio window will appear, showing you how many clips are left to 
analyze, the speed at which the analysis is taking place vs. real time, and approximately how much 
longer the analysis of the selected clips will take. There is a button to cancel this operation at any time.

The speech balloon 
icon showing that 
a clip has been 
transcribed 

Any clip that has a transcription attached to it will have a small speech balloon icon appear in the 
lower left of its thumbnail in the Media Pool.

To remove a transcription from a clip:

1 Select a clip you want to delete the transcription from in the Media Pool.

2 Right-click on the selected clips and select Audio Transcription > Clear Transcription from the 
contextual menu.

Audio Transcription of Timelines
Audio Transcription works not just with clips but for timelines as well and in the same way as 
described above. There are several practical uses for a text transcription of a timeline for legal and 
organizational requirements. However, if you’re intending to make subtitles or captions for the 
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Timeline, there is a dedicated tool specifically for that purpose. For more information on the Create 
Subtitles from Audio feature, see Chapter 52, “Subtitles and Closed Captioning.”

The Transcription Window

The Transcription Window 
showing multiple clips 
with the Search pane open. 
The searched for text is 
highlighted in yellow. 

The In and Out range of the 
clip is highlighted in teal, 
and the current playhead 
position in the Viewer is 
indicated by a red triangle.

The Transcription Window is where the text is displayed, along with its options and editing tools. 
For ease of use, the Transcription Window is freely movable around the GUI, even to another monitor.

To access the Transcription Window:

 — Right-click on a clip or clips that have been transcribed, and select Transcribe Audio from the 
contextual menu. Or click on the Transcribe Audio icon in the Media Pool toolbar.

The Transcription Window is comprised of the following sections and tools:

Export: Clicking this icon will launch a file browser, where you can save 
a .txt file of the transcription results for use in other programs.

Search: Clicking this icon will expose a Search and Replace dialog, letting you 
find specific words or phrases across all the selected clips in the Clips panel. 
Found words will be highlighted in yellow.

Options Menu: Reveals the Transcription Window options.  
Currently the only option is Remove Silent Portions.
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Clips: This panel shows all the selected clips that you’ve chosen to see the transcription for. 
Clicking on a thumbnail loads that clip’s transcription into the Transcript window. 

The selected clip is outlined in orange. If you only selected one clip, this panel does not appear.

Transcript: Displays the transcription text. You can also use this box to select the playhead 
position and set in and out points of a clip, as described in the Text Based Editing section below.

Text View Controls: Allows you to control the font size and the high contrast settings 
of the text in the Transcript window.

Create Subclip: Creates a new subclip of the shot based on the In and Out 
points set by the highlight in the Transcript window.

Marker: Places a marker at the word location that is highlighted in red, or if an 
In/Out range is highlighted, it will place a duration marker for the range instead.

Stop: Stops playback of the clip in the Viewer.

Play: Plays the clip forward in realtime in the Viewer.

Play in to Out: Plays forward only between the set In and Out range.
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Insert: Performs an Insert edit of the selected range into the Timeline.

Append: Performs an Append edit of the selected range to the 
end of the Timeline.

Editing Text in the Transcription Window
Not everything transcribed in the audio of a clip is useful or wanted in the final transcription. Crew 
chatter, flubbed lines, and long silences can all be edited out, as well as mistakes fixed in the Audio 
Transcription process itself. 

Selecting Text
In order to edit text, you first need to select it in the Transcription Window. There are a few ways of 
doing so, depending on how much text you wish to select.

To select a specific word in the transcription:

 — Double-click on the word to select it and highlight it in teal.

To select a range of text in the transcription:

 — Click and drag over the text you want to edit to select it and highlight it in teal.

To select an entire paragraph in the transcription:

 — Triple-click on any word in the paragraph to select the whole paragraph and highlight it in teal.

To select all the text in the transcription:

 — Press Command-A to select all of the text and highlight it in teal.

Editing Text
Once any text is selected (highlighted in teal), you can right-click on it to bring up the editing options. 
Clicking on any of the editing tools executes the action.

The Transcription Window Editing tools (l-r): Edit, Delete, Undelete, 
and Copy, accessed by right-clicking on any selected text.

 — Edit: Clicking on this tool brings up a text field, where you can perform simple edits on the 
selected text. You can use this to correct the transcription in terms of incorrect words, spelling 
mistakes, and adjusting proper names. Radically altering the text, such as replacing an entire 
paragraph with a two or three word summary, will have unpredictable effects if used for editing. 
This action is undoable.
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 — Delete: Clicking this tool does not delete the selected text from the Transcription window as in a 
word processor, instead it will mark the text in orange with a strike-through. Any text thus marked 
will not appear in the exported transcript, nor will its range be inserted into the Timeline with any 
edit operation. This means a cut will appear in the Timeline where the deleted text range is in the 
transcript. Since the “deleted” words are all still there in the audio clip as they were recorded, it 
may be easier to think of this as an “exclude” operation rather than a deletion.

 — Undelete: Clicking on this tool reverses any previous deletion. It changes the orange strike-
through text back into normal text, allows it back into the exported transcription, and re-includes 
its range for editing purposes. 

 — Copy: Copies the selected range for use in other applications. There is no Paste command for the 
Transcription Window.

Understanding Silence (…) in the Transcription Window
In most shots, a significant portion of the audio clip will have no dialog at all. These silences are 
marked in the Transcription window as ellipses (…). As important as knowing where the dialog is, it’s 
also useful to know where it isn’t. These silences (…) can be treated just like words in the Transcription 
Window, meaning they can be deleted, and thus excluded from any editing operation. 

For example, say you have a long interview with frequent pauses between questions. You could 
cut this long clip up manually by setting In and Out points and picking out the individual questions 
and answers. But, by using Audio Transcription and deleting all the silences (…) in the Transcription 
Window and then editing that range into the Timeline, you would instantly have a series of individual 
clips laid down comprised of only the questions and the answers. This lets you automatically insert 
all of the relevant clips at once, without all the tedious scrubbing and setting of edit points for every 
single section of the clip in the Viewer.

The original Interview clip (Tracks V1, A1 violet) and the same media with all 
silences removed using the transcription window (tracks V2, A2). Note how it 
is automatically broken into individual question and answer clips.

Removing silences in the Transcript Window has many useful applications for both exporting a 
transcript and in text based editing, and so has a dedicated tool for deleting them all.

To delete all the silences (…) in the Transcription Window:

 — Click on the Option menu in the upper right of the Transcription Window, and select Remove Silent 
Portions from the contextual menu.

Audio Transcription Supported Languages
You can choose which language is used to generate the transcription in the Project Settings > Subtitle 
and Transcription> Transcription Setup section. You can select any of the supported language models, 
or keep it on Auto for DaVinci Resolve to figure out who is speaking what.
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As of this writing Audio Transcription and Text-Based Editing support the following languages:

 — Danish, Dutch, English, French, German, Italian, Japanese, Korean, Mandarin (Simplified, 
Traditional), Norwegian, Portuguese, Russian, Spanish, and Swedish.

Text-Based Video Editing
After a Transcribe command has been applied, DaVinci Resolve now knows the exact timecode position 
of each word in the clip, and that information opens up several useful text-based editing tools using 
the Transcription Window. Text-based video editing is available in the both the Cut and Edit pages.

The cursor in the Transcription Window and the playhead in the Viewer are linked. As you move the 
cursor in the text, the playhead updates to that respective position in the clip in the Viewer. This allows 
you to precisely place the playhead exactly where you want it based on the text word, rather than 
having to scrub back and forth through the audio track. 

To move the playhead to a specific word in the clip:

 — Click on a word in the Transcript Window, and it will highlight with a red arrow. The viewer 
playhead will then jump directly to the end of that word in the clip in the Viewer.

In addition to the cursor and playhead being linked, the In and Out points of a clip are also linked to 
the selected range of the text in the Transcription Window.

To select an In and Out range in the clip:

 — Click and drag over the text in the Transcription Window to highlight it in teal. The In point of 
the clip is set just before the first word, and the Out point is set just after the last word in the 
highlighted text.

Selecting a text range in the Transcription Window (R), automatically sets 
In and Out points for that range on the clip in the Viewer (L).

With an In and Out range set, you can now use the editing tools in the Transcription Window to 
perform some common editing and media management functions.

The Create Subclip and Add Marker 
tools in the Transcription window
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To create a new subclip from a selected range:

1 Select a range of text in the Transcription window by clicking and dragging to highlight the text in teal.

2 Press the Create Subclip icon in the lower left of the Transcription window.

3 In the Create Subclip window, enter a new name for the subclip and select the Create button.

To add a marker to a clip:

1 Either select a specific word in the Transcription window (red arrow) for a standard marker, or 
select a range of text by clicking and dragging to highlight the text in teal for a duration marker.

2 Click on the Marker icon in the lower left of the Transcription Window.

The Insert and Append edit icons 
in the Transcription window

To edit an In and Out range into the current timeline:

1 Select a range of text in the Transcription window by clicking and dragging to highlight the 
text in teal.

2 Click the Insert Edit icon in the lower right of the Transcription window to insert the selected range 
into the Timeline, or click on the Append icon to add the clip to the end of the Timeline.
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Chapter 36

Editing Basics
In this chapter, you’ll learn many of the fundamental methods 
and commands you’ll use when beginning to assemble clips 
into the Timeline. 

This includes drag and drop operations to begin assembling a timeline, different ways of selecting and 
deselecting the clips you’ve edited in preparation for different tasks, maintaining sync between the 
audio and video components of clips you’re editing, and deleting clips and gaps you don’t want.
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Using Auto Select Controls to Define Selections  700

Defining Selections With the Help of Auto Select Controls  700
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Locking Tracks You Don’t Want to Change  704
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Keyboard Shortcuts in This Chapter
Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

Key Shortcut Function

V Select nearest edit to playhead

Shift-V Select clip intersecting playhead

U Select incoming, outgoing, or centered part of edit

Option-U
Toggle selection among video+audio, video only, and 
audio only

Option-Y Select clips forward (of the playhead) on all tracks

Command-Option-Y Select clips backward (of the playhead) on all tracks

Y Select clips forward (of the playhead) on current track

Command-Y Select clips backward (of the playhead) on current track
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Key Shortcut Function

Up, Down Arrow Keys Move selection to previous/next edit or clip

Delete Delete clip and leave gap (lift edit)

Forward Delete
Ripple delete; deletes a clip and moves the rest of the timeline 
left to fill the gap

Command-Backslash (\)
Insert edit; adds a cut to the clip(s) at the position of 
the playhead

N Toggle timeline snapping off and on

Command-Shift-L Toggle linked selection off and on

Option-1 through 8
Set video destination control to that track number; press 
again to enable/disable

Command-Option-1 thorugh 8
Set audio destination control to that track number; press 
again to enable/disable

Option-Shift-1 through 8 Toggle lock for individual video tracks

Option-Shift-9 Toggle lock for all video tracks

Option-Shift-F1 through F8 Toggle lock for individual audio tracks

Option-Shift-F9 Toggle lock for all audio tracks

F9
Insert Edit selected clip(s) from Media Pool or Source Viewer  
to the Timeline

F10
Overwrite Edit selected clip(s) from Media Pool or Source 
Viewer to the Timeline

F11
Replace Edit the first of selected clip(s) from Media Pool or 
Source Viewer to the Timeline

F12
Place On Top Edit from Media Pool or Source Viewer to 
the Timeline

Shift-F10
Ripple Overwrite from Media Pool or Source Viewer to 
the Timeline

Shift-F11 Fit to Fill from Media Pool or Source Viewer to the Timeline

Shift-F12
Append To End Edit from Media Pool or Source Viewer to 
the Timeline

Undo Command-Z

Redo Command-Shift-Z
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Drag and Drop Editing
If you’ve already used other editing programs, the procedures in this section will almost certainly be 
remedial, but if you’re new to editing, this section covers the most basic methods of editing a series of 
clips into the Timeline to get you started. The absolute simplest method of editing is to drag clips from 
the Media Pool and drop them into the Timeline. You can do this with individual clips, or with selected 
groups of clips.

Drag and Drop Editing of Individual 
Clips Into the Timeline
If you’re just editing one clip at a time to create an edited sequence in a timeline, 
this is how that works.

1 If you need to edit specific ranges of the clips you’re editing, you can set In and Out points in 
source clips first by doing one of the following:

 — Setting In and Out points while skimming a thumbnail in the Metadata View: As you’re 
skimming over a clip’s thumbnail in the Viewer, press I and O to set In and Out points to 
encompass the part of that clip you’re going to want to use. If you’ve turned on Live Media 
Preview in the Source Viewer, then the Source Viewer will show what you’re skimming so you 
can get a closer look. If you don’t like the current In and Out points, you can press Option-X to 
clear them both.

 — Setting In and Out points while skimming a thumbnail in the Media Pool: As you’re 
skimming over a clip’s thumbnail in the Viewer, press I and O to set In and Out points to 
encompass the part of that clip you’re going to want to use. If you’ve turned on Live Media 
Preview in the Source Viewer, then the Source Viewer will show what you’re skimming so you 
can get a closer look. When you’re finished, that clip’s thumbnail will show a range indicator at 
the bottom to show how much of the clip you’ve selected. If you don’t like the current In and 
Out points, you can press Option-X to clear them both.

 — Using the Media Pool Filmstrip in the Media Pool’s List view: Set the Media Pool to List 
view, select Show Filmstrip in the option menu, then select a clip to expose it in the Filmstrip 
at the top of the Media Pool, drag the pointer through the Filmstrip to watch it play and press 
I and O to set In and Out points to the appropriate range. The Filmstrip will dim the heads and 
tails to let you see the range of media you’ve marked. If you’ve turned on Live Media Preview 
in the Source Viewer, then the Source Viewer will show what you’re skimming so you can get 
a closer look. If you don’t like the current In and Out points, you can press Option-X to clear 
them both.

 — Using the Source Viewer: Open a clip in the Viewer by double-clicking it in the Media Pool, or 
by selecting it in the Media Pool and pressing the Return or Enter key. Then use the transport 
controls, jog bar, control panel buttons, Spacebar, or JKL commands to move the playhead, 
and place In and Out points using the In and Out buttons to the right of the transport 
controls, or by pressing the I or O keys. If you don’t like the current In and Out points, you can 
press Option-X to clear them both.
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2 Drag the clip you want to edit from either the Media Pool or the Source Viewer, and drop it onto 
the desired position in the Timeline to perform an overwrite edit. If you drag a clip on top of 
another clip that’s already in the Timeline, the clip you’re dragging will overwrite the part of the 
clip that it overlaps.

Dragging a clip from the Media Pool to overwrite a clip in the Timeline

TIP: If you drag a clip into the blank area above an existing video track or below an existing 
audio track, a new track will automatically be created.

Drag and Drop Editing of Several Clips 
Into the Timeline At Once
The procedure above also works when you want to edit 
several clips into the Timeline at once by dragging them 
from the Media Pool.

1 Change the sort order of the Media Pool’s browser 
area to put the clips into the order in which you 
want them to appear. In Thumbnail view you can 
use the Sort Order menu, but in List view you can 
click the header of any metadata column to sort 
by that column’s data. If you’ve used the Metadata 
Editor to add Scene, Shot, Take, or other information 
to identify each clip, you can sort by these 
metadata criteria.

2 Use the Media Pool thumbnails, the Media Pool List 
view Filmstrip, or the Source Viewer to set In and Out 
points to define the part of each clip that you want to 
edit into the Timeline.

3 Select the Media Pool clips you want to edit into the 
Timeline by dragging a bounding box, Command-
dragging multiple bounding boxes over different 
sets of clips, by Shift-clicking a range of clips, or by 
Command-clicking individual non-contiguous clips. Using the Sort Order menu to change 

the sort order of clips in the Media Pool
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4 Drag any of the selected clips to the desired position in the Timeline to perform an overwrite edit.

Dragging multiple clips into the Timeline in the sort order of the Media Pool

The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. Multiple clips 
dragged from the Media Pool will be edited in the order in which they’re sorted in the Media Pool, 
using each clip’s In and Out points.

Drag and Drop Editing of Video-Only 
or Audio-Only Edits
While it’s easy to edit just the video or just the audio of a clip by disabling the audio or video 
destination control in the Timeline prior to doing any sort of edit (described later in Chapter 39, 
“Three- and Four-Point Editing”), there’s also a pair of keyboard modifiers you can use to do the very 
same thing while you’re dragging.

 — To edit only the video of a clip from the Media Pool: Option-drag clips from the Media Pool/
Filmstrip, Source Viewer, or Finder into the Timeline.

 — To edit only the audio of a clip from the Media Pool: Shift-drag clips from the Media Pool/
Filmstrip, Source Viewer, or Finder into the Timeline.

 — To edit only the video or audio of a clip from the Source Viewer: Open a clip into the Source 
Viewer, then move the pointer over the Source Viewer and drag from either the Video-only or 
Audio-only overlays that appear over the bottom of the image.
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Video and Audio-only overlay controls appear 
in the Source Viewer that let you drag just the 
video or just the audio into the Timeline

Drag and Drop Insert Editing
You can also drag multiple clips from the Timeline, or a single clip from the Source Viewer, at any 
frame of the current timeline to either insert the selection between any two clips or to insert it in the 
middle of an existing clip, moving (actually rippling) all media to the right of the new edit point you 
create to make room for the new incoming media.

To shuffle insert multiple clips from the Media Pool or Source Viewer into the Timeline:

1 Select one or more clips in the Media Pool (the sort order dictates the final order of the edited 
clips), or open a clip in the Source Viewer.

2 Press and hold the Command and Shift keys, and drag the selection from the Media Pool or 
Source Viewer into the Timeline. 

3 As you drag, the clips you’re dragging will be inserted into the Timeline at the pointer location. 
Release the mouse to finish making the edit.

Making an Insert Edit while dragging clips from the Media Pool

Dragging Clips From the File System 
Into the Timeline
You can also drag a clip directly from your file system to the Timeline on supported platforms.
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Dragging multiple clips into the Timeline from the macOS Finder

Inserting Multiple Clips into the 
Timeline From the Media Pool
For certain large volume editing projects, you can insert multiple clips from the Media Pool into 
a timeline all at once. The parameters for the order and positioning of the clips depend on the 
method used.

Insert Selected Clips to Timeline Using Timecode
Clips can now be edited directly from the Media Pool into a timeline, such that each clip’s source 
timecode is aligned with an identical record timecode value in the Timeline. This can be useful for 
long form multi-camera events, like weddings or concerts, where all cameras are linked by the same 
timecode to ensure all edits are perfectly synced. This function matches the Source Overwrite edit on 
the Cut page.

IMPORTANT: The timecode of the Timeline must overlap the timecode of the clip(s) for this 
edit to function. This can be set in the Start Timecode field of the New Timeline settings.

To insert selected clips to timeline using timecode:

1 Select one or more clips to edit into the Timeline in the Media Pool. If there are In and Out points 
set on the clip, the edit will respect those boundaries. If no In/Out points are set, each selected 
clip’s full duration will be edited in its entirety.
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2 Set a destination control to determine which track in the Timeline you want to edit to.

3 Right-click one of the selected clips and choose “Insert Selected Clips to Timeline Using Timecode” 
from the drop-down menu.

4 All of the selected clips will be overwritten into the Timeline at their appropriate timecode 
locations onto the destination track.

IMPORTANT: If multiple selected clips have overlapping timecode, no edit will occur.

Insert Selected Clips to Timeline With Handles
This command inserts multiple clips into the Timeline serially, using the current sort order of the 
Media Pool, with handles subtracted from the current In and Out points of each clip (using the Default 
Handles Length in the Editing panel of the User Preferences). Combined with the Add Transition tool 
(Command-T), this function is useful when quickly creating montages from multiple clips.

To insert clips with handles to the Timeline: 

1 Select the clips to insert into the Timeline with handles in the Media Pool. 

2 Right-click any selected clip, then choose “Insert Selected Clips to Timeline With Handles.” 
The clips will be inserted starting at the Timeline In point with the default handles length 
already calculated.

TIP: To finish creating the montage, select the clips in the Timeline, then choose 
“Add Transition” (Command-T) from the Timeline menu. This will apply the default 
transition to all of the clips at once.

Audio Track Creation While Editing
When dragging an audio clip to the undefined gray area of the Timeline below currently existing 
audio tracks in order to create a new track, the new track is set to a channel mapping that reflects the 
number of channels of the audio clip you’re dragging.

This also means that if you’ve used Clip Attributes to map a clip’s audio to consist of multiple tracks 
where each track has a different channel mapping, for example, one 5.1 track, one stereo track, and 
six mono tracks, then editing that clip into the Timeline so that the audio portion creates new tracks 
will automatically create eight tracks: one that’s 5.1, one that’s stereo, and six that are mono.
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Using Keyboard Shortcuts 
and Three-Point Editing 
to Assemble a Program
While drag and drop editing is intuitive enough, there are other methods of editing clips into the 
Timeline by using the playhead to define where those clips will start that can be more efficient and 
precise. These examples all use “overwrite” edits, which delete unwanted media from the Timeline as 
you’re adding clips that you do want. Here are two examples of how to do this.

Example: Assembling Clips Into the 
Timeline From the Source Viewer
The following example shows how you can use the Edit page to assemble a quick first cut of edits 
using different features of the Media Pool, Viewers, and Timeline. Written out with every possible 
option, this may seem like a lot of steps, but once you learn these fundamentals and develop some 
muscle memory for the keyboard shortcuts in use, these methods become really fast to do.

1 Press Command-1 to open the Bin list, and use the Arrow keys to select a bin (Up and Down to 
change the selection, Right and Left to open and close bins). Then press Command-2 to choose 
the clip browser, and use the Arrow keys to select a specific clip.

2 Press the Return or Enter key to open the selected clip into the Source Viewer.

3 Drag the playhead with the pointer or use the Spacebar or JKL keys to move the playhead and set 
In and Out points (I and O) to define the section of that clip you want to edit into your program.

4 By default, the destination controls are assigned to tracks V1 and A1. If necessary, choose 
different video and audio tracks to edit the clip to in the Timeline by doing one of the following:

 — Click the destination controls of the tracks you want to edit to. You can also drag them from 
where they are now to where you want them to be.

 — Use the Command-Option Up and Down Arrow (for audio) and Command-Shift Up and Down 
Arrow (for video) shortcuts to move the destination controls up and down.

 — Use the Option-1–8 (for video) and Command-Option-1–8 (for audio) key shortcuts to assign 
the video and audio destination controls to specific tracks.

5 By default, all destination controls are enabled. If you want to edit clips into the Timeline as audio 
or video only, you can do one of the following: 

 — Click any destination control itself to disable the video or audio component.

 — Press Option-1–8 (for video) or Command-Option-1–8 (for audio) for the currently assigned 
tracks to toggle the destination controls on those tracks on and off.

Setting the 
destination control 
to the track you 
want to edit into.
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6 In the Timeline Viewer or the Timeline itself, use the pointer, Spacebar, or JKL controls to move the 
Timeline playhead to the frame you want the beginning of the clip you’re about to edit to start. If 
no In or Out points are set in the Timeline, the playhead position is used as the In point by default.

7 To perform an overwrite edit, do one of the following:

 — Drag the clip from the Source Viewer to the Timeline Viewer and drop it on the Overwrite 
overlay. If you’re in single viewer mode, this overlay only appears when you drag a clip from 
the Media Pool to the Timeline Viewer.

 — Click the Overwrite Clip button in the toolbar.

 — Choose Edit > Overwrite (or press F10).

The selected clip(s) are overwritten to the selected track at the position of the playhead, and 
the playhead automatically moves to the end of the newly edited clip, ready for you to perform 
another edit. If that clip is the last one on the Timeline, you’ll see the last frame to the left of 
the playhead (with a jagged overlay at the right-hand side of the Timeline Viewer) instead of the 
black that is the actual frame after that clip. This makes it easier for you to line up the next edit. 
Otherwise, the playhead will show whatever frame happens to be at that point in time.

The Timeline playhead 
at the first frame after 
the clip you’ve just 
edited; the Timeline 
Viewer shows a jagged 
overlay at the right 
to let you know this 
isn’t a real frame

8 To edit another clip, open the next clip you want to edit into the Source Viewer, set In and Out 
points, and use the Overwrite Clip button or command to edit it into the Timeline. Continue this 
process until you’ve edited together the assembly of edits you want.
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Example: Assembling Clips Into the 
Timeline From the Media Pool
If you want, you can also edit clips directly into the Timeline from the Media Pool using a variety of 
commands. This can be a fast way of appending clips to the end of the Timeline (although you can also 
perform insert edits this way).

To edit one or more clips from the Media Pool to the Timeline:

1 Press Command-2 or click with the pointer to choose a clip in the Media Pool. 

2 Set In and Out points for one or more clips in the Media Pool by doing one of the following:

 — In Metadata view, drag the pointer over a clip’s thumbnail and use the I and O keys. If Live 
Media Preview is enabled in the Source Viewer, dragging over a clip’s thumbnail mirrors the 
content in the Source Viewer.

 — In Thumbnail view, drag the pointer over a clip’s thumbnail and use the I and O keys. If Live 
Media Preview is enabled in the Source Viewer, dragging over a clip’s thumbnail mirrors the 
content in the Source Viewer.

 — In List view, drag over the Media Pool Filmstrip Viewer and use the I and O keys. If Live Media 
Preview is enabled in the Source Viewer, dragging over the filmstrip mirrors the content in the 
Source Viewer.

3 Change the sort order of the Media Pool’s browser area to put the clips into the order in which you 
want them to appear. In Thumbnail view you can use the Sort Order menu, but in List view you can 
click the header of any metadata column to sort by that column’s data.

4 Click, drag, use the Command-Option and Command-Shift Up and Down Arrow Key shortcuts, 
or use the Option-1–8 and Command-Option-1–8 key shortcuts to assign the video and audio 
destination controls to the tracks you want to edit the video and audio of the incoming clip(s) 
to. Click any destination control itself to disable it if you want to edit clips into the Timeline as 
audio or video only.

5 Select one or more clips you want to edit. Insert, overwrite, place on top, ripple overwrite, and 
append at end edits are all capable of editing multiple clips at once, while replace and fit to fill 
edits can only edit one clip at a time, and will only edit the first of multiple selected clips into 
the Timeline.

6 To perform the edit, do one of the following:

 — Use any of the editing commands in the Edit menu.

 — Use the equivalent keyboard shortcuts to Insert (F9), Overwrite (F10), Replace (F11), Place 
On Top (F12), Ripple Overwrite (Shift-F10), Fit to Fill (Shift-F11), or Append To End of Timeline 
(Shift-F12) the selected clips into the Timeline.

 — Right-click one or more selected clips in the Media Pool, and choose “Insert Selected Clips to 
Timeline” or “Append Selected Clips to Timeline.”

The selected clip(s) are edited into the Timeline.
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Making Selections in the Timeline
Once you’ve assembled a sequence of clips in the Timeline, you’ll probably need to manipulate them 
further, moving, deleting, trimming, or otherwise adjusting the clips in the Timeline to make the edit 
play with the pacing and verve you require.

Manually Selecting Clips in the Timeline
Many operations require you to make a selection first, to define the scope of what you’re about to do. 
There are many ways to do so.

Selections you can make using the mouse:

 — To select one clip: Click a clip with the mouse.

 — To select all clips under the playhead: You can select all the clips under the playhead at once, 
regardless of how many tracks they are spread across by selecting Trim > Select All Clips Under 
Playhead (Option-Shift-V).

 — To select a continuous range of clips by dragging: Drag a bounding box from an empty area of 
the Timeline to surround a group of clips.

Dragging a bounding box to select a continuous range of clips in the Timeline

 — To select a continuous range of clips by Shift-clicking: Click the first clip you want to select, 
and then Shift-click the last clip you want to select, and all clips in-between will automatically be 
selected as well.

 — To select a discontinuous range of clips: Command-click any clips to select them no matter 
where they appear on the Timeline. Command-clicking a selected clip deselects it.

Command-clicking to select a discontinuous range of clips in the Timeline
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Selecting clips using the keyboard or menu commands:

 — To select one clip: Using the keyboard, make sure the Auto Select button for the track the clip is 
on is enabled, then move the playhead over that clip and press Shift-V.

 — To select a clip using keyboard navigation: Holding down the Command key and pressing the 
Up, Down, Left, and Right Arrow keys allows you to select clips above and below the current track 
and to the left and right, independently of the playhead.

 — To select all clips forward of the playhead on the current track: Move the playhead to the first 
clip you want to include in the selection, then press the Y key (Timeline > Select Clips Forward > On 
This Track) to select that clip and every clip to its right in the same track of the Timeline.

 — To select all clips forward of the playhead on all tracks: Move the playhead to the first clip 
you want to include in the selection, then press Option-Y (Timeline > Select Clips Forward > On All 
Tracks) to select that clip and every clip to its right in all tracks of the Timeline.

 — To select all clips backward from the playhead on the current track: Move the playhead 
to the last clip you want to include in the selection, then press Command-Y (Timeline > Select 
Clips Backward > On This Track) to select that clip and every clip to its left in the same track 
of the Timeline.

 — To select all clips backward from the playhead on all tracks: Move the playhead to the last 
clip you want to include in the selection, then choose Command-Option-Y (Timeline > Select Clips 
Backward > On All Tracks) to select that clip and every clip to its left in all tracks of the Timeline.

 — To select all clips in the Timeline: Make sure the Timeline has focus, then press Command-A.

To change which clip is selected using the keyboard:

 — Select a clip, then use the Up Arrow and Down Arrow keys to change the selection to the previous 
or next clip among all tracks with Auto Select turned on.

Selecting Clips Based on Markers, 
Flags, and Clip Color
It’s also possible to select multiple clips that have a particular color of marker, flag, or clip coloration. 
This is useful in any situation where you’re using these organizational tools to keep track of clips with 
specific characteristics that you might need to later select for multi-clip operations. 

For example, you might add purple markers to a series of audio clips that might need special 
EQ settings. Later, you can choose Timeline > Select Clips With Marker Color > Purple to select all of 
those clips in order to move them to another track, where you can apply the same EQ to all of them 
using an audio filter applied to the track. There are three ways of selecting groups of clips.

To select groups of clips based on marker, flag, or clip color:

 — Choose Timeline > Select Clips With Flag Color > Blue – Cream

 — Choose Timeline > Select Clips With Marker Color > Blue – Cream

 — Choose Timeline > Select Clips With Clip Color > Orange – Chocolate
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Selecting Edits in the Timeline
A variety of editing and trimming methods require you to select an edit point, or part of an edit point, 
in order to resize, ripple, or roll an edit. You can do so using the mouse or using the keyboard.

Methods for selecting edit points using the mouse:

 — To select an edit to roll: Move the mouse to the center of an edit point, and when the ripple 
cursor appears, click to select the edit.

Selecting an edit point to roll

 — To select just the incoming or outgoing half of an edit point to resize or ripple: Move the 
mouse to the left or right of the center of an edit, and when the resize/ripple cursor appears, click 
to select that portion of the edit.

Selecting incoming or 
outgoing halves of an edit 
point to resize or ripple

To select multiple edit points, do one of the following:

 — To select multiple roll points: Command-click the center of multiple edit points. Command-click 
a selected edit point to deselect it.

Command-clicking the center of several edits to prepare to roll them all

 — To select multiple ripple points: Command-click the left or right sides of multiple edit points.

Command-clicking the left or right of several edits to ripple them all

 — To drag to select many edit points: Select the Trim tool (T), and drag a bounding-box over the 
edit points you want to select. You can press U to switch all selected edit points among rippling 
incoming edits, rippling outgoing edits, and rolling edits.
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Using the Trim tool, you can drag a bounding box to select multiple edits

There is also a flexible set of keyboard shortcuts that makes it easy to select edit points in 
preparation for various operations if you like to avoid using the mouse.

Keyboard shortcuts for selecting edits:

 — V: Selects the nearest edit point to the playhead on the lowest track with Auto Select enabled. 
Selects both the audio and video edit points of a clip together.

 — Option-E: Selects the nearest video edit point to the playhead on the lowest track with Auto 
Select enabled. Linked audio edit points are not selected.

 — Shift-E: Selects the nearest audio edit point to the playhead on the lowest track with Auto Select 
enabled. Linked video edit points are not selected.

 — U: Once you’ve selected an edit point, this shortcut toggles among selecting the outgoing half, 
incoming half, or the entire edit.

 — Option-U: Once you’ve selected an edit point, this shortcut toggles among selecting the 
video+audio of the edit, just the video, or just the audio.

To move the selection to another edit:

 — Select a single edit point, then use the Up Arrow key (Previous Edit) or Down Arrow key (Next 
Edit) to change the selection to the previous or next edit point among all tracks with Auto Select 
turned on.

To deselect all edit points:

 — Using the mouse: Click any empty area of the Timeline.

 — Using the keyboard: Press Shift-Command-A.

A Practical Example of Keyboard-Driven Selections
Here’s an example of how you would use these keyboard shortcuts together as a 
sequence of operations.

To select an edit point using the keyboard:

1 Press Command-4 to give focus to the Timeline.

2 Move the Timeline playhead close to the edit point you want to select using the JKL keys.

3 Press the V key to select the nearest edit point to the playhead on the lowest track with Auto 
Select enabled. If there are overlapping superimposed clips on multiple tracks, turn off the Auto 
Select controls of tracks with edits you don’t want to select using Option-F1 through Option-F8 
corresponding to the Auto Select controls on tracks 1–8. Using the mouse, you can solo a track’s 
Auto Select state by Option-clicking its Auto Select button. (Option-F9 toggles the Auto Select 
controls of all video tracks.)
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4 Initially, the entire edit is selected, in preparation for a roll edit. To toggle among selecting the 
outgoing half, incoming half, and the entire edit, press the U key.

5 To toggle among selecting the video+audio of the edit, just the video, or just the audio, 
press Option-U.

6 Perform whatever operation you need to. When you’re finished, using Up-Arrow or Down-Arrow to 
move the selection backward or forward in the Timeline, or press Command-Shift-A to deselect it.

Using Auto Select Controls to 
Define Selections
The Timeline Auto Select controls are extremely useful and versatile controls that serve many 
purposes. In short, they give you a way to specify which tracks will be affected or considered when 
you’re performing an operation upon multiple superimposed clips on multiple tracks of the Timeline. 

Also, the Timeline Auto Select controls are particularly convenient when you’re using keyboard 
shortcuts to edit and you don’t want to have to grab your mouse to explicitly select a single clip, since 
you can turn Auto Select on or off via keyboard shortcuts.

Defining Selections With the Help 
of Auto Select Controls
Here is the easiest example of when the Auto Select controls are indispensable. In the following 
example, there are two superimposed video clips and three superimposed audio clips. Supposing you 
only want to delete the media from tracks V2, V1, and A1, but you want to leave the media on A2 and 
A3 alone, you can turn off the Auto Select controls for tracks A2 and A3, and set Timeline In and Out 
points to define the range of the clips you want to delete. When you press the Delete key, only the 
media on the Auto Select-enabled tracks is deleted.

Before and After deleting a clip with Auto Select on Tracks A2, A3, and A4 turned off
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TIP: If you set In and Out points to perform an operation and you don’t see any shading 
in the Timeline to indicate which parts of the Timeline will be affected and which won’t, 
chances are you have another selected clip in the Timeline somewhere you can’t see that’s 
overriding auto select. Press Command-Shift-A to de-select all and things should go back 
to normal.

Overriding Automatic Selections by 
Making Manual Selections
It’s important to note that manual selections that you make which highlight specific clips in the 
Timeline always override whatever the Auto Select control of a track is set to. In the following example, 
three clips are superimposed and the Auto Select control of every track except V2 has been turned 
off. Setting Timeline In and Out points now automatically defines that region of the clip on track V2 to 
be deleted were you to press the Delete key. You can see the affected part of the Timeline because it’s 
highlighted while the rest of the Timeline is dimmed.

Soloing the Auto Select control on track V2 to limit a Delete operation

However, if you clicked the clip on track V1 to select it manually, the automatic selection defined by the 
In and Out points disappears in favor of the highlighted clip you just clicked. This is because manual 
selections almost always take precedence over automatic selections you define using the In and Out 
points and Auto Select controls.

Making a manual selection overrides the Auto Select controls

This is good to keep in mind for situations where the fastest way to do the operation you need to do is 
to simply manually select the clip you want to define the operation.
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Using Auto Select Controls to 
Control Other Operations
Other operations that are affected by the Auto Select controls include any command that uses “the 
clip on the lowest-numbered track with Auto Select enabled” to define what happens. This includes 
Copy and Paste, Mark Clip, Go To Next Edit/Previous Edit, the Selection Follows Playhead mode, Next 
Gap/Previous Gap, and so on (a full list of affected operations appears later).

A common example of when this is important is whenever you use the Mark Clip command to 
automatically set In and Out points to match the duration of a clip on the Timeline. If that clip happens 
to be at a section of the Timeline where there are multiple superimposed clips, each of which has a 
different duration, then by default the In and Out points (first and last frames) of the clip on the lowest 
numbered track is used to set Timeline In and Out points when you use Mark Clip. 

Using Mark Clip with all Auto Select controls enabled, the clip on the lowest-
numbered video track with Auto Select enabled defines the result

However, if you disable the Auto Select control of track V1, then whichever clip is on the lowest video 
track with Auto Select still enabled is used as the target clip for the Mark Clip operation. In this 
example, the shorter clip on track V2 now sets the locations of the In and Out points.

Using Mark Clip with Auto Select controls enabled

Methods of enabling and disabling the Auto Select controls:

 — To toggle Auto Select for any track: Click any track’s Auto Select control.

 — To toggle Auto Select for video tracks: Press Option-F1 through F8 to toggle Auto Select on the 
corresponding tracks. 

702Edit | Chapter 36 Editing Basics



 — To toggle Auto Select for audio tracks: Press Option-Command-F1 through F8 to toggle Auto 
Select on the corresponding tracks. 

 — To toggle all video track Auto Select tracks off and on: Press Option-F9.

 — To toggle all audio track Auto Select tracks off and on: Press Option-Command-F9.

 — To “solo” Auto Select for a track and disable Auto Select on all other tracks: Option-click any 
Auto Select control to leave that control on while turning off all other Auto Select controls of that 
type (video or audio).

 — To turn all audio or video Auto Select controls on and off: Shift-click any video or audio Auto 
Select control to toggle on or off all Auto Select controls of that type (video or audio).

The following operations are affected by the state of each track’s Auto Select control:

 — Cutting, ripple cutting, copying, or deleting clips: When using Timeline In and Out points 
to delete a range of media from the Timeline, only media on tracks with an enabled Auto Select 
control will be cut, copied, or deleted.

 — Deleting gaps: When selecting and deleting gaps in the Timeline, clips on other tracks that 
overlap the selected gap will also be deleted on tracks with an enabled Auto Select control. Media 
to the right of affected tracks will ripple left to close the gap.

 — Selecting edit points using the keyboard: When you press V to select the nearest edit point, the 
edit point on the lowest track with Auto Select enabled is selected. When pressing the Up Arrow 
and Down Arrow keys to move the selection from edit point to edit point, edit points on tracks 
with a disabled Auto Select control are ignored.

 — Selecting clips using the keyboard: When a clip is selected, you can press the Up Arrow and 
Down Arrow keys to move the selection from clip to edit clip, but clips on tracks with a disabled 
Auto Select control are not seen by this operation.

 — Using Mark Clip: When using the Mark Clip command, clips on tracks with disabled Auto Select 
controls are ignored. This lets you choose a target clip to use for marking the clip when there are 
multiple overlapping superimposed clips.

 — Match Frame: When making a Match Frame operation, clips on tracks with disabled Auto Select 
controls are ignored. This lets you choose a target clip to use for matching a frame when there are 
multiple overlapping superimposed clips.

 — Rippling the Timeline during a trim operation: Tracks with Auto Select turned off will not be 
rippled. For more information on the rules of ripple trimming, see Chapter 43, “Trimming.”

 — Pasting clips: All copied clips will be pasted to the lowest numbered track with Source Control 
enabled. If all tracks of a particular type have their Auto Select controls turned off, then no clips of 
that type will be pasted at all.

 — Paste Insert: Tracks with Auto Select turned off will not be rippled or affected by clips being 
pasted via a Paste Insert command.

 — Using the insert or ripple overwrite edits: Only clips on tracks with Auto Select turned on will 
be rippled during an insert edit or ripple overwrite edit.

 — Finding gaps: When using Playback > Previous Gap (Command-Option-Semicolon) or Next Gap 
(Command-Option-Apostrophe), gaps on tracks with Auto Select disabled will be ignored.

 — Using Selection Follows Playhead: When you turn on “Selection Follows Playhead” so that 
the clip intersecting the position of the playhead is automatically selected. If multiple clips are 
intersecting the playhead, the clip on the highest track will be selected. Clips on tracks with Auto 
Select disabled will not be selected.
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Locking Tracks You Don’t 
Want to Change
Another step you can take to prepare before performing any kind of editorial operation is to lock 
tracks with media that you don’t want to be affected by whatever it is you’re about to do. For example, 
if you have a complex set of music edits on track A3 that you don’t want to be affected by operations 
that will ripple the Timeline, you can lock track A3 so those clips remain unaffected.

Tracks V2, V1, and A1 are unlocked, while tracks A2, A3, and A4 are locked

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial operations. 
Furthermore, parameters of locked clips cannot be edited in the Inspector. However, clips on locked 
tracks can be graded and otherwise modified in the Color page.

To toggle the lock or unlock state of tracks, do one of the following:

 — Click any track’s lock control to toggle lock on and off.

 — Shift-click any track’s lock control to toggle locking on and off for all tracks.

 — Press Option-Shift-1 through 8 to lock or unlock tracks V1 through V8.

 — Press Option-Shift-9 to lock or unlock all video tracks.

 — Press Option-Shift-F1 through F8 to lock or unlock tracks A1 through A8.

 — Press Option-Shift-F9 to lock or unlock all audio tracks.

Position Lock for Finishing
In a nutshell, turning position lock on prevents clips from being moved to the left or right, and it 
prevents all ripple operations. This is primarily useful when you’re near the end of post on a project for 
which the cut has been locked (or at least as “locked” as directors and producers allow any more), but 
you still need to make surgical changes that don’t risk throwing the video out of sync with audio that 
may be being edited and mixed elsewhere because of an accidentally rippled edit.

With position lock on, you can still make edits (such as Replace), slip clips, roll edits, add Resolve FX 
and other Open FX, and alter all manner of effects in the Inspector. You just can’t do anything that 
alters the position of clips in the Timeline, or ripples entire sections of the Timeline. 

There are two ways you can enable Position Lock.

704Edit | Chapter 36 Editing Basics



Position Locking All Tracks
You can turn Position Lock on and off for all tracks via a button in the toolbar above the Timeline.

The Position Lock button on the toolbar

When you turn position lock on, the Lock button of all tracks changes to show that position lock is 
enabled instead.

Position lock indicated by each 
track’s Lock icon changing

Position Locking Individual Tracks
You can also be extra tricky and enable position lock on a track-by-track basis by Command-clicking 
any track’s Lock button.

Position lock can be released by simply clicking that track’s Lock icon.

Command-click any track’s Lock button 
to put that track into Position Lock mode
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Disabling and Re-Enabling 
Clips in the Timeline
Sometimes there’s one or more video or audio clips in the Timeline that you don’t want to play along 
with the rest of the edited sequence, but you don’t want to remove from the Timeline either, in case 
you change your mind later. For this reason, it’s possible to Disable clips, effectively turning them off 
without removing them.

Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and they’re 
not output to video. However, their position is preserved in the Timeline, so you can always re-enable 
them at a later time if you change your mind and decide you want to use them.

A clip that’s been disabled between two enabled clips; the disabled clip is dimmed

To disable or re-enable one or more selected clips:

 — Right-click part of the selection and choose Enable Clip from the contextual menu.

 — Choose Clip > Enable Clip.

 — Press D.

Deleting Clips and Gaps 
From the Timeline
There are two ways you can delete clips you don’t want in the Timeline. Using the Delete key, you can 
perform what’s sometimes called a “lift edit,” removing the unwanted clips and leaving a gap. Using 
the Forward Delete key, you can perform a “ripple delete,” removing unwanted clips and closing the 
gap by rippling the rest of the edited Timeline to the right of the deleted clip(s) by moving it to the left.

Deleting clips as a “lift edit” operation:

 — To remove one or more clips from the Timeline, leaving a gap: Select a clip in the Timeline, or 
Shift-click or Command-click to select the clips you want to remove, and press the Delete key (or 
right-click the selection and choose Delete).
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 — To remove a range of media from the Timeline on multiple tracks, leaving a gap: Set 
Timeline In and Out points defining the range of media you want to delete, then turn off the Auto 
Select controls of any tracks with media you want to preserve, and press the Delete key (or right-
click the selection and choose Delete).

Deleting Clip I using the Backspace or Delete key and leaving a gap

Deleting clips as a “ripple delete” operation:

 — To delete one or more clips and close the gap by rippling the Timeline left: Select a clip in 
the Timeline, or Shift-click or Command-click to select the clips you want to remove, and press the 
Forward Delete key.

 — To delete a range of media and close the gap by rippling the Timeline left: Set Timeline In 
and Out points defining the range of media you want to delete, then turn off the Auto Select 
controls of any tracks with media you want to preserve, and press the Forward Delete key.

Deleting Clip I using the Forward Delete key to ripple all clips with 
In points to the right in the Timeline to close the gap
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As with any ripple operation, all clips with In points to the right of the deleted range of media on tracks 
with auto select enabled are rippled to close the gap, and any clips with In points to the left of the In 
point of the affected range of media are unaffected.

Finding, Selecting, and Deleting Gaps in the Timeline
A gap is defined as a space between any two clips on the same track. Often gaps are desirable as 
they allow audio or video clips to be spaced apart from one another very specifically, but sometimes 
they’re not. If you want to find accidental gaps in your timeline that may be too small to see, a pair of 
commands lets you do this.

To move the playhead to the next gap on the Timeline:

1 Turn off the Auto Select controls of any tracks you want to omit from this operation.

2 Do one of the following:

 — Choose Playback > Previous Gap, or press Option-Command-Semicolon (;) to move the 
playhead to the next gap to the left of the playhead’s current position.

 — Choose Playback > Next Gap, or press Option-Command-Apostrophe (‘) to move the playhead 
to the next gap to the right of the playhead’s current position.

To select or deselect a gap:

 — Click once to select a gap, and click that gap again to deselect it.

You can only select one gap at a time. The principal reason to select a gap is to delete it, in the 
process rippling the Timeline to close the gap. In the following example, there’s a gap between 
two clips on track V1 that you’d like to close.

Selecting a gap on track V1

To delete a gap:

 — Press the Delete key to close the gap. All clips to the right of it on tracks with Auto Select enabled 
will be rippled to the left to close the gap. Clips on tracks with Auto Select disabled will not ripple.

If you select a gap in a timeline with clips on multiple tracks, which clips will be deleted depends 
on the state of the Auto Select controls for each track in the Timeline.

 — All tracks with Auto Select enabled: The range of media that overlaps the selected gap will 
also be deleted. Clips on those tracks will ripple left to fill the gap.

 — All tracks with Auto Select disabled: The range of media that overlaps the selected gap will 
be left intact, and clips on those tracks will not ripple left, going out of sync with whichever 
clips do ripple.
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Deleting Multiple Timeline Gaps at Once
You can also ripple-delete video and audio gaps in the Timeline all at once using the Edit > Delete 
Gaps command. This removes gaps among consecutive clips in the Timeline on all Auto Select enabled 
tracks. Each segment of the Timeline with a gap is rippled, in order to move clips that are to the right 
of each gap left to close that gap. 

All gaps are defined for purposes of this command as empty spaces between clips that span all tracks 
in the Timeline. In the following example, various audio/video, audio-only, and video-only clips have 
gaps between them. Using Remove Gaps causes the Timeline to be rippled such that these clips abut 
one another as a continuous sequence, without any of them overlapping any others.

(Top) Before removing gaps, (Bottom) After removing gaps

This is an extremely powerful and wide-ranging command. However, it’s made safer by following strict 
rules in order to maintain overall A/V sync in timelines:

 — Gaps will not be removed past the point where video and/or audio clips will overlap one another.

 — Gaps will not be removed if they’re under superimposed video clips that bridge the gap.

 — Gaps will not be removed if one or more continuous audio clips bridge the gap.
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 — You can limit the range of the gaps to be deleted by setting In/Out points on the Timeline.

 — If a linked set of video and audio items has a gap that includes an L or J split edit, it will be closed 
to the point that the audio or video, whichever extends the farthest, abuts the nearest clip to it.

Disabling a track’s Auto Select Control omits that track from consideration when following the above 
rules. This lets gaps on other tracks be closed so clips overlap those on the Auto Select-disabled track.

WARNING: Performing Remove Gaps with Auto Select disabled on one or more tracks 
could result in massive loss of video/audio sync if you’re not careful. To avoid this, Shift-
click one video Auto Select control (or press Option-F9) and one audio Auto Select control 
(or press Command-Option-F9) to toggle all video and all audio Auto Select controls until 
they’re all turned on at once.

Audio/Video Linking
DaVinci Resolve gives you complete control over the linked relationship between the video and audio 
associated with a clip. By default, DaVinci Resolve tries its best to keep the video and audio of clips and 
timelines in sync. However, there are several ways you can suspend automatic syncing when you need 
to make a specific kind of edit.

Controlling Linked Selection
While selecting edits and clips, you can also choose whether the video and audio associated with a 
clip should be selected together (linked) or not. This determines whether operations performed to 
the video of a clip automatically affect the audio of the clip, and vice versa. In most instances, you’ll 
probably want to leave Linked Selection turned on, so that selecting the video of a clip to move it 
elsewhere in the Timeline also results in the audio being selected and moved at the same time. 
Disabling A/V linking in this case could cause your video and audio to go out of sync undesirably.

However, there are plenty of instances when you’ll want to temporarily suspend this linked A/V 
relationship, such as when you want to create a split edit, where a clip’s audio In point is at a different 
frame than the video In point. In this case, you can suspend Linked Selection to select just the audio 
In point, then roll it either farther back or forward to create the split, without changing the In point of 
that clip’s video. When you’re finished, you can re-enable A/V linking.

At all times, the state of Linked Selection is visible via the Chain-link button at the right of the toolbar.

The Link Audio/Video button

710Edit | Chapter 36 Editing Basics



To turn Linked Selection off and on:

 — Click the Link Audio/Video button (or press Shift-Command-L).

To temporarily suspend Linked Selection while making a selection:

 — Press the Option key while clicking a clip or edit point to select the video without selecting the 
audio, or vice versa.

Linked Move Across Tracks
The Timeline > Linked Move Across Tracks setting works in conjunction with Linked Selection to let 
you change how linked video and audio items move in the Timeline when you drag them up and down 
to reorganize clips from track to track. Depending on the task at hand, one or the other behaviors 
might be more convenient, but no matter how you have this mode set, video/audio sync is always 
maintained when you move clips left and right.

 — When Linked Move Across Tracks is enabled: (On by default) Dragging one of a linked pair 
of video and audio items up or down in the Timeline moves the linked item up or down as well. 
So, moving a video clip from track V1 to V2 results in its linked audio clip moving from track 
A1 to A2 as well.

Before and after with 
Linked Move Across Tracks 
enabled; if video clip is 
moved, the linked audio 
clip moves simultaneously

 — When Linked Move Across Tracks is disabled: Dragging one of a linked pair of video and audio 
items up or down to another track in the Timeline only moves that one item, other linked item(s) 
remain in the same track. So, moving a video clip from track V1 to V2 leaves the audio clip in track 
A1, where it was originally. This makes it easy to reorganize video clips into different tracks while 
leaving your audio clips organized the way they were, or vice versa. Keep in mind that in this mode, 
while you can move one item of a linked pair up and down freely, moving that item left or right 
results in all linked items moving by the same amount, so sync is maintained.
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Before and after with 
Linked Move Across Tracks 
disabled; if the video clip 
is moved, the linked audio 
clip remains in its original 
position or vice versa

Dealing with Audio Video Sync Offsets
Audio/video sync is one of the most important things to maintain in any edited program. However, 
there are times when you may want to override the sync relationship of a clip’s audio and video to 
make a particular edit, so moving a clip’s audio and video out of sync is allowed.

If you disable Linked Selection and then move the audio or video of a clip independently of its linked 
video or audio counterpart, you’ll see red “out-of-sync” indicators at the left of each clip’s name bar, 
that displays the timecode offset by which the audio and video of that clip are out of sync. In the 
following example, the audio and video of a clip have been moved out of sync by Option-clicking the 
video and dragging it to the left.

Sync markers on a clip with audio and video out of sync

If you’ve moved the audio and video of a clip out of sync with one another, there’s a really easy way of 
getting them back into sync, by right-clicking the red out-of-sync indicator of any clip and choosing 
one of the available commands:

 — Slip into place: Slips the content of the selected clip, without moving the clip, so that it’s in sync 
with the other items that are linked to that clip.

 — Move into place: Moves the selected clip so that it’s in sync with the other items that are 
linked to that clip.
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 — Slip others into place: Slips the content of all other items that are linked to the selected clip, 
without moving them, so that all linked items are in sync.

 — Move others into place: Moves all other items that are linked to the selected clip so 
that all linked items are in sync.

Commands in the 
contextual menu 
of sync tooltips

Manually Unlinking and Relinking Audio and Video
By default, clips that you import into DaVinci Resolve have their video and audio linked together, 
which makes it easy to maintain the relationship and sync of the audio and video components of a 
clip while you’re editing. However, there are many reasons you might want to override this automatic 
relationship, either breaking the A/V linking of a clip’s audio and video completely, or breaking it and 
relinking in a different way, or to different clips.

Methods of permanently changing audio/video linking in the Timeline:

 — To unlink audio and video from one another: Select a clip, then right-click it and choose Link 
from the contextual menu (or press Option-Command-L). Unlinked clips do not appear with a 
chain icon before the clip name in the Timeline.

 — To link audio and video clips to one another: Command-click an audio clip and a video 
clip so they’re both selected, then right-click the selected clips and choose Link from the 
contextual menu (or press Option-Command-L). A chain icon appears before the name of linked 
clips in the Timeline.

(Left) linked video and 
audio with a chain icon 
to the left of the clip 
name, (Right) unlinked 
audio and video 
items have no icon.

Linking Multiple Clips in the Timeline
You don’t just have to link audio and video clips that sync together, though. You can actually link any 
number of video and audio clips that you want to be able to select, move, and edit together as one, 
even if they were never originally meant to be synced. This makes linking an organizational mechanism 
as much as a sync management tool. 
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Here are some examples of how you can use this:

 — You can link a text generator with a subtitle to the clip it plays along with.

 — You can link a sandwich of overlapping audio sound effects with the video clip they accompany.

 — You can link off camera audio to an on camera shot.

 — You can link the background and foreground clips of a green screen composite, with 
sound from both.

Linking multiple clips in the Timeline works the same as linking a single audio and video clip together; 
every single linked item appears with a chain icon to the left of the clip name, and suspending linked 
selection to force any single clip out of sync will result in the display of an “out-of-sync” indicator.

Multiple audio and 
video items that have 
been manually linked 
together to act as 
a single clip in the 
Timeline when Linked 
Selection is enabled

Commands for Slipping Audio/Video Sync
Another set of commands in the Trim > Slip Audio submenu let you slip the contents of one or 
more selected clips in order to alter the sync between the audio and video, either in whole frame 
increments, or in sub-frame increments if there are clips with marginal sync that you want to improve.

 — One Frame Forward (Option-Period)

 — One Frame Reverse (Option-Comma)

 — One Subframe Forward (Option-Right Arrow)

 — One Subframe Reverse (Option-Left Arrow)
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Chapter 37

Using the Inspector 
in the Edit Page
The Inspector holds all the controls to modify, resize, retime and 
generally adjust anything related to a clip, transition, or effect on 
the Edit page Timeline.
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Using the Inspector
The Inspector has been redesigned to make it easier to find specific controls and to adjust common 
settings for your clips. Instead of a long vertical list, different aspects of the Inspector have now been 
organized into panels, with each controlling specific grouped sets of parameters for your clip. 

The Inspector is activated by clicking on the Inspector panel in the upper-right section of the User 
Interface toolbar. The Inspector is broken up into individual Video, Audio, Effects, Transition, Image, 
and File panels. Inspector panels that are not applicable to your clip or selection are grayed out.

The Inspector Panel icon in the 
upper right of the UI toolbar

The Inspector panels showing Video, Audio, and File parameters 
available for adjustment; others are grayed out.

Methods of using controls in the Inspector:

 — To activate or deactivate a control: Click the toggle to the left of the control’s name. 
The orange dot on the right means the control is activated. A gray dot on the left means the 
control is deactivated. 

 — To reveal a control’s parameters: Double-click the control’s name.

 — To reset controls to their defaults: Click the reset button to the right of the control’s name.

Video
The Video panel of the Inspector exposes a vast array of controls designed to manipulate the size, 
speed, and opacity of your clips. 

Transform
The Transform group includes the following parameters for resizing and repositioning your clips:

 — Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y parameters can 
be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one 
direction only.

 — Position X and Y: Moves the image within the frame, allowing pan and scan adjustments to be 
made. X moves the image left or right, and Y moves the image up or down.

 — Rotation Angle: Rotates the image around the anchor point.

 — Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. 
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 — Pitch: Rotates the image toward or away from the camera along an axis running through the 
center of the image, from left to right. Positive values push the top of the image away and bring 
the bottom of the image forward. Negative values bring the top of the image forward and push 
the bottom of the image away. Higher values stretch the image more extremely.

 — Yaw: Rotates the image toward or away from the camera along an axis running through the 
center of the image from top to bottom. Positive values bring the left of the image forward and 
push the right of the image away. Negative values push the left of the image away and push the 
right of the image forward. Higher values stretch the image more extremely.

 — Flip Image: Two buttons let you flip the image in different dimensions.

 — Flip Horizontal control: Reverses the image along the X-axis, left to right.

 — Flip Vertical control: Reverses the clip along the Y-axis, turning it upside down.

The Transform section of the Video Inspector panel

Smart Reframe (Studio Version Only)
The Smart Reframe feature makes it easier to quickly reframe material across extreme aspect ratio 
changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing 
to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or 
using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or 
automatically executed using the DaVinci Resolve Neural Engine. 

 — Object of Interest: Tools for selecting the subject that the resize will frame around.

 — Auto: DaVinci Resolve’s Neural Engine will analyze the clip and choose its most representative 
object. This will be the only option if more than one clip is selected for Smart Reframing.

 — Reference Point: Allows you to manually adjust a bounding box around the subject to 
reframe around.

 — Reframe: This button executes the Smart Reframe command. This can take some time depending 
on the length and number of clips.

The Smart Reframe section of the Video Inspector panel

Cropping
The Video Inspector controls the image’s cropping parameters.

 — Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency so that whatever is underneath shows through.
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 — Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the edges 
inside of the crop box, while setting this to a positive value softens the edges outside of 
the crop box.

 — Retain Image Position: Clicking this checkbox will lock the crop parameters in place when you 
resize the image using the Transform tool above. Unchecking this box will scale and position the 
crop as well as the image.

The Cropping section of the Video Inspector panel

Dynamic Zoom
The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan 
effects to zoom into or out of a clip. Turning the Dynamic Zoom group on activates two controls 
in the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls. 
For more information on using the Dynamic Zoom controls, see Chapter 50, “Compositing and 
Transforms in the Timeline.” 

 — Dynamic Zoom Ease: Lets you choose how the motion created by these controls accelerates. 
You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

 — Swap: This button reverses the start and end transforms that create the dynamic zoom effect.

The Dynamic Zoom section of the Video Inspector panel

Composite
Composite modes can be used to combine clips that are superimposed over other clips in 
the Timeline.

 — Composite Mode: This selects the type of composite mode to combine the superimposed 
clips. The default “Normal” means no compositing mode is applied. For more information on 
Composite Modes, see Chapter 50, “Compositing and Transforms in the Timeline.”

 — Opacity: This slider makes a clip more or less transparent in addition to compositing 
already being done.

The Composite section of the Video Inspector panel
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Speed Change
You can change the speed of your clip directly in the Video Inspector’s Speed Change controls. This 
method has the benefit of being available in both Cut and Edit pages.

 — Direction: Selects the desired motion of the clip, forward, backward, or freeze frame.

 — Speed %: Adjusting this slider changes the clips motion on a percentage basis. This value 
can be keyframed.

 — Frames Per Second: Adjusting this slider changes the clips motion by increasing or decreasing 
the number of frames per second to play the clip back at. This value can be keyframed.

 — Duration: You can directly select how long you want the clip to be by setting a specific duration 
here in HH:MM:SS:FF format. This will then automatically adjust the speed of the clip to playback all 
frames in that exact amount of time.

 — Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple the 
Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, 
then turn on this checkbox.

 — Pitch Correction checkbox: Checking this box will perform pitch correction on the audio 
attached to the clip so that while the audio duration is changed to match the picture speed, it will 
still sound natural. Be aware that pitch correction on large speed adjustments may not sound as 
good as pitch corrections made to small speed adjustments.

The Speed Change controls in the Video Inspector

Stabilization
These controls let you smooth out or even steady unwanted camera motion within a clip. The analysis 
is performed in such a way as to preserve the motion of individual subjects within the frame, as well as 
the overall direction of desirable camera motion, while correcting for unsteadiness.

These are the same stabilizer controls found in the Color page’s Tracker palette (minus the tracker 
graph), and the resulting stabilization analysis is mirrored on the Color page, where you can see the 
data visualized on the graph, if necessary.

A pop-up menu provides three different options that determine how the selected clip is analyzed and 
transformed during stabilization. You must choose an option first, before clicking the Stabilize button 
above, because the option you choose changes how the image analysis is performed. If you choose 
another option, you must click the Stabilize button again to reanalyze the clip.

 — Perspective: Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.

 — Similarity: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where 
perspective analysis results in unwanted motion artifacts.

 — Translation: Enables pan and tilt analysis and stabilization only, for instances where only X and Y 
stabilization gives you acceptable results.
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The Stabilization section of the Video Inspector panel

The other controls let you customize how aggressively the selected clip is stabilized.

 — Stabilization Toggle: The toggle control for the Stabilization controls lets you turn stabilization 
off and on to be able to compare the stabilized and unstabilized image.

 — Camera Lock: Turning on this checkbox disables Cropping Ratio and Smooth, and enables 
the stabilizer to focus on eliminating all camera motion from the shot in an effort to create a 
locked shot.

 — Zoom: When this checkbox is turned on, the image is resized by a large enough percentage to 
eliminate the blanking (black edges) that is the result of warping and transforming the image 
to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more 
DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn 
this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output 
along with the image, on the assumption that you’ll have dedicated compositing artists deal with 
eliminating this blanking by filling in the missing image data in a more sophisticated manner. You 
may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom 
parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only 
where it occurs, using only as much zooming as is necessary for each region of the shot.

 — Cropping Ratio: This value limits how hard the stabilizer tries to stabilize, by dictating how much 
blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. A 
value of 1.0 results in no stabilization being applied. Progressively lower values enable more 
aggressive stabilization. Changing this value requires you to click the Stabilize button again to 
reanalyze the clip.

 — Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, 
allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform 
less smoothing, allowing more of the character of the original camera motion to show through, 
while higher values smooth the shot more aggressively. Changing this value requires you to click 
the Stabilize button again to reanalyze the clip.

 — Strength: This value is a multiplier that lets you choose how tightly you want to use the 
stabilization track to eliminate motion from a shot using the current analysis. With a value of 1, 
stabilization is maximized. Since some clips might look more natural with looser stabilization, 
choosing a number lower than 1 lets a percentage of the original camera motion show through. 
Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization by 
choosing –1 when pasting a stabilization analysis from another clip to perform a match move 
based on the overall motion of the scene, and you can use a negative value either lower than 0 or 
higher than –1 to under or overcompensate when inverting the stabilization, simulating the effects 
of parallax where foreground and background planes move together but at different speeds.
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Lens Correction
The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for 
lens distortion in the image, or add lens distortion of your own.

 — Analyze: Automatically analyzes the frame in the Timeline at the position of the playhead 
for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the 
Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging 
clip, a progress bar will appear to let you know how long this will take.

 — Distortion: Dragging this slider to the right lets you manually apply a warp to the image that lets 
you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked 
the Analyze button and the result was an overcorrection, then dragging this slider to the left lets 
you back off of the automatic adjustment until the image looks correct.

The Lens Correction section of the Video Inspector panel

Retime and Scaling
The Retime and Scaling group has four parameters that affect retiming quality and clip scale:

 — Retime Process: Lets you choose a default method of processing clips in mixed frame rate 
timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-
clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same 
way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more 
detail in the Speed Effect Processing section of Chapter 51, “Speed Effects.”

 — Motion estimation mode: When using Optical Flow to process speed change effects or clips with 
a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose 
the best-looking rendering option for a particular clip. Each method has different artifacts, and 
the highest quality option isn’t always the best choice for a particular clip. The default setting is 
“Project Settings,” so all speed-effected clips are treated the same way. There are several options. 
The “Standard Faster” and “Standard Better” settings are the same options that have been 
available in previous versions of DaVinci Resolve. They’re more processor efficient and yield good 
quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” 
should yield superior results in nearly every case where the standard options exhibit artifacts, at 
the expense of being more computationally intensive, and thus slower on most systems. 

The Speed Warp setting is available for even higher-quality slow motion effects using the DaVinci 
Neural Engine. Your results with this setting will vary according to the content of the clip, but in 
ideal circumstances this will yield higher visual quality with fewer artifacts than even the Enhanced 
Better setting. 

 — Scaling: Lets you choose how clips that don’t match the current project resolution are handled on 
a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the 
same method of being automatically resized. However, you can also choose an individual method 
of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information 
see the 2D Transforms section of Chapter 149, “Sizing and Image Stabilization.”
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The Retime and Scaling section of the Video Inspector panel

 — Resize Filter: For clips that are being resized in any way, this setting lets you choose the filter 
method used to interpolate image pixels when resizing clips. Different settings work better for 
different kinds of resizing. There are four options:

 — Sharper: Usually provides the best quality in projects using clips that must be scaled up 
to fill a larger frame size, or scaled down to HD resolutions.

 — Smoother: May provide higher quality for projects using clips that must be scaled down 
to fit an SD resolution frame size.

 — Bicubic: While the Sharper and Smoother options are slightly higher quality, Bicubic is still an 
exceptionally good resizing filter and is less processor intensive than either of those options.

 — Bilinear: A lower quality setting that is less processor intensive. Useful for previewing your 
work on a low-performance computer before rendering, when you can switch to one of the 
higher quality options.

 — Other Resize Methods: A selection of specific resize algorithms is available if you need to 
match them to other VFX workflows.

 — Deinterlace Quality (Interlaced Clips Only): Allows per clip deinterlace-quality 
adjustments regarding how DaVinci Resolve combines the two fields of interlaced media into 
progressive frames.

 — Normal: A high-quality deinterlacing method that is suitable for most clips. For many clips, 
Normal is indistinguishable from High. Normal is always used automatically during playback 
in DaVinci Resolve.

 — High: A more processor-intensive method that can sometimes yield better results, depending 
on the footage, at the expense of slower rendering times.

 — DaVinci Neural Engine: This option uses the advanced machine learning algorithms of 
the DaVinci Neural Engine to analyze motion between the fields of interlaced material and 
reconstructs them into a single frame. This option is very computationally intensive but, 
ideally, will deliver an even more aesthetically pleasing result than the “high” setting.

Super Scale
For instances when you need higher-quality upscaling than the standard Resize Filters allow, you 
can now enable one of the “Super Scale” options in the Inspector. Unlike using one of the numerous 
scaling options in the Edit, Fusion, or Color pages, Super Scale actually increases the source resolution 
of the clip being processed, which means that clip will have more pixels than it did before and will 
be more processor-intensive to work with than before, unless you optimize the clip (which bakes in 
the Super Scale effect into the optimized media) or cache the clip in some way. For more detailed 
information on Super Scale, see Chapter 11, “Image Sizing and Resolution Independence.”
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Using Super Scale in the Inspector is functionally equivalent to setting the same controls for the media 
clip in the Clip Attributes. This means that changing this setting affects all of the additional edits 
referencing the selected media as well.

The Super Scale parameters

The Super Scale group has the following parameters that affect the quality and clip scale:

 — Super Scale: Lets you choose the amount of scaling required. The options are: 2x, 2x Enhanced, 
3x, or 4x. 

 — Sharpness: Lets you choose the amount of detail in the scaling. This is limited to Low, Medium, 
or High, unless the Super Scale Mode is set to 2x Enhanced, which allows you to apply variable 
sharpness. You will want to balance this setting against Noise Reduction.

 — Noise Reduction: Lets you choose the amount of noise reduction in the scaling. This is limited 
to Low, Medium, or High, unless the Super Scale Mode is set to 2x Enhanced, which allows you to 
apply variable noise reduction. You will want to balance this setting against Sharpness.

Audio
The Audio tab contains four commonly used audio 
controls for video editing purposes, including Clip 
Volume, Clip Pan, Clip Pitch, and Clip Equalizer.

 — Clip Volume: Each clip has a single volume 
control that corresponds to the volume overlay 
over each audio clip.

 — Clip Pan: (Only exposed for clips) A simple Pan 
slider that controls stereo panning.

 — Voice Isolation (Studio Version Only): 
Voice Isolation is a plugin that can remove 
loud, undesirable sounds from existing 
voice recordings. This effect utilizes AI to 
provide models that let you completely 
remove undesired sounds. The AI model is 
trained for any type of human voice, male or 
female, young or old, so you can get incredible 
results that isolate dialog from background 
sounds in a recording, including everything 
from air conditioning or fans to extremely 
loud sounds like a jackhammer, restaurant 
background noise, or music playing at the 
same time that the subject is speaking, 
and so on.

The Audio Inspector parameters
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 — Amount: Lets you adjust the amount of voice isolation processing. 

 — Preset Menu: The preset menu provides the following options:

 — Optimized for most sources: This option is selected by default and works well as 
for most sources.

 — More lift for low levels: Select this option if the source has more low level dialog that you 
want to boost.

 — Lift soft whispery sources: Select this option if the source has whispered dialog and 
background noise.

 — Reduce Loud Dialogue: When enabled, louder dialogue is ridden downward on peaks, and acts 
somewhat like a “perfect limiter” where you don’t have to adjust threshold or time constants. 
Due to the “near real time” aspect, analysis occurs prior to audible playback for optimal results.

 — Lift Soft Dialogue: When enabled, finds low level dialogue and lifts and evens out material that 
is more variable in level and softer, but because the process is dialogue focused it doesn’t tend 
to raise background sounds (unless they are happening at the same time as the dialogue itself). 
More often than not, the Lift Soft Dialogue option is the most useful of the three options, as 
it makes less audible lines of dialogue more audible and naturally smooth, while not boosting 
background noise.

 — Background Reduction: When enabled, reduces background sounds by focusing on dialogue 
and gently removing them based on the internal presets (Preset menu).

 — Output Gain: Adjust the Output Gain by clicking and dragging on the Output Gain control or 
by entering a value in the numeric field (Output Gain control in dB with 0 to +6 dB range with 
.1dB resolution).

 — Clip Pitch: Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust 
clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 
100th of a semi tone).

 — Clip Equalizer: Each clip also has a four-band EQ, complete with low-pass, high-pass, and 
parametric settings for fine tuning and problem-solving audio issues at the clip level.

NOTE: There are many more refined plugins and effects for audio clips in the Audio FX 
library. If you apply any of these, the controls will appear in the Inspector’s Effects tab 
Audio section, instead of here.
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Effects

The Effects Inspector controls

Any Fusion FX, Open FX, or Audio FX filters that have been applied to a clip can be modified here 
in their respective tabs. Different effects in the Timeline expose different controls in the Effects 
panel. Whichever panels are exposed, parameters within each panel are organized into groups, 
with a title bar providing the name of that group, along with other controls that let you control all 
parameters within that group at the same time. 

These controls include:

 — Enable button: A toggle control to the left of the parameter group’s name lets you disable 
and re-enable every parameter within that group at once. Orange means that track’s enabled. 
Gray is disabled.

 — Parameter group title bar: Double-clicking the title bar of any group of parameters collapses or 
opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter 
group collapses or opens all parameter groups at once.

 — Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the group. 
When the button is highlighted orange, a keyframe is at the current position of the playhead. 
When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead 
from keyframe to keyframe for further adjustment.

 — Reset button: Lets you reset all parameters within that group to their default settings.

 — Use Alpha: Checking this box applies the Open FX alpha channel to the selected clip, compositing 
it over any background elements that appear in lower tracks. If more than one alpha-modifying 
effect is applied to a single clip, the alpha channels are mixed together. 

For a detailed explanation of each of the Resolve FX plugins that accompany DaVinci Resolve, 
see Part 12, “Resolve FX Overview.”
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Transition

The Transition Inspector controls

Double-clicking a transition in the Timeline opens that Transition Panel in the Inspector. Each 
transition has the following properties you can edit.

 — Transition Type: The currently selected transition. You can change to any other installed 
transition by selecting one in the drop-down menu. 

 — Duration: The duration of the transition, shown in both seconds and frames.

 — Alignment: A drop-down that lets you choose the transition’s position relative to the edit point it’s 
applied to. Your choices are “Start on Edit,” “Center on Edit,” and “End on Edit.”

Additional properties that are specific to each type of transition appear in another group below. Since 
the Cross Dissolve transition is the most common transition used, its properties will be shown as 
an example.

 — Style: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, and so on) expose this 
drop-down that lets you choose different ways for the outgoing clip to blend into the incoming 
clip during the dissolve. There are six different options to choose from:

 — Video: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.

 — Film: A logarithmic dissolve, simulating film dissolves as created by an optical printer.

 — Additive: The outgoing and incoming clips are cross faded using the Additive composite 
mode. As a result, the transition seems to brighten at the halfway point.

 — Subtractive: The outgoing and incoming clips are cross faded using the Subtractive 
composite mode. As a result, the transition seems to darken at the halfway point.

 — Highlights: The outgoing and incoming clips are cross faded using the Lighten composite 
mode. The lightest parts of each clip are emphasized during this transition.

 — Shadows: The outgoing and incoming clips are cross faded using the Darken composite 
mode. The darkest parts of each clip are emphasized during this transition.

 — Start Ratio: Defines the percentage of completion for the transition at its first frame, from 0 
to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately 
appearing at a more fully cross-dissolved state from the very first frame.

 — End Ratio: Defines the percentage of completion for the transition at its last frame. Setting the 
End Ratio to anything but 0 results in the transition never fully dissolving to the incoming shot at 
its last frame.
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 — Reverse: Reverses the transition. This parameter is disabled for Dissolve transitions.

 — Ease: A drop-down that lets you apply nonlinear acceleration to the beginning, ending, or overall 
duration of a transition. The result is to add inertia to the transition from the outgoing clip to the 
incoming clip, providing a gentler change from each clip into and out of the transition.

 — None: The outgoing clip fades away to the next shot in a linear fashion.

 — In: The outgoing clip lingers as the beginning of the transition dissolves more slowly 
than the end.

 — Out: The outgoing clip fades away more quickly as the beginning of the transition dissolves 
more quickly than the end.

 — In & Out: Both the outgoing and incoming clips make slower transitions at the beginning and 
end of the dissolve, but the very center of the transition is faster as a result.

 — Custom: Lets you modify the parameters of the fade manually using the Transition 
Curves below.

 — Transition Curve: Allows you to manually set keyframes controlling the progress of the transition 
along its duration.

Other types of transitions display properties that are specific to that transition’s particular effect. 
For a detailed explanation of each of the transitions that accompany DaVinci Resolve, see Chapter 47, 
“Using Transitions.”

Image

The Image Inspector controls for BRAW footage

The Image panel contains groups of parameters that correspond to every camera raw media 
format that’s supported by DaVinci Resolve. Using these parameters in the Image panel, you 
can override the original camera metadata that was written at the time of recording and make 
simultaneous adjustments to camera raw media throughout your project.

For a detailed explanation of each of the RAW camera parameters supported by DaVinci Resolve, 
see Chapter 7, “Camera Raw Settings.”
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File

The File Inspector controls

The File panel of the Inspector provides a consolidated way to view and edit a subsection of a clip’s 
most commonly used media file metadata. It’s easily accessible in the Inspector across the Media, 
Cut, Edit, and Fairlight pages. The tab is composed of the following parts:

 — Clip Details: Presents data about the clip’s data format (codec, resolution, frame rate, etc.).

 — Metadata: Presents a reduced set of common metadata fields for quick user entry.

 — Timecode: The start timecode of the clip. This field is editable if you want to manually change 
the clip’s starting timecode.

 — Date Created: The date that the clip was created. This field is editable if you want to manually 
change the clip’s creation date.

 — Camera: Sets the Camera # metadata.

 — Reel: Sets the Reel/Card ID.

 — Scene: The Scene number of the clip.

 — Shot: The Shot letter/number of the clip.

 — Take: The Take number of the clip.

 — Good Take: This checkbox indicates if the clip is a good or circled take.

 — Clip Color: Assign a specific color to a clip that is reflected in the Timeline.

 — Name: This can be entered manually, and changes a clip’s name in that specific timeline only. 

 — Comments: Add a text description to the clip.

 — Auto Select Next Unsorted Clip: When this box is checked, the next clip in the Media Pool 
is selected when you hit the Return button after entering a metadata field, and the cursor is 
automatically placed in the same field. This allows rapid sequential metadata entry without 
having to manually click to load each individual clip in the Media Pool. The Next Clip button will 
select the next clip in the Media Pool, regardless of the checkbox status.
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Chapter 38

Modifying Clips 
in the Timeline
Once you’ve edited a variety of clips into the Timeline, you’ll start 
working with them as you refine your edit. In this chapter, you’ll 
learn simple methods of modifying clips, including resizing, splitting, 
shuffling, disabling, copying and pasting, and duplicating.
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Keyboard Shortcuts in This Chapter
Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

Key Shortcut Function

A Selection tool/mode

V Select nearest edit to playhead

Shift-V Select clip intersecting playhead

U Select incoming, outgoing, or centered part of edit

Option-U Toggle selection among video+audio, video only, and audio only

Up, Down Arrow Keys Move selection to previous/next edit or clip

Comma, Period
“Nudge” keys to move a selected edit or clip left or right a 
frame at a time

Shift-Comma, Period
“Fast Nudge” keys to move a selected edit or clip left or right 
5 frames at a time (customizable)

Shift-Left, Right Bracket ([, ])
Trim Start to Playhead and Trim End to Playhead to trim a clip 
at the position of the playhead

E Extend edit to move a selected edit point to the playhead

B Razor blade tool for adding cuts to clips using the pointer

Command-Backslash (\)
Insert edit; adds a cut to the clip(s) at the position of 
the playhead

Delete Delete clip and leave gap (lift edit)

Forward Delete
Ripple delete; deletes a clip and moves the rest of the 
Timeline left to fill the gap

N Toggle timeline snapping off and on

Command-Shift-L Toggle linked selection off and on

Command-D Change clip duration

Command-Shift (modifier)
While dragging, holding Command-Shift lets you “shuffle” or 
“swap” edit clips forward or backward to rearrange clips in 
the Timeline

D Disable/Enable selected clips

Command-X Cut selected clips, leave gap

Command-Shift-X Ripple cut selection; close gap left by cut clip(s)

Command-C Copy selected clips

Command-V Paste clips

Command-Shift-V Paste insert clips
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Moving, Resizing, and 
Rolling Clips in Selection Mode
After editing a series of clips into a timeline, the next thing even the most careful of editors probably 
needs to do is to start making changes. The simplest changes are made in Selection Mode, using the 
regular arrow pointer. 

The Selection Mode button at 
left is enabled; the Trim mode 
button at right is disabled

This is the default mode when you open DaVinci Resolve, and allows you to move clips to other places 
in the Timeline, resize them to make them longer or shorter, and roll the edit points between two clips 
to move the edit to an earlier or later position on the Timeline. What this tool does depends entirely on 
what you click to select as you work.

Manipulating clips using the mouse: 

1 Click the Selection Mode tool (the arrow), or press A.

2 Do one of the following:

 — To move clips in the Timeline: Drag any clip in the Timeline to any other position. If you drag a 
clip to overlap another clip, the clip you’re dragging overwrites the clip you’re dropping it onto.

Moving a clip in the Timeline to overwrite part of another 
clip; a tooltip shows you how many frames you’ve moved

 — To move clips in the Timeline up or down to other tracks while keeping them at the 
same time: Hold the Shift key down while dragging clips up or down in the Timeline. Or, you 
can hold the Option key down and press Up or Down Arrow.
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Moving a clip into another track without sliding it in time by holding the Shift key down

 — To shorten or lengthen clips: Move the Selection Mode pointer over the beginning or end of 
a clip, and when it turns into the Resize cursor, drag the In or Out point to the left or right to 
change the clip’s length. As you do so, the audio will scrub along with the Resize cursor.

Resizing a clip in the Timeline to create a gap; a tooltip shows the offset, and 
outlines show you how much media is available in the clip being adjusted

 — To roll any edit: Move the Selection Mode pointer over any edit point, and when it turns into 
the Roll Edit cursor, drag it to the left or right to move the edit point while simultaneously 
resizing the outgoing and incoming edits points of the two clips surrounding it. As you do so, 
the audio will scrub along with the right clip’s In point.

Rolling an edit; a tooltip shows the offset, and an outline shows the available area you can roll within
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Manipulating clips using the keyboard:

1 Press A to choose Selection Mode.

2 Do one of the following:

 — To roll any edit incrementally: Select the closest edit point to the playhead using the V key, 
moving the selection to another edit, if necessary, by using the Up Arrow and Down Arrow 
keys. Then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to 
roll the selected edit to the left or right. Shift-Comma and Shift-Period nudges by 5 frames.

 — To roll any edit using the playhead: Select the closest edit point to the playhead using the 
V key, moving the selection to another edit, if necessary, by using the Up Arrow and Down 
Arrow keys. Then use the JKL keys to move the playhead to the frame you want to move the 
edit to, and press E to do an “extend” edit.

 — To shorten or lengthen clips incrementally: Select the closest edit point to the playhead 
using the V key, then use the U key to toggle the selection among the end of the outgoing clip 
and the beginning of the incoming clip. Then, press the Comma key (nudge 1 frame left) or 
Period key (nudge 1 frame right) to shorten or lengthen that side of the clip. If you nudge one 
end of a clip to overlap another, the clip you’re nudging overwrites the adjacent clip. Shift-
Comma and Shift-Period nudges by 5 frames. In Selection mode, this either leaves a gap or 
overwrites neighboring clips.

 — To shorten clips using the playhead: Use the JKL keys to move the playhead over the frame 
in the Timeline where you want to set a new In or Out point for that clip, then press Shift-Left 
Bracket ([) to “trim start,” or Shift-Right Bracket (]) to “trim end.” No selection is necessary. In 
Selection mode, this leaves a gap.

 — To lengthen clips using the playhead: Select the closest edit point to the playhead using the 
V key, then use the U key to toggle the selection among the end of the outgoing clip and the 
beginning of the incoming clip. Then, use the JKL keys to move the playhead to the frame to 
want to extend that edit point to, and press E to do an “extend” edit. In Selection mode, this 
overwrites neighboring clips.

 — To move clips forward or back in the Timeline: To select a clip in preparation for moving it, 
either click it, or use the Spacebar or JKL keys to move the playhead over it and press Shift-V. 
Then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to move 
the clip to the left or right. If you nudge a clip to overlap another clip, the clip you’re nudging 
overwrites the adjacent clip. Shift-Comma and Shift-Period nudges by 5 frames. In Selection 
mode, this leaves a gap.

 — To move clips up or down to other tracks: To select a clip in preparation for moving 
it, either click it, or use the Spacebar or JKL keys to move the playhead over it and press 
Shift-V. Then, press Option-Up Arrow to move the Video and Audio of that clip to the next 
higher-numbered track, or press Option-Down Arrow to move the Video and Audio to the next 
lower-numbered track.

TIP: You can hold down the Shift key while nudging a selection to do a “fast nudge.” 
The duration of a fast nudge is customizable in the Editing panel of the User Preferences. 
By default it’s five frames, but you can set it to whatever you want.
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Trimming Gaps
The start and end of gaps can also be rippled using the Trim tool. For more information,  
see Chapter 43, “Trimming.”

Using the Trim tool to ripple the Out point of a gap to narrow it

Modifying Clip Duration 
Via Timecode
You can change a clip’s duration numerically in one of two ways.

To change a selected clip’s duration:

1 Decide if you want to ripple the Timeline or overwrite neighboring clips when you change a 
clip’s duration. If you want to ripple the Timeline, choose the Trim tool. If you want to overwrite 
neighboring clips or leave a gap, choose the Selection tool.

2 Do one of the following:

 — Select a clip and choose Clip > Change Clip Duration.

 — Right-click any clip in the Timeline and choose Change Clip Duration from the 
contextual menu. 

3 When the Edit Duration Change dialog appears, enter a new duration in the Timecode field, and 
click Change. For more information on timecode entry, see “Moving the Playhead Using Timecode” 
in Chapter 35, “Preparing Clips for Editing and Viewer Playback.”

A window for changing the duration 
of a clip in the Timeline
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Resizing or Trimming Clips 
in the Source Viewer
You can also open a clip from the Timeline into the Source Viewer to perform trimming in different 
ways. You can do this in one of two ways:

 — Double-click a clip in the Timeline to open it into the Source Viewer.

 — Move the playhead over a clip in the Timeline, press Shift-V to select that clip, and then press the 
Return or Enter key to open it into the Source Viewer.

Once you open a clip into the Source Viewer, the Source Viewer has focus, enabling you to use the 
Spacebar or JKL commands to move the playhead around in the Viewer in order to make edits. How 
these edits affect the Timeline depends on whether you use the Selection tool or the Trim tool.

TIP: To instead open a match frame of a clip in the Timeline using the pointer, hold the 
Option key down while double-clicking a clip.

Using the Selection Tool
When the Selection tool is selected, you can drag the In and Out markers, or use the playhead and I 
and O keyboard shortcuts to resize that clip in the Timeline.

(Left) A Timeline clip opened in the Source Viewer, (Right) resizing the clip 
and leaving a gap by dragging its In point in the Source Viewer

Using the Trim Tool
When the Trim tool is selected, dragging the In and Out points, or setting new ones using the I and O 
keys resizes the clip while rippling the Timeline left or right as necessary.
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Doing a Slip Edit in the Viewer
If you hold the Shift key down while dragging the In or Out point of a timeline clip you’ve opened 
in the Source Viewer, you’ll move both the In and Out points together, doing a slip edit of that clip’s 
content in the Timeline. This works using either the Selection or Edit tools.

Shuffle/Swap Insert Edits
A Shuffle Insert edit (sometimes referred to as a Swap Insert edit) lets you quickly rearrange one or 
more selected clips in the Timeline simply by Command-Shift dragging them to the left or right. When 
you do so, the surrounding clips automatically move to the right or left to switch places with the clip 
or clips that you’re dragging. This is a really fast way to reorder clips to try out different arrangements, 
without needing to drag clips onto multiple tracks to get them out of the way, first.

You have a lot of flexibility in how you shuffle clips around. You can select one clip, or multiple consecutive 
clips to shuffle. If you select multiple consecutive clips, they’ll move together as a single block. You can 
even select multiple consecutive clips on multiple tracks to shuffle around the Timeline as a single item.

Furthermore, you can also select clips that are part of split edits, where the audio and video In and 
Out points start or end at different frames. In this case, how other clips move in the Timeline to make 
room for the split edit clip you’re dragging depends on whether you click the video or audio portion of 
the clip to start dragging:

 — If you click-and-drag the video portion of the clip, then all clips will rearrange themselves based 
on the duration of that video item on that track, so that all video items on that track rearrange 
themselves without either overwriting one another or leaving gaps. As you drag to shuffle the 
selection through the Timeline, overlapping linked audio items will either overwrite the audio on 
neighboring clips, or leave a gap.

 — If you click-and-drag the audio portion of the clip, then all clips will rearrange themselves based 
on the duration of that audio item on that track, so that all audio items on that track rearrange 
themselves without either overwriting one another or leaving gaps. As you drag to shuffle the 
selection through the Timeline, overlapping linked video items will either overwrite the video on 
neighboring clips, or leave a gap.

Given the rules previously described, shuffling clips is really easy, and you can do so in one of two ways.

To shuffle insert clips with adjacent clips in the Timeline:

1 Turn snapping on.

2 Select one or more consecutive clips you want to shuffle.

3 Press and hold the Command and Shift keys down and drag either the video or audio portion of 
the selected clips to the left or right. 

So long as you move clips to the In or Out points of adjacent clips, they’ll automatically switch 
places with the selection of clips you’re dragging. Snapping will help make sure that you align 
clip(s) you’re dragging with previously existing edit points until dropped in the desired location.
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Before and after clip L being shuffled with clips I, K, and J in a scene to rearrange the sequence

To shuffle insert one clip into adjacent clips in the Timeline:

1 Turn snapping off.

2 Select one or more consecutive clips in the Timeline that you want to shuffle.

3 Press and hold the Command and Shift keys down and drag either the video or audio portion of 
the selected clips to the left or right. 

4 The selection of clips you’re dragging will be more easily inserted in the middle of adjacent clips 
as you drag with snapping turned off, and the cut portion of each clip will be moved into the 
gap that’s left behind by the clip(s) you’re dragging. Drop the clip into the desired location when 
you’re finished.

Before and after clip L being inserted into the middle of Clip K, which is split in half to make way for it

To shuffle insert multiple clips to another position in the Timeline:

1 Select all of the clips you want to move to another position on the Timeline. 

2 Press and hold the Command and Shift keys, and drag the clips left or right. Make sure the item 
you click to drag is on the same track as the majority of clips you’re rearranging; the item you click 
defines which track is used to guide the rearrangement of clips. 

In the following example, the video item of Clip C is selected on track V1, so as it’s dragged to the 
right, all clips on other tracks are rearranged according to the duration and location of clips B 
and C on track V1. As a result, clips on tracks other than V1 may be overwritten, or leave gaps, as 
necessary for the items on track V1 to be rearranged cleanly.
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Before and after a group of clips being shuffled to the right. The clip that 
was clicked to drag defines how all other clips will be rearranged

To shuffle insert multiple clips from the Media Pool or Source Viewer into the Timeline:

1 Either select one or more clips in the Media Pool or open a clip in the Source Viewer.

2 Press and hold the Command and Shift keys, and drag the selection from the Media Pool or 
Source Viewer into the Timeline. 

3 As you drag, the clips you’re dragging will be inserted into the Timeline at the pointer location. 
Release the mouse to finish making the edit.

Splitting and Joining Clips
In many situations you may find yourself splitting clips (adding edits) in order to separate multiple 
clips that were inadvertently baked together, or to cut up clips into sections that you’re planning on 
applying different effects to or grading differently.

Methods of splitting and joining clips:

 — To split a clip once: Drag the playhead to the frame where you want to split a clip, and press 
Command-Backslash (\) to split every clip on a track with Auto Select enabled.
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 — To split many clips: Click the Razor Edit mode button (or press B), and then click clips in the 
Timeline to split as many clips as you want.

 — To split clips using the DaVinci control panel on the Color page: Move the playhead to the 
frame you want to split, then press SHIFT UP and SPLIT/UNDO on the T-bar panel.

 — To join clips using the DaVinci control panel on the Color page: Move the playhead to the edit 
point you want to join, and press SHIFT UP and JOIN/REDO on the T-bar panel. Both clips must be 
from the same media file, and the frames to either side of the edit point need to be continuous for 
those clips to be joined.

TIP: Using the Blade Edit Mode or Split Clip command on a clip that’s currently selected 
preserves the selection on the first half of the clip after cutting.

Through Edits
When you split a clip, a through edit appears to show that you currently have an edit with continuous 
timecode running from the outgoing to the incoming half. This is called a through edit, and is 
displayed with a dotted line running along its edge so you know that it’s special.

A through edit seen in the Timeline

To eliminate a through edit, do one of the following:

 — Select it in the Timeline, and press Delete.

 — Right-click a through edit in the Timeline, and choose Delete Through Edit.

TIP: You can show an isolated list of every through edit in the Timeline by opening the 
Edit Index and choosing “Show Through Edits” in the Edit Index Option menu. Clicking any 
item in the list jumps the playhead to that through edit, making it easy to check all the 
through edits in a timeline to see if they’re necessary or not.
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Enabling and Disabling 
Clips and Tracks
As you work in the Timeline, you’ll find there are times when you want to disable clips that you don’t want 
to appear during playback, without actually removing them from the edit. For example, you may decide 
to disable superimposed clips that are positioned as insert shots in the middle of a scene because of a 
client’s notes, but you don’t want to eliminate the clips because they might change their minds.

A disabled clip on track V2

In another example, you’ve edited a series of titles on track V3, so you need to disable track V3 in its 
entirety to output a textless version of the movie as a deliverable.

When a clip or track is disabled, clips within it appear dimmed, and these disabled clips don’t appear 
in the Color page, and aren’t output to tape or rendered to disk in the Deliver page until that track is 
re-enabled first.

Track V3 is disabled, making the Timeline textless as a result

To disable/enable one or more clips in the Timeline:

 — Select one or more clips, then right-click the selection and check or uncheck Enable Clip in the 
contextual menu, or press D to toggle a clip’s enabled state. 

To disable/enable an entire track:

 — Click the track enable button.
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Copying and Pasting 
Clips in the Timeline
Clips can be cut, copied, and pasted in a variety of ways using standard keyboard shortcuts. You can 
cut or copy one clip or a selection of several, and you can also choose to copy or cut just the video or 
audio media of a clip. When pasting, you can paste to the same timeline, or to a different timeline if 
you want to move media from one to another.

Methods of doing simple cut, copy, and paste:

 — To cut one or more clips, leaving a gap: Make a selection, and choose Edit > Cut (Command-X). 
The selected clip or clips are removed from the Timeline and stored in memory for pasting.

 — To ripple cut one or more clips and ripple the Timeline to close the gap: Make a selection, 
and choose Edit > Ripple Cut (Command-Shift-X). The selected clip or clips are removed from the 
Timeline and stored in memory for pasting. All clips on tracks with Auto Select enabled will be 
rippled to the left to fill the gap left by the cut clips.

 — To copy one or more clips: Make a selection, and choose Edit > Copy (Command-C). The selected 
clip or clips are left in the Timeline, but copies are stored in memory for pasting.

 — To paste one or more clips to the same track: Move the playhead to the frame where you want 
the pasted selection to start, and then choose Edit > Paste (Command-V). By default, each copied 
clip is pasted onto the same track it was copied from. Pasted clips overwrite any clips in that track 
that are in the way. Pasted clips are automatically selected, ready for nudging left or right, or for 
other operations.

 — To paste one or more clips to a different track: Pasting clips to a different track requires a 
slightly different procedure. Move the playhead to the frame where you want the pasted selection 
to start, then either Option-click any empty area on the track you want to paste the clip(s) to or 
Option-click the Auto Select control of that track to solo that track, and then choose Edit > Paste 
(Command-V). Pasted clips overwrite any clips in that track that are in the way. Pasted clips are 
automatically selected, ready for nudging left or right, or for other operations.

Paste Insert
Another paste command, Edit > Paste Insert (Command-Shift-V), lets you paste clips that you cut 
or copied via an insert edit, so that an edit is added at the position of the playhead to clips that are 
already in the Timeline, and all media to the right of the playhead is rippled farther right to make room 
for the clip or clips being pasted. As with all other ripple edits, only clips on tracks with their Auto 
Select control turned on are affected. Pasted clips are automatically selected, ready for nudging left or 
right, or for other operations.

Cut/Copy/Paste of Partial Clip 
Segments Using In and Out Points
You can use the Timeline’s In and Out points to cut and copy partial segments of longer clips in 
various ways. This is a valuable technique for doing in-depth audio and dialog editing, although it’s 
useful for copying partial segments of any kind of clip in the Timeline.
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To cut or copy part of a clip to paste elsewhere:

1 Set In and Out points to isolate the part of the clip you want to cut or copy. You can use the Auto 
Select controls to include or omit clip segments on specific tracks while you do this.

2 Press Command-X to cut or Command-C to copy that clip segment.

3 Clear the In and Out points by pressing Option-X. Otherwise, you’ll paste the clip segment right 
back into the same place it started.

4 Move the playhead to the frame of the Timeline you want the pasted clip to start, and use the 
Paste or Paste Insert commands to paste the clip segment there. Pasted clips are automatically 
selected, ready for nudging left or right, or for other operations.

You can also use In and Out points to paste only a partial segment of a much longer clip that you’ve 
cut or copied.

To paste only part of a clip:

1 Select a clip, and press Command-X to cut or Command-C to copy that clip.

2 Set In and Out points to identify the region of the Timeline you want to paste into.

3 Use the Paste or Paste Insert commands to paste only as much of the Cut or Copied clip as will fit 
between the In and Out points you’ve placed. Pasted clips are automatically selected, ready for 
nudging left or right, or for other operations.

Copying and Pasting Clips to a Different Track
If all Auto Select controls on all tracks are turned on, clips are always pasted back to the same track 
they were copied from, starting at the position of the playhead. This is valuable for the many instances 
where you’ll find yourself copying and pasting clips you want to repeat, especially when doing 
audio editing. 

However, if you want to paste the clips you cut or copied to a different track entirely, you need to use 
the Auto Select controls to specify which track you want to paste to. 

Here are the rules:

 — You can force paste what you copied to a specific track by Option-clicking that track’s Auto Select 
control to solo it before pasting. 

 — When one or more Auto Select controls are disabled, then clips are pasted to the lowest-
numbered track with an enabled Auto Select control. 

 — If you’ve copied clips on multiple tracks, clips on the lowest copied track will be pasted to the 
lowest Auto Select enabled track, and all other clips will be pasted to higher tracks, with new 
tracks automatically created, if necessary.

 — If Auto Select is disabled on every single track, then a new track will be created above all other 
video tracks and/or below all other audio tracks, and the clip will be pasted into this new track, 
which has Auto Select turned on.
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Audio Channels When Copying 
and Pasting Audio Clips
Copying and pasting audio has one other consideration. If you’re force pasting a clip into a different 
track, the track you solo the Auto Select control of could possibly be set to an audio channel mapping 
that doesn’t match the clips you’re pasting there. An example of when this would happen is if you copy 
stereo audio clips from a stereo track and paste them to a mono audio track.

DaVinci Resolve allows you to do this, so you have the freedom of pasting audio clips to any track you 
want to. However, extra audio channels within clips that exceed the number of channels supported by 
the audio track they’re on will be muted. Fortunately, this situation is easy to rectify. Simply right-click 
the track header of the problem audio track, and use the Change Track Type To submenu to change its 
channel mapping to one more appropriate to the clips you’ve pasted into it.

Auto Align Clips
Auto Align Clips slides one or more selected clips to align with the timecode or audio waveforms of 
another clip that has matching timecode or audio. This function works for video clips, which can be 
aligned using timecode, and for audio clips, which can be aligned using either timecode or waveform 
matching. Waveform matching can also be used if you’re working with audio/video clips. 

You can only select one clip per video or audio track to align, and they all will align to whichever clip 
is on the lowest-numbered video or audio track. Clips selected that have no overlapping timecode or 
audio waveform will not be moved and left in their original position on the Timeline.

For example, clip A on track V1 overlaps with clip B on track V2, but not with clip C on track V3, or clip D 
on track V4. Selecting all clips and using Auto Align Edits will slide clip B to align with clip A, but clips C 
and D won’t be moved because they don’t overlap with clip A.

The original Timeline with clip A (blue) and clip B (orange) that 
have some overlapping audio but are out of sync 
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The same Timeline after the Auto Align command; clip B (orange) has been slipped to 
sync via audio waveform with clip A (blue). Clips C (tan) and D (green) were also selected, 
but because they had no overlapping timecode or audio, they remained in place. 

In another example, clip A on track V1 overlaps with clips B, C, and D on tracks V2, V3, and V4 
respectively. Selecting all clips and using Auto Align Edits will slide clips B, C, and D to be aligned 
with clip A.

The original Timeline with clip A (blue), and clip B (orange), C (tan), and 
D (green) all have overlapping audio, but are out of sync.

The same timeline after the Auto Align command. All clips are now in sync and the audio waveforms now 
all match. All the other clips moved to clip A’s (blue) position because it was the lowest clip on the Timeline.
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To use Auto Align clips:

1 Arrange the clips you want to align with one another on the Timeline so that there’s one clip per 
track. All clips will sync to the clip on the lowest track number. All clips must have overlapping 
timecode or audio waveforms.

2 Select every clip that you want to align (only one per track).

3 Right-click one of the selected clips, and choose an option from the Auto Align Clips submenu, 
either “Based on Timecode,” or “Based on Waveform.” 

If Timecode is selected, the operation will be instant. If Waveform is used, a progress bar will appear 
showing you how long it will take DaVinci Resolve to analyze the selected audio waveforms before your 
clips are aligned. If you’ve selected clips that can’t be aligned, a warning box will appear and tell you 
which clips had errors.

For video, this can be useful for multi-camera editing situations where you want to align an insert 
with the action of an alternate angle. For audio, this is useful for situations where you have multiple 
recordings of the same audio that you want to align for further editing. 

NOTE: Waveform matching won’t work for re-recorded audio, such as dialog that’s been 
re-recorded using the ADR tools of the Fairlight page, as the correspondence between two 
waveforms must be precise for a match to be found.

Duplicating Clips and 
Transitions in the Timeline
One or more clips can be duplicated by making a selection, and then Option-dragging the selected 
clips to another position and/or track in the Timeline. When duplicating clips in this way, you must hold 
the Option key down until you release the mouse button.

Individual selected transitions can also be duplicated by Option-dragging them to another edit point.

Smart Reframe (Studio Version Only)
The Smart Reframe feature in DaVinci Resolve makes it easier to quickly reframe material across 
extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and 
find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media 
deliverables, or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used 
manually, or automatically executed using the DaVinci Resolve Neural Engine.

745Edit | Chapter 38 Modifying Clips in the Timeline



Smart Reframe in action, with the Reference Point bounding box active (right)

The Smart Reframe tool is found in the Sizing tab of the Inspector and is available in both the Cut 
and Edit pages.

To use the Smart Reframe tool:

1 Duplicate your timeline, right-click the Timeline and choose Timelines > Timeline Settings, and click 
Use Custom Settings to change the Timeline Resolution to the aspect ratio needed for delivery. 
Make sure that “Mismatched resolution files” is set to “Scale full frame with crop,” and click OK. 

2 Select one or more clips you want to reframe, and open the Inspector to the Sizing tab.

3 Open the Smart Reframe controls, leave the Object of Interest drop-down menu set to Auto (if 
you’ve selected more than one clip, Auto is the only setting available), and click “Reframe.” DaVinci 
Resolve will analyze your footage and should automatically adjust each individual clip’s position to 
a more aesthetically pleasing framing. 

4 (Optional) If the “Auto” setting does not give you desirable results for a particular clip, you can 
manually select the main subject using the following steps.

a) To manually select the subject area, choose “Reference Point” from the Object of 
Interest drop-down menu, and click the target icon just to the right of the menu. This 
automatically sets the Viewer mode to Smart Reframe, exposing the onscreen controls for 
choosing a reference.

b) Drag the Reference Point bounding box around the main subject of interest in the frame. You 
may use the Transform controls directly above in the Inspector to move the source clip around 
if your subject is outside the current framing. 

c) Click “Reframe.”

The Inspector’s Smart Reframe controls 
showing the manual reference point selected

DaVinci Resolve locks onto and, if necessary, tracks your subject using the reference you’ve 
selected, automatically panning and scanning the original clip as needed to keep the reference 
within the new aspect ratio. While involving a bit of manual adjustment, this function still 
dramatically reduces the time involved in pan and scanning footage by manually adjusting and 
keyframing the sizing controls.
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Scene Cut Detection on the Timeline  
If you need to break down a previously edited video into its component clips for re-editing or color 
correction, you can do so directly in the Timeline. Using the DaVinci Neural Engine, DaVinci Resolve 
can automatically analyze and split up an edited video into individual clips.

Timeline Scene Cut Detection is also available in the Cut page. If you prefer, you can continue to use 
the original Scene Cut Detection tool found in the Media Pool.

To use Scene Cut Detection on the Timeline:

1 Select one or more clips you want to split on the Timeline. Alternately, you can limit Scene Cut 
Detection to just a portion of a clip by setting In and Out points on the Timeline around the 
section you want to analyze.

2 Choose Timeline > Detect Scene Cuts.

A dialogue box appears, “Detecting scene cuts in clips x of x.” This process can take some time, 
depending on the length, number, and complexity of the clips you’ve selected. When the Scene 
Cut Detection has finished, the clip you selected will be broken up into a number of through edits 
that now can be used as independent clips. 

Checking and Fixing Your Results
If the Neural Engine has made an error, you can fix it manually by navigating to the cut using the Up 
and Down Arrow keys to go back and forth in the Timeline, and by then doing one of the following:

 — To remove a Cut: Click the through edit to select it, and press the “Delete” key.

 — To make a New Cut: Place the timeline indicator at the cut point, and choose Timeline > 
Split Clips (Command-\).

A single clip of a finished edit, consisting of multiple cuts before the Detect Scene Cuts command

Multiple individual clips extracted from the edited clip via Detect Scene Cut; the operation has been 
contained by the In and Out points, and one of the resulting through edits has been highlighted in green.
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Clean Up Video Tracks
While it’s convenient to be able to edit overlapping clips on multiple video tracks to try slipping clips 
back and forth, or to stack multiple takes or versions of a VFX clip, there comes a time when all those 
unnecessary clips take a toll on the visual organization of your timeline, not to mention your colorist’s 
sanity. For this reason, a trio of commands for cleaning up your timeline have been added to the 
Timeline > Clean Up Video Tracks menu. These are:

 — Flatten Unused Clips: All superimposed clips with In and Out points that are aligned with clips 
below them are moved down to track V1, so long as they don’t have any kind of opacity, composite 
mode, transition, or fade effect applied to them making them a compositing effect.

 — Disable Unused Clips: All clips that are underneath superimposed clips that don’t have any kind 
of opacity, composite mode, transition, or fade effect applied to them are disabled.

 — Change Unused Clips Color: All clips that are underneath superimposed clips that don’t have 
any kind of opacity, composite mode, transition, or fade effect applied to them have their color 
changed to whatever you select.

(Top) The original timeline, (Bottom) The Flatten Unused Clips command is 
used to move superimposed clips with In and Out points that match other clips 
underneath them to track V1 to simplify the Timeline for future work
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Chapter 39

Three- and 
Four-Point Editing
A more controlled form of editing is to use three- and four-point 
editing to make a specific range of source media fit into a specific 
range of the Timeline. 

This chapter covers the basics of three- and four-point editing, as well as the wide variety of edit 
commands that are available.
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Keyboard Shortcuts in This Chapter
Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

Key Shortcut Function

Command-1 Choose Media Pool Bin list

Command-2 Choose Media Pool browser area

Arrow Keys
Move selection in the Media Pool Bin list or browser area 
to choose a bin or clip

Return or Enter Open selected clip or timeline into the Source Viewer

Q Toggle focus between Source and Timeline Viewers

I, O Set In or Out point

Shift-I, O Move playhead to In or Out point

Option-I, O Delete In or Out point

Shift-A
Set In and Out points to match the current clip selection in 
the Timeline

X
Set In and Out points to fit the current clip at playhead in 
the Timeline

Option-X Delete both In and Out points

Command-Shift-Up, Down Arrow
Move video destination control up or down to 
another track

Command-Option-Up, Down Arrow
Move audio destination control up or down to 
another track

Option-1 through 8
Set video destination control to that track number; 
press again to enable/disable

Command-Option-1 t horugh 8
Set audio destination control to that track number; 
press again to enable/disable

Option-F1 through F8 Toggle video auto-select for that track number

Option-F9 Toggle all video auto-select controls off or on

Option-Command-F1 t hrough F8 Toggle audio auto-select for that track number

Option-Command-F9 Toggle all audio auto-select controls off or on

Option-Shift-Q
Toggles “Switch to timeline after edit,” to set whether focus 
stays on the Source Viewer or switches to the Timeline 
after you make an edit; on by default

F9
Insert Edit selected clip(s) from Media Pool or 
Source Viewer to the Timeline
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Key Shortcut Function

F10
Overwrite Edit selected clip(s) from Media Pool or 
Source Viewer to the Timeline

F11
Replace Edit the first of selected clip(s) from Media Pool or 
Source Viewer to the Timeline

F12
Place On Top Edit from Media Pool or Source Viewer to 
the Timeline

Shift-F10
Ripple Overwrite from Media Pool or Source Viewer to 
the Timeline

Shift-F11 Fit to Fill from Media Pool or Source Viewer to the Timeline

Shift-F12
Append To End Edit from Media Pool or Source Viewer to 
the Timeline

Undo Command-Z

Redo Command-Shift-Z

Introduction to Three-Point Editing
Three-point editing is a standard editorial method that’s shared with many other post-production 
applications, so this procedure should feel familiar. The idea is that you need only set any combination 
of three In and Out points in the source clip and Timeline to edit a clip into your program at a specific 
time, and DaVinci Resolve automatically figures out the fourth edit point that’s necessary to execute 
the edit. Three-point editing is most commonly accomplished using overwrite and insert edits.

Choosing a Track to Edit and 
Using Destination Controls
The orange destination controls, found in the Timeline header area, let you specify which video and 
audio tracks you want incoming source clips to be edited to when you use editing methods other than 
drag and drop. No matter how many video or audio channels may be embedded within a single clip of 
media, only one video and one audio destination control is available. In the case of video, you can only 
expose one video channel of a clip at a time. In the case of audio, all audio channels for a given clip are 
embedded within a single Timeline track, making it a snap to edit stereo or other multi-channel audio 
sources together. For more information about working with audio, see Chapter 44, “Working with Audio 
in the Edit Page.”

Setting the destination control of a track is a vital step in the process of creating an edit and is easy to 
do. You can set the video and audio destination controls to be separate tracks.
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To assign the destination tracks of incoming source clips, do one of the following:

 — Click the destination control of any unassigned track to enable that track as the destination.

 — Drag the destination control to any unassigned track in the Timeline.

 — Press Command-Shift Up Arrow and Down Arrow to move the Video destination control up and 
down among different video tracks, or press Command-Option Up Arrow and Down Arrow to 
move the Audio destination control up and down among different audio tracks.

 — Press Option-1 through 8 to set a video destination, or press Option-Command-1 through 8 to set 
an audio destination on tracks 1 through 8.

 — Press Option-Command-9 to set the audio destinations to all tracks.

Moving the destination 
control to track V2, 
labeled “Titles”

You can also disable the Video or Audio destination controls in situations where you want to edit a 
source video clip into the Timeline without its audio, or vice versa.

To disable or reenable a destination control, do one of the following:

 — Click an already assigned destination control to toggle it off and then on again. 

 — Pressing the “assign destination control” repeatedly for a given track (Option 1-8 for video, 
Option-Command-1-8 for audio) toggles the destination track on and off.

Disabled destination controls are highlighted gray.

A disabled 
destination control
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Setting In and Out Points 
in the Timeline
When you’re setting up an edit to the Timeline, you can oftentimes get away with simply putting the 
Timeline playhead at the frame where you want to edit the incoming source clip. In the absence of In 
or Out points, the playhead is used as the In point. However, you can set up different kinds of edits by 
setting specific In and Out points to define different ranges of the Timeline.

Methods of setting and clearing In and Out points in the Timeline:

 — To set an In or Out point: Select the Timeline or Timeline Viewer by clicking or pressing the 
Q key, then use the transport controls, jog bar, or control panel buttons to move the playhead, 
and press the I key to set an In point, or the O key to set an Out point.

 — To clear In or Out points: With the Timeline Viewer selected, press Option-I to clear the current 
In point, or Option-O to clear the current Out point.

 — To clear both the In and Out points at once: Press Option-X.

´In and Out points 
shown in the Timeline, 
with unmarked 
areas outside the 
selection dimmed

Methods of moving In and Out points in the Timeline:

 — Move the playhead, and then press the I or O keys to change the In or Out points to the new 
position of the playhead.

 — Drag any In or Out point in the Timeline ruler to another position.

The area of the Timeline outside the region that’s currently defined by In and Out points is dimmed, to 
call attention to the portion of the Timeline that will be affected by the next edit you’ll make.

To move the playhead to an In or Out point in preparation for making an adjustment:

 — Press Shift-I to immediately move the playhead to the current In point, or Shift-O to move the 
playhead to the current Out point. 

The Go to In and Go to Out commands are capable of placing the playhead at the implicit (but 
unmarked) In and Out points defined by a three point edit you’re setting up, even when Preview Marks 
have not been enabled. For example, if you mark In and Out points in the Timeline, and you then mark 
an In point for a clip in the Source Viewer, pressing Shift-O (Go to Out) automatically moves the Source 
Viewer playhead to the frame that will be the Out point of that clip were you to execute this edit.
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In and Out points set 
in the Timeline and 
an In point set in the 
Source Viewer set up 
a three point edit

Using Go to Out to 
move the Source Viewer 
playhead to the implicit 
Out point defined by 
a three point edit
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Mark Clip and Mark 
Current Selection
These commands are automatic ways of setting In and Out points in the Timeline both at once, using 
the timing of other clips. They’re both exceptionally handy for defining the range of an incoming edit 
using clips that are already in the Timeline that you want to replace, or gaps in the Timeline that you 
want to fill. 

In short, Mark Clip uses the first and last frame of a target clip or gap in the Timeline to automatically 
set Timeline In and Out points for editing. For example, if there’s a shot in an edit that you want to 
replace with a different take of the same action, or there’s a gap in a sequence of clips that you’d like 
to quickly fill with B-roll, you can use the Mark Clip command to help set this up.

Mark Current Selection uses the first and last frames of a range of selected clips to automatically 
set Timeline In and Out points for editing. A good example is when you have a series of clips in the 
Timeline, all of which you’d like to overwrite with a single incoming source clip, you can use the Mark 
Current Selection command.

To use Mark Clip:

1 Move the playhead to intersect either a clip you want to use to set In and Out points, or a gap 
(empty area) between two other clips that you want to target. The playhead can be on any frame 
of this clip, it doesn’t matter which.

Positioning the 
playhead at a clip 
you want to mark

2 If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target to set the In and Out 
points. If you want to target a clip on a higher track, then either disable the Auto Selection controls 
of all timelines underneath, or Option-click the Auto Selection control of the track with the clip 
you’re targeting to solo it, which will force that track to be the target of this operation.

3 Press the X key to automatically set In and Out points that match the first and last frames of the 
target clip.
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Using Mark Clip to set 
In and Out points that 
match a clip’s duration

TIP: To clear both In and Out points, press Option-X, which is 
the opposite of this command.

To use Mark Selection:

1 Select one or more clips in the Timeline.

Selecting clips you 
want to use as a 
range to mark In 
and Out points

2 Press Shift-A to automatically set In and Out points that match the first and last frames 
of the selection. A range of discontinuous clips will produce the same result as a range of 
continuous clips.

Marking a selection to 
set In and Out points

TIP: You can also mark gaps in the Timeline with Mark Selection.
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Preview Marks During 
Three-Point Editing
In order to help you see what will happen whenever you execute a three-point edit, preview marks 
appear in either the Source Viewer or the Timeline Ruler to let you know the exact duration of the 
Timeline that’s about to be affected by the edit you’re preparing to make. To prevent them from being 
a distraction, preview marks only appear once you’ve explicitly marked three edit points in the Source 
Viewer and Timeline, and they can be turned on and off by choosing View > Show Preview Marks.

For example, if you set In and Out points in the Source Viewer, and an In point in the Timeline, then a 
preview marker will appear in the Timeline Ruler to show the implied Out point in the Timeline of the 
edit you’re about to make.

A preview marker in the Timeline shows the Timeline Out point being automatically calculated by 
DaVinci Resolve based on the In and Out points that are set in the Viewer, and the In point in the Timeline

On the other hand, if you set both In and Out points in the Timeline, and only an Out point in the 
Source Viewer, a preview marker appears in the jog bar of the Source Viewer to show you the implied 
In point, in the Source Viewer, of the edit you’re about to make.
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A preview marker in the Source Viewer shows the Source Viewer In point being 
automatically calculated by DaVinci Resolve based on the In and Out points 
that are set in the Timeline, and the In point in the Source Viewer

If you like, you can move the playhead to the position of the preview mark by using Shift-I if the 
preview mark is an In point, or Shift-O if the preview marker is an Out point.

Dragging Preview Marks to Change an Edit
You can drag preview marks to alter the edit you’re about to make. When you drag a preview mark, 
the corresponding In or Out point that’s opposite the Viewer with focus is altered to accommodate 
the new three-point edit you’re setting up. For example, if you have an In point in the Source Viewer, 
and In and Out points set in the Timeline, a preview mark appears in the Source Viewer to show the 
Out point that will be used to edit the clip in the Source Viewer into the Timeline. However, you can 
drag this preview mark to the left in the Source Viewer, and the result will be that the Out point in the 
Timeline will move along with it, since you’re retiming the edit.
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Dragging a 
preview mark in 
the Source Viewer 
changes the 
opposite edit point 
in the Timeline

The Rules of Three-Point Editing
In the previous examples, three-point editing was being used by virtue of source In and Out points 
being set to define a range of the source clip to be edited into the Timeline, and the Timeline playhead 
being used as the acting Timeline In point; three points defined the edit to be made. However, three-
point editing is also very useful when you need to overwrite sections of a previously edited timeline 
with new source clips in a controlled manner, such as when adding an insert shot to a scene to cover a 
particular change you’re making that would break continuity.

Depending on the combination of Source and Timeline In and Out points you set, the following rules 
govern three-point editing:

 — If there is no In point in the source clip: The first frame of media will be used as the acting 
source In point. This can be seen by the thick bar that extends to the left of the Out point in the 
Source Viewer’s jog bar.

A thick bar indicates which part of the source clip will be used in the absence of a Source In point

 — If there is no Out point in the source clip: The last frame of media will used as the acting source 
Out point. This can be seen by the thick bar that extends to the right of the In point in the Source 
Viewer’s jog bar.

A thick bar indicates which part of the source clip will be used in the absence of a Source Out point

 — If there are no In or Out points in the Timeline: The playhead will be used as the acting 
Timeline In point. 
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 — If you set a Timeline In point but no Timeline Out point: The whole range from the In to Out 
points of the source clip is edited into the Timeline such that the Source In point is aligned with 
the Timeline In point. This can be seen by the thick bar that extends to the right of the In point in 
the Timeline Ruler.

A thick bar indicates where the Source clip will be edited in the absence of a Timeline Out point

 — If you set a Timeline Out point but no Timeline In point: The incoming source clip will be 
backtimed so the Out point of the source clip is aligned with the Timeline Out point. This can be 
seen by the thick bar that extends to the left of the Out point in the Timeline Ruler.

A thick bar indicates a backtimed edit in the absence of a Timeline In point

 — If you set Timeline In and Out points but only a Source Out point: In this case, the incoming 
source clip will also be backtimed so the Out point of the source clip is aligned with the Timeline 
Out point, with the Timeline edit points defining the duration of the source clip being edited.

 — If you set all four Source In and Out and Timeline In and Out edit points: The Timeline edit 
points dictate the duration of source clip that is edited into the Timeline, and the frame at the 
Source In point is aligned with the Timeline In point, unless you perform a Fit to Fill or ripple 
overwrite edit, both of which can be done as four-point edits.

TIP: If you want to use all four Source and Timeline edit points to retime a source clip to fit 
into a specific range of the Timeline, use a Fit to Fill edit instead of an overwrite edit.

Editing Rules for Split In and Out Points
If you’ve created split In and Out points in the Source Viewer or Timeline, the following rules apply:

 — If the Source Viewer has split In and Out Points: The leftmost split point of the incoming clip, 
whether video or audio, will be aligned with the playhead when the clip is edited; the other split 
point will be offset to the right.

 — If the Timeline has split In and Out Points: The In point of the incoming clip will be aligned with 
the leftmost split point, whether video or audio; the accompanying audio or video In point will be 
offset to the split point to the right.
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Editing a Specific Range of the 
Source Clip Into the Timeline
This section provides some common examples of three-point editing when performing edits in the 
middle of a previously edited timeline. In the following example, you have a specific range of source 
media that you need to edit into the Timeline, and you don’t particularly care what gets overwritten in 
the Timeline by the incoming clip.

1 Set In and Out points in a source clip, either in the Media Pool or in the Source Viewer.

Setting source 
clip In and 
Out points

2 To set where you want the incoming clip to go, set the destination control to the tracks you want 
to edit onto, and then do one of the following:

 — Move the Timeline playhead to the frame you want to use as the Timeline In point for the edit.

 — Set a Timeline In point for the edit.

Using the 
playhead to act as 
a Timeline In point

3 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

The resulting 
edit; the duration 
of the source 
clip defines the 
duration of the edit
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Editing Part of a Source Clip to Fit Into 
a Specific Range of the Timeline
In this example, you have a section of a clip or a gap in the edited sequence of clips in the Timeline 
that you want to fill with as much of the current source clip as it will take to “plug the hole.”

1 Set an In point in the source clip, if necessary, to define the first frame of the range of source 
media that you want to edit into the Timeline.

Setting a source 
clip In point only

2 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and how 
much of the incoming clip you want to use.

Setting both In 
and Out points 
of the Timeline 
for a gap

3 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

The resulting edit; 
the duration of 
the Timeline edit 
points define how 
much of the source 
clip is edited
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Backtiming a Source Clip When 
Editing Into the Timeline
In this last example, you’ve got a specific moment in the second half of a source clip that you need 
to align with an Out point in the Timeline, such that the remaining duration of the incoming clip 
overwrites the edited sequence of clips from the right to the left. This is referred to as backtiming, 
when you’re lining up a Source Out point with a Timeline Out point in order to make an edit, and can 
be set up one of two ways.

Backtiming method one:

1 Set In and Out points in the source clip, either in the Media Pool or in the Source Viewer.

2 Set an Out point in the Timeline, at the frame where you want the corresponding Out point of the 
incoming source clip to be aligned.

Setting up a backtimed match-on-action edit via In and Out points in 
the Source Viewer, and only an Out point in the Timeline

3 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip 
onto the overwrite overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline

Backtiming method two:

1 Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and how 
much of the incoming clip you want to use.
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Setting up a backtimed edit by setting an Out point in the Source Viewer, and 
In and Out points in the Timeline to define the duration of the edit

3 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline

Switch Focus to Timeline After Edit
A setting in the Edit menu, “Switch focus to timeline after edit” (Option-Shift-Q), lets you set whether 
or not DaVinci Resolve changes the application focus from the Source Viewer to the Timeline Viewer/
Timeline every time you make an edit. This setting is on by default.

For example, if you’re assembling clips from many different source files into the Timeline, and 
trimming the results as you go, leaving this option on may save you time. In this case, after every edit, 
the focus switches from the Source Viewer to the Timeline, so you can quickly select the clip or edit 
point you want to trim and make your adjustments before loading the next clip into the Source Viewer 
in preparation for the next edit.

On the other hand, if you’re editing several pieces from a long interview clip into the Timeline, you may 
want to turn this setting off to make it easy to continue playing forward in the Source Viewer, setting 
In and Out points and editing clips into the Timeline as you go. After every edit, focus remains on the 
Source Viewer, so you can continue making edits from the same source clip without interruption.
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Different Types of 
Three- and Four-Point Edits
This section covers the different types of edits that are available for cutting source clips into the 
currently open Timeline.

Overwrite Edits
The most common type of edit you’ll make, an overwrite edit eliminates whatever media was in the 
Timeline previously with the incoming source clip taking the place of whatever was there. Overwrite 
edits are commonly used when initially assembling clips, or doing three-point editing.

Overwrite edits do not ripple the Timeline.

To overwrite one or more clips in the Timeline:

1 Move the playhead to the frame of the Timeline where you want to insert a clip.

2 Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3 Select a single clip in the Media Pool to open it into the Source Viewer, then set In and Out points 
to define the range of media you want to insert.

4 To make the edit, choose Edit > Overwrite, click the Overwrite Clip button in the toolbar, press the 
F10 key, or drag a clip onto the Overwrite overlay in the Timeline Viewer.

Before and after an overwrite edit, the Timeline duration stays the same

The selected clips in the Media Pool are overwrite edited to the selected track starting at the position 
of the playhead, eliminating whatever was there originally while adding incoming clip. No other clips 
are rippled during this operation.
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Insert Edits
An insert edit splits whatever media is already in the Timeline at the position of the playhead, and 
pushes that media to the right to make room for the incoming clip.

Insert edits have the effect of rippling almost all clips in the Timeline that are to the right of the insert 
edit point you’re making, pushing them farther to the right by the duration of the incoming source 
clip. However, clips in any tracks of the Timeline that overlap to the left of the insert edit point aren’t 
rippled, and remain in place.

For example, if you’re insert editing a clip into the middle of a sequence of clips in track V1 and A1 of 
the Timeline, and there’s also a clip of music edited into track A2 that overlaps well to the left of the 
insert edit point, the music clip remains where it is, but the other clips on track V1 and A1 that are to 
the right of your edit point on are pushed to the right.

To insert edit one or more clips into the Timeline:

1 Move the playhead to the frame of the Timeline where you want to insert a clip.

2 Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3 If necessary, set In and Out points in the clip or clips you want to insert edit into the Timeline using 
the controls of the Media Pool or the Source Viewer.

4 Do one of the following:

 — Select one or more clips in the Media Pool, right-click one of the selected clips, and choose 
“Insert Selected Clips to Timeline.” 

 — Choose Edit > Insert, click the Insert Edit button in the toolbar, press the F9 key, or drag any 
clip onto the Insert overlay in the Timeline Viewer.

The selected clips are insert edited to the selected track at the position of the playhead, pushing 
all other media in the destination track back by the total duration of the selected clips, except for 
clips on other tracks that overlap to the left of the edit point (as seen by the overlapping music clip 
in the example below).

Before and after an insert edit, the Timeline gets longer as non-overlapping 
clips to the left of the edit point are rippled to the right
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Replace Edits
Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer playhead 
with the frame at the Timeline playhead when the edit is executed. This is the fastest edit type to use 
when you need to align an action at a specific frame of video, or a sound at a specific frame of audio, 
to a particular frame’s action or sound in the video or audio of the Timeline.

The fastest way of using the replace edit is to not bother setting either In or Out points in the Source 
Viewer, and to either use the duration of an existing clip intersecting the Timeline to define the edit, or 
a pair of timeline In/Out points specifying either a section of a clip you want to overwrite, or an empty 
section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

Replace Edits to Replace Existing Clips in the Timeline
A replace edit automatically replaces an existing clip in the Timeline with a clip in the Source Viewer, so 
long as that clip overlaps the playhead and is on a track with its destination control enabled. When you 
make a replace edit in this way, DaVinci Resolve automatically uses the duration of the Timeline clip to 
define the duration of the incoming media, and the positions of the Viewer and Timeline playheads 
to line up how the incoming media should be placed. This is an extremely fast edit to make, since you 
needn’t use any In or Out points at all.

To replace a clip in the Timeline:

1 Move the playhead in the Timeline to the clip that you want to replace, and align it with a frame 
that you want to line up with a frame in the clip you’ll be replace editing into the Timeline.

2 Click the appropriate audio and video destination controls of the track containing the 
clip you want to replace.

3 Open a clip into the Source Viewer.

4 Move the playhead in the Source Viewer to the frame that you want to line up with the frame at 
the position of the playhead in the Timeline.

In the Source Viewer to the left is a VFX clip we want to edit into the Timeline to 
replace the existing Timeline clip, shown in the Timeline Viewer at right
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In the example shown above, the original clip that was shot on location of a car driving past a 
slab of real concrete (shown in the Timeline Viewer at right) is going to be replaced by a VFX shot 
of a concrete wall with a small hole for the car to drive through (shown in the Source Viewer at 
left). The playhead in the Source Viewer is aligned on the very same frame as the playhead in the 
Timeline Viewer, which can be seen by the identical position of the white stripe on the road in the 
lower right-hand corner of the picture.

5 Now that the playheads are aligned on the frames that must match one another in both the 
Source and Timeline Viewers, choose Edit > Replace, click the Replace Clip button in the toolbar, 
press F11, or drag any clip onto the Replace overlay in the Timeline Viewer.

The resulting replace edit, in which the original timeline clip is replaced by 
the incoming Source Viewer clip by aligning the frames at each playhead

The camera original clip in the Timeline is now replaced with the VFX source clip from the 
Media Pool, with the source frame at the Source Viewer playhead aligned with the frame at the 
Timeline playhead.

Replace Edits to Edit Clips Into Empty Tracks
You can also use a replace edit to edit a clip into an empty track of the Timeline so that the frame at 
the position of the Source playhead is aligned with the Timeline playhead, and the In and Out points of 
the incoming clip fall where they may. This is useful when you want to “spot” a particular action of an 
alternate take or a cue in a sound effect to a specific frame of the Timeline.

To use replace edit to spot a sound effect or action video clip into the Timeline:

1 Move the playhead in the Timeline to the clip that contains the moment you want to align the new 
incoming audio or video clip with, and position it on the exact frame that you want to line up with 
a frame of the clip you’re going to edit into the Timeline.

2 Click the appropriate audio and video destination controls of the empty track you want to edit the 
incoming clip into.

3 Open a clip into the Source Viewer.

4 Move the playhead in the Source Viewer to the frame that you want to line up with the frame 
at the position of the playhead in the Timeline. This may be the sample of a sound effect that 
corresponds to the action in a particular frame of your program’s video, or a frame of video that 
corresponds to a particular sound in your program’s audio.

In the example shown below, the beginning of an audio cue of a billiard ball being hit is being 
lined up with the frame in which the cue ball is first hit in the video.

5 If necessary, set In and Out points in the Timeline to restrict how much of the incoming clip will be 
edited. Otherwise, the entire source clip will be edited into the Timeline.
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In the Source Viewer to the left is an SFX clip we want to edit into the Timeline to 
match the visuals of a cue ball being hit, shown in the Timeline Viewer at right

6 Now that the playheads are aligned on the frames that must match one another in both the 
Source and Timeline Viewers, choose Edit > Replace, click the Replace Clip button in the toolbar, 
press F11, or drag any clip onto the Replace overlay in the Timeline Viewer.

The resulting replace edit, 
in which the incoming 
Source Viewer clip is aligned 
perfectly with the video

The SFX source clip has now been edited into the specified audio track, with the source frame at 
the Source Viewer playhead perfectly aligned with the frame at the Timeline playhead so that the 
cue ball hit is in sync with the visuals.

Replace Edit Using Clips Already in the Timeline
To facilitate workflows where multiple clips are stacked in the Timeline to manually track different 
takes or versions of stock footage, VFX clips, or other versionable media, there’s a method of drag 
and drop replace editing that copies the grade of the clip being replaced to the clip you’re replacing 
it with at the same time, so that newer versions of effects can inherit the same grade as the previous 
version of the effect being replaced. This only works for clips that have already been edited into the 
Timeline and that are superimposed (over or under) other clips in the Timeline, such as in the following 
screenshot. Be aware that this technique can also be used for multiple selected clips on the Timeline 
to do several replace edits all at once.
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(Left) Before replace 
editing a clip in the 
Timeline, (Right) After  
Command-dragging a 
clip over one under it in 
the Timeline to replace 
edit the one below 
with the one above

To replace edit one clip that’s stacked on the Timeline into another:

1 Select one or more clips that are already on the Timeline. Typically these will be clips that are 
superimposed over other clips.

2 Hold the command key down while dragging one superimposed clip on top of another to 
overwrite a clip and copy its grade to the clip you’re overwriting it with.

NOTE: This won’t work with clips you’re editing into the Timeline from the Media Pool or 
Source Viewer.

Fit to Fill
Fit to fill edits are the only edit type that actually use all four edit points, and it’s the only edit type that 
retimes clips at the same time as they’re being edited. By setting In and Out points in the incoming 
source clip, and another pair of In and Out points in the Timeline, you can stretch or compress the 
timing of the specified range of source media to cover the entire specified range of the Timeline. In 
the process, the speed ratio of the clip changes so the clip plays in either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly slow, 
and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also 
incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source 
clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit to fill edits do not ripple the Timeline.

To use fit to fill to edit a clip into the Timeline:

1 Do one of the following to define where in the Timeline to edit the incoming clip:

a) You can set both In and Out points in the Timeline, to define the duration you want to fill with 
the incoming source clip as a three-point edit.

b) You can clear the Timeline In and Out points (pressing Option-X), so that you can instead use 
the duration of whichever clip or gap intersects the playhead on the track with the destination 
controls assigned to them. In the following screenshot, the clip can easily be edited to take the 
place of the gap by positioning the playhead anywhere within it. 
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Setting timeline In and Out points to mark a gap

2 Next, you’ll need to set both In and Out points in the Source Viewer to define a longer or shorter 
source clip that you want to fill into the available space. In this example, we have a very short 
section of the source clip defined that, because of the matching action in the Timeline, must be fit 
into the larger gap seen above.

Setting In and Out points in a source clip to define a shorter duration 
segment that you want to completely fill the gap

3 Click the audio and video destination controls of the tracks you want to edit the incoming source 
clip onto. If necessary, create new tracks.

4 Choose Edit > Fit to Fill, drag any clip onto the Fit to Fill overlay in the Timeline Viewer, 
or press Shift-F11.

The resulting edit; the shorter source clip is retimed to fit into the longer timeline gap

The incoming source clip is retimed, as necessary, to fit into the specified duration of the Timeline. 
This can be seen by the retiming badge that appears within the clip that’s just been edited into 
the Timeline.

Place on Top
Place on top edits automatically superimpose clips onto the first empty track above (for video clips) 
or below (for audio clips) any other clips in the Timeline that either intersect the playhead or fall in 
between the currently set Timeline In and Out points, regardless of the current track specified by 
the destination controls. It’s designed to make it easy to superimpose titles and other clips you want 
to composite over another clip, or to add additional versions of clips such as VFX on top of previous 
versions that you want to preserve.
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Place on top edits create new timeline tracks if necessary, and do not ripple the Timeline.

To use place on top to edit a clip into the Timeline:

1 To choose where in the Timeline the clip will be “placed on top,” do one of the following:

Move the playhead to intersect the clip you want to edit the incoming source clip on top of.
Set In and Out points in the Timeline to define the duration within which you want to place the 
incoming source on top.

2 Set In and Out points in a source clip that you want to edit.

3 Choose Edit > Place on Top, drag any clip onto the Place on Top overlay in the Timeline Viewer, 
or press F12.

Before and after using place on top, the incoming text generator is 
superimposed to a track above the clip at the position of the playhead

Incoming video clips will be edited to the topmost video track so they are above any previously 
existing video in the Timeline. Incoming audio clips are edited to the bottom-most audio track so 
they are below any previously existing audio. If necessary, new video and/or audio tracks will be 
created automatically to hold the new incoming clip.

Ripple Overwrite
Ripple Overwrite is a four-point edit that’s useful when you can identify a segment of the Timeline 
you want to overwrite, but the incoming clip is of a different duration and you want DaVinci Resolve to 
automatically ripple the Timeline to accommodate the difference.

You can use the Ripple Overwrite command one of two different ways:

 — You can overwrite an entire clip in the Timeline with another clip of different length.

 — You can overwrite a section of the Timeline marked with In and Out points with a another clip of 
different length. 

In both cases, all clips to the right of the clip or timeline section being overwritten are rippled to the 
right or left to make room or fill the gap. Because of this, the ripple overwrite edit will most likely 
change the overall duration of your edited sequence of clips.
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Using Ripple Overwrite on an Entire Clip in the Timeline
Using ripple overwrite as an automatic four-point edit, you can overwrite whichever clip in the 
Timeline intersects the playhead on the tracks defined by the destination controls, in its entirety, with 
the incoming clip. For this to work, there must be no In or Out points set in the Timeline.

After performing a ripple overwrite in this way, the original timeline clip is eliminated and the incoming 
clip takes its place, and all clips to the right of the clip being replaced are either (a) rippled to the right 
if the incoming clip is longer than the original timeline clip, or (b) rippled to the left if the incoming clip 
is shorter than the original timeline clip. All of this is done in a single step.

This is useful in situations where you want to quickly switch one clip in the Timeline with another of 
unequal duration and have the Timeline automatically make room to allow this all in one step.

To use ripple overwrite to replace an entire clip in the Timeline with another source clip:

1 Move the playhead in the Timeline to intersect the clip that you want to replace; the playhead’s 
exact position is not important.

2 Click the appropriate audio and video destination controls of the track containing the clip 
you want to replace, and press Option-X to eliminate any In and Out points there might be in 
the Timeline.

3 Open a clip into the Source Viewer, and set In and/or Out points as necessary to define how much 
of the clip you want to edit into the Timeline.

4 To execute the edit, choose Edit > Ripple Overwrite, drag the clip to the Ripple Overwrite overlay 
of the Timeline Viewer, or press Shift-F10.

Before and after of using ripple overwrite with no Timeline In or Out points; Clip K at the 
position of the playhead is replaced in its entirety by the short segment of Clip U from the 
Source Viewer; all clips with In points to the right are rippled to the left to fill the gap

Using Ripple Overwrite on a Section of the Timeline 
Defined by In/Out Points
You can also use ripple overwrite as an explicit four-point edit, to overwrite a section of the Timeline 
that’s marked with In and Out points with an incoming clip that’s also marked with In and Out points 
that is of unequal duration. 

773Edit | Chapter 39 Three- and Four-Point Editing



After performing a ripple overwrite in this way, the section of the Timeline marked with In and Out points 
is eliminated and the incoming clip takes its place, and all clips to the right of the clip being replaced are 
either (a) rippled to the right if the incoming clip is longer than the original timeline clip, or (b) rippled to 
the left if the incoming clip is shorter than the original timeline clip. All of this is done in a single step.

A good example of when this can be useful is when you’re cutting a close-up of an actor performing 
a particular action into a medium shot of the actor performing the same action that’s already in the 
Timeline, and the action you’re matching is of different durations in each of the shots.

To use ripple overwrite to replace a section of the Timeline with another source clip:

1 Set In and Out points in the Timeline to mark what part of the clip or clips you want to overwrite. 
You must set both In and Out points for this to work as expected. In this example, the part of the 
clip where the woman leans forward is marked.

Setting In and Out points to identify an action in the Timeline that you 
want to overwrite with another clip that has a matching action

2 Open a clip into the Source Viewer, and set In and/or Out points as necessary to define how much 
of the clip you want to edit into the Timeline. In this example, a section of the woman’s close up 
where she leans forward in a way that matches the same movement in the wider shot is marked.

Setting In and Out points to identify an action in a source clip that you want to 
overwrite the action you’ve marked in the Timeline. It’s a matching action, but 
the timing might be different, and that’s okay with this kind of edit.
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3 To execute the edit, choose Edit > Ripple Overwrite, drag the clip to the Ripple Overwrite overlay 
of the Timeline Viewer, or press Shift-F10. As a result, the section of the timeline that was marked 
in step 1 is overwritten by the section of the source clip marked in step 2, and all clips to the right 
of this edit in the Timeline are rippled to the right to make room for the much longer source clip. 
The final result is an edit where the movements match nicely.

After the ripple overwrite, the part of the Timeline clip marked with In and Out points 
has been overwritten by the part of the Source clip marked with In and Out points, and 
all clips to the right of this edit in the Timeline are rippled left or right as necessary

Append to End
Append to end always puts the edited clip at the very end of the current Timeline. It’s a very useful edit 
type when you’re quickly stringing together a series of clips.

To use append to end to edit a clip into the Timeline:

1 Set In and Out points in a source clip that you want to add to the end of the current Timeline. If 
necessary, change the sort order of the Media Pool to put these clips into the order in which you 
want them to be added to the Timeline.

2 Click the audio and video destination controls of the tracks you want to edit the incoming source 
clip onto. If necessary, create new tracks.

3 Choose Edit > Append to End of Timeline, drag the clip to the Append at end overlay of the 
Timeline Viewer, or press Shift-F12.

Incoming video clips are added after the very end of the last clip in the Timeline.

Insert Selected Clips to Timeline Using Timecode
Clips can be edited directly from the Media Pool into a timeline, such that each clip’s source timecode 
is aligned with an identical record timecode value in the Timeline. This can be useful for long form 
multi-camera events, like weddings or concerts, where all cameras are linked by the same timecode 
to ensure all edits are perfectly synced. This function matches the Source Overwrite edit on 
the Cut page.

IMPORTANT: The timecode of the Timeline must overlap the timecode of the clip(s) for this 
edit to function. This can be set in the Start Timecode field of the New Timeline settings.
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To insert selected clips to timeline using timecode:

1 Select one or more clips to edit into the Timeline in the Media Pool. If there are In and Out points 
set on the clip, the edit will respect those boundaries. If no In/Out points are set, each selected 
clip’s full duration will be edited in its entirety.

2 Set a destination control to determine which track in the Timeline you want to edit to.

3 Right-click one of the selected clips and choose “Insert Selected Clips to Timeline Using Timecode” 
from the drop-down menu.

4 All of the selected clips will be overwritten into the Timeline at their appropriate timecode 
locations onto the destination track.

IMPORTANT: If multiple selected clips have overlapping timecode, no edit will occur.

Insert Selected Clips to Timeline With Handles
“Insert Selected Clips to Timeline With Handles” is a command that’s available from the Media Pool 
contextual menu for editing one or more selected clips to the currently open timeline, such that the 
default handle length is subtracted from the beginning and end of each clip. The goal is to make it 
easy to string together a series of clips that you want to connect using transitions by automatically 
changing the In and Out points of each clip being edited into the Timeline in order to add handles. 

To use insert selected clips to timeline with handles to edit one or 
more clips into the Timeline:

1 Select one or more clips in the Media Pool that you want to add to the Timeline. If necessary, 
change the sort order of the Media Pool to put these clips into the order in which you want them 
to be added to the Timeline.

2 Click the audio and video destination controls of the tracks you want to edit the incoming source 
clip onto, and position the playhead where you want the incoming clips to start. If necessary, 
create new tracks.

3 Right-click one of the selected clips in the Media Pool and choose “Insert selected clips to timeline 
with handles” from the contextual menu.

The selected clips are added to the Timeline starting at the position of the playhead.

To change the length of handles that are removed, open the Editing panel of the User Preferences 
and change the “Default handles length” setting. Handles will not be added in either of the following 
two cases:

 — If any of the selected clips in the Media Pool already have handles because of In and Out points 
that you’ve set, then additional handles won’t be added.

 — If the duration of the frames to be removed to create handles in this operation is greater than 
the duration of one or more of the clips you’ve selected in the Media Pool, then handles won’t be 
added at all. 
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Three-Point Editing 
From the Media Pool
You can also execute three-point edits directly from the Media Pool, with no need to use the 
Source Viewer.

Example: Assembling Clips Into the 
Timeline From the Media Pool
If you want, you can also edit clips directly into the Timeline from the Media Pool using a variety of 
commands. This can be a fast way of appending clips to the end of the Timeline (although you can also 
perform insert edits this way).

To edit one or more clips from the Media Pool to the Timeline:

1 If necessary, set In and Out points for each of the clips you want to edit into the Timeline 
using either the Media pool thumbnails (in Thumbnail view), the Media Pool Filmstrip Viewer 
(in List view), or by opening each one into the Source Viewer. For each method, press I to set an In 
point, and O to set an Out point.

2 Change the sort order of the Media Pool’s browser area to put the clips into the order in which you 
want them to appear. In Thumbnail view you can use the Sort Order menu, but in List view you can 
click the header of any metadata column to sort by that column’s data.

3 Position the playhead to where you want to edit the clips.

4 Click, drag, use the Command-Option and Command-Shift Up and Down Arrow Key shortcuts, 
or use the Option-1–8 and Command-Option-1–8 key shortcuts to assign the video and audio 
destination controls to the tracks you want to edit the video and audio of the incoming clip(s) to. 
Click any destination control itself to disable it if you want to edit clips into the Timeline as audio or 
video only.

5 Select one or more clips you want to edit. Insert, overwrite, place on top, ripple overwrite, and 
append at end edits are all capable of editing multiple clips at once, while replace and fit to fill 
edits can only edit one clip at a time, and will only edit the first of multiple selected clips into 
the Timeline.

6 To perform the edit, do one of the following:

 — Drag the selected clips to the Timeline Viewer and drop them on an editing overlay to execute 
that edit type.

 — Right-click one or more selected clips in the Media Pool, and choose “Insert Selected Clips to 
Timeline,” or “Append Selected Clips to Timeline.”

The selected clip(s) are edited into the Timeline.
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Chapter 40

Marking and Finding 
Clips in the Timeline
As you work on your project, you’ll find it useful to identify 
important information about each clip, and about significant 
moments in each timeline, using a combination of Flags, 
Markers, and clip Label colors. 

These can be applied to source clips in the Media Pool, or to clips that have already been edited into 
timelines. In the case of markers, these can also be added to the Timeline ruler itself to help you 
keep track of important moments or notes, and to help you with snapping. You’ll also find yourself 
modifying clips in different ways, unlinking and relinking the audio and video of different clips, 
enabling and disabling clips in the timeline. 
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Finding Edit Index Events Using 
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Using Flags
Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that shares 
the same Media Pool source clip, making this a handy way of quickly identifying which clips in a given 
timeline come from the same Media Pool source.

The Flag and Marker 
buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to flagging 
specific media files, flags can be useful for timeline filtering in the Color page, sorting by column in the 
Media Pool, and a variety of other operations.

Methods for flagging clips:

 — To flag a clip using the toolbar: Select one or more clips, and either click the Flag button to flag 
that clip with the current color, or click the Flag drop-down in the toolbar to choose a different 
color and then click the Flag button. In the Edit page, flags appear in the Timeline superimposed 
in the name bar of each clip.

 — To flag a clip: Select one or more clips, and Choose Mark > Add Flag > Current Selected (G) 
to add a markers of a specific color directly to clips and the Timeline. The individual flag color 
commands can be assigned specific keyboard shortcuts if you want to be able to place a specific 
flag color at a keystroke.

 — To flag a clip in the Source Viewer: Open a clip in the Source Viewer, and while the Source 
Viewer has focus, choose Mark > Add Flag > Current Selected (G). The individual flag color 
commands can be assigned specific keyboard shortcuts if you want to be able to place a specific 
flag color at a keystroke.
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 — To remove all flags from a clip: Select one or more clips with flags you want to remove, then click 
the Flag drop-down in the toolbar, and choose the top “Clear All” option. 

 — To show or hide a particular color of flags: Choose a color of flag to hide from the View > 
Show Flags submenu, or choose View > Show Flags > All to show them all.

 — To filter all flagged clips in the Edit Index: Click the Option menu of the Edit Index and choose 
Show Flags. Each flagged clip appears in a list, with a column showing the color(s) of the flags 
applied to each entry in the list.

Using Markers
Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text into a 
marker, that marker displays a small dot that indicates there’s more information inside of it. Once 
placed, markers snap to In and Out points, edit points, the playhead, and other markers whenever 
snapping is enabled, making it easy to use markers to “measure” edits and trims that you make in 
the Timeline.

Adding Markers to Clips
You can place markers on the jog bar of source clips in the Source Viewer (or in the Media page 
Viewer), and on clips that are selected within a timeline.

(Top) Markers placed on a 
source clip,  
(Bottom) Markers placed 
on a clip in the Timeline

When you add markers to a source clip, those markers also appear in the Media Pool as 
hierarchically disclosable items attached to that clip in List view (markers are not visible in 
Thumbnail view). More information about using markers in the Media Pool’s List view appears 
later in this chapter.
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Markers can be viewed as 
separate clips identified 
by marker name when the 
Media Pool is set to List view

The following procedures describe how to add markers to clips and timelines in DaVinci Resolve.

To mark a source clip in the Source Viewer or Media Page Viewer, do one of the following: 

 — To place a marker without doing anything else, move the playhead to the frame you want to mark, 
and then press M. 

 — To place a marker and immediately open the marker dialog to enter a name or note within it 
during playback, press Command-M (or press M twice). Playback pauses until you enter the text 
you want to and close the marker dialog again, at which point playback continues.

 — Move the playhead to the frame you want to mark, then right-click in the jog bar and choose a 
marker color from the Add Marker submenu of the contextual menu.

To mark a clip in the Timeline, do one of the following: 

 — Select one or more clips you want to mark, then move the playhead to the frame of a selected 
clip in the Timeline, and click the Marker button in the toolbar (or press M) to place a marker 
at that frame, using the current color (if multiple overlapping clips are selected, you’ll 
add a marker to all clips). 

 — To place a marker during playback and immediately open the marker dialog to enter a name or 
note within it, select one or more clips you want to mark, play through the selection until you want 
to place a mark, then press Command-M (or press M twice). Playback pauses until you enter some 
text and close the marker dialog again, at which point playback continues.

 — Select one or more clips you want to mark, and then click the Marker drop-down to choose a 
different color, and click the Marker button. 

Markers appear in the 
Timeline at the top of 
the title bar of the clip to 
which they’re applied
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Adding Markers to Timelines
You can also place markers of any color into the Timeline ruler to denote specific times for future 
reference, or add notes about issues you want to keep track of.

Timeline markers placed for future reference

You should note that all markers placed on clips or in the Timeline also appear within the Mini-Timeline 
of the Color page, making it easy to place notes for later reference when grading.

Clip and Timeline markers as seen in the Mini-Timeline of the Color page

Once you’ve added one or more markers placed on clips, snap to clip In and Out points, edit points, 
the playhead, and other markers whenever snapping is enabled.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following: 

 — Press M.

 — Click the Marker button to place a marker of the currently selected color in the Timeline ruler. 

 — To place a marker during playback and immediately open the marker dialog to enter a 
name or note within it, select one or more clips you want to mark, then press Command-M 
(or press M twice). Playback pauses until you enter some text and close the marker dialog again, at 
which point playback continues.

 — Click the Marker drop-down to choose a different color, and click the Marker button. 

 — Right-click in the Timeline ruler and choose a marker color from the Add Marker submenu of the 
contextual menu.

 — Choose Mark > Add Marker > Current Color (M) to add the current marker color. Alternatively, you 
can choose Mark > Add Marker > Blue/Cyan/Green/and so on to add a marker of a specific color 
directly to clips or the Timeline. These commands can be assigned specific keyboard shortcuts if 
you want to be able to place a specific marker color at a keystroke.
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Individually 
mappable 
marker color 
commands

Saving In and Out Point Ranges 
As Markers with Duration
You can also create markers with duration to keep track of any region of a clip or timeline that you’ve 
defined with In and Out points. This lets you identify multiple regions of a clip that you might later 
want to edit into a program.

To turn In and Out points into a marker with duration:

1 Set In and Out points in the Source Viewer jog bar to identify a region you want to log for 
future reference.

Marking In and Out points in preparation 
to log that section of the clip

2 Do one of the following:

 — Right-click the jog bar and choose Convert In and Out to Duration Marker

 — A marker with duration appears above the In and Out points. To edit its name or notes, 
double-click the marker, press Shift-M, or choose Mark > Modify Marker.

A marker with duration is created 
from the In and Out points

In this way, you can log several regions within a single clip for future use. 

A clip with multiple logged sections identified via markers with duration
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This an extremely useful logging technique for two reasons. First, markers with duration can be 
searched for in the Media Pool using the All Fields, Marker Name, and Marker Notes Filter by options. 
Second, they can be filtered with Smart Bins using the Marker Name and Marker Notes Media Pool 
Properties options.

Editing Marker Information and Keywords
Once you’ve added some markers, you may want to edit their contents to make them more useful.

To open a marker’s edit dialog to alter its properties:

1 Do one of the following:

 — Press Command-M to add a marker during playback and immediately open its edit dialog.

 — Double-click any marker you want to edit.

 — Move the playhead to the frame containing the marker you want to annotate using Shift-Up 
Arrow/Down Arrow and press M.

 — Select a marker anywhere in the Source Viewer or Timeline, and press Shift-M.

2 When the marker dialog opens, you can modify several properties in separate fields. For fast 
editing, you can press Tab to select the next field, or you can press Shift-Tab to select the 
previous field.

Editable properties in the Marker dialog

 — Time: The frame the marker is positioned at relative to that clip or timeline. This is editable, so 
you can numerically change a marker’s position.

 — Duration: Optional; the length of a marker that’s been assigned a duration. This is also 
editable, so you can numerically assign a duration to a marker or alter a marker that already 
has duration.

 — Name: The name of the marker, defaults to the number of that marker in the order it was 
added (Marker 1, Marker 2, etc.).

 — Notes: A field where you can enter any information you want to keep track of.

 — Color: A series of buttons for choosing the color of the marker.
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 — Keyword: A keyword field lets you keyword markers in the same way you can keyword clips 
in the Metadata Editor, which can be a powerful way of identifying sections of clips you want 
to find later in Smart Bins or Search operations. Typing text in the Keyword field automatically 
searches the dictionary for matching keywords. Press Return to accept a found keyword (you 
can choose from a list using the Arrow keys), or press the Up Arrow key back to the Keyword 
field to manually enter your own new variation instead. For more information about using and 
editing Keywords, see Chapter 16, “Using Variables and Keywords.”

 — Remove Marker: Deletes that marker.

 — Done: Closes the marker edit dialog.

3 When you’re finished, click Done.

Once you add notes to a marker, a small symbol appears on top of that marker to show 
you it has information.

A small dot on a marker 
shows that it contains notes

Changing Marker Timing
Once you’ve placed one or more markers, there are a variety of ways you can move them around to 
better line up with important events in source footage or the Timeline, or delete them once they’re 
no longer useful. Additionally, you can enable or disable the ability to have markers ripple along with 
other clips in areas of the Timeline that are affected by rippling operations.

To move one or more markers in the Timeline or Source Viewer: 

 — Click a marker or Command-click multiple markers you want to move, and drag them to a 
new location.

 — Drag a bounding box from the Timeline up into the Timeline ruler to select multiple markers, and 
drag them to a new location.

 — Open a marker’s edit dialog and manually edit the time and duration timecode fields to 
numerically move that marker, or to create a marker with a specific duration. Furthermore, the 
timecode in these fields can be copied from or pasted to.

To enable marker rippling:

 — Choose Timeline > Ripple Timeline Markers. When checked, all markers to the right of a clip being 
ripple edited, trimmed, or ripple deleted will ripple to the left along with the rest of the Timeline. 
You can turn this behavior off and on at will.

To modify marker duration:

 — Option-drag any marker to the right or left to create a marker with duration.

 — Move the playhead to the frame containing the marker you want to modify and press M, or double-
click the marker you want to edit, then type a number into the duration field, and click Done. 
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 — Markers with duration appear as a bar in the Timeline ruler or jog bar of the Source Viewer. 
Drag the middle of a marker with duration to move it, or drag the left or right edge to change 
its duration.

 — To eliminate a marker’s duration, set its numeric duration to 00:00:00:00 in the marker dialog, or 
drag either end so that it merges with the other as a single marker.

A marker with duration in the Timeline

Methods of deleting markers:

 — To remove one or more markers using the mouse: Click to select a marker, or Command-click 
to select multiple markers, and press the Delete key. You can also double-click a marker to open 
its dialog, and click the Delete button.

 — To remove a marker using the keyboard: Move the playhead to the marker you want to delete, 
and press Option-M.

 — To remove all markers from a clip: Select one or more clips with markers you want to 
remove, then either press the Backspace key, or click the Marker drop-down in the Toolbar, and 
choose Clear All.

 — To remove all markers from the Timeline: With all clips deselected, choose Clear All from the 
marker drop-down menu in the Toolbar, or right-click the Timeline ruler, and choose Remove All 
Markers from the contextual menu.

Drawn Annotations on the Viewer
It’s now possible to use the Annotations mode of the Timeline Viewer to draw arrows and strokes of 
different weights and colors directly on the video frame, in order to point out or highlight things that 
need to be fixed. These annotations are stored within markers, similarly to marker names and notes. 
To start, simply choose Annotations mode from the Timeline Viewer mode drop-down menu.

Choosing Annotations from the 
Viewer Mode drop-down menu
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Once in Annotations mode, an Annotations toolbar appears showing the following options:

The Annotations toolbar in the Viewer

Draw tool with line weight drop-down: Click the Draw tool to be able to freeform 
draw on the Viewer. Click the Line Weight drop-down to choose from one of three 
line weights to draw with.

Arrow tool: Click the Arrow tool to draw straight-line arrows pointing at features 
you want to call attention to. Arrows are always drawn at the same weight, 
regardless of the weight selected for the Line tool.

Line Tool: Click the Line tool to draw straight lines on the Viewer.

Rectangle Tool: Click the Rectangle tool to draw boxes on the Viewer.

Color drop-down: Choose a color for drawing or lines.

Methods of making and editing annotations:

 — To create an annotation: Simply enable Annotations mode, then park the playhead on any frame 
of the Timeline and start drawing. A marker will automatically be added to the Timeline at that 
frame, and that marker contains the annotation data. If you park the playhead over a preexisting 
timeline marker, annotations will be added to that marker.

 — To edit a stroke or arrow you’ve already created: Move the pointer over a stroke or arrow and 
click to select it, then choose a new line weight or color from the appropriate drop-down menu, or 
drag that stroke or arrow to a new location to move it.

 — To delete a stroke or arrow: Move the pointer over a stroke or arrow and click to select it, then 
press the Delete or Backspace keys.

Drawing annotations to highlight feedback
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Reading Marker Information
Once you’ve added a number of markers with custom information, there are two ways of viewing this 
information without having to open the marker dialog.

To read marker notes using your pointer:

 — Double-click a marker to open its marker dialog.

 — Move the pointer over any marker in the Source Viewer or Timeline to see a tooltip showing that 
marker’s information.

Moving the pointer over a marker 
displays its information in a tooltip

To read marker information in the Source and/or Timeline viewers:

1 Open the Source or Timeline Viewer’s option menu, and turn on Show Marker Overlays.

2 Stop playback, and move the playhead to a marker. That marker’s information is displayed in the 
Viewer, superimposed.

Marker information shown in the Source Viewer

Using Markers for Navigation
Markers can be used to aid navigation, via two keyboard shortcuts that let you jump the playhead 
from marker to marker. When moving the playhead among markers, Clip and Timeline markers are 
mixed together.

To move the playhead to the next or previous marker:

 — Press Shift-Up Arrow to move the playhead to the next marker to the left in the Timeline.

 — Press Shift-Down Arrow to move the playhead to the next marker to the right in the Timeline.

The marker under the playhead is then automatically selected.
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To move the playhead to a specific marker using the Source or 
Timeline Viewer’s Marker list:

 — For a source clip or timeline with multiple markers, you can move the playhead immediately to a 
specific marker by opening the Source or Timeline Viewer’s Option menu, and choosing a marker 
from the Markers submenu, which exposes all the markers that are available in that Viewer, by 
name and note.

All markers in the currently open clip as seen in 
the Source Viewer Option menu Markers list

Using Timeline Markers for Chapters
Certain file types, like QuickTime, allow chapter-based navigation in the final video. This allows 
the viewer to skip back and forth through the video landing at exact points specified by the 
video’s creator. This chapter-based navigation is especially useful in instructional videos or long 
presentations. Chapter points in DaVinci Resolve are set by timeline markers.

Currently only the QuickTime and MP4 formats support chapter markers in DaVinci Resolve.

To create a chapter marker in the Timeline:

 — Put the playhead at the spot in the Timeline you wish to make a chapter point, and choose 
Add Marker (M). 

 — Edit the marker by double-clicking on it, or by selecting Modify Marker (Command-M). 

 — Edit the Name field to create the chapter name that will show up in the player.

 — Select a color for the marker. All chapter markers must be assigned the same color.

To export embedded chapter markers in a QuickTime movie:

 — In the Deliver page, select Quicktime or MP4 as the Format in the Video Panel.

 — Check the box next to Chapters from Markers, and select the chapter marker color you chose 
earlier from the drop-down menu.
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The Chapters from Markers checkbox in the QuickTime 
Export Video settings of the Deliver page

Using Markers in the Marker Index
You can use the Marker Index to easily view, edit, and organize all your timeline and clip markers in 
one convenient location. The Marker Index can be found by clicking on the Index panel, and selecting 
the Markers tab.

Methods of working with markers in the Marker Index:

 — To filter markers in the Marker Index: Click the Option menu of the Marker Index and choose 
Show All or Show Only to choose a specific color. Each clip with a matching marker appears in 
a list, with columns corresponding to the color(s), information, and notes of each timeline and 
clip marker. Columns can be sorted in ascending or descending order by clicking on the column 
header. Individual columns can be turned on or off by right-clicking on the column header, and 
checking or unchecking the column name.

 — To move the playhead to the position of a marker in the Marker Index: Double-click that 
marker’s entry in the list.

 — To edit marker information: You can change the values of a marker by clicking in the Name, 
Notes, or Keyword fields, and modifying the text field. Other values are not editable in the Marker 
Index and should be changed in the timeline marker’s Edit dialog.

 — To search for a specific marker: Click on the search icon (magnifying glass), and type in your 
search terms. Currently the search only queries the Marker Name column; you can not search by 
notes and keywords.

 — To switch between Thumbnail and List view: Click on either the Thumbnail or List View icons in 
the top bar of the Marker Index.
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The Marker Index in List View mode lets you edit and organize all your timeline’s markers in one place.

Exposing Markers in Lists
You can also use the Edit Index to filter out a list of markers appearing within the current Timeline. 
You can filter all markers at once, in which case columns expose the notes and colors applied to each 
marker. You can also filter by a specific marker color if you only want to see one type of marker.

Methods of working with markers in the Edit Index:

 — To filter all clips with markers in the Edit Index: Click the Option menu of the Edit Index and 
choose Show Markers > All or choose a specific color. Each clip with a matching marker appears in 
a list, with columns corresponding to the color(s) and notes of each Timeline and Clip marker.

 — To move the playhead to the position of a marker in the Edit Index: Click that marker’s entry 
in the list.

 — To show hidden marker columns: Right-click any column header, and turn on either Color or Notes 
to reveal that column. If necessary, columns can be rearranged by dragging them left or right.

You also have the option to export lists of markers as an EDL, a .txt, or .csv file.

Exporting lists of markers:

 — To export Timeline markers as an EDL: Right-click that timeline in the Media Pool, and choose 
Timelines > Export > Timeline Markers to EDL. Choose a location and export format from the 
Export Edit Index dialog, and click Save. Each Timeline marker is listed in the resulting EDL, with 
any notes included along with a duration, where applicable.

 — To export all filtered markers in the Edit Index as a .txt or .csv file: After you choose Show 
Markers in the Edit Index option menu, then right-click that timeline in the Media Pool, and choose 
Timelines > Export > Edit Index. Choose a location and export format from the Export Edit Index 
dialog, and click Save.

Using Markers in the Media Pool
Once you’ve added one or more markers to source clips in the Media Pool, you can use them for 
editing in a considerably more direct way than just using them to move the playhead around. Markers 
can be exposed in the List view of the Media Pool, and once exposed, they can be opened into the 
Source Viewer, edited into the Media Pool, or turned into subclips just like any other clip.
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To show markers in the Media Pool:

 — Set the Media Pool to List view, then click the disclosure button to the left of the clip with 
markers you want to work with. They appear as a hierarchical list underneath the clip to which 
they’re attached.

 — Use the Right Arrow key to open a clip’s marker hierarchy. Use the Up and Down arrows to select a 
particular marker. Use the Left Arrow key to close the clip’s marker hierarchy.

Markers exposed in the Media Pool in List view

To open a marker in the Media Pool into the Source Viewer:

 — Double-click any marker to open that clip into the Source Viewer with the playhead at the position 
of that marker.

To edit a clip defined by the marker into the Timeline:

 — Drag any marker into the Timeline. A clip will be edited into the Timeline with the In point 
defined as the frame at the marker, and the Out point defined by either (a) the frame before 
the next marker in that clip, or (b) the duration of that marker if the duration is greater than the 
default 1 frame.

To turn a marker in the Media Pool into a subclip:

 — Select one or more markers, and drag the selection into another region of the Media Pool, or into 
another Bin, and a sub clip will be generated with the clip start defined as the frame at the marker, 
and the clip end defined by either (a) the frame before the next marker in that clip, or (b) the 
duration of that marker if the duration is greater than the default 1 frame.

To add metadata to a marker subclip in the Media Pool:

 — Select a marker subclip in the Media Pool and then edit the name, notes, keywords and color fields 
in the Media Metadata panel.

Hiding Markers By Color
View > Show Markers enables users to either show and hide markers based on color, or show them 
all at once. An example of when this is useful is when you’re using the color of markers to send 
information to specific artists, such as green for Fairlight mixing notes, or orange for Fusion page 
compositing notes. Users on those pages can then hide all other markers except for the color they’re 
interested in, enabling them to visually prioritize only the markers they care about.
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Deleting Markers By Color
Mark > Delete All Markers lets users remove all markers of a specific color all at once, or remove all 
markers altogether.

Renaming Clips in the Timeline
For organizational purposes, you can create custom clip names that are tied to a specific timeline. 
This can be useful to display information about a clip that is persistent, readily apparent, and does not 
require you to click on a flag or marker to view. Clips renamed in this manner are only changed in the 
current timeline, and do not modify the Clip Name in the Media Pool.

You can rename clips on the Timeline by using the File Inspector and entering a new name in the 
Name field.

Renaming a clip in the File Inspector’s Name field

The new name will show in the Timeline track at bottom of the clip.

The new clip name shown in the Timeline.

IMPORTANT: Changing a clip name in the Timeline only affects the instance of the clip 
in that specific Timeline. It does not rename the original Clip Name in the Media Pool, nor 
does it rename that same clip that may exist in other timelines. If you want to rename a clip 
across your entire DaVinci Resolve project, modify the Clip Name in the Media Pool instead.

TIP: If you want to use a custom clip name on more than one timeline, you can copy and 
paste the clip between timelines, and the pasted clip will retain its custom name. However 
both clip names will be independent from each other from that point forward.
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Color Labeling Clips in the Timeline
By default, different clips have specific colors that identify each type of clip. Furthermore, clips with 
effects applied to them (adjustments in the Inspector, volume level changes, speed changes, and so 
on), appear as a darker shade of their default color to help you identify at a glance which clips have 
been modified. 

The following table lists what these default colors are.

Clip Type Color

Video Clip Steel Blue

Audio Clip Light Green

Generator Light Purple

Text Beige

Clip with effects Shaded darker

Custom Clip Colors
Additionally, you can assign one of 16 colors to clips. Each clip can only have a single color assigned 
to it. Also, unlike flags, clip colors are clip-specific, so assigning a clip color to one use of a clip in the 
Timeline has no effect on any other clips that share the same source media in the Media Pool. 

Clip Color Appearance
How these colors appear depends on the location of the clip. There are two options:

 — Clip thumbnails in the Media Pool or the Thumbnail timeline of the Color page show a small 
colored dot at the upper-right-hand corner of the thumbnail.

Thumbnails with label colors 
showing as dots in the corner

 — Clips in the Timeline are tinted everywhere but the thumbnail area of video clips. If you edit a clip 
into a track that has itself been colored, the clip color overrides the track color.
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A timeline with audio clips that have been tinted to identify what they are to the editor 

NOTE: Clip colors are distinct from flags, which appear as badges in the Timeline, 
Media Pool, and Color page.

Assigning Clip Colors
Clip colors can be assigned in many different areas of DaVinci Resolve.

To assign a clip color to one or more clips, do one of the following:

 — Use the Media page to assign clip colors to clips in the Media Pool using the Shot & Scene preset 
in the Metadata Editor. Clip colors do not appear in the Media Pool. Clip colors can be removed by 
clicking the X  to the left of the Clip Color buttons in the Metadata Editor.

 — Right-click one or more selected clips in the Timeline, and choose a color from the Clip Color 
submenu of the contextual menu. Clip colors can be removed by choosing Default Color from this 
same submenu.

 — Colorists can right-click one or more selected clip thumbnails in the Color page and choose a color 
from the Clip Color submenu of the contextual menu. Clip colors can be removed by choosing 
Default Color from this same submenu.

Track Colors
Another method of visually organizing clips is the use of track colors. Each track can be color coded 
with one of 16 different colors. These color codes also appear in the Fairlight page, where they also 
correspond to the Edit page Mixer, and to the Fairlight page Mixer and Audio Meters. 

To choose a new color for any track:

When you assign a color to a track, that track’s color appears in a thin strip to the left of that track’s 
header controls. 

 — Right-click the track header and choose a color from the Change Track Color submenu. 
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Color-coded  
timeline tracks

All clips that you place onto that track will appear with that color, unless they’ve been assigned an 
individual clip color, in which case the individual clip color overrides the track color. This makes 
track colors a great method of visual organization, because you don’t have to do any advance 
preparation; the very act of placing a clip on a specific track color codes it according to that track’s 
designated purpose.

A timeline with color-coded tracks automatically tints the clips on each 
track; individual colored clips on V1 can be seen at left

Finding Clips, Media, Markers, 
Gaps, and Timelines
DaVinci Resolve has several methods of locating clips, markers, and gaps, to help you troubleshoot 
problem timelines, or to find media that you want to edit into a timeline differently.

Finding Clips in the Timeline
DaVinci Resolve makes it easy to find one or more clips in the Timeline that correspond to specific 
criteria using the Edit Index.
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To find a clip in the Timeline: 

1 Open the Edit Index.

2 Click the magnifying glass button to open the search controls.

3 Choose a criteria from the Filter By drop-down menu.

4 Type a search term in the Search field at the top right of the Edit Index. 

As soon as you start typing, all edit events that don’t match the search criteria are temporarily 
hidden. To show all of the clips in the Edit Index again, click the X at the right of the search field.

5 Click any event in the Edit Index to move the playhead to that clip in the Timeline.

Finding Offline Clips in the Timeline
It’s also easy to use the Edit Index to find all of the offline clips that may be in the Timeline.

To locate offline media in the current Timeline via the Edit Index:

1 Open the Edit Index.

2 Click the Option menu of the Edit Index and choose Show Offline Clips Only. 

3 The Edit Index is filtered to only show the offline clips in the currently open Timeline, and you can 
click any item on the list to jump the playhead to that particular clip in the Timeline.

4 Click any event in the Edit Index to move the playhead to that clip in the Timeline.

Finding Edit Index Events Using Clips in the Timeline
You can also locate specific Edit Index events using the Timeline playhead.

To locate a clip in the Edit Index from the Timeline: 

 — Move the Timeline playhead to intersect a clip you want to find in the Edit Index. That clip’s 
corresponding event (or events if the playhead intersects multiple clips) are automatically 
highlighted in the Edit Index.

 — To move the playhead to a clip in the Timeline via the Edit Index. 

 — Click any event in the Edit Index to move the Timeline playhead to the In point of that clip.

Finding Clips
As you work, there are a variety of methods you can use to find clips in the Media Pool or your file system.

Methods of finding clips in the Media Pool or File System:

 — To find a clip in the Media Pool: Open the Media Pool, and use the drop-down menu next to the 
Search button to choose whether to search through all bins in the current project, or just look at 
the currently selected bin or bins in the Bin List. If necessary, select the bin or bins that you want 
to search, and click the magnifying glass button to open the search controls. Optionally choose a 
criteria from the Filter By drop-down menu, then type a search term in the Search field. As soon 
as you start typing, all clips that don’t match the search criteria are temporarily hidden.

 — To locate a Timeline clip in the Media Pool: Right-click any clip in the Timeline, and choose 
Find in Media Pool. That clip appears highlighted in the Media Pool. 
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 — To locate a Source Viewer clip in the Media Pool: With any clip open in the Source Viewer, 
press Option-F.

 — To locate a media file in the Finder from the Media Pool: Right-click any clip in the Media Pool 
and choose Reveal in Finder. A Finder window, or its equivalent in Windows and Linux, opens to 
the directory with that clip, which appears highlighted.

 — To find the audio clip that a video clip has been synced to: Right-click a video clip 
that’s been synced to audio, and choose “Reveal synced audio in Media Pool” from the contextual 
menu. The bin holding the synced audio clip is opened and that clip is selected.

Finding Clips Using Markers or Flags
If you’re using markers to keep track of notes, issues, or items on your to-do list, there are a few 
different ways of finding and moving among them.

Methods of finding markers or flags:

 — To find all markers or flags via the Edit Index: Click the Option menu of the Edit Index and 
choose Show Markers or Show Flags. Each clip with one or more markers appears in a list, with 
columns corresponding to the color(s) and notes of each timeline and clip marker.

 — To find a specific marker or flag in the Edit Index: Click the magnifying glass button in the Edit 
Index, choose Notes in the Filter by drop-down, and type a search term in the Search field.

 — To move the playhead to the next marker forward or previous: Choose Playback > Previous 
Marker (Shift-Up Arrow) or Next Marker (Shift-Down Arrow).

Finding Gaps
Gaps, or spaces between two clips on the Timeline, appear by default as black. Unwanted gaps 
may appear as black flashes while your program plays back, and are generally to be avoided. 
DaVinci Resolve makes it easy to find gaps in specific tracks of your timeline.

To find gaps in the Timeline:

1 Make sure that the Auto Select control is enabled on any track you want to search for gaps. Turn 
Autoselect off on any tracks you don’t want to search for gaps (for example, title tracks where 
gaps are to be expected).

2 Do one of the following: 

 — Choose Playback > Previous Gap or press Option-Command-Semicolon.

 — Choose Playback > Next Gap or press Option-Command-Apostrophe.

The playhead will automatically move to the first frame of the next gap in the Timeline.

To delete gaps in the Timeline:

1 Make sure that the Auto Select control is enabled on any track you want to delete gaps. 
Turn Autoselect off on any tracks you don’t want to delete gaps (for example, title tracks where 
gaps are to be expected).

2 Choose Edit > Delete Gaps. If you want to limit the range of the deleted gaps this command 
respects both In/Out ranges and clip selections on the Timeline.
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Finding the Currently Open Timeline 
in the Media Pool
If you’re not using one of the available methods for organizing timelines separately from clips, it can 
be easy to lose track of where your timeline happens to be. To find the currently open Timeline in the 
Media Pool, choose Timeline > Find Current Timeline in Media Pool.

Finding Media Using Match 
Frame Operations
Match frame operations are a terrific time saver when you need to match the original source clip to 
a clip in the Timeline, or when you want to use a clip in the Source Viewer to find that same clip in the 
Timeline. With a single command, you can match one clip to another in order to set up a new edit to 
take care of a variety of tasks.

Matching From the Timeline
A classic example of using Match Frame is when you originally edited a video clip into the Timeline 
without its corresponding audio, and you later decide you want that audio in the Timeline after all. 
An easy fix is to move the playhead in the Timeline to intersect the clip you need to fix, and use the 
Match Frame command to automatically load the original source media for that clip into the Source 
Viewer, setting Source In and Out points that match those of the Timeline clip, and putting the Source 
playhead at the same frame as the Timeline playhead. At that point, you can simply edit the source 
audio and video back into the Timeline to overwrite the video-only clip you started with, confident that 
you’re editing exactly the same range of media at the same place.

Using the pointer to Match Frame from the Timeline to find a source clip:

 — Hold the Option key down and double-click the clip in the Timeline. 

The original source media for that clip is automatically loaded into the Source Viewer, with In and Out 
points that match those of the targeted Timeline clip; the Source playhead is at the same frame as the 
Timeline playhead.

Using keyboard shortcuts or Viewer controls to Match Frame 
from the Timeline to find a source clip:

1 Move the Timeline playhead to intersect the clip you want to target.

Placing the playhead 
over a clip to 
Match Frame
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2 If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the highest video track will be used as the target for Match Frame 
operations. If you want to target a clip on a lower track, you can click on the specific clip under the 
playhead to highlight it. Alternatively you can disable the Auto Selection controls of all timelines 
above, or Option-click the Auto Selection control of the track with the clip you’re targeting to solo it.

3 Press the F key, or click the Match Frame button at the bottom right of the Timeline Viewer (it’s at 
the left of the In and Out buttons).

The frame that’s matched to the frame at the playhead in the Timeline; In 
and Out points are set to match those of the clip in the Timeline

The original source media for that clip is automatically loaded into the Source Viewer, with In and 
Out points that match those of the targeted Timeline clip; the Source playhead is at the same 
frame as the Timeline playhead.

Matching From a Source Clip
Match Frame also works in the opposite direction. You can open a source clip into the Source 
Viewer that you know corresponds to a clip in the Timeline, and then you can use Match Frame to 
automatically find any clip in the Timeline that corresponds to media found within the source clip.

To use Match Frame in the Source Viewer to find a clip in the Timeline:

1 Open a clip in the Source Viewer that includes a range of media that’s already been edited into 
the Timeline. If no part of the source clip has been edited into the Timeline, source match framing 
won’t work.

2 Move the Source Viewer playhead to a frame that you want to find in the Timeline. Again, if the 
frame at the position of the playhead in the Source Viewer hasn’t already been edited into the 
Timeline, the Source Match Frame command won’t work.

3 Click the Match Frame button at the bottom right of the Source Viewer (it’s at the left of the In and 
Out buttons), or press the F key.

The Timeline playhead automatically moves to the clip and frame after the current playhead 
position that matches the clip in the Source Viewer.
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Finding a Clip in the Media Pool 
Using a Timeline Clip
There are two ways you can use a clip in the Timeline to find a clip in the Media Pool.

Using a Clip in the Source Viewer to 
Find a Media Pool Clip
To locate the original clip in the Media Pool that corresponds to a clip in the Timeline:

1 Open a Timeline clip into the Source Viewer by doing one of the following:

 — Double-click a clip in the Timeline.

 — Move the playhead to a clip in the Timeline, press Shift-V to select it, then press the Return key.

2 Press Option-F to locate the source clip corresponding to the clip that’s open in the Source Viewer 
in the Media Pool. That clip appears highlighted in the Media Pool.

Using a Clip in the Timeline to Find a Media Pool Clip
To locate a Timeline clip’s corresponding clip in the Media Pool, right-click any clip in the Timeline, and 
choose Find in Media Pool from the contextual menu. That clip appears highlighted in the Media Pool.

Tracking Media Usage
As clips are added to timelines, two mechanisms come into play for keeping track of which clips are 
used in which timelines.

Thumbnail Clip Usage Indicators
Whenever you open a timeline, all thumbnails in the Media Pool automatically update to show 
highlighted usage bars to let you know which parts of that clip are used in that timeline.

Two colored highlights at the bottom of 
the thumbnail indicate which parts of a clip 
are used by the currently open Timeline

If you right-click on a thumbnail that shows usage, a Usage submenu shows you a list of each instance 
of that clip in the currently open Timeline. Choosing an instance from this list jumps the playhead to 
that clip in the Timeline.
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List View Clip Usage Column
A Usage column can be optionally shown in the Media Pool while in List view. By default, this column is 
empty, but if you right-click in the Media Pool and choose the Update Usage command, the project is 
analyzed, and every use of that clip in every timeline of the entire project is logged in this column.

A Usage column shows how many times a 
clip is used in every timeline, after analysis

NOTE: The usage column increments for each clip item that appears in the Timeline. 
This means that if a clip consists of one video item and one audio item linked together, the 
usage column will show the number 2.
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Chapter 41

Multicam Editing
If you’re working with media that was shot simultaneously using 
multiple cameras, then you can use the Multicam Editing tools in 
DaVinci Resolve to create multicam clips that can be edited using 
a visual switcher. Additional controls let you change the angles of 
multicam clips that have already been edited into the Timeline.
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Introduction to Multicam Editing
If you’re working on a program where a performance, interview, or event was recorded using multiple 
simultaneous cameras, DaVinci Resolve has multi-camera editing tools; multicam editing for short. 
Editing using these tools is a three part process:

 — First, you have to create multicam clips from the individual camera angles (called “ISOs,” 
or isolated cameras). 

 — Second, you need to put the multicam clips you’ve created into a timeline. 

 — Third, you turn on the Multicam Viewer, and then you’re ready to start cutting and switching 
among angles, as if you were a live multi-camera director.

This section describes all of these steps, and the various options available for each of them.

Creating and Modifying 
Multicam Clips
Before you do anything else, you need to create one or more multicam clips. 

To create a multicam clip:

1 Import all the ISO (isolated camera) clips that correspond to the multi-camera performance or 
event that you’ll be editing into the Media Pool.

2 Select all the clips that you need to sync together, right-click the selection, and choose “Create 
Multicam Clip Using Selected Clips.”

3 When the New Multicam Clip Properties dialog opens, choose from the following options:

New Multicam Clip 
Properties dialog

 — Start Timecode: Presents the start timecode of the new multicam clip you’re about to create, 
which is determined by either the timecode value of the sync point if Angle Sync is defined by 
timecode, or by the sync point timecode value of the clip with the earliest timecode if Angle 
Sync is defined by waveform.

 — Multicam Clip Name: Use to choose a more descriptive name than “Multicam 1” for the 
multicam clip you’re about to create.
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 — Frame Rate: Automatically lists the frame rate associated with the clips you selected.

 — Angle Sync: The method used to synchronize all of the different angles. If you’re manually 
syncing all of the angles, you can use In or Out points that you set within each clip. If matching 
timecode was jam synced to each camera recording an angle, you can choose Timecode for 
a fast sync that’s as accurate as the timecode is. If each camera had a microphone with which 
to simultaneously record the location audio, you can choose Sound to use the shape of each 
audio waveform to align all of the angles.

 — Angle Name: The method used to name each angle within the multicam clip being created. 
The angles can have Sequential numbering, use Angle or Camera metadata, or use the 
Clip or File name.

 — Detect clips from same camera: Turning on this checkbox results in multiple clips that are 
identified as being from the same camera being put into the same angle track of the resulting 
multicam clip being created. It also enables the “Detect using” drop-down menu.

 — Detect Using: The metadata used to determine which clips come from the same camera. 
You can choose from Camera #, Angle, Reel Number, Reel Name, and Roll/Card #, which are 
user-editable in the Metadata Editor of the Media page, or you can choose Reel Name which 
is automatically or manually derived using either the Conform Options of the General Options 
panel of the Project Settings, or the Name panel of the Clip Attributes window. For more 
information on the Conform Options, see Chapter 4, “System and User Preferences.”

 — Move Source Clips to “Original Clips” Bin: A checkbox that lets you move all of the original 
ISO clips into an Original Clips bin to get them out of the way after the multicam clip has 
been created.

4 When you’re done choosing options, click Create. Depending on the Angle Sync method you 
chose, a waveform analysis might generate a progress bar, and then the new multicam clip is 
created in whichever bin is currently selected in the Media Pool. Multicam clips appear with a 
multicam badge in the lower left-hand corner of the clip thumbnail.

A multicam clip 
showing its badge 
in the Media Pool

Converting Compound Clips or 
Timelines to Multicam Clips
You can convert compound clips and timelines into multicam clips for easier editing using the Edit 
page’s Multicam Editing interface. This conversion is a one-way process. You cannot reconvert a 
multicam clip back to a timeline or compound clip. If you wish to preserve the original timeline or 
compound clip, make sure to duplicate it first, and then convert the copy.
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To convert a compound clip or timeline to a Multicam clip:  

 — Right-click on the clip or timeline in the Media Pool and choose “Convert Compound Clips 
(Timelines) to Multicam Clips” from the drop down menu.

Logging and Editing Multicam Clips
Once you create one or more multicam clips, you can view them in the Media page or in the Source 
Viewer of the Edit page, and add markers to them (all angles share the same markers) to prepare for 
the multicam edit you’re planning on performing. When viewing multicam clips in the Media page, you 
can choose how many angles to show in the viewer via the Viewer Option menu. 

Markers set in a multicam clip in the Media page to prepare for editing

Setting up a Timeline for 
Multicam Editing
Once you’ve created one or more multicam clips, preparing them for editing is as simple as editing 
them into the Timeline, either by dragging and dropping the multicam clip to the Timeline from 
the Media Pool, or by opening the multicam clip into the Source Viewer, and then using any of the 
available editing methods to cut it into the Timeline from there. Once edited, they appear in the 
Timeline like any other clip, just with a multicam badge to the left of the clip name.

Multicam clip badge 
in the Timeline
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When you perform a multicam edit, DaVinci Resolve plays the entire audio mix while you’re editing, so 
if you want to take the opportunity to edit a master audio mix file or additional piece of music to play 
along with the multicam clip, you can do so.

Opening and Altering Multicam Clips
After you’ve created a multicam clip and put it into a timeline, you can modify it in a variety of ways by 
right-clicking it in the Media Pool and choosing “Open in Timeline.” This replaces the contents of the 
Timeline with a vertical stack of superimposed angles, one per track, each of which is offset from the 
beginning of the Timeline to align with one another. 

An open multicam clip appears like a timeline with a vertical stack of clips

With the multicam clip open, you can make a variety of changes in preparation for editing:

 — You can slide a multicam clip left or right to alter its sync (selecting an angle and using the Period 
(.) and Comma (,) “nudge” keyboard shortcuts can be a good way of doing this).

 — You can delete the track of an angle you don’t need (right-click the track header and 
choose Delete Track).

 — You can rearrange tracks to rearrange the order in which angles appear (right-click any track 
header and choose Move Track Up or Move Track Down).

 — You can rename tracks to change the angle name that appears by default in the Multicam Viewer 
and that will also appear in the Timeline when you do cut and switch editing.

 — You can disable audio or video tracks that correspond to angles you don’t want to see, but don’t 
want to eliminate, either.

 — You can grade each multicam angle separately (discussed later in this section).

When you’ve finished altering the contents of the multicam clip, you can close it using the path control 
at the bottom left-hand corner of the Timeline. Click the name of the edited timeline to go back, in 
preparation for the next steps.

A path control lets you 
exit the multicam clip
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Performing a Multicam Edit
After you’ve created one or more multicam clips and edited them into a timeline, actually executing a 
multicam edit is simple.

1 Open the Timeline you created to hold the multicam clip or clips comprising your edit, and 
position the playhead where you want to start editing.

2 Choose Multicam from the Source Viewer mode drop-down.

Switching the 
Source Viewer to 
Multicam viewing

The Source Viewer changes to display all of the different angles within that clip as 
switching controls.

3 Choose how many angles you want to display from the drop-down menu at the bottom right of 
the Source Viewer. If you’re using a computer that’s not very fast, you may need to reduce the 
number of angles you’re viewing to maintain real time playback.

Choosing how many 
angles to view in the 
Multicam Viewer

If there are more angles within the multicam clip intersecting the playhead in the Timeline than 
the Multicam Viewer is set to show, then page controls appear to the left of this drop-down menu 
that let you choose which set of angles you want to view. 

You can move to another page of angles by doing one of the following:

 — Click any dot to jump to that page of angles.

 — Click the arrows to move among next/previous sets of angles.

 — Choose Edit > Multicam > Previous Page (Option-Shift-Left Arrow) or Next Page 
(Option-Shift-Right Arrow).

4 Choose whether you want to switch both the audio and video, just the video, or just the audio 
using the Audio/Video selection buttons at the bottom center of the Multicam Viewer. You can 
also choose Edit > Multicam > Video and Audio (Option-Shift-[ ), Video Only (Option-Shift-] ), 
Audio Only (Option-Shift-\).
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Buttons for choosing 
whether to switch the 
video, the audio, or both

5 Start playback, and while watching the program play, do one of the following:

 — Click any angle in the Multicam Viewer to insert a cut in the Timeline and switch to that angle. 
As you cut-and-switch, the cuts immediately appear in the Timeline while you play onward.

 — Option-click any angle to switch the angle used by the current clip without adding a cut. This is 
useful if you later regret the angle you cut to and just want to switch the entire segment since 
the last cut you made. This can also be accomplished by choosing Edit > Multicam > Previous 
Angle (Command-Shift-Left Arrow) or Next Angle (Command-Shift-Right Arrow).

As you play, the entire mix in the Timeline will play along with what you’re switching, so you can 
work in context.

A timeline while it’s being edited using cut and switch

6 When you’re ready to stop multicam editing, simply stop playback. If you want to start trimming 
the Timeline to fine-tune what you’ve done, choose Source from the Source Viewer mode drop-
down, and you can re-edit and trim the multicam clips in the Timeline just like any others.

Multicam Controls in 
the Source Viewer
The Source Viewer, in Multicam mode, has four sets of controls that let you set up and execute 
multicam editing.

 — Multicam Angle buttons: Each multicam angle displayed in the Source Viewer is a button that 
lists the angle name underneath. Clicking any of these buttons inserts a cut and switches the 
angle of the next clip, while Option-clicking changes the angle of the clip at the position of the 
playhead without adding a cut.

 — Audio/Video Selection buttons: Clicking any of these buttons inserts a cut and switches the 
angle of the next clip, while Option-clicking changes the angle of the clip at the position of the 
playhead without adding a cut.

 — Multicam display drop-down: Lets you choose how many angles to view while switching. 
Depending on your workstation’s performance, reducing the number of angles can improve 
playback performance while you edit. You can choose from a grid of 1x1, 1x2, 2x2, 3x3, or 4x4 
angles to view.
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 — Multicam Page buttons: If there are more angles within the multicam clip intersecting the playhead 
in the Timeline than the Multicam Viewer is set to show (via the multicam display drop-down), then 
page controls appear that let you choose which set of angles you want to view. Click any dot to 
jump to that page of angles, or click the arrows to move among next/previous sets of angles.

The Source Viewer showing Multicam switching controls

Multicam Keyboard Controls
There’s also a full set of keyboard shortcuts that can be used for multicam editing.

 — Multicam Cut: (Clip > Multicam Cut submenu) Pressing the 1 through 9 number keys performs a 
cut-and-switch operation, the same as if you’d clicked on an angle button of a multicam clip in the 
Source Viewer.

 — Multicam Switch: (Clip > Multicam Switch submenu) Pressing Option-1 through 9 performs a 
switch operation, the same as if you’d Option-clicked an angle button of a multicam clip in the 
Source Viewer.

 — Previous/Next Angle: (Edit > Multicam submenu) Pressing Command-Shift-Left or Right Arrow 
lets you switch to the previous or next angle. These controls will also loop back around to the first 
or last angles in the multicam clip.

 — Audio/Video Switching: (Edit > Multicam submenu) Pressing Option-Shift-[ sets the Multicam 
Viewer to cut or switch both Video and Audio at the same time. Pressing Option-Shift-] sets the 
Multicam Viewer to cut or switch Video only. Pressing Option-Shift-\ sets the Multicam Viewer to 
cut or switch Audio only.

 — Previous/Next Page: (Edit > Multicam submenu) Pressing Option-Shift-Left or Right Arrow lets 
you move to the previous or next page of multicam angles, if there are more angles than can be 
displayed in the Viewer’s current multi-angle setting.
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Editing Multicam Clips in the Timeline
When it comes to editing and trimming, there’s no functional difference between multicam clips and 
any other kind of clip. Because you’re technically adding through edits to a single clip, you have the 
option or deleting any edit by selecting it and pressing the Delete key.

But multicam clips are special in that you always have the option of switching angles, either using the 
Multicam Viewer, or right in the Timeline via each clip’s contextual menu.

To switch the angle of any multicam clip in the Timeline:

 — Right-click any clip and choose a new angle from the “Switch Multicam Clip Angle” submenu. 
This also allows you to change angles without needing to use the Multicam Viewer.

In the event that you want to eliminate all unused angles from a multicam clip and “flatten” 
it to simply be a single clip in the Timeline, there’s a command for that. 

To flatten a multicam clip in the Timeline: 

 — Right-click any clip and choose Flatten Multicam Clip from the contextual menu. Select either 
Copying Multicam Grades to copy the existing color grade to all other angles, or Retaining Grades 
from Angles to keep any color grades done on individual angles. All unused angles are deleted, 
the clip becomes shorter if it included black tails because of another unused angle, and you end 
up with a single ordinary clip in the Timeline.  

To Match Frame to the angle of any multicam clip in the Timeline:

 — Place the playhead over the frame in the Timeline you want to match and press F. The exact 
frame of the mulitcam clip referenced will appear in the Source Viewer with the appropriate angle 
already selected.

To Match Frame to the multicam clip in the Source Viewer:

 — Open the multicam clip in the Source Viewer. Navigate to the frame you want to find using the jog 
bar and press F. The playhead in the Timeline will move to the exact frame of the mulitcam clip 
referenced in the Source Viewer. If the frame you selected is not in the Timeline, when you press F 
nothing will happen.

To edit an angle of any multicam clip directly from the Source Viewer:

 — You can click and drag any multicam angle directly from the Source Viewer to the Timeline. 
The length of the clip is bounded by the In and Out point selection of the clip.

Referencing a Line Cut
You may sometimes be provided with what’s called a “line cut” from a production. 
This is a pre-edited version of the program, cut live with the switcher and recorded during 
the performance or event, that’s meant to be used as a reference for what you’re doing. 
If you want to reference a line cut that’s been given to you as a movie file, you can add it 
as an Offline Reference Movie, and compare it to the Timeline using the Offline Reference 
Movie mode of the Source Viewer in the Edit page. For more information on using an 
Offline video to compare with a timeline in the Edit page, see Chapter 55, “Preparing 
Timelines for Import and Comparison.” 
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Grading Multicam Clips
Multicam clips appear like any other clip in the Color page. However, each angle within a multicam clip 
has its own grade (unlike the Take Selector described later, in which all takes share the same grade). 
If you grade a multicam clip, you’re actually editing the grade of the specific angle that’s currently 
exposed in that clip. 

If you want access all of the angles within a multicam clip for grading, right-click it and choose “Open 
in Timeline” to expose each angle within a superimposed stack. Then you can open the Color page 
and grade whatever angles you want, whether they’re visible back in the Edit page or not. You might 
do this to make the different angles match one another better, or to pre-grade all of the angles to give 
them the look you want prior to multicam editing. You also need to use “Open in Timeline” in order to 
access and manipulate the camera RAW settings if your footage was shot in a RAW format. 

An open multicam clip in the Color page exposes all of its angles for individual grading

Because opening multicam clips in the Timeline results in a vertical stack of superimposed clips, you’ll 
want to turn on Unmix in the Color page viewer so that you can actually see the currently selected 
angle in the Thumbnail Timeline while you work.

The Unmix control lets 
you see only one of a 
superimposed stack of clips

When flattening a multicam clip, you can choose to grade individual angles or the multicam clip as a 
whole. In the Edit page, select Flatten Multicam Clip and either Copying Multicam Grades to copy the 
existing color grade to all other angles, or Retaining Grades from Angles to keep any color grades 
done on individual angles.

When you’re done grading, go back to the Edit page, and use the path control at the bottom left-hand 
corner of the Timeline to return to your edited Multicam timeline.
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Chapter 42

Take Selectors, 
Compound Clips, 
and Nested Timelines
This chapter covers a variety of different ways you can turn multiple 
clips into a single object in the Timeline, to accommodate a variety 
of different editing tasks. 

Take Selectors, compound clips, and nested timelines all appear as a single clip in the Timeline, 
but they all organize multiple clips in different ways. Take Selectors let you organize multiple clips 
vertically, making it easy to associate clips with one another so you can easily switch among them. 
Compound clips and nested timelines let you organize multiple clips horizontally, so that you can 
manage long or short sequences of clips within an edit as a single clip, when convenient.
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Take Selectors
Take Selectors in DaVinci Resolve provide a way for you to manage multiple takes or versions of a 
particular clip in the Timeline. They’re ideal for storing multiple useful takes for scenes where you or 
the client can’t quite decide which one is the best, or for maintaining multiple versions of VFX clips that 
are going through different iterations. 

When you place a number of clips inside a Take Selector, only one clip appears in the Timeline, but 
you can open that Take Selector and switch to any other take or version that’s stored within to switch 
which clip appears in the Timeline whenever you want.

A Take Selector, 
shown open, with 
several alternate 
takes placed within

Take selectors are easy to create and use and populate. Once you’ve placed a number of clips inside 
the Take Selector, you can drag any take to slip that clip’s range of media to synchronize it with the 
other takes, or click a take to choose that clip within the Take Selector to appear in the Timeline, before 
closing the Take Selector to confirm your change. 

When closed, a Take 
Selector appears as a 
regular clip with a badge

When closed, multi-take clips can be edited, trimmed, composited, graded, and rendered like any 
other single clip in the Timeline. A Take Selector badge appears to the left of the name of a clip to 
which it’s applied to show its status; double-clicking this badge opens the Take Selector so you can 
adjust its contents.
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Methods of using Take Selectors:

 — To create a Take Selector: Right-click any clip that’s not a title or generator, and choose Take 
Selector from the contextual menu. The Take Selector interface appears, disabling the rest of the 
Timeline temporarily while you work with the Take Selector’s contents.

 — To populate a Take Selector: Drag any clip from the Media Pool into the Take Selector, and it 
appears “stacked” on top of the original clip in the Timeline.

 — To choose the current take: Click any clip within the Take Selector so that it’s highlighted, and 
then click the close button at the upper-left corner of the Take Selector. When next you open the 
Take Selector, the current clip appears at the bottom of the stack, with a star at the upper-left 
corner. Absent a choice, the current take will default to the last clip added to the Take Selector.

 — To set a Take Selector to ripple the Timeline when a longer or shorter take is selected: 
Click the Ripple Take button, at the upper right-hand corner of the Take Selector panel, to the left 
of the trash can button. With this turned on, selecting a take that’s longer or shorter than the 
current take will ripple the Timeline. With this turned off, selecting a take that’s longer or shorter 
will either overwrite the next clip to the right, or leave a gap.

 — To slip a clip within the Take Selector: Drag any clip to the left or right to slip the range of media 
that appears within the Take Selector’s duration in the Timeline. This is useful for synchronizing 
other takes to fit the same narrative beat as the first take you used.

 — To remove a clip from a Take Selector: Click the clip you want to remove to select it, then 
click the trash can button at the upper-right corner of the Take Selector. That take disappears from 
the Take Selector.

 — To close a Take Selector: Click the X close button, or press the escape key. Whichever take was 
selected is now the clip that appears in the Timeline.

 — To reopen a Take Selector: Double-click the Take Selector badge at the left of a clip’s name, or 
right-click a multi-take clip and choose Take Selector from the contextual menu.

 — To eliminate a Take Selector leaving only the take you want: Close the Take Selector, if open, 
then right-click that clip in the Timeline and choose Finalize Take from the contextual menu.

Compositing and Grading Take Selectors
Since compound clips act like a single clip in the Timeline, they appear as a single MediaIn node in the 
Fusion page, and you grade them as you would any other single clip in the Color page. However, for 
Take Selectors, the composite or grade is applied to the Take Selector itself; when you switch to any 
other take, it appears with the same composition and grade.

NOTE: Any keyframing you do is relative to the Timeline of the overall Take Selector. This 
means that if you create a keyframed effect in either the Fusion or Color pages using take 1, 
and you then switch to takes 2, 3, or 4, the timing might not be exactly the same and you 
might need to make some adjustments.
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Compound Clips
You can select a series of clips in the Timeline, be they edited one after the other in serial or 
superimposed and stacked in parallel, and turn them into a compound clip, which is a single clip in 
the Timeline that’s actually comprised of many other audio and video clips embedded inside. This 
allows you to work with a block of clips as if it were a single unit, governed by a single set of Inspector 
controls, and able to be connected to another clip in your timeline by a single transition.

Editing a compound clip works the same as editing any other type of clip. They can be edited, 
trimmed, and deleted using all the same methods. In addition, compound clips can be renamed, and 
decomposed back into their component clips right in the Timeline.

To create a compound clip by selection:

1 Select a range of clips.

Selecting a range of clips to turn into a compound clip

2 Right-click one of the selected clips and choose New Compound Clip.

3 Enter an optional start timecode and a name, and click Create.

The New Compound 
Clip Properties dialog

A compound clip is created which takes the place of the original clips you selected on the Timeline. 
Additionally, a copy of that compound clip appears in the currently selected bin of the Media Pool.
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The resulting compound clip

To create a compound clip by In-Out range:

1 Select a range of clips using In and Out points on the Timeline. This allows you to select partial 
sections of a clip to add to the compound, rather than the whole clip. All tracks between the In-
Out range will be included, even if the track is disabled or auto select is off. 

Selecting a range of 
clips based on In and 
Out points to turn 
into a compound clip. 
Note that this selection 
includes only parts 
of the first and last 
clips in the range.

2 Right-click on the timeline range and choose Convert In and Out to Compound Clip.

Right clicking on the 
In-Out range (gray bar) 
on the Timeline brings 
up the context menu.

3 Enter an optional start timecode and a name, and click Create.
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The resulting bounds 
of the compound clip 
showing only the 
media included in the 
exact In-Out range.

To rename a compound clip:

 — Click the name of the compound clip twice in the Media Pool to select the name text. Type a new 
name, and press the Return key to accept the change.

To edit a compound clip:

1 Right-click any compound clip and choose Open in Timeline from the contextual menu. 

The Timeline updates with the contents of the compound clip, which you can re-edit 
at your discretion. 

An open compound 
clip in the Timeline

2 To return to the original timeline when you’re finished, double-click the name of the enclosing 
timeline in the path control at the bottom left-hand corner of the Timeline.

The path control you can use to close the compound clip
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To decompose a compound clip into its individual clips in the Timeline:

 — Right-click any compound clip and choose Decompose in Place from the contextual menu. 
The compound clip is replaced by the individual clips it was made from.

To edit a compound clip from the Media Pool to the Timeline as individual clips:

1 Choose Edit > Decompose Compound Clips on Edit so the menu item is checked.

2 Use any editing command except for Fit to Fill or Place on Top to edit a compound clip 
from the Media Pool or Source Viewer to the Timeline to edit it as a sequence of individual, 
decomposed clips.

Compositing With and Grading Compound Clips
Since compound clips act like a single clip in the Timeline, they appear as a single MediaIn node in 
the Fusion page, and you can grade them as a single clip in the Color page. However, if you want 
to individually apply effects, adjust the RAW camera settings, or grade the original clips inside the 
compound clip, you can use the Open in Timeline command to access its constituent clips, and then 
open the Fusion or Color pages, where you’ll find each of the individual clips available for separate 
compositing or grading. When you’re done, go back to the Edit page and close the compound clip, and 
you’ll go back to seeing it as a single clip whenever you open the Fusion and Color pages.

Nested Timelines
Timelines, and sections of timelines, can be edited inside other timelines, either partially or whole. For 
example, if you’ve edited a program in scenes or reels such that each reel is contained in a separate 
timeline, you can edit all of the timelines together, one after the other, into a single timeline to 
assemble them into a final program.

Multiple timelines edited together into a single sequence

Nested timeline clips appear with a special badge to the left of the timeline name.

The badge that indicates a nested timeline
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Timelines can be edited like any other clip, you can select one or more timelines and drag and drop 
them into another timeline, drag them onto the Timeline Viewer editing overlay, or use the toolbar 
editing buttons or keyboard shortcuts to edit them, just as you would any other clip. 

Additionally, you can select multiple timelines in the Media Pool, right-click them, and choose Create 
Timeline Using Selected Clips to quickly assemble a group of timelines into a nested sequence.

The one exception is that you must drag and drop a timeline into the Viewer if you want to use it to set 
In and Out points, since double-clicking a timeline, or selecting a timeline and pressing Return simply 
opens it into the Timeline Editor. However, you can set In and Out points for timelines in the Filmstrip 
of the Media Pool, or you can edit a timeline into another timeline in its entirety, and then trim the 
head and tail down to just what you need. Double-clicking a nested timeline opens it into the Source 
Viewer for trimming, exactly like any other clip.

Re-Editing a Nested Timeline
If you want to edit the contents of a nested timeline, you can right-click it and choose Open in 
Timeline. Unlike compound clips, no path control appears when you do this, because you’ve simply 
opened the original timeline. To go back to the previous timeline, find and double-click it in the Media 
Pool, or choose it from the Timeline drop-down at the top of the Timeline Viewer.

Editing an original timeline does nothing to change the duration of nested instances of that timeline 
inside other timelines. If you trim or delete clips in the original timeline that appear in nested 
instances of that timeline, then those areas of the nested timeline simply go black.

Swapping the Contents of the 
Source Viewer and Timeline
When editing the partial contents of one timeline into another, it can be useful to see the contents of 
a timeline that’s open in the Source Viewer in the Timeline Editor. To do so, choose Timeline > Swap 
Timeline and Source Viewer (Command-Page Up). This puts the timeline that was open in the Source 
Viewer into the Timeline Editor, and the timeline that was in the Timeline Editor into the Source Viewer. 
This makes it easier to mark In and Out points while seeing the exact boundaries of clips, prior to 
pressing Command-Page Up to swap the contents of the Source Viewer and Timeline Editor once 
again in preparation for executing the next edit.

Editing Source Media From a 
Timeline or Compound Clip
If you have a timeline that has clips you want to edit into another timeline, but as source clips and not 
as nested timeline segments, you can turn on Edit > Decompose Compound Clips on Edit. 

This a mode determines whether a timeline is edited into another timeline as a nested timeline, 
or immediately decomposed into its constituent source clips. Turning this mode on lets you edit 
source clips from a timeline using drag and drop, 3-point edits, or whatever other method you 
find convenient. To go back to editing nested timelines, turn Edit > Decompose Compound Clips 
on Edit off.

This mode is especially useful for workflows where you’re assembling “selects” timelines with the 
best moments of various interviews or performances, which you later want to edit as sources into the 
actual program you’re editing.
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Marking Clips in Timelines Loaded 
into the Source Viewer
While you’re editing Source Media from a timeline that’s loaded into the Source Viewer, you can use 
the Mark Clip (the X key) to set Viewer In and Out points that match the start and end of whatever clip 
intersects the playhead within that timeline. This makes it easy to edit one clip from a Timeline in the 
Viewer into your program, all by itself.

(Left) A timeline in the Source Viewer, (Right) Pressing X marks In and 
Out points for the clip at the playhead, ready for editing

Decomposing Nested Timelines
There are two main ways you can turn a nested timeline back into its constituent clips.

Decomposing in Place
To decompose a nested timeline that’s already been edited into another timeline, right-click it and 
choose Decompose in Place. You can also do this for multiple selected nested timelines, all at once.

(Top) A nested timeline, (Bottom) The result of using Decompose In Place
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If the decomposed clip has more audio, video, or subtitle tracks as a result, then additional tracks will 
be added to the Timeline to make room. If this is a problem, you can rearrange the clips

Decomposing Nested Timelines While Editing
If you want to edit an entire timeline into another timeline solely as the source clips, you can turn 
on Edit > Decompose Compound Clips on Edit, and then edit that timeline into your program using 
whatever method you find convenient, as described previously in this chapter.

Compositing and Grading Nested Timelines
Similarly to compound clips, nested timelines act like a single clip in the Timeline; they appear as a 
single MediaIn node in the Fusion page for compositing, and you can grade them as a single clip in 
the Color page. However, if you want to individually add effects to or grade the original clips inside 
a nested timeline, you can either open that timeline from the Media Pool, or right-click that clip and 
choose Open in Timeline in order to access its constituent clips for compositing or grading.

Audio Buses in Nested Timelines
When you nest a timeline inside of another timeline that has buses set up for mixing in the Fairlight 
page, all Sub and Aux routings work as intended within the nested timeline, which exposes all 
channels of Main 1 in the enclosing timeline. In this sense, the audio of the nested timeline can be 
considered to be a submix that outputs its resulting audio to the audio track it’s edited onto. For more 
information about Buses and audio mixing in general, see Part 13, “Fairlight.”

Converting Compound Clips 
or Timelines to Multicam Clips
It’s possible to convert compound clips and timelines into multicam clips for easier editing using the 
Edit page’s Multicam Editing interface. This conversion is a one-way process. You cannot reconvert 
a multicam clip back to a timeline or compound clip. If you wish to preserve the original timeline or 
compound clip, make sure to duplicate it first, and then convert the copy. For more information,  
see Chapter 41, “Multicam Editing.” 

To convert a compound clip or timeline to a Multicam clip:  

 — Right-click on the clip or timeline in the Media Pool and choose “Convert Compound Clips 
(Timelines) to Multicam Clips” from the drop down menu.
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Chapter 43

Trimming
Most editors would agree that trimming is half the job of editing. 

While you can make many kinds of changes in the Timeline using the selection and razor blade 
tools, there is a dedicated Trim mode in which you can perform more sophisticated trim operations 
in fewer steps using either the mouse or keyboard shortcuts, depending on how you like to work. 
Mastering DaVinci Resolve’s trimming operations will save you time when doing the necessary work of 
fine-tuning your edit. 
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Trimming Multiple Edits or Clips at Once  844
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Keyboard Shortcuts in This Chapter
Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

Key Shortcut Function

T Trim mode, ripples edits and slips or slides clips

A Selection mode, resizes edits and moves clips

Command-L and J
“Fast trim” dynamically trims the selection at 100% forward and 
reverse speeds

W Dynamic trim or resize mode, uses JKL to trim the selection

S
Toggles between Slip and Slide mode when a clip is selected 
in Trim mode

V
Selects the edit point closest to the playhead and moves the 
playhead there

Shift-V Selects the clip or gap that intersects the playhead

Shift (modifier)
A modifier that temporarily disables the 2- and 4-up display 
that appears when trimming edits and clips with either the 
pointer or keyboard shortcuts.

Shift-Q
Toggles Enable Preview During Editing to control visibility 
of the 2- and 4-up displays
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Key Shortcut Function

Option-F1 through F9 Toggles Auto Select for video tracks 1 through 9

Command-Option F1 
through F9

Toggles Auto Select for audio tracks 1 through 9

U
Toggles edit point selection among the outgoing, centered, or  
incoming part of the edit

Comma, Period
“Nudge” keys to move a selected edit or clip left or right a 
frame at a time

Shift-Comma, Period
“Fast Nudge” keys to move a selected edit or clip left or  
right 5 frames at a time (customizable)

/ Play around current selection

Command-/ Toggles looped playback off and on

Down Arrow, Up Arrow
Moves both the playhead and selection to the next or previous 
edit point

E
Extend edit to resize or ripple selected edit points to the 
position of the playhead

Shift-Left, Right Bracket ([, ])
Trim Start to Playhead and Trim End to Playhead to trim a clip 
at the position of the playhead and leave a gap (unless you’re in 
Trim mode so the gap will be closed)

Shift-Command-Left, 
Right Bracket ([, ])

Ripple Trim Start to Playhead and Ripple Trim End to Playhead 
to trim a clip at the position of the playhead and close the gap

Command-Shift-X Ripple cut selection; close gap left by cut clip(s)

Command-C Copy selected clips

Command-V Paste clips

Command-Shift-V Paste insert clips

Summarizing Trim Operations
Before going into the different methods of trimming that are available, users who are new to editing 
might benefit from a quick summary of what each trimming operation actually does. Each trim 
operation is designed to let you move edits and clips in relation to whichever clips are around them, 
by performing several operations at once. The five primary methods of trimming are:

 — Resize: Shortens or lengthens the end of an outgoing clip or the beginning of an incoming 
clip, while either overwriting a neighboring clip or leaving a gap behind as necessary. 
While this isn’t usually included iç a discussion of “trim” operations, it’s actually the simplest 
kind of trimming you can do.

 — Roll: Moves an edit point to the left or right by either shortening the outgoing clip while 
lengthening the incoming clip, or vice versa. Roll edits do not change the duration of the 
overall Timeline.
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 — Ripple: Shortens or lengthens the end of an outgoing clip or the beginning of an incoming 
clip, while simultaneously moving all clips either to the right in the Timeline (if you’re rippling to 
lengthen a clip) or left in the Timeline (if you’re rippling to shorten a clip) to fill the gap or prevent 
overwriting that would otherwise occur if you were doing a resize operation. Ripple edits do 
change the duration of the overall Timeline and can alter the sync relation between different 
tracks if you’re not careful.

 — Slip: Keeps a clip in the same place in the Timeline, while changing the range of media that 
appears in that spot. Slip edits do not change the duration of the overall Timeline.

 — Slide: Keeps a clip’s range of media the same, but moves that clip to the left or right by 
either shortening the outgoing clip to its left while lengthening the incoming clip to its right, 
or vice versa. 

Selection-Based Trimming 
Using the Trim Tool
Trim mode differs from Selection mode in that operations that would move clips with the Selection 
tool will either slip or slide clips with the Trim tool. Other operations that would resize edits with the 
Selection tool instead ripple the Timeline to automatically close gaps when using the Trim tool. The 
following sections describe the various trim operations that are available, both when using the mouse, 
and when using the keyboard.

To enter Trim Edit mode:

 — Click the Trim Edit button, or press the T key.

How the Trim Tool Differs From the Selection Tool
Aside from the actual trimming operations that are available, there are a few other important 
differences between the Trim tool and the Selection tool. 

Selecting Edit Points
When the Trim tool is selected, dragging a bounding box over a series of clips in the Timeline selects 
the edit points to join clips together, instead of the clips themselves. This makes it fast and easy to 
select multiple edit points that you want to operate on simultaneously.

Selecting edit points in the Timeline using the Trim tool
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Rippling the Timeline With Different Operations
When the Trim tool is selected, other commands and controls that would ordinarily resize a clip or clips 
and leave gaps in the Timeline instead move (ripple) clips that are to the right of the clip or edit you’re 
trimming over to the left to prevent gaps whenever clips or edits are moved or resized. 

Rippling the incoming edit point of Clip L to resize it and prevent a gap from appearing 
by moving all clips that are to the right (Clips P, L, and N) over to the left

For example, the Retime controls, the Extend and Trim Start/End commands, and the Nudge keyboard 
shortcuts all work differently depending on whether you’re using the Selection or Trim tools. This lets 
you use one set of tools to do different operations, depending on what you need to do.

Rippling Gap
You can also use the Trim tool (or other trim operations described later in this chapter) to ripple the 
start and end of a gap in the Timeline. Rippling a gap lets you grow or shrink the gap while moving 
the portion of the Timeline to the right of the gap forward or backward in time. Whenever you ripple 
against gap, a 2-up display appears that lets you see both the clip you’re trimming and whatever 
superimposed clips may be showing through that gap.

 

Using the Trim tool to ripple the Out point of a gap to narrow it

TIP: You can temporarily toggle between the selection (A) and trim tools (T) while using 
these operators to see their effects. Releasing the key will return you to the originally 
selected mode.
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Using the Trim Tool With the Mouse
When trimming using the mouse, you can perform every kind of trim operation that’s available using 
a single tool, simply by clicking the Trim mode/tool button, and then dragging on the appropriate area 
of a clip in the Timeline.

Methods of trimming with the mouse in Trim Edit mode:

 — To slip a clip: To slip a clip’s range of content without changing its position in the Timeline, click 
the middle top region of a clip, and then drag to the left or right to “slip” the clip to contain a 
different range of frames. A dashed overlay shows the total duration of media available for you to 
slip with, which moves left and right as you drag.

Clicking the top clip area before a slip, an overlay shows the clip’s available range of media

After dragging to slip, clips don’t move, but the slipped clip’s range of media has changed

When slipping clips, a 4-up display shows all relevant outgoing and incoming frames, so you 
can compare the continuity of action from one clip to the next. During a slip, the top two frames 
update to show you the new incoming and outgoing frames of the clip being slipped, relative to 
the unchanging outgoing frame of the clip to the left and incoming frame of the clip to the right.

TIP: You can temporarily disable this four-up display by pressing the Shift key while 
you slip so that you only see the frame at the position of the playhead. This makes it 
possible for you to see which frame passes the playhead by as you ripple the Timeline. 
You can toggle this two-up display off completely by selecting View > Enable Multiview 
Edit Preview.
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Four-up display when slipping a clip

 — To slide a clip: To slide a clip, moving it to another position in the Timeline while simultaneously 
adjusting the Out point of the previous clip and the In point of the next clip to accommodate the 
change in position of the current clip being dragged, click the bottom-middle name bar of the clip 
and drag it to another position.

After dragging to slide, the selected clip is at a new location, surrounding clips filled the gap

When sliding clips, a 4-up display shows all relevant outgoing and incoming frames, so you can 
compare the continuity of action from one clip to the next. During a slide, the bottom two frames 
update to show you the new outgoing frame of the clip to the left, and the new incoming frame of 
the clip to the right of the clip being slid.

TIP: You can temporarily disable this four-up display by pressing the Shift key while 
you slide so that you only see the frame at the position of the playhead. This makes it 
possible for you to see which frame passes the playhead by as you ripple the Timeline. 
You can toggle this two-up display off completely by choosing View > Enable Multiview 
Edit Preview.
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4-up display when sliding a clip

 — To roll an edit point: To roll an edit, moving the Out point of the outgoing clip and the In point of 
the incoming clip at the same time, drag an edit point between two clips to the left or right. (Roll 
edits can also be done in Selection mode.)

Selected edit point before roll

Edit point moved farther to the right, both adjacent clips resized to prevent gap

When rolling an edit, a 2-up display shows the changing continuity of action from the outgoing 
frame of the clip to the left to the incoming frame of the clip to the right, and you will hear the 
audio scrubbing of the right clip.
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Two-up display when rolling an edit

 — Ripple edit: To ripple the outgoing or incoming part of an edit to add or remove media to a clip 
while simultaneously moving all other clips at the left in the Timeline to make room, click the 
Trim tool, and drag an edit point to a new position in the Timeline.

Selected outgoing half of an edit point before ripple

Rippled clip is shorter, the rest of the Timeline has moved left to fill the gap

When rippling an edit, a 2-up display shows the continuity of action from the outgoing frame of 
the clip to the left to the incoming frame of the clip to the right. Which frame updates depends on 
which side of the edit you’re rippling.

TIP: You can temporarily disable this two-up display by pressing the Shift key while 
you ripple so that you only see the frame at the position of the playhead. This makes it 
possible for you to see which frame passes the playhead by as you ripple the Timeline. 
You can toggle this two-up display off completely by selecting View > Enable Multiview 
Edit Preview.
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Two-up display when rippling an edit

Turning Off the Heads Up Display While You Trim
If you press the Shift key while performing most drag and trim operations, you can suspend the 
multi-frame heads up displays that appear in the Timeline window in order to focus on the frame that 
intersects the playhead.

To toggle the two- and four-frame heads up displays off or on:

 — Choose View > Enable Multiview Edit Preview.

Trim Tool Operations 
With the Keyboard
You can also perform every trim operation more precisely using the Nudge keyboard shortcuts.

To trim with the keyboard:

1 Press T to select the Trim tool.

2 To trim the selection, do one of the following:

 — To slide a clip: Press Shift-V to select a clip, and press the Comma key to slip it one frame to 
the left, or the Period to slip it one frame to the right. Shift-Comma and Shift-Period slips the 
clip in 5-frame increments.

 — To slip a clip: Press Shift-V to select a clip, then press the S key to toggle to Slip mode 
(pressing S again toggles back to Slide mode) and press Comma or Period to slide its contents 
to the left or right. Shift-Comma and Shift-Period slides the contents in 5-frame increments.

 — To roll an edit: Press V to select an edit point, then press the Comma key to nudge it one 
frame to the left, or the Period to nudge it one frame to the right. Shift-Comma and Shift-
Period rolls the edit in 5-frame increments.

 — To ripple an edit: Press V to select an edit point, then press U to select either the incoming or 
outgoing side of the edit by itself. Then, press the Comma key to ripple the selected In or Out 
point of the clip to the left, or the Period to ripple it one frame to the right. Shift-Comma and 
Shift-Period ripples in 5-frame increments.
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3 If you want to suspend the 2- or 4-up display that appears in the Timeline Viewer while trimming, 
you can Choose View > Enable Multiview Edit Preview to toggle the trimming displays off and on.

TIP: When holding down the Shift key while nudging to do a “fast nudge,” the duration of 
the nudge is customizable in the Editing panel of the User Preferences. By default it’s five 
frames, but you can set it to whatever you want.

Important Trimming Keyboard Shortcuts
When trimming using the keyboard, the following keyboard shortcuts are important for you to 
remember. Most of these commands, and many more that haven’t been assigned to keyboard 
shortcuts, can also be found in the Trim menu. You can remap many of these commands to different 
keyboard shortcuts using the Keyboard Mapping panel of the User Preferences. For more information, 
see Chapter 4, “System and User Preferences.”

Key Shortcut Function

T Trim mode, ripples edits and slips or slides clips.

A Selection mode, resizes edits and moves clips.

Command-L and J
Fast trim commands, lets you dynamically trim the selection at 100% 
forward and reverse speeds.

W Dynamic trim or resize mode, uses JKL to trim the selection.

S
Toggles between Slip and Slide mode when a clip is selected in 
Trim mode.

V
Selects the edit point closest to the playhead, and moves the 
playhead there.

Shift-V
Selects the clip or gap that intersects the playhead. If there are 
superimposed clips, turn off the Auto Select controls of tracks 
containing clips you don’t want to select.

Shift
A modifier that temporarily disables the 2- and 4-up display that 
appears when trimming edits and clips with either the pointer or 
keyboard shortcuts.

Option-F1 through F9
Toggles Auto Select for video tracks 1 through 9, making it possible 
to restrict certain selection and trim operations performed with 
the keyboard.

Command-Option F1 
through F9

Toggles Auto Select for audio tracks 1 through 9, making it possible 
to restrict certain selection and trim operations performed with 
the keyboard.

U
Toggles the currently selected edit point among the outgoing, 
centered, or incoming part of the edit.
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Key Shortcut Function

Option-U
Toggles the currently selected edit point or clip among Video+Audio, 
Video Only, or Audio Only.

Comma (,)
After you’ve made a selection, nudges selected edits or clips one 
frame to the left. Shift-Comma nudges 5 frames (the duration is 
customizable in the Editing panel of the User Preferences).

Period (.)
After you’ve made a selection, nudges selected edits or clips one 
frame to the right. Shift-Period nudges 5 frames (the duration is 
customizable in the Editing panel of the User Preferences).

Forward-Slash (/)

This command works contextually depending on what’s selected in 
the Timeline. Plays a section of the Timeline from x frames before 
to y frames after (a) the playhead (if nothing’s selected), (b) the 
currently selected edit point, (c) the currently selected clip, (d) a 
selection of multiple clips. This command is useful for previewing 
how the current selection plays within the context of the clips 
immediately surrounding it. The pre-roll and post-roll time is 
customizable in the Editing panel of the User Preferences.

Command-/ Toggles looped playback off and on.

Down Arrow, Up Arrow

Moves both the playhead and selection state to the next or previous 
edit point. If multiple clips or edits are superimposed, the first clip 
on the lowest numbered track will be selected first, then the next 
clip up, and so on until the topmost superimposed clip is selected, 
before selecting the next clip in the Timeline.

E
Extend edit. Resizes or ripples selected edit points to the current 
position of the playhead.

Shift-[
Trim Start. Resizes (Selection) or ripples (Trim) the In point of all clips 
on auto-select-enabled tracks that intersect the playhead to the 
position of the playhead.

Shift-]
Trim End. Resizes (Selection) or ripples (Trim) the Out point of all 
clips on auto-select-enabled tracks that intersect the playhead to 
the position of the playhead.

Shift-Command-[
Ripple Trim Start. Regardless of whether Selection or Trim mode is 
enabled, always ripples the In point of clips on auto-select-enabled 
tracks that intersect the playhead to the position of the playhead.

Shift-Command-]
Ripple Trim End. Regardless of whether Selection or Trim mode is 
enabled, always ripples the Out point of clips on auto-select-enabled 
tracks that intersect the playhead to the position of the playhead.

IMPORTANT: While the Slip, Roll, and Slide tools will change the sync relationship of 
the clips you’re adjusting with a matching soundtrack, the rest of the Timeline won’t be 
affected. Using Ripple can alter the overall sync relationship of large portions of your 
timeline and its matching soundtrack, so you should use it with extreme care.

834Edit | Chapter 43 Trimming



Trimming Using Timecode Entry
You can also use absolute or relative timecode entry to trim clips and edits. What is trimmed depends 
on the selection you’ve made prior to entering timecode. If you want to use timecode to trim the 
selection forward relative to its current position, be sure to type an equal sign or plus (= or +) before 
the timecode value; to trim the selection backward relatively, type minus (–) before the timecode value.

 — To roll an edit: Select the center of an edit point, enter a timecode value, and press Return.

 — To ripple an edit: Select either the outgoing or incoming half of an edit point, enter a timecode 
value, and press Return.

 — To slip a clip: Select a clip, and press S if necessary to switch to Slip mode, enter a timecode value, 
and press Return.

 — To slide a clip: Select a clip, and press S if necessary to toggle to Slide mode, enter a timecode 
value, and press Return.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the 
Timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished typing, 
press the Return key to execute the Timecode command. The rules for timecode entry are as follows:

 — The rightmost pair of timecode values (or period) you enter is always the frame number.

 — A period to the left or to the right of any number you type is considered to be a pair of zeroes. 

 — A single period between two numbers is considered to either be a single zero or ignored if it’s 
between two pairs of numbers.

 — Any untyped pairs of values to the left of what you enter are assumed to be whatever those values 
were prior to the timecode you entered; this makes it easy to type partial timecode values even 
when the Timeline starts at hour one. 

 — It’s not necessary to enter colons or semicolons. 

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points 
are selected when you press the Return key, the playhead will move to that timecode value. If an 
edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, 
if possible. Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 115.. 01:15:00:00

01:10:10:10 23... 23:00:00:00
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Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus 
results in the value you type being added to the current timecode value for purposes of offsetting 
the playhead or moving a selection. Adding a minus will subtract the value you type from the current 
timecode value.

Here are two examples of  relative timecode entry:

+20. 00:00:20:00 is added to the current timecode value.

-5  00:00:00:05 is subtracted from the current timecode value.

Commands to Make 
Selections and Trim
A series of commands in the Trim menu make it fast to automatically select the In or Out point of the 
clip that’s nearest to the current position of the playhead, and go into either Selection or Trim mode in 
preparation for resizing or ripple trimming that edit point. These commands are:

 — Select Nearest Edit to Resize In

 — Select Nearest Edit to Resize Out

 — Select Nearest Edit to Ripple In

 — Select Nearest Edit to Ripple Out

 — Select Nearest Edit to Roll

 — Select Nearest Clip to Move

 — Select Nearest Clip to Slip

 — Select Nearest Clip to Slide

These commands are similar to using the Edit Selection (V) or Clip Selection (Shift-V) keyboard 
shortcuts along with those for choosing the Selection (A) or Trim tool (T) both at once, to get you ready 
for trimming in the way that you want. However, they have the added benefit of, in some cases, letting 
you specifically choose the In or Out points of the clip nearest the current position of the playhead. 
These commands don’t have keyboard shortcuts by default, but if you prefer this way of working, 
you can assign them to keyboard shortcuts of your choosing using the Keyboard Customization tool 
(Option - Command - K).

Trimming Clips in the Source Viewer
Additionally, you can double-click a clip in the Timeline to open it into the Source Viewer for trimming. 
When the Selection tool is selected, you can drag the In and Out markers, or use the playhead and I 
and O keyboard shortcuts to resize that clip in the Timeline. With the Trim tool selected, you can ripple 
the In and Out points of the clip.
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A Timeline clip being ripple-resized by opening it into the Source 
Viewer dragging its In point using the Trim tool
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You can slip the contents of the clip by holding the Shift key down and dragging either the In or 
Out point.

A Timeline clip being slipped by opening it into the Source Viewer and Shift-dragging its In point 
using the Trim tool

NOTE: To open a match frame of a clip that’s part of an edited sequence into the 
Source Viewer using the mouse, hold the Option key down while double-clicking a clip 
in the Timeline.

Ripple Editing Rules
Ripple operations are the only trim functions that change the duration of the overall Timeline, and that 
can potentially alter the sync relationship between multiple clips on different tracks. This makes them 
incredibly useful, but it’s important to understand which parts of the Timeline will move as part of a 
ripple operation, and which parts won’t.

The following operations ripple the Timeline:

 — Ripple deleting a clip or gap (Forward-Delete)

 — Ripple cutting a clip (Shift-Command-X)

 — Rippling one or more edits or gaps using the Trim tool (press T to choose the Trim tool)

 — Using the Extend Edit (E), Trim Start (Shift-[), or Trim End (Shift-]) commands in Trim mode

 — Using the Ripple Start (Command-Shift-[) or Ripple End (Command-Shift-]) commands in any mode

 — Performing an insert edit (F9) or ripple overwrite edit (Shift-F10)

 — Using the Retime controls to speed up or slow down a clip in Trim mode

 — Using the Change Speed dialog with the Ripple Sequence checkbox turned on

 — Changing clips in a Take Selector with the Ripple control enabled

During a ripple edit, superimposed clips with an In point that’s to the left of the edit point or clip being 
rippled are not moved. This can be seen in the previous example via the audio clip at the bottom 
of the Timeline, which stays in place even as the clips on track V1 and A1 are rippled. All clips with 
In points to the right of the edit point or clip being rippled move left to follow the trim operation 
you’re making.
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Before Ripple

After Ripple

Before Ripple Before Ripple

After RippleAfter Ripple

The rules of timeline rippling illustrated. All clips with In points to the left of Subclip B 
(the clip being rippled) are left in place (area in blue), while all clips to the right of the 
edit being rippled are moved by the duration of the ripple operation (in red)
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This simple rule means that, if you’re in the habit of building sequences of clips from left to right, long 
overlapping superimpositions such as titles, graphics, and music clips will stay in place while you’re 
rippling various clips within a montage that you’re editing in relation to these longer clips.

However, there’s one exception to this rule. It is often the case that split edits, where linked audio and 
video are cut at different places, create a situation where the audio In point of a pair of linked audio 
and video items precedes a video In point that you want to ripple. In other words, the audio In point 
extends to the left of the video In point, which ordinarily would trigger the rule that clips with edit 
points to the left of a rippled edit point  won’t be moved, which would throw the audio and video of 
this item out of sync. In this case, you probably want to maintain sync, so all items that are linked to a 
clip being rippled always ripple along with it, even if they do have In points that extend to the left of 
the edit point being rippled.

Using Auto Select Controls 
to Control Trimming
The Auto Select buttons on each track in the Timeline control a host of different operations, but while 
they’re deceptively powerful, they’re also among the most misunderstood controls of the Timeline. 
When a track’s Auto Select control is on, clips on that track are automatically included in three 
different types of operations:

 — Operations that affect clips intersecting the position of the playhead

 — Operations that affect clips intersecting a region defined by timeline In and Out points

 — Operations that ripple clips to the right of an affected clip on the Timeline

When a track’s Auto Select control is off, clips on that track are ignored by those same categories of 
operations, unless you manually select one or more clips or edit points.

The next three sections go into detail on how the Auto Select buttons help you control the trimming 
operations described in this chapter, particularly when it comes to operations that ripple the 
Timeline, and the kinds of “playhead-targeted” trim operations described later in this chapter. For 
more information on using the Auto Select controls to define selections and control other editing 
operations, see Chapter 36, “Editing Basics.”

Using Auto Select to Control 
Which Clips Are Trimmed
One of the principal uses of the Auto Select controls is to let keyboard shortcut-driven editors choose 
which specific clips on which tracks will be affected by an operation that would otherwise affect 
every superimposed clip at the position of the playhead or encompassed by In and Out points set in 
the timeline. 
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For example, if multiple clips are superimposed in V1, V2, and V3, and A1, A2, and A3, all six tracks have 
their Auto Select controls turned on, and you park the playhead over one of them and use the Trim 
End command in Selection mode, then all six superimposed clips will be trimmed.

Trimming all clips at the position of the playhead

However, if you only want to trim the clip in track V3, then you can solo the Auto Select control of 
V3 by Option-clicking it, and then when you use the Trim End command, the clip on V3 is the only 
one that’s trimmed, the other clips are ignored.

Trimming only the clip in V3 by soloing the V3 Auto Select controls
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Using Manual Selections to Control 
Which Clips Are Trimmed
It’s important to know that manual selections you make in the Timeline that highlight specific clips 
always take precedence over whatever the Auto Select controls are set to. For example, if Auto Select 
is turned on for tracks V1, V2, and V3, but you’ve selected a clip on track V1, only the selected clip will 
be still be affected by whatever operation you decide to perform. For example, if you use Trim End, the 
clip on track V1 will be affected.

Manual selection of a clip on track V1 overrides 
the Auto Select controls on all tracks

Using Auto Select to Control 
Which Tracks Are Rippled
Each track’s Auto Select control is also used to control how trimming and editing operations that 
ripple the Timeline affect timelines with multiple tracks and superimposed clips. Using Auto Select 
controls, you can turn off rippling on specific tracks, while leaving it on for others. 

For ease of use, you’ll typically want to leave Auto Select on for all tracks when rippling clips, to ensure 
that all the parts of your timeline stay in sync with one another. However, when the occasion requires, 
the Auto Select controls provide the option to suspend rippling on specific tracks while allowing 
rippling on others.

The rules are simple:
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 — Tracks with Auto Select enabled: Ripple editing or ripple deleting affects all clips to the right of 
the clip or clips on that track being trimmed.

Before and After, clip to the right of Clip T on tracks V2, V1, A1, and A2 are 
rippling because those tracks’ Auto Select controls are enabled

 — Tracks with Auto Select disabled: Rippling is disabled on these tracks.

Before and After, clip to the right of Clip T on tracks V1 and A1 are rippling because 
those tracks’ Auto Select controls are enabled, but clips on tracks V2 and A2 
aren’t rippling because those tracks’ Auto Select controls are disabled
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Another set of rules govern what happens when you select clips or edits for trimming on tracks 
with Auto Select disabled: 

 — Selected Tracks with Auto Select turned off with an edit selection: If you select the outgoing 
or incoming half of an edit on a track that has Auto Select off, the result will be a resize operation. 
Ripple deleting clips leaves a gap.

Before and After, clips to the right of Music Cue 03 on tracks V1, V2, A1, and A2 are rippling 
because Auto Select is enabled on those tracks, but because the clip being trimmed on 
track A3 has Auto Select disabled, it doesn’t ripple, instead resizing to open up a gap

Trimming Multiple Edits 
or Clips at Once
DaVinci Resolve lets you select multiple edit points or clips for certain trimming operations, making 
it possible to trim multiple edits and clips at the same time. In simple cases, this makes it easy to 
resize, ripple, slip, and slide several superimposed clips at the same time, which is a real convenience, 
or you can select the In point of every title generator in a credit sequence at once in preparation for 
shortening or lengthening them all at once. In more complicated cases, this lets you create more 
complicated trimming scenarios, such as multi-track asymmetric trimming, to quickly take care of 
difficult tasks.

No matter how ambitious a trim operation you want to set up, the procedure is exactly the same as for 
an ordinary trim operation. Just make sure you follow these three general steps, and you’ll be good:

1 Choose Selection mode, and select the edit points or clips you want to trim. To make multiple 
selections, click once to select the first item, then Command-click each subsequent item you 
want to add to the selection. You can select as many clips and/or edit points on as many tracks 
as you like.
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2 To ripple, slip, or slide the entire selection at once, choose Trim mode. To resize or move each 
selected item at once, continue using Selection mode.

3 Use the mouse, keyboard shortcuts, or timecode entry to execute the trimming operation, just as 
you would if a single edit point or clip were selected.

The following sections describe each of the special-case multi-selection trim operations that are 
possible, along with each one’s special rules and limitations.

Resizing and Rolling Multiple Edit Points
You can resize or roll multiple edit selections at once. In this way, you can adjust the edit points of 
multiple superimposed clips all together. Trimming multiple edit points essentially lets you “gang” 
them so that all selected edits move together as one.

 — To resize multiple clips at once, select the left (outgoing) or right (incoming) half of each edit point 
you need to adjust, then use the Selection tool to drag those edit points to resize them all.

 — To roll multiple clips at once, select every edit point you need to adjust right at the center, so 
that both the incoming and outgoing halves of each edit point are selected, then use either the 
Selection or Trim tools to drag those edit points to roll them all.

NOTE: You cannot combine ripple and roll operations at the same time.

Rippling Multiple Edit Points
It’s also possible to select multiple incoming or outgoing edit points on either superimposed video 
tracks, or on the same video track, in order to ripple them all at once. A good example of when you’d 
want to ripple multiple clips on the same track is if you’ve got an end credit sequence of 14 text 
generators, and you’d like to shorten the entire sequence by a particular amount. This example can be 
seen below. 

When you ripple trim multiple edits on the same track, how many frames are trimmed in a particular 
trim depends on what method you use to do your trimming. 

 — If you use use the Trim tool via dragging in the Timeline, then you can choose to ripple the entire 
selection of edits by an arbitrary duration, for example, shortening or lengthening the entire 
selection by eight frames. To do this, DaVinci Resolve performs your multi-selection trim operation 
one edit at a time, removing a frame at a time from each selected edit from the left to the right 
as you trim, until either you stop the operation, or every single selected edit has had a frame 
removed, at which point DaVinci Resolve begins trimming the second frame from each selected 
edit from the left to the right, and then the third, and so on, until you stop trimming. Working this 
way, you can use the mouse to trim any number of clips to fit into any duration. 

 — You can also choose to ripple each selected edit by the same amount, for example removing 
three frames from each of the selected edits, all at once. To do so, hold the Command key down 
while dragging selected edits with the Trim tool, or use Dynamic JKL trimming, or trim by entering 
relative timecode values, or use the nudge keys (Period and Comma). 
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To ripple trim multiple edits on the same track: 

1 Click the Trim tool, and drag a bounding box in the Timeline to select all 14 edits. 

2 Press the U key to select the incoming half of each selected edit. 

3 Use whichever trimming method you prefer to ripple the sequence to be shorter or longer. 
Dragging using the Trim tool lets you trim by an arbitrary number of frames, while holding the 
Command key down while dragging with the Trim tool, using timecode entry to trim, using the 
Comma and Period nudge keys, or using Dynamic JKL trimming lets you trim every selected edit 
by the same number of frames. 

(Before) Selecting 14 incoming credits edit points, (After) Trimming them all at once

In the following example, the incoming edit of three clips in the following montage are selected 
and simultaneously rippled using the Trim tool. Notice that each overlapping clip ripples along 
with the nearest selected edit that’s to the left of it; this means that the superimposed clip in track 
V2 and the audio clip in track A4 ripples along with the third selected edit, while the audio clip in 
track A2 ripples along with the second selected edit. Since the audio clip in track A3 starts to the 
left of the first selected edit, it does not ripple.

Selecting three incoming edit points,

Trimming them all at once
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Asymmetric Trimming
Asymmetric resize or ripple trimming can also be done to multiple clips, with one selection per track 
allowable on as many tracks as you require. To asymmetrically trim two or more clips, select an 
outgoing edit point on one track, and then Command-click an incoming edit on another track. 

Selecting opposite outgoing video and incoming audio edit points in 
preparation for performing an asymmetric ripple trim

To select the outgoing video edit of one clips and the incoming audio edit of the next clip in 
preparation for making a split edit, you can Option-click the outgoing video edit to suspend linked 
selection, and then Command-click the incoming audio edit to add it individually to the selection. 
Now when you drag, nudge, or use timecode to trim, each selected edit point will move in the 
opposite direction.

Dragging to perform an asymmetric ripple trim 
to create a split edit using the Trim tool

DaVinci Resolve allows you to do asymmetric trims to multiple edits in the same video and/or 
audio track. There are two compelling reasons for doing so:

Select the outgoing half of an edit point (the left side), then Command-click to select the incoming 
half of the same edit point (the right side) separately. This will not perform a roll edit, but will allow 
you to either use the Selection tool to resize both edit points away from each other to create a 
gap, or use the Trim tool to ripple both sides of the edit to shorten both clips while tightening up 
the Timeline at the same time.
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Before and After ripple trimming both the incoming and outgoing halves 
of an edit to shorten the duration of both clips at once

You can also select the In and Out points of a clip in the Timeline at the same time, and use the 
Trim tool to ripple both the beginning and end of the clip closer to the center, shortening the clip 
while preserving the content in the middle, while tightening up the Timeline. 

Before and After ripple trimming both the In and Out points of a clip at the same time, 
shortening the clip by removing heads and tails, and preserving the action in the middle

In short, you can use nearly any combination of edit selections you need to simultaneously 
trim multiple clips in the same track, in multiple tracks, whatever you need to do to save time. 
Furthermore, asymmetric trimming can be done in either Selection or Trim mode, either to open 
and close gaps, or to move edit points to overlap one another to create split edits.
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Slipping Multiple Clips
You can simultaneously slip any number of selected clips (so long as they have handles) on any 
combination of tracks by selecting the clips you want to slip, then choosing the Trim tool, and dragging 
their name bars or using the Comma and Period keys to nudge the selection.

Dragging to slip multiple selected clips at once

Sliding Multiple Clips
You can select as many clips as you like in preparation for a slide operation. If you select multiple 
contiguous clips, they slide together as one.

(Before) Selecting four clips to slide, (After) All four clips slid to the right using the mouse

Keyboard Trimming During 
Looped Playback
A great technique for editors who like to do precision trimming using the Nudge commands is 
the ability to enable looped-playback so that the Play Around command (Forward Slash) will loop 
continuously around the edit point you’re trimming as you nudge one or five frames at a time to fine-
tune the cut.
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To trim while looping:

1 Move the playhead near the edit point you want to trim, and press V to select it.

2 Press the U to choose which side of the edit you want to select in order to ripple or roll it, and/or 
Option-U to choose whether you want to trim video+audio, the video only, or the audio only.

3 Press Command-Forward Slash (/) to enable looped playback.

4 Press Forward Slash (/) to play around the current selection. With looping on, playback 
will continue until you stop it. Pre-roll and post-roll can be changed in the Edit panel of the 
User Preferences.

5 During looped playback, press the Comma (,) and Period (.) keys to trim the selection back or 
forward by a single frame, or Shift-Comma and Shift-Period to trim the selection in 5-frame 
increments. If you do this during the post-roll of looped playback, the loop immediately replays 
from the beginning so you waste no time seeing the result.

6 When you’re finished, press the Spacebar or K key to stop playback.

TIP: When holding down the Shift key while nudging to do a “fast nudge,” the duration of 
the nudge is customizable in the Editing panel of the User Preferences. By default it’s five 
frames, but you can set it to whatever you want.

Dynamic JKL Trimming
One of DaVinci Resolve’s most interactive trimming features is the ability to dynamically resize, 
ripple, roll, slip, slide, or move selected edit points and clips using the JKL transport control keyboard 
shortcuts. This means that you can make an appropriate selection in the Timeline (edit points to 
resize, ripple, or roll, or clips to slip or slide) then trim them during playback, while monitoring audio 
and watching the video.

Trimming while viewing the selected clip or edit point playing back has the advantage of letting you 
get emotionally involved in what you’re watching, as well as experiencing the timing of a clip as it plays, 
in order to help you get a better feel for how, exactly, you need to trim a particular cut. 

While you’re dynamically trimming, you see the same two-up or four-up display, the same Timeline 
overlays, and the same dynamically updating Timeline that appear when you use the Trim tool with the 
mouse. The only difference is that you’re trimming while your program plays.

There are two methods of doing dynamic trimming:

 — Quick Trim: You can select one or more edit points or clips, and immediately trim it by pressing 
Command-J or Command-L to trim back or trim forward. This is a fast way of dynamically 
trimming, but you can only trim forward and backward at 100 percent speed or greater.

 — Turning on Dynamic mode: If you want to do more detailed work, you can press the W key 
to enable Dynamic mode (or choose Trim > Dynamic Trim Mode), at which point you are in a 
special mode where the JKL shortcuts only trim the current selection, whatever it happens to be. 
However, this mode also gives you additional options for controlling which part of the selection, in 
the case of multiple selection trims, you want to monitor for audio/video playback.
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TIP: If nothing is selected while you’re in Dynamic Trim mode, JKL simply plays through the 
Timeline, as usual.

Quick Trimming
If you’re in a hurry and you can accomplish the trim you want via real time or faster playback, then 
pressing the Command key while using the J or L keyboard shortcuts lets you dynamically trim any 
selection in the Timeline, with audio/video playback.

To dynamically trim using Command-J or Command-L:

 — To dynamically roll an edit: In either Selection or Trim mode, select the center of one or more 
edit points, and hold the Command key down while using J or L to move the selection around.

 — To dynamically ripple an edit: Choose Trim mode, select the outgoing or incoming half 
of one or more edit points, and hold the Command key down while using J or L to move the 
selection around.

 — To dynamically resize an edit: Choose Selection mode, select the outgoing or incoming half 
of one or more edit points, and hold the Command key down while using J or L to move the 
selection around.

 — To dynamically move a clip: Choose Selection mode, select one or more clips, and hold the 
Command key down while using J or L to move the selection around.

 — To dynamically slip or slide a clip: Choose Trim mode, select one or more clips to slip, or a single 
clip to slide, press S to toggle between Slip or Slide modes, then hold the Command key down 
while using J or L to execute either slip or slide operations.

If you’re trimming multiple selections, you can control which edit point you monitor during the trim 
operation by positioning the playhead at one of the selected edit points.

TIP: When you’re finished with a “quick trim” operation and you want to see how that edit 
plays, you can press the Forward Slash key (/) to play around the current selection to quickly 
preview that section of the Timeline.

Dynamic Trimming (or “JKL Trimming”)
If you want to also have the option of trimming using the JKL shortcut keys in slow motion or frame by 
frame, in addition to trimming at 100% or greater playback speeds, then you’ll need to enable Dynamic 
Trim mode.

To use Dynamic mode to dynamically trim one or more selected clips or edits:

1 It’s not necessary to make a selection prior to enabling Dynamic mode for trimming, since the act 
of entering Dynamic mode automatically selects the closest edit point to the playhead. However, if 
you want to use Dynamic mode to make a complex trim operation, you can select any combination 
of edit points to resize, ripple, or roll, or you can select one or more clips that you want to slip or 
slide (using the S key to toggle between slipping and sliding).
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2 Press W to enter Dynamic mode, or click the Dynamic tool in the toolbar. If nothing is selected in 
the Timeline, then the edit point that’s nearest to the playhead will be automatically selected. If 
you’ve already made a selection, that selection will remain and be used for trimming.

Once you’ve entered Dynamic mode, the Dynamic Trim tool in the toolbar turns yellow to let you 
know that you’re in Dynamic mode, and the icon shows you whether you’re in Slip or Slide mode 
for trimming. Additionally, the playhead turns yellow to serve as a constant reminder that you’re in 
Dynamic mode, in which all you can do is trim clips.

The Dynamic tool highlights in the toolbar to let you 
know you’re in Dynamic mode; this tool also indicates 
whether you’re in Slip (Left) or Slide (Right) mode

3 Choose the type of operation you want to perform by clicking either the Selection tool 
(or pressing A) or the Trim tool (or pressing T):

 — In Selection mode:

 — You can dynamically resize or roll edits if you’ve selected one or more edit 
points in the Timeline.

 — You can move or slip clips if you’ve selected one or more clips in the Timeline. You can choose 
whether to move or slip selected clips by pressing the S key, or by right-clicking the Dynamic 
trim tool in the toolbar and choosing Slip or Slide from the drop-down menu.

 — In Trim mode:

 — You can dynamically ripple or roll edits if you’ve selected one or more clips in the Timeline.

 — You can slide or slip clips if you’ve selected one or more clips in the Timeline. You can choose 
whether to slide or slip selected clips by pressing the S key, or by right-clicking the Dynamic 
trim tool in the toolbar and choosing Slip or Slide from the drop-down menu.

4 If you’ve selected multiple edit points or clips, then you can use the Left and Right arrow keys in 
Dynamic mode to move the playhead to the selected edit point you want to monitor while you’re 
trimming. If the playhead isn’t aligned with a selected edit point, then it will jump to the nearest 
selected edit point once trimming commences.

5 Use any combination of the JKL keyboard shortcuts to initiate playback and trimming, including:

 — J+K or K+L to trim in slow motion, with slow motion audio playback

 — Pressing K while tapping J or L to trim a frame at a time

 — Pressing J or L to trim with real time playback

 — Pressing J or L repeatedly to trim in fast-reverse or fast-forward, at a variety of speeds

As you dynamically trim, all audio clips in all audio tracks will play back as the playhead scrolls 
across them, so you can hear your entire mix as you’re trimming.
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6 After you’ve made a trim, pressing the Spacebar initiates Play Around Current Selection so you can 
see how that trim plays. 

In Dynamic mode, the Spacebar only executes a Play Around Current Selection operation, rather 
than play forward as it usually does. What is played by Play Around Current Selection depends on 
what is selected; a selected edit plays around just that edit, a selected clip plays around the whole 
clip, multiple clips or edits play around the total selection, including the current Pre-Roll and Post-
Roll settings in the Editing panel of the User Preferences.

7 When you’re finished, you can use the Up and Down Arrow keys to move both the selection 
and playhead to another edit point or clip you’d like to trim, or you can press W again to toggle 
Dynamic mode off.

You always want to be sure to turn Dynamic mode off when you’re done, because otherwise using JKL 
will continue trimming selections whenever one or more edits or clips are selected, instead of playing 
the Timeline.

NOTE: While Dynamic mode is enabled, you can use JKL for playback if no clips or edit 
points are selected (press Command-Shift-A to deselect all). However, if anything in the 
Timeline is selected, then JKL will trim the selection as described above.

Trim Operations that are 
Targeted Using the Playhead
The following series of Trim editing commands let you trim clips and edits in different ways using the 
position of the playhead to guide the result.

Trim Start and Trim End
The Trim > Trim Start (Shift-[) and Trim End (Shift-]) commands let you move the In or Out point of 
all clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize operation 
(in Selection mode). You do not need to make a selection to use Trim Start and Trim End, making 
these commands fast to use in the right situation. A classic use of Trim End is when you have several 
superimposed clips of different lengths that you want to either start or end at the same time.

 — Trim Start resizes or ripples (depending on what mode you’re in) all clips that intersect the 
playhead, so that each clip’s In point is moved to the current playhead position. 
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Before and after a Trim Start operation, all clips 
that intersect the playhead are trimmed

 — Trim End resizes or ripples intersecting clips so that each intersecting clip’s Out point is moved to 
the current playhead position.

Before and after a Trim End operation, all clips that intersect the playhead are 
trimmed; clips that don’t intersect the playhead are not affected
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Clips that don’t intersect the playhead are not affected. Furthermore, you can exclude clips on specific 
tracks from this operation by disabling the Auto Select controls on those tracks.

Resize, Ripple, and Roll Start and End Commands
Another set of commands in the Trim menu lets you combine the Trim Start and Trim End functions 
with the act of choosing either Selection or Trim mode, and the ability to resize, ripple, or roll, all with 
single commands.

 — Resize Start to Playhead

 — Resize End to Playhead

 — Ripple Start to Playhead (Command-Shift-[)

 — Ripple End to Playhead (Command-Shift-])

 — Roll Start to Playhead

 — Roll End to Playhead

Just as with Trim Start and Trim End, these commands use the Timeline Auto Select controls to 
determine, of all clips intersecting the playhead, which clips on which tracks to trim. Many of these 
commands don’t have keyboard shortcuts by default, but if you prefer this way of working, you can 
assign them to keyboard shortcuts of your choosing using the Keyboard Mapping Customization tool 
(Option - Command - K).

Slip and Slide Playhead to In and Out Commands
Yet another set of commands in the Trim menu lets you slip a clip from the frame at the current 
position of the Playhead to the In or Out point of that clip.

 — Slip Playhead to In

 — Slip Playhead to Out

TIP: The Slip Playhead to In command functions identically to using the extend edit while 
the playhead intersects a selected clip.

Just as with Trim Start and Trim End, these commands use the Timeline Auto Select controls to 
determine, of all clips intersecting the playhead, which clips on which tracks to trim. These commands 
don’t have keyboard shortcuts by default, but if you prefer this way of working, you can assign them 
to keyboard shortcuts of your choosing using the Keyboard Mapping Customization tool (Option - 
Command - K).

Extend Edits
The Extend Edit command (choose Trim > Extend Edit, or press E) lets you resize or ripple one or more 
selected edit points or clips. Unlike Trim Start and Trim End, it doesn’t matter if the playhead intersects 
clips when doing an extend edit. 
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Extend Editing Edit Points
Make one selection per track of any combination of In or Out points, and press the E key to move 
those edit points to the current position of the playhead. 

Before and after a multi-track extend edit performed in Selection mode. Before, the red 
selections indicate that you’ve selected the first frame of media for those clips. After, the 
selections turn green to indicate that there’s additional frames at the head of the edit for trimming.

In Trim mode, selected edit points will ripple instead of resizing affected clips. However, to simplify 
multi-track extend edit operations when using the Trim tool, the lowest numbered video track 
with auto-select enabled defines the amount by which the extend edit will ripple the rest of the 
Timeline; all selected edit points on other tracks are simply resized to the position of the playhead.
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Before and after a multi-track extend edit performed in Trim mode; you can see that the 
lowest numbered track with a selection defines how far the Timeline will be rippled

Using Extend Edits to Slide Clips
You can also use the Extend Edit command to slide the contents of a single selected clip using either 
the Selection or Ripple tools. Simply select a clip, position the playhead over the frame of that clip you 
want to slip to the In point of that clip’s position in the Timeline, and press E to perform the slip. You 
can even do this during playback if you want to watch the clip play and press E to slip that frame back 
when the moment feels right.

Using the extend edit to slip a clip in the Timeline, the red marker shows that the 
frame at the playhead is slipped back to the In point of that clip in the Timeline
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Chapter 44

Working with Audio 
in the Edit Page
DaVinci Resolve has a solid set of features for editing, mixing, and 
mastering audio in your programs right in the Edit page. 

Whether you’re adjusting synced audio for dailies, finessing the levels of an edited project you’re 
assembling, mixing a program for output, or importing and laying in audio mix files from the sound 
designer to output for mastering, DaVinci Resolve has Level, Pan, and Channel Assignment controls 
to control your audio output for both monitoring and delivery, automated fader recording at both the 
track and clip level for mixing, and VST and Audio Unit audio filter support for mastering audio tracks 
and channels using industry-standard noise reduction, compression, EQ, and other filters. And, if all 
that’s not enough for you, you can export to Pro Tools in the Delivery page to hand off your program 
and its audio in a state ready for further work.

When you’ve finished doing the editorial audio work in your program, and you want to really drill into 
your program’s audio for detailed audio editing and mixing, you can use the audio-specific tools of the 
Fairlight page. For more information, see Chapter 166, “Using the Fairlight Page.”
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Audio in the Edit vs. Fairlight Pages
While the Fairlight page provides dedicated audio editing and mixing capabilities that are suitable 
for sweetening the audio of your program once it’s been edited, the Edit page has extensive audio 
capabilities of its own. This enables editors to edit and refine audio clips, set levels, and do simple 
mixes as they assemble the program in the first place. However, once things have been edited 
together, you’re meant to go freely back and forth between the Edit and Fairlight page as you refine 
your work, using whichever environment is most suitable for the task at hand.

Compatible Audio Formats
DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF, iOS Voice 
Memo (macOS only), both MTS and QuickTime containers that use the AC3 audio format, and 
Enhanced AC-3 (macOS and Windows only). DaVinci Resolve is compatible with audio at sample rates 
including 32, 44.1, 48, 88.2, 96, and 192 kHz.

Assigning Audio Channels 
in the Media Pool
When you first import audio into the Media Pool, it’s a good idea to make sure that whatever channels 
those files contain are assigned correctly before you start editing clips into the Timeline. In other 
words, you want to make sure that stereo files are set to be stereo clips, that 5.1 and 7.1 files are set 
to be surround clips, and that multi-channel files are set to expose however many tracks you want 
to edit separately in your program. Clip channel assignments are made in the Audio panel of the Clip 
Attributes window.

This is particularly important when clips have more than two channels of audio. For example, 
production sound recordists might record three, six, or even more audio channels, corresponding to 
multiple microphones used on set to simultaneously record different actors plus a mixdown track. In 
this case, you need to define how many of these channels you want to play (or mute), and how many 
audio items you want to appear in the Edit and Fairlight page Timelines. 

Mono, stereo, 5.1, and 7.1 clips are handled automatically, but multi-channel clips needing custom 
assignments in the Media Pool should be remapped as necessary using Clip Attributes, so that 
DaVinci Resolve can more easily place incoming audio clips into the correct track of the Timeline. You 
can alter the clip attributes for clips one at a time, or for multiple selected clips at once. For more 
information on these settings, see Chapter 22, “Modifying Clips and Clip Attributes.”

How to Assign Audio Channels
Each clip with audio has the following options in the Audio panel of the Clip Attributes window:
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The controls available for adding tracks with which to remap channels

A set of controls at the top of the Track/Channel list lets you add additional tracks to a clip. Adding 
additional tracks to a clip let you remap that clip’s available channels to appear as additional items 
in the timeline when you edit it, one item per track with an unmuted channel.

How you handle audio in your timeline is up to you. In the case of production audio consisting 
of five channels, four for different microphones plus one mixdown channel, you might use Clip 
Attributes to map all channels to a single track.

The Audio panel of the Clip Attributes window  
for a single-track clip with four channels

With this mapping, this audio clip exposes only one item on one track in the Edit page Timeline, or 
five lanes within a single track in the Fairlight page Timeline. Either way, this mapping exposes a 
single editable unit.
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A single audio channel exposed in the Timeline

Optionally, you could choose to mute the four individual microphone channels and only monitor 
the top mixdown channel. This can be accomplished by setting channels 2-5 to mute. Muted 
channels are always retained, just not heard, and you can turn them back on whenever you like 
using by right-clicking a clip in the Timeline and choosing Clip Attributes to get back to these 
controls for the specific timeline clip you’ve edited.

The Audio panel of the Clip Attributes window  
for a clip with four channels muted

NOTE: If you export audio clips with muted tracks to Pro Tools in the Deliver page, the 
muted channels are exported as well.

Alternately, you might elect to set these clips up with five separate audio tracks with a single audio 
channel each, in order to expose each channel separately in the Timeline for independent editing. 
First, set the top track to be Mono using Embedded Channel 1. Then, using the Add channel controls 
at the top of the channels list, you can set Tracks to 4, format to Mono, and click Add to create four 
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additional tracks in addition to the one track that clip had originally. Remapping channels 2-5 to these 
new tracks will result in the track mapping seen in the following screenshot.

The Audio panel of the Clip Attributes window after adding four channels

Editing such a clip into the Timeline results in five linked audio items appearing on five separate 
audio tracks, each of which can be edited separately in the Timeline.

Each channel exposed as a separately editable clip in the Timeline

863Edit | Chapter 44 Working with Audio in the Edit Page



Support for Mixed Audio Track 
Formats from Source Clips
DaVinci Resolve also supports media with multiple audio tracks that have differently formatted 
channels embedded within them. For example, a clip with one stereo track, one 5.1 surround track, 
and six mono tracks can all be appropriately set up in the Audio panel of Clip Attributes after that clip 
has been imported.

The Audio panel of Clip Attributes now has controls over what format (Mono, Stereo, 5.1, 7.1, Adaptive) 
the channels embedded within a particular clip should be configured as. This means that you can set 
up clips with multiple tracks, each one using potentially different formats of audio employing different 
combinations of clips, which is handy for mastering.

Clip Attributes now lets you assign channels among  
different tracks with different channel assignments.
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Editing Audio Into the Timeline
A separate set of audio tracks in the Edit page Timeline contain all of the audio that you edit into the 
Timeline, as well as any stand-alone audio files that might have been imported along with an AAF 
or XML file.

Editing Audio Using the Source Viewer
Opening an audio-only clip into the Source Viewer, or opening a clip with both video and audio and 
setting the Viewer to Audio Waveform results in a split view, with the complete waveform of the entire 
source clip shown in the top half, and a zoomed-in view of the waveform in the bottom half that can be 
set to zoom from 1x to 50x from the Zoom menu at the upper left-hand corner of the Source Viewer. 
This view makes it easy to drag the box at the top to find the section of audio you need relative to the 
entire clip, and yet still place In and Out points with great precision using the scrubber bar below.

This view shows every channel within each track of the current clip.

An audio clip opened into the Source Viewer

You can add markers and set In and Out points for audio clips just as you would for any other clip, 
in preparation for editing.

Simultaneous Audio Waveform 
Display in the Source Viewer
It’s also possible to edit using audio waveforms even when the Source Viewer is set to Source. 
Two options in the Option Menu let you see a superimposed audio waveform running along the 
bottom of the Viewer, over the video of the currently selected clip.
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 — Show Current Frame Audio Waveform: Shows a zoomed-in section of audio that scrolls as you 
play the clip. Useful for seeing dialog and music cues as you play through a clip.

 — Show Full Clip Audio Waveform: Shows the audio waveform for the entire source media of 
that clip. The section of audio from the In to Out points you’ve set in the Source Viewer are 
highlighted. Useful for using the audio waveform to navigate throughout that clip using the 
waveform as a reference.

The Source Viewer with “Show Current Frame Audio Waveform” enabled, 
displaying the audio waveform along the bottom of the image

Using Multi-Channel Timeline Tracks
Multi-channel audio tracks in the Edit page Timeline are extremely convenient when you’re dealing 
with clips that are stereo, 5.1, 7.1, or have an arbitrary number of channels that were recorded in 
the field, as you can fit all of these channels as a single clip into a single track, that will be correctly 
mapped to your project’s outputs, and that can be edited conveniently as a single item in the Timeline.

However, when you open the Fairlight page you’ll see that although the overall number of audio tracks 
is identical to the Edit page, the Fairlight page shows the channels that are otherwise hidden on the 
Edit page as lanes within each track, which expose each channel as a visible audio item in the Timeline. 
In this way, editors can work with multi-channel audio without worrying about visual clutter, while 
audio editors and mixers can see every channel on every track to help them get their work done.

Getting back to audio tracks on the Edit page, there are different types of audio tracks just like there 
are different types of audio clips: Mono, Stereo, 5.1, 7.1, and Adaptive. While you can edit any kind of 
audio clip into any kind of audio track, all clip audio channels that exceed the number of channels 
possessed by a particular type of timeline track will be muted. For example, you’re allowed to edit a 
six-channel Adaptive audio clip into a Mono audio track, but only the first channel will play because the 
Mono track only outputs one channel.
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Because of this, it’s a good idea to organize your timeline such that all clips appear on tracks that can 
accommodate the number of channels they have.

TIP: Editing an audio clip into the undefined gray area below existing audio tracks in the 
Timeline will result in the automatic creation of new audio tracks that are equal in number 
to the number of tracks the clip you’re dragging has, and each new track will have audio 
mappings that match the incoming audio items.

Defining Timeline Audio Track Channels at Creation
When you first create a new audio track, you have to choose what kind of audio track it will be. Right-
clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-menu that 
lets you create one of three different kinds of audio tracks.

 — Mono: Holds a single channel.

 — Stereo: Holds stereo left and right channels. Stereo tracks can be panned.

 — 5.1: Holds the six channels corresponding to a 5.1 surround mix. For broadcast, SMPTE specifies 
Left, Right, Center, LFE, Left Surround, Right Surround. For cinema distribution these tracks are 
ordered Left, Center, Right, Surround Left, Surround Right, and LFE.

 — 7.1: Holds the eight channels corresponding to a 7.1 surround mix. For broadcast, SMPTE specifies 
Left, Right, Center, LFE, Left Surround, Right Surround, Back Surround Left, and Back Surround 
Right. For cinema distribution these tracks are ordered Left, Center, Right, Left Surround, Right 
Surround, LFE, Back Left Surround, and Back Right Surround.

 — Adaptive: Capable of holding up to 24 audio channels. An adaptive audio track can hold clips with 
different combinations of channels, up to the maximum number of channels allowed within that 
track. The number of channels allowable on a particular Adaptive track is user-definable (1–24) at 
the time that track is created. If you edit a clip with more channels into an Adaptive track that was 
created to hold fewer channels, the extra channels are muted.

Four audio tracks with a variety of audio tracks shown. From the top down, Mono, Stereo, Adaptive, 5.1
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Changing How Many Channels an Audio Track Has
If you had set up your timeline with one kind of audio track, but you discover you actually need a 
different kind, you can change any audio track’s type at any time. Just right-click anywhere in that 
audio track’s timeline header, and choose an option from the Change Track Type To submenu of the 
contextual menu.

Contextual menu for changing audio track types

Creating Timelines With Audio Mixer Presets
For advanced audio workflows and ease of use with Fairlight, you can now create a timeline with pre-
assigned audio tracks using a previously created Fairlight Configuration preset. To use this function, 
create a new timeline, and check the “Use Fairlight Configuration Preset” box. A drop-down menu then 
appears, allowing you to select the specific preset for the Timeline.

You can create Fairlight Configuration presets using the Fairlight Presets Library, available from the 
Fairlight menu. For more information, see Chapter 167, “Setting Up Tracks, Busses, and Patching.” 

Editing Audio Clips Into the Timeline
When you edit a video clip with accompanying audio, or an audio-only clip, into the Edit page Timeline, 
what you see depends on how the audio’s internal tracks and channels were defined in the Media 
Pool, using Clip Attributes. If you’ve defined a clip to expose multiple tracks of audio, each exposing 
a different channel, then you exchange the convenience of managing multiple channels of audio as a 
single item for the freedom to individually edit each channel of audio separately, as individual clips in 
the Timeline. 

For example, if you’ve been given a multi-channel recording that consists of two boom microphones, 
two separate lavaliere microphones, and a mixdown track that were recorded simultaneously, you 
can use the Audio panel of the Clip Attributes window to set that clip’s audio up as 5-channel Adaptive 
audio with 5 tracks containing one channel each. Editing this into the Timeline, you end up with five 
separate audio items appearing in five tracks.
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Editing a multi-channel production recording as five separate tracks of audio

This way, when you edit that clip into the Timeline, each audio channel appears as its own clip in its 
own audio track of the Timeline, which can be separately edited so you can edit the scene to isolate 
the best dialog from each microphone.

Editing multi-track audio to isolate the best dialog from each microphone
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Changing Audio Clip Attributes After Editing
It’s best to make decisions about which audio tracks and channels are assigned prior to beginning 
editing. This is because once you’ve edited a clip into a timeline, you can’t use the Clip Attributes 
window to edit how many audio tracks and audio channels are exposed in the Timeline. 

However, you can use Clip Attributes to change which channels are assigned and/or muted within 
the available tracks and channels you’ve edited into the Timeline. For example, if you’re editing clips 
that have five channels of source audio (channels 1 and 2 are a stereo mix and channels 3 through 5 
are three different microphones), you may have set your synced source clips to have one audio track 
and five audio channels, with channels 3–5 muted. Later you have a few clips that would sound much 
better if you only used channel 4, which is the isolated lavaliere microphone for that actor, so you can 
select those clips and use the Audio panel of Clip Attributes to mute all channels but channel 4.

If, for whatever reason, you need to expose more audio tracks in the Timeline than you originally set 
an audio clip to use, you can do the following.

To re-edit an audio clip to expose more audio tracks than were originally available:

1 Right-click the clip you want to change the audio track mapping of in the Timeline, and choose 
Find in Media Pool from the contextual menu.

2 Right-click that clip in the Media Pool and choose Clip Attributes from the contextual menu.

3 Open the Audio panel of the Clip Attributes dialog, and choose how many audio tracks and audio 
channels you want to set that clip up with. Click OK.

4 Once that’s done, edit the changed audio clip from the Media Pool to the Timeline to replace the 
original clip using whichever method makes sense.

Displaying Waveforms in the Timeline
The Timeline View options palette lets you turn Audio Waveform display on and off via a button at 
the top. The Audio View options let you define how you wish your waveforms to be presented on 
the Timeline.

 — Audio View Options: Three buttons govern the look of audio waveforms in the Timeline, 
when visible.

 — Non-Rectified Waveform: Lets you toggle between the waveform being drawn from the 
bottom of the audio track up, or centered and mirrored about itself.

 — Full Waveform: Hides the divider bar that keeps the waveform separate from the file 
name area of each audio clip, so the waveform occupies the full space of each audio bar 
in the Timeline.

 — Waveform Border: Draws a dark border around the edges of each waveform to make them 
easier to see.

 — Video track height slider: Lets you resize the size of all video tracks at once, independently of the 
audio tracks.

 — Audio track height slider: Lets you resize the size of all audio tracks at once, independently of 
the video tracks.
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The Audio Waveform display 
option (circled in red) in 
the Timeline View drop-
down. Audio View Options 
are (L-R) Non-Rectified 
Waveforms, Full Waveform, 
and Waveform Border.

While a single averaged audio waveform representing all the channels in that clip is shown by 
default, you can switch any clip to seeing each individual waveform in a vertical stack by right-
clicking any audio clip and choosing Display Individual Audio Channels.

Whenever you cut an audio clip, you cut all audio channels with it. Audio channels that are 
embedded within a single track cannot be individually edited.

Enabling the 
display of multiple 
channel waveforms 
in the Timeline

Editing Audio In the Timeline 
Using In and Out Points
Audio clips can be edited using all of the commands and tools available for video clips. However, it’s 
good to know that one of the most common techniques of editing audio in other environments is 
available in DaVinci Resolve, and that is the ability to identify a range of audio to cut, copy, or delete 
using Timeline In and Out points, so that you can easily eliminate, move, or duplicate partial sections 
of audio without having to use the Razor Edit or Split Clip commands.
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To delete a section of audio using In and Out points:

1 Set In and Out points in the Timeline to identify the range of audio you want to eliminate. If 
necessary, turn off the Auto Select controls of tracks to omit overlapping audio clips you don’t 
want to delete from this operation.

2 Press the Backspace key to delete the section of audio and leave a gap, or press the Forward 
Delete key to delete the section of audio and ripple the Timeline to close the gap.

Setting In and Out points to identify 
a range of audio to delete

Deleting the audio using the 
Backspace key to leave a gap

To copy a section of audio using In and Out points:

1 Set In and Out points in the Timeline to identify the range of audio you want to copy. 
If necessary, turn off the Auto Select controls of tracks with overlapping audio you don’t want to 
copy; you can Option-click the Auto Select control of the audio track you’re copying from to solo 
it, and you can Shift-click any video track’s Auto Select control to turn them all off. In this example, 
we’re copying some background ambience to continue building an ambience track.

Setting In and Out 
points to identify a 
range of audio to copy

2 Press Command-C to copy that section of audio.

3 Press Option-X to clear the Timeline In and Out points, and move the playhead to where you want 
to paste the copied section of audio.

4 Press Command-V to paste the copied audio. If you’re looping a section of audio, you can paste 
many times to loop what you’ve copied.
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Pasting the background ambience several times to loop it

Resizing Audio Clips in 
Subframe Increments
DaVinci Resolve lets you optionally make subframe audio adjustments to the In and Out points of 
audio clips in the Timeline.

Enabling and Disabling Subframe Editing
The “Align audio edits to frame boundaries” preference in the Editing panel of the DaVinci Resolve 
User Preferences lets you choose whether audio clip In and Out points align to whole frame 
boundaries, just like video clips. When this option is turned on, you cannot make subframe audio 
edits. When turned off (the default), you can.

Subframe Editing of In and Out Points 
While you cannot move the playhead in subframe increments, you can resize audio clips in 
subframe increments by dragging an audio clip’s In or Out point in the Timeline, or by dragging 
an audio edit to perform a roll. This can be useful for trimming minute bits of audio such as pops, 
clicks, or vocalizations.

Resizing the Out point 
of an audio item in 
subframe increments, 
seen within a one-frame 
playhead shadow

Know that if you have Linked Selection turned on and you’re trying to resize a selected Video+Audio 
pair of items, the whole-frame resizing required for video prevents you from being able to resize the 
audio separately. This is easily solved by Option-Clicking to select the linked audio item by itself, at 
which point you can subframe resize it freely. 
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Also, if snapping is enabled, it may be impossible to make a subframe adjustment if you’re too close to 
another edit point, a marker, or the playhead. In this case, pressing the N key to turn snapping off will 
solve the problem.

Eliminating Subframe Audio Edits
If you’ve done a variety of subframe edits and you discover you need to eliminate these subframe 
adjustments, you can choose Timeline >  . This moves each subframe edited In or Out point in the 
timeline to the nearest frame boundary.

Audio Settings in the Inspector
Each clip has some simple audio-related parameters in the Audio panel of the Inspector.

 — Volume: Each clip has a single volume control that corresponds to the volume overlay 
over each audio clip.

 — Pan: (Only exposed for clips) A simple Pan slider that controls stereo panning.

 — Pitch: Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust 
clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 
100th of a semi tone).

 — Equalizer: Each clip also has a four-band EQ, complete with low-pass, high-pass, and parametric 
settings for fine tuning and problem-solving audio issues at the clip level.

Additionally, when you apply other audio plugins from the Audio FX panel of the Effects Library, 
additional parameters and controls are exposed (covered towards the end of this chapter).

Setting Volume
Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has its 
own Volume level. This means that audio clips with multiple channels share a common Volume setting. 
There are several ways you can adjust these levels simply.

Adjusting Audio in the Inspector
Each clip has individual Volume parameters that are accessible in the Audio panel of the Inspector 
when one or more audio clips are selected.

The Volume parameter available for audio clips in the Inspector
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Selecting an audio clip in the Timeline and adjusting its volume only alters that clip, which lets you set 
basic levels for individual clips in your program. The Volume control affects every channel within that 
clip simultaneously. 

If you select multiple clips in the Timeline, then adjusting the Volume sliders or virtual sliders for all of 
them simultaneously will make a relative adjustment to all of the clips, preserving their offsets from 
one another. If you want to set all clips to the same level, then making a numeric adjustment will set all 
selected clips to the same absolute level.

Adjusting Audio in the Timeline
Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s level by 
simply dragging it up or down with the pointer. Holding the Shift key down while you drag allows finer 
adjustments. This overlay corresponds to the Volume parameter in the Inspector.

Dragging a Volume overlay to adjust the clip level

You can also click the Curve Editor button at the bottom right-hand corner of the audio clip, which 
opens the Audio Curve Editor. At the time of this writing, the only parameters you can edit in this 
Curve Editor is volume and pan.

Showing the Volume overlay in the Curve Editor
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Adjusting Volume Using Keyboard Shortcuts
You can also adjust the volume of selected clips using keyboard shortcuts, even while the Timeline is 
playing. There are several ways you can set this up.

 — To adjust just one clip: Select that clip, and use one of the commands for changing volume.

 — To adjust any clip at the position of the playhead: Turn on Timeline > Selection Follows 
Playhead so that whichever clip intersects the playhead becomes selected, and use one of the 
commands for changing volume. If multiple clips are intersecting the playhead, the selected clip 
will be the one on the highest track.

 — To adjust multiple clips all together: Select all of the clips you want to adjust, all at once, and 
use one of the commands for changing volume. If the clips you select have differing Volume levels, 
these differences will be maintained as you make your adjustments.

The commands for changing volume are as follows:

 — To change volume in increments of 1dB: do one of the following:

 — Clip > Audio > Increase Audio Level 1dB (Option-Command-Equals) 

 — Clip > Audio > Decrease Audio Level 1dB (Option-Command-Minus)

 — To change volume in increments of 3dB: do one of the following:

 — Clip > Audio > Increase Audio Level 3dB (Option-Shift-Equals) 

 — Clip > Audio > Decrease Audio Level 3dB (Option-Shift-Minus)

Normalize Audio Volume Command
The Normalize Audio Levels command automatically adjusts the level of clips to a specific target 
level, and you can choose the method used to analyze each audio clip’s levels to determine how to 
normalize each clip’s volume. Options include a variety of loudness normalization algorithms specific 
to various international standards, which are useful for balancing the perceived overall loudness of 
several clips to one another, regardless of transient levels throughout each clip. You can also do Peak 
normalization, with options for both Sample Peak and True Peak.

The various loudness options are designed to analyze an audio signal based on its perceived loudness 
to the listener, which results in a more accurate automatic balancing of different clips’ audio levels to 
one another, regardless of transient peaks occurring throughout different clips.

The target peak meter now uses the BS.1774 standard for measuring maximum “true peak,” which 
means that this meter is capable of measuring “inter-sample peaks,” rather than only the peaks at 
each sample of a waveform. However, you still have the option to measure Sample Peak, which is the 
previous method of measuring the actual peak of the samples in a media file.

The change made by the Normalize Audio Volume command is only a volume adjustment; no 
dynamics are applied, so the result of using this command is that the loudest parts of each selected 
clip are going to match one another at the target level. This command is also available in the 
Fairlight page.
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To normalize one or more selected audio clips:

1 Right-click one of the selected clips and choose Normalize Audio Levels. The Normalize Audio 
Level dialog appears.

The Normalize Dialog in the Edit page

2 Choose the Normalization Mode you want to use. You can choose among a variety of standardized 
loudness measurement algorithms, or Sample Peak, or True Peak.

3 Choose the reference level that you want to set the peak volume of the selected clips to match.

4 Choose how you want to set the level of multiple selected clips:

 — When Set Level is set to Relative, all selected clips are treated as if they’re one clip, so that 
the highest peak level of all selected clips is used to define the adjustment, and the volume 
of all selected clips is adjusted by the same amount. This is good if you have a series of clips, 
such as a dialog recording, where the levels are consistent with one another, and you want to 
normalize all of them together.

 — When Set Level is set to Independent, the peak level of each clip is used to define the 
adjustment to that clip, so that the volume of every selected clip is adjusted by an amount 
specific to that clip. The end result may be a set of very different volume adjustments 
intended to make the peak levels of each audio clip match one another. This is good if, for 
example, you’re trying to balance a series of different sound effects with one another that 
have very different starting levels.

For more information about loudness normalization, see Chapter 178, “Audio Meters and 
Audio Monitoring.”

Pan
Each audio clip in the Timeline has a simple stereo Pan control that lets you pan that clip. While most 
professional mixes will restrict panning to the more robust panner found in the Fairlight page Mixer, 
this simple clip-based Pan control is useful for editors of visuals working in the Edit page to quickly 
create simple panning effects to aid in a craft edit. Dragging the slider lets you pan audio left to right. 
This control is centered at 0 by default.

Clip Pan Control
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Pitch
Selecting a clip and opening the Inspector reveals a new set of Clip Pitch controls that Lets you alter 
the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in semi tones (large 
adjustments, a twelfth of an octave) and cents (fine adjustments, 100th of a semi tone).

Clip Pitch control in the Inspector

Equalizer
Each audio clip in the Timeline has a four-band equalizer that has both graphical and numeric controls 
for boosting or attenuating different ranges of frequencies within that clip, before it even gets to 
the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), 
Frequency, Gain, and Q-factor (sharpness of the band), with the available controls for each band of 
EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s being 
applied. This indicator cannot be adjusted; you must open the EQ window to make modifications.

The channel strip’s EQ indicator, (Left) EQ is at detent, (Right) EQ is adjusted

Master EQ Controls
The Equalizer window has the following overall controls:

 — Enable button: Turns the overall EQ effect off and on, without resetting the controls.

 — Reset button: Resets all controls of the EQ window to their defaults.
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Graphical EQ controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ bands listed 
below. You can drag any numbered handle to boost or attenuate the range of frequencies governed 
by that band, using whatever type of equalization that band has been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each band’s parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 4
The outer two sets of band controls let you make high-pass and low-pass adjustments, if necessary.

 — Band enable button: Turns each band of EQ on and off.

 — Band filter type: Bands 1 and 4 can be switched among six specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top to bottom): 
Lo-Pass, Lo-Shelf, Bell, Notch, Hi-Shelf, and Hi-Pass.

 — Freq: Adjusts the center frequency of the EQ adjustment.

Bands 2 and 3
The middle two sets of band controls let you make a wide variety of equalization adjustments.

 — Band enable button: Turns each band of EQ on and off.

 — Band filter type: Bands 2–3 can be switched among four different filtering options (from top to 
bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf.

 — Frequency: Adjusts the center frequency of the EQ adjustment.

 — Gain: Adjusts the amount by which the affected frequencies are affected. Negative values 
attenuate those frequencies, while positive values boost those frequencies.

 — Q Factor: Adjusts the width of affected frequencies. Lower values include a wider range of 
frequencies; higher values include a narrower range of frequencies.
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Keyframing Audio
There are two ways you can keyframe audio in the Edit page. You can use each audio clip’s volume 
curve in the Timeline, or you can use the keyframe controls in the Inspector to animate the Volume 
parameter of individual clips as you would any other clip attribute, fading the level up or down, 
panning from left to right, or dynamically changing any one of a host of filter controls, in subframe 
increments, if necessary. 

For more information on keyframing in the Inspector, see Chapter 53, “Keyframing Effects in the 
Edit Page.” Any keyframes you create using the Keyframe controls of the Inspector automatically 
appear on the volume curve of that audio clip in the Timeline.

Overlay Controls for Volume
Each audio clip in the Timeline appears with a Volume overlay control on top of it, that by default starts 
out completely flat. Similar to such controls found in other applications, the level curve lets you alter 
each clip’s levels, either overall, or dynamically using keyframes.

Volume curves adjusting the level of a clip’s audio in the Timeline

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner of 
each audio clip, to open an audio-specific Curve Editor in which you can also keyframe volume.

The button for opening an 
audio clip’s Curve Editor 

How to Add and Adjust Volume Keyframes
Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of 
balancing clip levels with one another, fixing level problems within a particular clip, or even creating 
simple mixes (although the mixing capabilities of the Fairlight page are considerably more robust). 
When manually editing any audio parameter curve, you can use the following procedures.
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Methods of adding or selecting audio keyframes using the pointer:

 — To add keyframes to the Volume curve: Hold the Option key down and click the curve to 
place a keyframe at that frame. You must add at least two keyframes to create an automated 
change in Volume.

 — To select one or more keyframes: Click any keyframe to select it. 

 — To select multiple discontiguous keyframes: Command-click all keyframes you want to select, 
whether they’re next to one another or not.

 — To select multiple contiguous keyframes: Click the first keyframe you want to select, and then 
shift-click the last keyframe you want to select, and all keyframes between will also be selected.

Methods of adjusting keyframes in the Volume overlay (or curve) using the pointer:

 — To adjust any curve segment: Position the pointer over the overall segment for clips with no 
keyframes, or position it between any two keyframes, directly on top of the curve segment you 
want to raise or lower. When the Move cursor is displayed, click and drag up to raise the volume, 
or down to reduce the volume.

 — To adjust a keyframe in any direction: Move the pointer over a keyframe so that the four-
way cursor appears, and then click and drag up or down to change the volume, or side 
to side to change its timing. The timing of audio keyframes can be adjusted in subframe 
increments, for precision mixing.

 — To adjust a keyframe in only one direction: Move the pointer over a keyframe so that the four-
way cursor appears, press Shift, and click and drag in the intended direction of adjustment, either 
vertically to change the volume of the clip at that frame, or horizontally to move the keyframe to 
a different point in time. Once you start dragging a keyframe into a particular direction, keyframe 
movement is constrained in that direction until you release that keyframe. The timing of audio 
keyframes can be adjusted in subframe increments, for precision mixing.

 — To change one or more Linear keyframe to Ease In or Ease Out: Eased keyframes create 
animated changes that begin slowly and accelerate to full speed, or slow down gradually to 
decelerate to a stop. This only works when you have two or more keyframes creating an animated 
effect. Select one or more keyframes, then right-click one of the selected keyframes and choose 
Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and the effect 
you want to create.

 — To change one or more eased keyframes to Linear: Select one or more keyframes, then right-
click one of the selected keyframes and choose Linear.

Methods of Cutting, Copying, Pasting, and Deleting keyframes:

 — To cut or copy, and paste one or more keyframes: Make a selection of keyframes, and use the 
Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you 
want the first of the copied keyframes to start, and press Paste (Command-V).

 — To delete one or more control points from a curve: Select the keyframe(s) you want to delete 
and press Backspace.
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Audio Fade Handles
When you position the pointer directly over an audio clip, a pair of Audio Fade handles appear at the In 
and Out points. Dragging each of these handles towards the center of the clip lets you fade in the clip 
volume at the beginning of the clip, and fade out the clip volume at the end of the clip.

Audio Fade handles at either end of an audio clip

NOTE: When you import a Final Cut Pro X project, the fade handles for each clip 
automatically import as well.

Audio Fade Handles can also be adjusted in subframe increments, if necessary, to 
create a precise transition.

Adjusting an Audio Fade handle in subframe increments, 
seen within a one-frame playhead shadow

Once you’ve created a fade effect, you can adjust the curve of the fade by dragging the handle that 
appears right on top of the fader curve. Dragging the handle up and down affects the angle of the 
curve, and dragging the handle left and right affects the shape of the curve. In this way, you can 
create all manner of fade effects.

Adjusting the curve of the fade Fade effects can be created 
and edited on both the Edit and Fairlight pages.
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Audio Crossfades
When you select an edit point with both video and audio components, and Linked Selection is enabled 
so that both the video and audio edit points are selected, then when you apply a video transition to an 
edit, a crossfade is added to the audio.

You can add Cross Fade transitions to any edit point between two audio clips that have enough 
handles similarly to how you add video transitions, by dragging and dropping from the Effects Library, 
by right-clicking an edit and choosing an option from the contextual menu, or by selecting an audio 
edit point and choosing Timeline > Add Audio Only Transition (Shift-T). 

Cross Fade transitions are a quick and easy way to fade the volume of the outgoing clip down while 
simultaneously fading the volume of the incoming clip up, letting you create a smooth aural transition 
between two audio clips. If you need to do precision editing, the start and end points of a crossfade 
can be edited in sub-frame increments.

An audio Cross Fade transition applied between two clips

You can double-click a Cross Fade transition to open it into the Inspector, revealing 
the following parameters:

 — Duration: The duration of the transition, shown in both seconds and frames.

 — Alignment: A drop-down that lets you choose the transition’s position relative to the edit point it’s 
applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”

 — Transition style: You can choose –3dB, 0dB, or +3dB to set both the Fade In and Fade Out levels 
to the same value. For more information on what these levels mean, see the following parameter.

 — Fade In/Fade Out levels: There are three options that affect the incoming and outgoing halves 
of the Cross Fade effect independently. 0dB applies a linear fade (this is the default). +3dB applies 
a boosted curve; when applied to both Fade In and Fade Out, this can compensate for diminished 
levels in the middle of a Cross Fade. –3dB applies an attenuating curve, which deliberately lowers 
the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.

TIP: If you need an asymmetrical crossfade, that’s accomplished by “checkerboarding” 
clips on two tracks with overlapping handles at the beginning and end, and using the Fader 
handles to create exactly the timing and curves necessary to create the effect you require.
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The Audio Mixer
The Audio Mixer on the Edit page is a simplified version of the Mixer on the Fairlight page, designed to 
provide a streamlined set of graphical controls you can use to set basic track levels (there is no track 
level fader automation on the Edit page), pan stereo audio at the track level, and mute and solo tracks 
as you work.

To open the Audio Mixer, do the following:

 — Click the Mixer button on the Interface toolbar.

The Audio Mixer, with four channel strips 
corresponding to the four tracks in the Timeline

The Audio Mixer exposes a set of channel strips 
with controls that correspond to the tracks in 
the Timeline, and each channel strip displays a 
number of audio meters equal to the number 
of channels within that track. By default, a Main 
1 channel strip appears all the way to the right 
that lets you adjust the overall level of the mix. 
However, if you add subs and mains on the 
Fairlight page, those will appear at the right of 
the mixer as well.

NOTE: You cannot record automation 
in the Edit page. Comprehensive mixing 
controls with full automation recording 
are found in the Fairlight page.

Audio Mixer Controls
Each track’s channel strip has the following controls:

 — Track Color: Each track can be differently color-coded to help you keep organized. These colors 
also appear in the timeline track header and the Fairlight page.

 — Track Number: The number of the timeline audio track corresponding to each channel strip 
appears here.

 — Pan control: Lets you pan a Mono track’s audio from left to right, or invert a Stereo track’s left 
and right audio channels, or do surround mixing.
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 — Name: The name of the audio track that channel strip corresponds to. If you’ve edited the audio 
track names in the Timeline, those names will appear here.

 — Solo: Mutes all tracks other than ones that are soloed.

 — Mute: Disables that audio track.

 — dB: Shows you the volume, in decibels, that track is currently set to.

 — Fader: Each track’s vertical fader can be dragged with your mouse or other pointing device 
to adjust the volume of that track and perform automation recording. Dragging up increases 
volume, dragging down decreases volume.

 — Audio meters: Audio meters to the right of each fader display the audio volume of all channels on 
that track during playback. Each channel strip has individual meters corresponding to the number 
of channels that track has been set to accommodate. 

Mute and Solo Tracks For Output
When you use the Mute or Solo controls of the Audio Mixer, track audio is disabled both during 
playback and delivery for output. Make sure you have re-enabled any tracks you need before heading 
to the Deliver page. You can only modify mute and solo tracks on the Edit, Cut, and Fairlight pages.

Displaying Audio Meters
If you just want to see your program’s levels, you can also switch to display the “Control Room” 
audio meters instead of the Mixer. How many audio meters appear depends on the current speaker 
configuration in the Video and Audio I/O panel of the System Preferences.

To show the Audio Meters:

 — Click the Mixer button on the Interface toolbar to display the audio panel and then choose Meters 
from the option menu at the upper right-hand corner.

Audio Compound Clips
DaVinci Resolve supports audio compound clips, which are created just like any other compound 
clip, by selecting multiple audio clips, right-clicking one of them, and choosing New Compound Clip. 
Alternately, compound clips with video clips may now contain multiple audio items as well. 

When compound clips containing audio are opened in the Edit or Fairlight pages by right-clicking 
an audio compound clip and choosing Open in Timeline, breadcrumb controls appear beneath the 
Timeline that let you exit the compound clip and get back to the master Timeline.

Opening an audio compound clip
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Audio Playback for 
Variable Speed Clips
Video/audio clips with variable speed effects applied to them can now play either pitch-corrected or 
un-pitch-corrected variable speed audio. An option in the Speed menu of the Retime controls lets you 
choose whether or not the audio is pitch-corrected.

Using Audio Filters
DaVinci Resolve includes Fairlight FX, a set of DaVinci Resolve-specific audio plug-ins that run natively 
on macOS, Windows, and Linux, providing high-quality audio effects with professional features to all 
DaVinci Resolve users on all platforms. Additionally, DaVinci Resolve supports the use of third-party 
VST audio plug-ins on Mac OS X and Windows. On Mac OS X, DaVinci Resolve supports Audio Unit (AU) 
audio plug-ins. Once you install these effects on your workstation, they appear in the  Audio FX panel 
of the Effects Library. 

Audio filters in the Effects Library

Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of audio, to 
add creative qualities such as echo or reverb, or to take care of mastering issues using noise 
reduction, compression, or EQ.
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Methods of applying audio filters to clips in the Edit page:

 — To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects Library 
onto the clip in the Timeline you want to apply it to.

 — To apply an audio filter to multiple clips: Select all of the clips you want to apply an audio 
filter to, then drag any filter from the Audio FX panel of the Effects Library onto any of the 
selected clips.

To edit a clip’s audio filters:

 — Select that clip and open the Inspector. All audio filters applied to that clip appear under the 
Effects panel, in the Audio tab, with that filter’s controls appearing directly in the Inspector.

Many VST and Audio Unit audio filters have a custom user interface that makes it much easier to 
manipulate that filter’s controls. These can be opened from within DaVinci Resolve.

The custom audio filter interface for iZotope RX4

To expose a filter’s custom controls: 

 — Click the Custom Control button (the button to the right of the trash can). The custom 
controls appear in a floating window. When you’re finished adjusting the custom controls, 
close the window.

The button for opening a filter’s custom control

Methods of working with audio filters in the Inspector:

 — To disable or re-enable a filter: Click the toggle button at the far left of each filter’s title bar.

 — To remove a filter: Click the Trash Can button.

Once applied to a clip or track, audio filters can also be keyframed or automated just like volume and 
pan settings, to create dynamic audio effects that change over time.
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Installing Audio Filters
VST effects aren’t installed in a standard location, so it may sometimes be necessary to add a newly 
installed directory of VST plug-ins that you’ve just installed on your system. To help you deal with this, 
the Audio Plugins panel of the Preferences window has a list that lets you manually add and remove 
VST plug-in directories, if necessary. 

Once you’ve added one or more VST directories to the list, a second list underneath shows all audio 
plug-ins that are available within these directories. Each plug-in on the list has a checkbox that shows 
whether or not it’s currently enabled. Any VST plug-ins that cause DaVinci Resolve to crash while 
loading them during startup will be automatically disabled. 

You can use this list to see which plug-ins have been disabled, for troubleshooting purposes, and to 
reenable such “blacklisted” plug-ins, by turning their checkboxes back on.

The Fairlight Page
The audio controls of the Edit page are geared more towards simple mixing to have sensible levels as 
you work putting a program together. For comprehensive audio sweetening, mixing, automation, and 
mastering controls, the Fairlight page is only one click away. 

For more information, see Part 12, “Fairlight.” 

Pro Tools Export
It bears mentioning that, if the audio editing, mixing, and effects capabilities of DaVinci Resolve aren’t 
enough for you to take care of the audio in your program, you can also export an AAF with audio and 
a reference movie to Pro Tools using the Deliver page. The resulting media can be handed off to a 
Pro Tools-based audio facility to be worked on by a dedicated team of audio specialists, who will most 
likely output a stereo or 5.1 mix file that you can then reinsert in the Timeline you’re using to master 
the final output of your program.

For more information on exporting AAF for Pro Tools in the Deliver page, see Chapter 186, “Using the 
Deliver Page.”
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Chapter 45

Media Management
Media Management in DaVinci Resolve refers to operations that 
let you copy or transcode the media that’s linked to clips in your 
timeline, with the option to eliminate unused media in the process. 

Media Management is used to consolidate media from an edited timeline or from a 
project nearing completion.
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What Is Media Management in 
DaVinci Resolve?
If you’ve edited a program within DaVinci Resolve, you can use the Media Management command to 
take care of a variety of tasks, including but not limited to:

 — Creating a duplicate of your project’s clips that eliminates unused media in preparation for 
handing the media off to another facility.

 — Transcoding all clips in a timeline to another format while eliminating unused heads and tails.

For example, if you’re preparing to export a project to hand off to another DaVinci Resolve user 
somewhere else, or even an XML or AAF to give to someone using a completely different NLE or 
finishing application, you can use Media Management in DaVinci Resolve to consolidate and relink 
the media used by the timeline you’re handing off, so the exported project or timeline references a 
smaller set of media.

Even if you’re not handing a project off, if you’ve ingested an enormous amount of source media into 
a project, and after the majority of the editing decide that you want to create a consolidated set of the 
media you’re using in order to lighten the project’s load in the Media Pool, you can create a duplicate 
of the media to reconform to, omitting unused clips and trimming the unused heads and tails of the 
clips you are using in the process.

But Media Management isn’t just useful for projects you’ve edited in DaVinci Resolve. For example, if 
you’re importing a project from another application and you’ve been given an enormous amount of 
source media to conform to, you may be hesitant to copy all of it to your accelerated storage volume, 
since (a) most of it is probably unused by the project file you’ve been given, (b) it’ll take forever to copy 
from the cheap USB 2 hard drive they’ve given you, and (c) it will clog up your local storage, taking 
valuable space away from other projects. In this case, you can use the Media Management to copy a 
reduced set of media files consisting of only the clips used in the current timeline of the Edit page.

Media Management of Timelines 
Creates .drt Files
When performing Media Management operations to copy or transcode media from a timeline, a 
DaVinci Resolve Timeline (.drt) file is automatically created in the same bin as the resulting media 
files, linked to the newly created media. This timeline can then be imported into the same or a new 
DaVinci Resolve project.
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File Formats That Are Compatible 
With Media Management
No matter what you use if for, Media Management is designed to work with all video formats that are 
have decode support within DaVinci Resolve, and is capable of outputting a few more formats than 
the Deliver page can. Compatible formats include but are not limited to:

 — QuickTime

 — MXF

 — R3D

 — Image-based raw media formats 
including Blackmagic RAW  
and Alexa raw

 — DPX, EXR, JPEG 2000, TIFF, Cineon, and 
other compatible image sequence formats

 — AVI

 — H.264

 — XAVC

 — AVC-Intra

In addition, the “trim unused media” options of the Copy or Move operations are now compatible 
with clips that use codecs employing temporal compression, such as H.264, XAVC, and AVC-Intra, 
enabling you to eliminate unused media for these formats during media management without 
recompressing or transcoding.

Using Media Management
Using Media Management is simple. 

To media manage clips and timelines in a project you’ve created:

1 Select the items you want to media manage, either clips or one or more Timelines.

2 Choose File > Media Management, and the Media Management window appears.

Media Management window
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3 Choose the scope of the Media Management operation, shown at the top of the window. You 
can choose to affect the Entire Project, only one or more Timelines, or only Clips. What you had 
selected prior to opening the Media Management window affects the scope that is selected when 
you open this window, but it doesn’t limit to operation to only the selected items. So, if nothing 
was selected in the Media Pool, then “Entire Project” is automatically highlighted. If any clips were 
selected, then “Clips” is highlighted automatically. If any Timelines were selected, then “Timelines” 
is highlighted. However, if for whatever reason the wrong option is highlighted, you need only click 
the option you want to select it instead.

Media Management scope options

4 Next, choose which operation you want to perform:

 — Copy: Creates duplicates of all media associated with clips or timelines at the destination.

 — Transcode: Creates duplicates of all media associated with clips or timelines in a new format 
that you specify; all transcoded clips are written to the same destination.

Media Management operations

5 Click the Browse button and use the File Destination dialog to choose a location for the managed 
media to be written. The file path of this location appears in the Media Destination field.

6 Choose the options associated with the operation you selected. If you choose to media manage 
Timelines, then a Timeline Selection option lets you choose which Timelines you want to include 
in this operation. The current size of the selected media is listed below, alongside an estimate of 
the size of the media after the operation you’ve selected. Depending on which options you select, 
the estimate may be larger or smaller, but this will show you if you need to change the selected 
options to achieve a more desirable final size.
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Media Management options shown for copying 
trimmed media from a specific timeline

7 When you’ve finished choosing options, click Start. A progress bar appears showing you how long 
the operation will take.

The following workflow illustrates how you can use Media Management to cut down the amount of 
media you need to deal with when you’re conforming a project imported from elsewhere, and you’ve 
been given far more media then you actually need, because you only need what’s actually in the 
timeline you’re importing.

To use Media Management to create a consolidated duplicate 
of media for a project you’re conforming:

1 Connect the portable drive containing the media to be conformed to your workstation.

2 Import the AAF or XML project file you were given into the Edit page, and conform it to the media 
on the portable drive you connected in step 1. You’re only doing this to identify what clips you 
need to media manage, not because you’ll be working off that volume.

3 Choose File > Media Management. The Media Management window appears.

4 Choose Timelines at the top of the window, and then open the Timeline selection section and turn 
on the checkbox of the timeline you want to consolidate the media for.

5 Click the Browse button and choose the volume you want to write the consolidated media to.
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6 Choose the following options for consolidating the media. For this operation, you’ll want to enable:

 — Click the Browse button, and choose the accelerated storage volume you’re using for all 
media you’re using with DaVinci Resolve.

 — Choose the “Timelines” Media Management scope, if it’s not selected already, to manage all 
media from the selected timeline.

 — Choose “Copy” to make a duplicate of the media from the portable storage volume to your 
accelerated storage.

 — Choose “Copy and trim used media keeping 12 frame handles” if you’re comfortable 
with 12 frame handles.

 — Turn on “Consolidate multiple edit segments into one media file” if you don’t mind having 
larger media files that preserve the relationship of what clips come from which single media 
files. This can make grading simpler later on.

 — Turn on “Relink to new files” to automatically relink the timeline you’ve selected to the new 
media that’s being generated.

 

The Consolidate dialog lets you choose how 
and where to copy the trimmed media.

7 When you’re done choosing these settings, click Start. A progress bar appears showing you how 
long the operation will take.

A subset of media used by that timeline is copied to the specified directory, and a DaVinci Resolve 
Timeline (.drt) is automatically generated that is relinked to the timeline and clips in the Media 
Pool. You are now ready to continue working on the project.
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Continuing Media 
Management Jobs on Error
DaVinci Resolve has a more user-friendly behavior when dealing with errors during media 
management operations. In previous versions, DaVinci Resolve would stop and wait for user input 
immediately upon encountering an error, meaning that if an error happened while you were out at 
lunch, nothing would happen until you came back. Now, DaVinci Resolve will skip error-flagged files 
and continue to perform any remaining media management to all the other clips.

Options in the Media 
Management Window
The different Media Management operations offer different options.

 — Entire Project Copy/Transcode all media: (Not available for Timelines) Choosing this option 
copies the full amount of source media for every single clip in the project. If you add more media 
later, and then use the Copy function again, DaVinci Resolve will only copy the additional files 
needed to reflect the current Media Pool.

 — Destination: Click the Browse button to choose a destination to which to copy the managed 
media. To create a new directory, right-click a Volume icon in the File Browser list, choose New 
Folder, type a name into the resulting dialog, and click OK.

 — Timeline selections: If you’ve selected the Timelines mode of media management, you can 
open the Timeline Selection controls and turn on the checkbox by each timeline with media you 
want to include.

 — Copy/Transcode All media: Copies all media available to that operation.

 — Copy/Transcode Used media: Only copies media files for clips that are used in a timeline, and 
copies them in their entirety.

 — Copy/Transcode Used media and trim keeping x frame handles: Only copies media files that 
are used in a timeline, but eliminates unused heads and tails except for user-specified handles.

 — Use project name subfolder: Automatically creates a subfolder named for the project under the 
destination directory that contains all the copied or transcoded media.

 — Consolidate multiple edit segments into one media file: This option only becomes available 
if you’ve selected “Copy and trim used media” If multiple clips in a timeline come from the same 
media file, then a single consolidated media file will be generated that contains all frames from all 
of these clips, along with whatever additional frames lie between them. Even though this option 
results in more media being copied or moved, it’s extremely useful if you’re consolidating media 
that you want to grade using the automatic grade linking of remote versions, as this preserves the 
original relationship between each Timeline clip and the source media file it’s from.
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 — Preserve folder hierarchy after x folder levels: Retains a user-specified depth of the original 
directory structure used by a clip’s corresponding source media file, recreating it when rendering 
new files for output. The number you select determines how many levels of subdirectories 
DaVinci Resolve will automatically create within the currently specified “Render job to” directory to 
match the path used by the source files. Defaults to 0, which creates no matching subdirectories. 
The number of path levels is defined relative to the head of each media file path.

 — Relink to new files: (Appears for the Copy operation only) Relinks the selected clips and/or 
timelines to the new media you’ve created by copying, wherever you’ve copied it to.

Options for Transcode Only
The following options appear only when Transcode is the selected Media Management operation.

 — Settings: Exposes the default controls for the Media Management operation.

 — Video: Exposes the video codec controls for rendering to all available video formats.

 — Audio: Exposes the audio codec controls for rendering to all available audio formats.

File Naming When You 
Consolidate Media
When you’re media managing clip-based formats like QuickTime or MXF, if the “Trim Used Media” 
option is on, and the “Consolidate Multiple Edit Segments Into One Media File” checkbox is off, then 
timelines that use multiple clips derived from the same media file will generate multiple trimmed 
media files. To prevent these files from overwriting one another, additional characters are appended 
to each trimmed media file coming from the same source; which characters are used depends on the 
video format.

 — For DPX files: _0, _1 

 — For R3D files: _S000.RDC, _S001.RDC

 — For QuickTime files: _S000.mov, _S001.mov
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